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Safety messages

Safety messages are provided throughout this manual to protect personnel and equipment. Read each safety message carefully
before proceeding to the next step.

Safety and approval information

This Micro Motion product complies with all applicable European directives when properly installed in accordance with the
instructions in this manual. Refer to the EU declaration of conformity for directives that apply to this product. The following are
available: the EU Declaration of Conformity, with all applicable European directives, and the complete ATEX installation drawings
and instructions. In addition, the IECEx installation instructions for installations outside of the European Union and the CSA
installation instructions for installations in North America are available at Emerson.com or through your local Micro Motion
support center.

Information affixed to equipment that complies with the Pressure Equipment Directive, can be found at Emerson.com. For
hazardous installations in Europe, refer to standard EN 60079-14 if national standards do not apply.

Other information

Troubleshooting information can be found in the Configuration Manual. Product data sheets and manuals are available from the
Micro Motion web site at Emerson.com.

Return policy

Follow Micro Motion procedures when returning equipment. These procedures ensure legal compliance with government
transportation agencies and help provide a safe working environment for Micro Motion employees. Micro Motion will not accept
your returned equipment if you fail to follow Micro Motion procedures.

Return procedures and forms are available on our web support site at Emerson.com, or by calling the Micro Motion Customer
Service department.
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1 Before you begin

1.1 About this manual
This manual helps you configure, commission, use, maintain, and troubleshoot Micro Motion 2700
transmitters with FOUNDATION Fieldbus.

Important
This manual assumes that:
• The transmitter has been installed correctly and completely according to the instructions in the

transmitter installation manual.

• Users understand basic transmitter and sensor installation, configuration, and maintenance concepts and
procedures.

1.2 Fieldbus instrument data sheet
Transmitter operating conditions

Type Electronic microprocessor based

Input signal FOUNDATION fieldbus H1 ISA.50.02 IEC-61158

Baud rate 31.25 Kbps

Physical media Twisted pair wires, (H1) compliant

Power supply 9–32 VDC, bus powered, 4 wires

Power connections on FF bus 11.5 milliamps maximum

Input voltage Model 2700: 18–100 VDC or 85–265 VAC

Device class Link master; ITK 4.60 minimum

Minimum VCRs 20

Electrical class FISCO; Other

Function blocks

Device function block fixed type FOUNDATION fieldbus FF-891/FF-892 compliant

Analog Input Block (AI) Executable time: 18 ms

Analog Output Block (AO) Executable time: 18 ms

Discrete Input Block Executable time: 16 ms

Discrete Output Block Executable time: 16 ms

PID Block Executable time: 20 ms

Integrator Block (INT) Executable time: 18 ms

Instantiable Function Blocks Model 2700: DO/DI
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Transducer Block Type Measurement TB; Calibration TB
Local Display TB; Device Information TB
Enhanced Density TB; API TB

Diagnostics

Diagnostic TB

1.3 Communication methods
You can use several different communications methods to interface with the transmitter. You may use
different methods in different locations or for different tasks.

Interface Tool

Display Infrared-sensitive buttons

Universal Service Port ProLink™ III

FOUNDATION Fieldbus channel • Field communicator

• FOUNDATION Fieldbus (FF) host

— On an enhanced FF host, the transmitter parameters are displayed either
in the form of a menu tree (for example, the 475 Field Communicator)
or in the form of UIRD (for example, the AMS Intelligent Device Manager
with DeltaV™ System). Both the menu tree and UIRD are provided as
part of the Device Description.

— A basic FF host displays the transmitter parameters in the form of a list
under the Resource block and transducer blocks.

— The configuration sections contain information for both types of host.

For information about how to use the communication tools, see the appendices in this manual.

Tip
You may be able to use other communications tools, such as AMS™ Suite: Intelligent Device Manager.

1.4 Related documentation
You can find all product documentation on the product documentation DVD shipped with the product or at
Emerson.com.

See any of the following documents for more information:

• Micro Motion Series 1000 and Series 2000 Transmitters with MVD Technology Product Data Sheet

• Micro Motion 1700 and 2700 Installation Manual

• Micro Motion Enhanced Density Application Manual

• Modbus Interface Tool

• Sensor installation manual

Before you begin Configuration and Use Manual
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2 Quick start

2.1 Power up the transmitter
The transmitter must be powered up for all configuration and commissioning tasks or for process
measurement.

Procedure

1.  WARNING
If the transmitter is in a hazardous area, do not remove the housing cover while the transmitter is
powered up. Failure to follow these instructions can cause an explosion resulting in injury or death.

Ensure that all transmitter and sensor covers and seals are closed.

2. Turn on the electrical power at the power supply.
The transmitter will automatically perform diagnostic routines. The transmitter is self-switching and
will automatically detect the supply voltage. When using DC power, a minimum of 1.5 amps of startup
current is required. During this period, Alert 009 is active. The diagnostic routines should complete in
approximately 30 seconds. The status LED will turn green and begin to flash when the startup
diagnostics are complete. If the status LED exhibits different behavior, an alert is active.

Postrequisites

Although the sensor is ready to receive process fluid shortly after power-up, the electronics can take up to
ten minutes to reach thermal equilibrium. Therefore, if this is the initial startup, or if power has been off long
enough to allow components to reach ambient temperature, allow the electronics to warm up for
approximately ten minutes before relying on process measurements. During this warm-up period, you may
observe minor measurement instability or inaccuracy.

2.2 Check meter status
Check the meter for any error conditions that require user action or that affect measurement accuracy.

Procedure

1. Wait approximately 10 seconds for the power-up sequence to complete.

Immediately after power-up, the transmitter runs through diagnostic routines and checks for error
conditions. During the power-up sequence, Alert A009 is active. This alert should clear automatically
when the power-up sequence is complete.

2. Check the status LED on the transmitter.

Related information

View and acknowledge status alerts
Status alerts, causes, and recommendations
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2.2.1 Transmitter status reported by LED
LED state Description Recommendation

Solid green No alerts are active. Continue with configuration or process
measurement.

Flashing green (if
enabled)

Unacknowledged corrected condition (no
alert)

Continue with configuration or process
measurement. Acknowledge the alert if you
choose.

Solid yellow One or more low-severity alerts are active.

A low severity alarm can mean one or more
process variables is at a set output level (i.e.
simulation or two phase timeout).

A low-severity alert condition does not affect
measurement accuracy or output behavior.
You can continue with configuration or
process measurement, but Micro Motion still
recommends identifying and resolving the
alert condition.

Flashing yellow (if
enabled)

Calibration in progress.

One or more low-severity alerts are active and
have not been acknowledged.

A low-severity alert condition does not affect
measurement accuracy or output behavior.
You can continue with configuration or
process measurement, but Micro Motion still
recommends identifying and resolving the
alert condition.

Solid red One or more high-severity alerts are active. A high-severity alert condition affects
measurement accuracy and output behavior.
Resolve the alert condition before continuing.

Flashing red (if
enabled)

One or more high-severity alerts are active
and have not been acknowledged.

A high-severity alert condition affects
measurement accuracy and output behavior.
Resolve the alert condition before continuing.
Acknowledge the alert if you choose.

If Status LED Blinking is disabled, all LEDs will show a solid color rather than flashing.

2.3 Determine the FOUNDATION Fieldbus unique device ID
The transmitter is shipped with a sticker that displays a unique 32-digit number that the fieldbus segment
uses for identification. If the sticker is missing, use this procedure to determine your device ID.

Procedure

From ProLink III, navigate to Device Tools → Device Information → Transmitter Electronics → Fieldbus
Device ID.

2.4 Make a startup connection to the transmitter
For all configuration tools except the display, you must have an active connection to the transmitter to
configure the transmitter.

Procedure

Identify the communications tool to use (ProLink III or the Field Communicator), and follow the instructions
for that tool in the appropriate appendix.
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2.5 Verify mass flow measurement
Check to see that the mass flow rate reported by the transmitter is accurate. You can use any available
method.

Procedure

• Connect to the transmitter with ProLink III and read the value for Mass Flow Rate in the Process Variables
panel.

Postrequisites

If the reported mass flow rate is not accurate, check the characterization parameters.
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3 Introduction to configuration and
commissioning

3.1 Configuration flowchart
Use the following flowchart as a general guide to the configuration and commissioning process.

Some options may not apply to your installation. Detailed information is provided in the remainder of this
manual.

Configure device options and preferencesConfigure process measurement

Configure mass flow 
measurement

Configure volume flow 
meaurement

Configure temperature 
measurement

Volume flow type

Liquid Gas

Define gas properties

Configure display 
parameters

Configure fault handling 
parameters

Configure sensor 
parameters

Configure device 
parameters

Configure pressure 
compensation (optional)

Test and move to production

Done

Test or tune transmitter 
using sensor simulation

Back up transmitter 
configuration

Enable write-protection on 
transmitter configuration

Configure density 
measurement

Configure petroleum 
measurement (API) 

application (if available)

Configure concentration 
measurement application (if 

available)

Configure flow direction

Integrate device with control system

Configure digital 
communications
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3.2 Default values and ranges
See Default values and ranges to view the default values and ranges for the most commonly used parameters.

3.3 Enable access to the off-line menu of the display
Display OFF-LINE MAINT → OFF-LINE CONFG

ProLink III Device Tools → Configuration → Transmitter Display → Display Security

Field Communicator Configure → Manual Setup → Display → Display Menu → Offline Menu

Fieldbus host LDO TB → EN_LDO_OFFLINE_MENU (OD Index 17)

By default, access to the off-line menu of the display is enabled. If it is disabled, you must enable it if you want
to use the display to configure the transmitter.

Restriction
You cannot use the display to enable access to the off-line menu. You must make a connection from another
tool.

3.4 Disable write-protection on the transmitter
configuration

ProLink III Device Tools → Configuration → Write-Protection

Fieldbus Communicator Service Tools → Maintenance → Security and Simulation → Write Lock Setup

If the transmitter is write-protected, the configuration is locked and you must unlock it before you can change
any configuration parameters. By default, the transmitter is not write-protected.

Tip
Write-protecting the transmitter prevents accidental changes to configuration. It does not prevent normal
operational use. You can always disable write-protection, perform any required configuration changes, then
re-enable write-protection.

3.5 Place function, transducer, and resource blocks in
OOS mode
Prerequisites

Before you modify parameters on the fieldbus function blocks, you must place the function blocks in OOS
mode.

Procedure

Option Description

Display Not available
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Option Description

ProLink III Device Tools → Configuration → Communications → Fieldbus

Field Communicator Overview → Mode

Fieldbus host (block name) → MODE_BLOCK (OD Index Number 005)

Postrequisites

Before you return the device to operation, you must place them back in service (Auto mode).

3.6 Lockout FOUNDATION Fieldbus hosts
If you plan to use a fieldbus connection to configure the device, you can lock out fieldbus hosts. If you do this,
the fieldbus hosts will be able to read data from the device, but you will not be able to write data to the
device.

Restriction
This feature is available only if you are using the Field Communicator or AMS.

Procedure

Choose Service Tools → Maintenance → Security and Simulation → Write Lock Setup.

3.7 Restore the factory configuration
Display Not available

ProLink III Device Tools → Configuration Transfer → Restore Factory Configuration

Field communicator Service Tools → Maintenance → Reset/Restore → Master Reset

Fieldbus host Diagnostic TB → Restore Factory Config (OD Index 056)

Restoring the factory configuration returns the transmitter to the same configuration it had when it left the
factory. This may be useful if you experience problems during configuration.

Important
You cannot restore factory configurations with a 700 core.

Tip
Restoring the factory configuration is not a common action. You may want to contact customer support to
see if there is a preferred method to resolve any issues.

3.8 Enable or disable fieldbus write lock
When locked, the fieldbus write lock prevents any configuration changes being written from the fieldbus
segment.

Procedure

Set the Write Lock parameter (OD index 34) of the Resource block to Locked (1) or Unlocked (0).
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4 Configure process measurement

4.1 Configure mass flow measurement
The mass flow measurement parameters control how mass flow is measured and reported.

4.1.1 Configure Mass Flow Measurement Unit
Display OFF-LINE MAINT → OFF-LINE CONFG → UNITS → MASS

ProLink III Device Tools → Configuration → Process Measurement → Flow

Field Communicator Configure → Manual Setup → Measurements → Flow → Mass Flow Unit

Fieldbus host Measurement TB → MFLOW_UNITS (OD Index 15)

Mass Flow Measurement Unit specifies the unit of measure that will be used for the mass flow rate. The unit
used for mass total and mass inventory is derived from this unit.

Procedure

Set Mass Flow Measurement Unit to the unit you want to use.

The default setting for Mass Flow Measurement Unit is g/sec (grams per second).

Tip
If the measurement unit you want to use is not available, you can define a special measurement unit.

Options for Mass Flow Measurement Unit
The transmitter provides a standard set of measurement units for Mass Flow Measurement Unit, plus one
user-defined special measurement unit. Different communications tools may use different labels for the
units.

Unit description

Label

Display ProLink III Field Communicator

Grams per second G/S g/sec g/s

Grams per minute G/MIN g/min g/min

Grams per hour G/H g/hr g/h

Kilograms per second KG/S kg/sec kg/s

Kilograms per minute KG/MIN kg/min kg/min

Kilograms per hour KG/H kg/hr kg/h

Kilograms per day KG/D kg/day kg/d

Metric tons per minute T/MIN mTon/min t/min

Metric tons per hour T/H mTon/hr t/h

Metric tons per day T/D mTon/day t/d

Pounds per second LB/S lbs/sec lb/s
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Unit description

Label

Display ProLink III Field Communicator

Pounds per minute LB/MIN lbs/min lb/min

Pounds per hour LB/H lbs/hr lb/h

Pounds per day LB/D lbs/day lb/d

Short tons (2000 pounds) per minute ST/MIN sTon/min STon/min

Short tons (2000 pounds) per hour ST/H sTon/hr STon/h

Short tons (2000 pounds) per day ST/D sTon/day STon/d

Long tons (2240 pounds) per hour LT/H lTon/hr LTon/h

Long tons (2240 pounds) per day LT/D lTon/day LTon/d

Special unit SPECL special Special

Define a special measurement unit for mass flow
Display Not available

ProLink III Device Tools → Configuration → Process Measurement → Flow → Special Units

Field Communicator Configure → Manual Setup → Measurements → Special Units → Mass Special Units

Fieldbus host Measurement TB → MFLOW_SPECIAL_UNIT_BASE (OD Index 16)
Measurement TB → MFLOW_SPECIAL_UNIT_TIME (OD Index 17)
Measurement TB → MFLOW_SPECIAL_UNIT_CONV (OD Index 18)
Measurement TB → MFLOW_SPECIAL_UNIT_STR (OD Index 19)

A special measurement unit is a user-defined unit of measure that allows you to report process data, totalizer
data, and inventory data in a unit that is not available in the transmitter. A special measurement unit is
calculated from an existing measurement unit using a conversion factor.

Note
Although you cannot define a special measurement unit using the display, you can use the display to select an
existing special measurement unit, and to view process data using the special measurement unit.

The special unit label displays only on the local display. The AI block uses and displays the actual engineering
unit (i.e. lb/min).

Procedure

1. Specify Base Mass Unit.

Base Mass Unit is the existing mass unit that the special unit will be based on.

2. Specify Base Time Unit.

Base Time Unit is the existing time unit that the special unit will be based on.

3. Calculate Mass Flow Conversion Factor as follows:

a) x base units = y special units

b) Mass Flow Conversion Factor = x ÷ y

Configure process measurement Configuration and Use Manual
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The original mass flow rate value is divided by this value.

4. Enter Mass Flow Conversion Factor.

5. Set Mass Flow Label to the name you want to use for the mass flow unit.

6. Set Mass Total Label to the name you want to use for the mass total and mass inventory unit.

The special measurement unit is stored in the transmitter. You can configure the transmitter to use the
special measurement unit at any time.

Example: Defining a special measurement unit for mass flow

You want to measure mass flow in ounces per second (oz/sec).

1. Set Base Mass Unit to Pounds (lb).

2. Set Base Time Unit to Seconds (sec).

3. Calculate Mass Flow Conversion Factor:
a. 1 lb/sec = 16 oz/sec

b. Mass Flow Conversion Factor = 1 ÷ 16 = 0.0625

4. Set Mass Flow Conversion Factor to 0.0625.

5. Set Mass Flow Label to oz/sec.

6. Set Mass Total Label to oz.

4.1.2 Configure Flow Damping
Display Not available

ProLink III Device Tools → Configuration → Process Measurement → Flow

Field Communicator Configure → Manual Setup → Measurements → Flow → Flow Damping

Fieldbus host Measurement TB → FLOW_DAMPING → OD Index

Damping is used to smooth out small, rapid fluctuations in process measurement. Damping Value specifies
the time period (in seconds) over which the transmitter will spread changes in the process variable. At the end
of the interval, the internal value will reflect 63% of the change in the actual measured value.

Procedure

Set Flow Damping to the value you want to use.

• Default: 0.8 seconds

• Range: 0 seconds to 51.2 seconds

• Valid damping values: 0.0, 0.1, 0.2, 0.4, 0.8, 1.6, 3.2, 6.4, 12.8, 25.6, 51.2

Tip
• A high damping value makes the process variable appear smoother because the reported value changes

slowly.

• A low damping value makes the process variable appear more erratic because the reported value changes
more quickly.
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• The combination of a high damping value and rapid, large changes in flow rate can result in increased
measurement error.

• Whenever the damping value is non-zero, the reported measurement will lag the actual measurement
because the reported value is being averaged over time.

• In general, lower damping values are preferable because there is less chance of data loss, and less lag time
between the actual measurement and the reported value.

The value you enter is automatically rounded off to the nearest valid value. For example, if the damping is
currently set to 0.8 seconds, any value entered up to 1.2 seconds will be rounded down to 0.8 seconds, and
any value entered from 1.21 to 1.59 seconds will be rounded up to 1.6 seconds.

Effect of flow damping on volume measurement
Flow damping affects volume measurement for liquid volume data. Flow damping also affects volume
measurement for gas standard volume data. The transmitter calculates volume data from the damped mass
flow data.

4.1.3 Configure Mass Flow Cutoff
Display Not available

ProLink III Device Tools → Configuration → Process Measurement → Flow

Field Communicator Configure → Manual Setup → Measurements → Flow → Mass Flow Cutoff

Fieldbus host Measurement TB → MASS_LOW_CUT (OD Index 38)

Mass Flow Cutoff specifies the lowest mass flow rate that will be reported as measured. All mass flow rates
below this cutoff will be reported as 0.

Procedure

Set Mass Flow Cutoff to the value you want to use.

The default value for Mass Flow Cutoff is 0.0 g/sec or a sensor-specific value set at the factory. The
recommended value is 0.5% of the nominal flow rate of the attached sensor. See the sensor specifications. Do
not leave Mass Flow Cutoff at 0.0 g/sec.

Effect of Mass Flow Cutoff on volume measurement
Mass Flow Cutoff does not affect volume measurement. Volume data is calculated from the actual mass data
rather than the reported value.

Volume flow has a separate Volume Flow Cutoff that is not affected by the Mass Flow Cutoff value.
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4.2 Configure volume flow measurement for liquid
applications
The volume flow measurement parameters control how liquid volume flow is measured and reported.

Restriction
You cannot implement both liquid volume flow and gas standard volume flow at the same time. Choose one
or the other.

4.2.1 Configure Volume Flow Type for liquid applications
Display Not available

ProLink III Device Tools → Configuration → Process Measurement → Flow

Field Communicator Configure → Manual Setup → Measurements → GSV → Volume Flow Type → Liquid

Fieldbus host Measurement TB → SNS_EnableGSV (OD Index 66)

Volume Flow Type controls whether liquid or gas standard volume flow measurement will be used.

Restriction
Gas standard volume measurement is incompatible with some applications. Set Volume Flow Type to Liquid
if you are using any of the following applications:

• Petroleum measurement

• Concentration measurement

Procedure

Set Volume Flow Type to Liquid.

4.2.2 Configure Volume Flow Measurement Unit for liquid
applications

Display OFF-LINE MAINT → OFF-LINE CONFG → UNITS → VOL

ProLink III Device Tools → Configuration → Process Measurement → Flow

Field Communicator Configure → Manual Setup → Measurements → Flow → Volume Flow Unit

Fieldbus host Measurement TB → VOLUME_FLOW_UNITS (OD Index 25)

Volume Flow Measurement Unit specifies the unit of measurement that will be displayed for the volume
flow rate. The unit used for the volume total and volume inventory is based on this unit.

Prerequisites

Before you configure Volume Flow Measurement Unit, be sure that Volume Flow Type is set to Liquid.

Procedure

Set Volume Flow Measurement Unit to the unit you want to use.
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To read US gallons, select that unit from this menu. G/MIN stands for grams per minute (USGPM), not gallons
per minute. The default setting for Volume Flow Measurement Unit is l/sec (liters per second).

Tip
If the measurement unit you want to use is not available, you can define a special measurement unit.

Options for Volume Flow Measurement Unit for liquid applications
The transmitter provides a standard set of measurement units for Volume Flow Measurement Unit, plus one
user-defined measurement unit. Different communications tools may use different labels for the units.

Unit description

Label

Display ProLink III Field Communicator

Cubic feet per second CUFT/S ft3/sec CFS

Cubic feet per minute CUF/MN ft3/min CFM

Cubic feet per hour CUFT/H ft3/hr CFH

Cubic feet per day CUFT/D ft3/day ft3/d

Cubic meters per second M3/S m3/sec m3/s

Cubic meters per minute M3/MIN m3/min m3/min

Cubic meters per hour M3/H m3/hr m3/h

Cubic meters per day M3/D m3/day m3/d

U.S. gallons per second USGPS US gal/sec gal/s

U.S. gallons per minute USGPM US gal/min GPM

U.S. gallons per hour USGPH US gal/hr gal/h

U.S. gallons per day USGPD US gal/day gal/d

Million U.S. gallons per day MILG/D mil US gal/day Mgal/d

Liters per second L/S l/sec L/s

Liters per minute L/MIN l/min L/min

Liters per hour L/H l/hr L/h

Million liters per day MILL/D mil l/day ML/d

Imperial gallons per second UKGPS Imp gal/sec Impgal/s

Imperial gallons per minute UKGPM Imp gal/min Impgal/min

Imperial gallons per hour UKGPH Imp gal/hr Impgal/h

Imperial gallons per day UKGPD Imp gal/day Impgal/d

Barrels per second(1) BBL/S barrels/sec barrel(US Beer)/s

Barrels per minute BBL/MN barrels/min barrel(US Beer)/min

Barrels per hour BBL/H barrels/hr barrel(US Beer)/h

Barrels per day BBL/D barrels/day barrel(US Beer)/d

Beer barrels per second(2) BBBL/S Beer barrels/sec bbbl/s
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Unit description

Label

Display ProLink III Field Communicator

Beer barrels per minute BBBL/MN Beer barrels/min bbbl/min

Beer barrels per hour BBBL/H Beer barrels/hr bbbl/h

Beer barrels per day BBBL/D Beer barrels/day bbbl/d

(1) Unit based on oil barrels (42  U.S. gallons).
(2) Unit based on U.S. beer barrels (31 U.S. gallons).

Define a special measurement unit for volume flow
Display Not available

ProLink III Device Tools → Configuration → Process Measurement → Flow → Special Units

Field Communicator Configure → Manual Setup → Measurements → Special Units → Volume Special Units

Fieldbus host Measurement TB → VOL_SPECIAL_UNIT_BASE (OD Index 26)
Measurement TB → VOL _SPECIAL_UNIT_TIME (OD Index 27)
Measurement TB → VOL _SPECIAL_UNIT_CONV (OD Index 28)
Measurement TB → VOL _SPECIAL_UNIT_STR (OD Index 29)

A special measurement unit is a user-defined unit of measure that allows you to report process data, totalizer
data, and inventory data in a unit that is not available in the transmitter. A special measurement unit is
calculated from an existing measurement unit using a conversion factor.

Note
Although you cannot define a special measurement unit using the display, you can use the display to select an
existing special measurement unit, and to view process data using the special measurement unit.

The special unit label displays only on the local display. The AI block uses and displays the actual engineering
unit (i.e. L/min).

Procedure

1. Specify Base Volume Unit.

Base Volume Unit is the existing volume unit that the special unit will be based on.

2. Specify Base Time Unit.

Base Time Unit is the existing time unit that the special unit will be based on.

3. Calculate Volume Flow Conversion Factor as follows:

a) x base units = y special units

b) Volume Flow Conversion Factor = x ÷ y

4. Enter Volume Flow Conversion Factor.

The original volume flow rate value is divided by this conversion factor.

5. Set Volume Flow Label to the name you want to use for the volume flow unit.

6. Set Volume Total Label to the name you want to use for the volume total and volume inventory unit.
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The special measurement unit is stored in the transmitter. You can configure the transmitter to use the
special measurement unit at any time.

Defining a special measurement unit for volume flow

You want to measure volume flow in pints per second (pints/sec).

1. Set Base Volume Unit to Gallons (gal).

2. Set Base Time Unit to Seconds (sec).

3. Calculate the conversion factor:
a. 1 gal/sec = 8 pints/sec

b. Volume Flow Conversion Factor = 1 ÷ 8 = 0.1250

4. Set Volume Flow Conversion Factor to 0.1250.

5. Set Volume Flow Label to pints/sec.

6. Set Volume Total Label to pints.

4.2.3 Configure Volume Flow Cutoff
Display Not available

ProLink III Device Tools → Configuration → Process Measurement → Flow

Field Communicator Configure → Manual Setup → Measurements → Flow → Volume Flow Cutoff

Fieldbus host Measurement TB → VOLUME_FLOW_LOW_CUTOFF (OD Index 39)

Volume Flow Cutoff specifies the lowest volume flow rate that will be reported as measured. All volume flow
rates below this cutoff are reported as 0.

Procedure

Set Volume Flow Cutoff to the value you want to use.

The default value for Volume Flow Cutoff is 0.0 l/sec (liters per second). The lower limit is 0. Leaving the
volume flow cutoff at 0 is not recommended.

4.3 Configure GSV flow measurement
The gas standard volume (GSV) flow measurement parameters control how volume flow is measured and
reported in a gas application.

Restriction
You cannot implement both liquid volume flow and gas standard volume flow at the same time. Choose one
or the other.

4.3.1 Configure Volume Flow Type for gas applications
Display Not available

ProLink III Device Tools → Configuration → Process Measurement → Flow
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Field Communicator Configure → Manual Setup → Measurements → GSV → Volume Flow Type → Standard Gas Volume

Fieldbus host Measurement TB → GSV_Gas_Dens (OD Index 62)
Measurement TB → SNS_GSV_FlowUnits (OD Index 67)
Measurement TB → SNS_GSVflowFactor (OD Index 71)
Measurement TB → SNS_GSV_FlowCutoff (OD Index 74)

Volume Flow Type controls whether liquid or gas standard volume flow measurement is used.

Restriction
Gas standard volume measurement is incompatible with some applications. Set Volume Flow Type to Liquid
if you are using any of the following applications:

• Petroleum measurement

• Concentration measurement

Procedure

Set Volume Flow Type to Gas Standard Volume.

4.3.2 Configure Standard Density of Gas
Display Not available

ProLink III Device Tools → Configuration → Process Measurement → Flow

Field Communicator Configure → Manual Setup → Measurements → GSV → Gas Ref Density

Fieldbus host Measurement TB → GSV_Gas_Dens (OD Index 62)

The Standard Density of Gas value is the gas density at standard reference conditions. Use it to convert the
measured mass flow data to volume flow at reference conditions.

Prerequisites

Ensure that Density Measurement Unit is set to the measurement unit you want to use for Standard Density
of Gas.

Procedure

Set Standard Density of Gas to standard reference conditions.

4.3.3 Configure Gas Standard Volume Flow Unit
Display OFF-LINE MAINT → OFF-LINE CONFG → UNITS → GSV

ProLink III Device Tools → Configuration → Process Measurement → Flow

Field Communicator Configure → Manual Setup → Measurements → GSV → GSV Flow Unit

Fieldbus host Measurement TB → SNS_GSV_FlowUnits (OD Index 67)
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Gas Standard Volume Flow Unit specifies the unit of measure that will be displayed for the gas standard
volume flow. The measurement unit used for the gas volume total and the gas volume inventory is derived
from this unit.

Prerequisites

Before you configure Gas Standard Volume Flow Unit, be sure that Volume Flow Type is set to Gas Standard
Volume.

Procedure

Set Gas Standard Volume Flow Unit to the unit you want to use.

The default setting for Gas Standard Volume Flow Unit is SCFM (Standard Cubic Feet per Minute).

Tip
If the measurement unit you want to use is not available, you can define a special measurement unit.

Options for Gas Standard Volume Flow Unit
The transmitter provides a standard set of measurement units for Gas Standard Volume Flow Unit, plus one
user-defined special measurement unit. Different communications tools may use different labels for the
units.

Unit description

Label

Display ProLink III Field Communicator

Normal cubic meters per second NM3/S Nm3/sec Nm3/s

Normal cubic meters per minute NM3/MN Nm3/sec Nm3/min

Normal cubic meters per hour NM3/H Nm3/hr Nm3/h

Normal cubic meters per day NM3/D Nm3/day Nm3/d

Normal liters per second NLPS NLPS NL/s

Normal liters per minute NLPM NLPM NL/min

Normal liters per hour NLPH NLPH NL/h

Normal liters per day NLPD NLPD NL/d

Standard cubic feet per second SCFS SCFS SCFS

Standard cubic feet per minute SCFM SCFM SCFM

Standard cubic feet per hour SCFH SCFH SCFH

Standard cubic feet per day SCFD SCFD SCFD

Standard cubic meters per second SM3/S Sm3/sec Sm3/s

Standard cubic meters per minute SM3/MN Sm3/min Sm3/min

Standard cubic meters per hour SM3/H Sm3/hr Sm3/h

Standard cubic meters per day SM3/D Sm3/day Sm3/d

Standard liters per second SLPS SLPS SL/s

Standard liters per minute SLPM SLPM SL/min

Standard liters per hour SLPH SLPH SL/h
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Unit description

Label

Display ProLink III Field Communicator

Standard liters per day SLPD SLPD SL/d

Special measurement unit SPECL special Special

Define a special measurement unit for gas standard volume flow
Display Not available

ProLink III Device Tools → Configuration → Process Measurement → Flow → Special Units

Field Communicator Configure → Manual Setup → Measurements → Special Units → Special GSV Units

Fieldbus host Measurement TB → SNS_GSVflowBaseUnit (OD Index 69)
Measurement TB → SNS_GSVflowBaseTime (OD Index 70)
Measurement TB → SNS_GSVflowFactor (OD Index 71)
Measurement TB → SNS_GSVflowText (OD Index 72)

A special measurement unit is a user-defined unit of measure that allows you to report process data, totalizer
data, and inventory data in a unit that is not available in the transmitter. A special measurement unit is
calculated from an existing measurement unit using a conversion factor.

Note
Although you cannot define a special measurement unit using the display, you can use the display to select an
existing special measurement unit, and to view process data using the special measurement unit.
The special unit label displays only on the local display. The AI block uses and displays the actual engineering
unit (i.e. SCFM).

Procedure

1. Specify Base Gas Standard Volume Unit.

Base Gas Standard Volume Unit is the existing gas standard volume unit that the special unit will be
based on.

2. Specify Base Time Unit.

Base Time Unit is the existing time unit that the special unit will be based on.

3. Calculate Gas Standard Volume Flow Conversion Factor as follows:

a) x base units = y special units

b) Gas Standard Volume Flow Conversion Factor = x ÷ y

4. Enter the Gas Standard Volume Flow Conversion Factor.

The original gas standard volume flow value is divided by this conversion factor.

5. Set Gas Standard Volume Flow Label to the name you want to use for the gas standard volume flow
unit.

6. Set Gas Standard Volume Total Label to the name you want to use for the gas standard volume total
and gas standard volume inventory unit.

The special measurement unit is stored in the transmitter. You can configure the transmitter to use the
special measurement unit at any time.
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Example: Defining a special measurement unit for gas standard volume flow

You want to measure gas standard volume flow in thousands of standard cubic feet per minute.

1. Set Base Gas Standard Volume Unit to SCF.

2. Set Base Time Unit to minutes (min).

3. Calculate the conversion factor:
a. 1 thousands of standard cubic feet per minute = 1000 cubic feet per minute

b. Gas Standard Volume Flow Conversion Factor = 1 ÷ 1000 = 0.001 standard

4. Set Gas Standard Volume Flow Conversion Factor to 0.001.

5. Set Gas Standard Volume Flow Label to MSCFM.

6. Set Gas Standard Volume Total Label to MSCF.

4.3.4 Configure Gas Standard Volume Flow Cutoff
Display Not available

ProLink III Device Tools → Configuration → Process Measurement → Flow

Field Communicator Configure → Manual Setup → Measurements → GSV → GSV Cutoff

Fieldbus host Measurement TB → SNS_GSV_FlowCutoff (OD Index 74)

Gas Standard Volume Flow Cutoff specifies the lowest gas standard volume flow rate that will reported as
measured. All gas standard volume flow rates below this cutoff will be reported as 0.

Procedure

Set Gas Standard Volume Flow Cutoff to the value you want to use.

The default value for Gas Standard Volume Flow Cutoff is 0.0. The lower limit is 0.0. There is no upper limit.
The recommended value is 0.5% of the nominal flow rate of the attached sensor. See the sensor
specifications.

4.4 Configure Flow Direction
Display Not available

ProLink III Device Tools → Configuration → Process Measurement → Flow

Field Communicator Configure → Manual Setup → Measurements → Flow → Flow Direction

Fieldbus host Measurement TB → FLOW_DIRECTION {OD Index 41)

Flow Direction controls how forward flow and reverse flow affect flow measurement and reporting.

Flow Direction is defined with respect to the flow arrow on the sensor:

• Forward flow (positive flow) moves in the direction of the flow arrow on the sensor.

• Reverse flow (negative flow) moves in the direction opposite to the flow arrow on the sensor.
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Tip
Micro Motion sensors are bidirectional. Measurement accuracy is not affected by actual flow direction or the
setting of the Flow Direction parameter.

Procedure

Set Flow Direction to the value you want to use.

4.4.1 Options for Flow Direction
Flow Direction setting

Relationship to Flow Direction arrow on sensorProLink III Field Communicator

Forward Forward Appropriate when the Flow Direction arrow is in
the same direction as the majority of flow.

Reverse Reverse Appropriate when the Flow Direction arrow is in
the opposite direction from the majority of flow.

Absolute Value Absolute Value Flow Direction arrow is not relevant.

Bidirectional Bi directional Appropriate when both forward and reverse flow
are expected, and forward flow will dominate, but
the amount of reverse flow will be significant.

Negate Forward Negate/Forward Only Appropriate when the Flow Direction arrow is in
the opposite direction from the majority of flow.

Negate Bidirectional Negate/Bi-directional Appropriate when both forward and reverse flow
are expected, and reverse flow will dominate, but
the amount of forward flow will be significant.

Effect of flow direction on digital communications
Flow direction affects how flow values are reported via digital communications. The following table describes
the effect of the flow direction parameter and actual flow direction on flow values reported via digital
communications.

Table 4-1: Effect of the flow direction on flow values

Flow Direction setting

Actual flow direction

Forward Zero flow Reverse

Forward Positive 0 Negative

Reverse Positive 0 Negative

Bidirectional Positive 0 Negative

Absolute Value Positive(1) 0 Positive(1)

Negate Forward Negative 0 Positive

Negate Bidirectional Negative 0 Positive

(1) Refer to the digital communications status bits for an indication of whether flow is positive or negative.
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Effect of flow direction on flow totals
Flow direction affects how flow totals and inventories are calculated.

Flow Direction setting

Actual flow direction

Forward Zero flow Reverse

Forward Totals increase Totals do not change Totals do not change

Bidirectional Totals increase Totals do not change Totals decrease

Negate Forward Totals do not change Totals do not change Totals increase

Negate Bidirectional Totals decrease Totals do not change Totals increase

4.5 Configure density measurement
The density measurement parameters control how density is measured and reported.

4.5.1 Configure Density Measurement Unit
Display OFF-LINE MAINT → OFF-LINE CONFG → UNITS → DENS

ProLink III Device Tools → Configuration → Process Measurement → Density

Field Communicator Configure → Manual Setup → Measurements → Density → Density Unit

Fieldbus host Measurement TB → DENSITY_UNITS (OD Index 23)

Density Measurement Unit controls the measurement units that will be used in density calculations and
reporting.

Procedure

Set Density Measurement Unit to the option you want to use.

The default setting for Density Measurement Unit is g/cm3 (grams per cubic centimeter).

Options for Density Measurement Unit
The transmitter provides a standard set of measurement units for Density Measurement Unit. Different
communications tools may use different labels.

Unit description

Label

Display ProLink III Field Communicator

Specific gravity(1) SGU SGU SGU

Grams per cubic centimeter G/CM3 g/cm3 g/cm3

Grams per liter G/L g/l g/L

Grams per milliliter G/mL g/ml g/ml

Kilograms per liter KG/L kg/l kg/L

Kilograms per cubic meter KG/M3 kg/m3 kg/m3

Pounds per U.S. gallon LB/GAL lbs/Usgal lb/gal
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Unit description

Label

Display ProLink III Field Communicator

Pounds per cubic foot LB/CUF lbs/ft3 lb/ft3

Pounds per cubic inch LB/CUI lbs/in3 lb/in3

Short ton per cubic yard ST/CUY sT/yd3 STon/yd3

Degrees API D API degAPI degAPI

(1) Non-standard calculation. This value represents line density divided by the density of water at 4 °C.

4.5.2 Configure two-phase flow parameters
Display Not available

ProLink III Device Tools → Configuration → Process Measurement → Density

Field Communicator Configure → Manual Setup → Measurements → Density → Slug Low Limit
Configure → Manual Setup → Measurements → Density → Slug High Limit
Configure → Manual Setup → Measurements → Density → Slug Duration

Fieldbus host Diag TB → SLUG_LOW_LIMIT (OD Index 15)
Diag TB → SLUG_HIGH_LIMIT (OD Index 16)
Diag TB → SLUG_TIME (OD Index 14)

The two-phase flow parameters control how the transmitter detects and reports two-phase flow (gas in a
liquid process or liquid in a gas process).

Note
Two-phase flow is also referred to as slug flow.

Procedure

1. Set Two-Phase Flow Low Limit to the lowest density value that is considered normal in your process.

Values below this will cause the transmitter to post Alert A105 (Two-Phase Flow).

Tip
Gas entrainment can cause your process density to drop temporarily. To reduce the occurrence of two-
phase flow alerts that are not significant to your process, set Two-Phase Flow Low Limit slightly below
your expected lowest process density.

You must enter Two-Phase Flow Low Limit in g/cm³, even if you configured another unit for density
measurement.

2. Set Two-Phase Flow High Limit to the highest density value that is considered normal in your process.

Micro Motion recommends leaving Two-Phase Flow High Limit at the default value.

Values above this will cause the transmitter to post Alert A105 (Two-Phase Flow).

You must enter Two-Phase Flow High Limit in g/cm³, even if you configured another unit for density
measurement.

3. Set Two-Phase Flow Timeout to the number of seconds that the transmitter will wait for a two-phase
flow condition to clear before posting the alert.
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The default value for Two-Phase Flow Timeout is 0.0 seconds, meaning that the alert will be posted
immediately. The range is 0.0 to 60.0 seconds.

The Two-Phase Flow alert is set immediately. The flow rate will hold the last measured value for the
Timeout time. Then the flow rate will report zero flow. If the density goes back in range, the error clears
immediately.

Detecting and reporting two-phase flow
Two-phase flow (gas in a liquid process or liquid in a gas process) can cause a variety of process control issues.
By configuring the two-phase flow parameters appropriately for your application, you can detect process
conditions that require correction.

Micro Motion recommends leaving Two-Phase Flow High Limit at the default value.

A two-phase flow condition occurs whenever the measured density goes below Two-Phase Flow Low Limit or
above Two-Phase Flow High Limit. If this occurs:

• A two-phase flow alert is posted to the active alert log.

• All outputs that are configured to represent flow rate hold their last pre-alert value for the number of
seconds configured in Two-Phase Flow Timeout.

If the two-phase flow condition clears before Two-Phase Flow Timeout expires:

• Outputs that represent flow rate revert to reporting actual flow.

• The two-phase flow alert is deactivated, but remains in the active alert log until it is acknowledged.

If the two-phase flow condition does not clear before Two-Phase Flow Timeout expires, the outputs that
represent flow rate report a flow rate of 0.

If Two-Phase Flow Timeout is set to 0.0 seconds, the outputs that represent flow rate will report a flow rate of
0 as soon as two-phase flow is detected.

4.5.3 Configure Density Damping
Display Not available

ProLink III Device Tools → Configuration → Process Measurement → Density

Field Communicator Configure → Manual Setup → Measurements → Density → Density Damping

Fieldbus host Measurement TB → DENSITY_DAMPING (OD Index 34)

Density Damping controls the amount of damping that will be applied to the line density value.

Damping is used to smooth out small, rapid fluctuations in process measurement. Damping Value specifies
the time period (in seconds) over which the transmitter will spread changes in the process variable. At the end
of the interval, the internal value will reflect 63% of the change in the actual measured value.

Tip
Density damping affects all process variables that are calculated from line density.

Procedure

Set Density Damping to the desired value.
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• Default: 1.6 seconds

• Range: 0 to 51.2 seconds

• Valid damping values: 0.0, 0.1, 0.2, 0.4, 0.8, 1.6, 3.2, 6.4, 12.8, 25.6, 51.2

The default value is 1.6 seconds. The range depends on the core processor type and the setting of Update
Rate, as shown in the following table:

Tip
• A high damping value makes the process variable appear smoother because the reported value changes

slowly.

• A low damping value makes the process variable appear more erratic because the reported value changes
more quickly.

• The combination of a high damping value and rapid, large changes in flow rate can result in increased
measurement error.

• Whenever the damping value is non-zero, the reported measurement will lag the actual measurement
because the reported value is being averaged over time.

• In general, lower damping values are preferable because there is less chance of data loss, and less lag time
between the actual measurement and the reported value.

Effect of Density Damping on volume measurement
Density Damping affects liquid volume measurement. Liquid volume values are calculated from the damped
density value rather than the measured density value. Density Damping does not affect gas standard volume
measurement.

4.5.4 Configure Density Cutoff
Display Not available

ProLink III Device Tools → Configuration → Process Measurement → Density

Field Communicator Configure → Manual Setup → Measurements → Density → Density Cutoff

Fieldbus host Measurement TB → DENSITY_LOW_CUTOFF (OD Index 38)

Density Cutoff specifies the lowest density value that will be reported as measured. All density values below
this cutoff will be reported as 0.

Procedure

Set Density Cutoff to the value you want to use.

For most applications, the default setting (0.2 g/cm³) is sufficient. The range is 0.0 g/cm³ to 0.5 g/cm³.

Configuration and Use Manual Configure process measurement
20000326 August 2022

Configuration and Use Manual 33



Effect of Density Cutoff on volume measurement
Density Cutoff affects liquid volume measurement. If the density value goes below Density Cutoff, the
volume flow rate is reported as 0.

4.6 Configure temperature measurement
The temperature measurement parameters control how temperature data from the sensor is reported.

4.6.1 Configure Temperature Measurement Unit
Display OFF-LINE MAINT → OFF-LINE CONFG → UNITS → TEMP

ProLink III Device Tools → Configuration → Process Measurement → Temperature

Field Communicator Configure → Manual Setup → Measurements → Temperature → Temperature Unit

Fieldbus host Measurement TB → TEMPERATURE_UNITS (OD Index 21)

Temperature Measurement Unit specifies the unit that will be used for temperature measurement.

Procedure

Set Temperature Measurement Unit to the option you want to use.

The default setting is Degrees Celsius.

Options for Temperature Measurement Unit
The transmitter provides a standard set of units for Temperature Measurement Unit. Different
communications tools may use different labels for the units.

Unit description

Label

Display ProLink III Field Communicator

Degrees Celsius °C °C degC

Degrees Fahrenheit °F °F degF

Degrees Rankine °R °R degR

Kelvin °K °K K

4.6.2 Configure Temperature Damping
Display Not available

ProLink III Device Tools → Configuration → Temperature

Field Communicator Configure → Manual Setup → Measurements → Temperature → Temp Damping

Fieldbus host Measurement TB → TEMPERATURE_DAMPING (OD Index 33)
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Temperature Damping controls the amount of damping that will be applied to the line temperature value,
when the on-board temperature data is used (RTD).

Damping is used to smooth out small, rapid fluctuations in process measurement. Damping Value specifies
the time period (in seconds) over which the transmitter will spread changes in the process variable. At the end
of the interval, the internal value will reflect 63% of the change in the actual measured value.

Tip
Temperature Damping affects all process variables, compensations, and corrections that use temperature
data from the sensor.

Procedure

Enter the value you want to use for Temperature Damping.

The default value is 4.8 seconds. For most applications, the default temperature damping setting is sufficient.
The range is 0.0 to 38.4 seconds.

Tip
• A high damping value makes the process variable appear smoother because the reported value changes

slowly.

• A low damping value makes the process variable appear more erratic because the reported value changes
more quickly.

• Whenever the damping value is non-zero, the reported measurement will lag the actual measurement
because the reported value is being averaged over time.

• In general, lower damping values are preferable because there is less chance of data loss, and less lag time
between the actual measurement and the reported value.

The value you enter is automatically rounded off to the nearest valid value. Valid values for Temperature
Damping are 0, 0.6, 1.2, 2.4, 4.8, 9.6, 19.2, and 38.4.

4.6.3 Effect of Temperature Damping on process measurement
Temperature Damping affects all processes and algorithms that use temperature data from the internal
sensor RTD.

Temperature compensation

Temperature compensation adjusts process measurement to compensate for the effect of temperature on
the sensor tubes.

Petroleum measurement

Temperature Damping affects petroleum measurement process variables only if the transmitter is
configured to use temperature data from the sensor. If an external temperature value is used for petroleum
measurement, Temperature Damping does not affect petroleum measurement process variables.

Concentration measurement

Temperature Damping affects concentration measurement process variables only if the transmitter is
configured to use temperature data from the sensor. If an external temperature value is used for
concentration measurement, Temperature Damping does not affect concentration measurement process
variables.
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4.7 Configure the petroleum measurement application
The petroleum measurement application corrects line density to reference temperature according to
American Petroleum Institute (API) standards. The resulting process variable is referred density.

4.7.1 Configure petroleum measurement using ProLink III
The petroleum measurement parameters specify the API table, measurement units, and reference values to
be used in referred density calculations.

Prerequisites

You will need API documentation for the API table that you select.

Depending on your API table, you may need to know the thermal expansion coefficient (TEC) for your process
fluid.

You must know the reference temperature that you want to use.

Procedure

1. Choose Device Tools → Configuration → Process Measurement → Petroleum Measurement.

2. Specify the API table to use to calculate referred density.

Each API table is associated with a specific set of equations.

a) Set Process Fluid to the API table group that your process fluid belongs to.

API table group Process fluids

A tables Generalized crude and JP4

B tables Generalized products: Gasoline, jet fuel, aviation fuel, kerosene, heating oils,
fuel oils, diesel, gas oil

C tables Liquids with a constant base density or known thermal expansion coefficient
(TEC). You will be required to enter the TEC for your process fluid.

D tables Lubricating oils

b) Set Referred Density Measurement Unit to the measurement units that you want to use for
referred density.

c) Click Apply.

These parameters uniquely identify the API table to be used to calculate referred density. The selected
API table is displayed, and the meter automatically changes the density unit, temperature unit,
pressure unit, and reference pressure to match the API table.

Your choice also determines the API table that will be used to calculate the correction factor for volume
(CTL).

Restriction
Not all combinations are supported by the petroleum measurement application. See the list of API
tables in this manual.

3. Refer to the API documentation and confirm your table selection.
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a) Verify that your process fluid falls within range for line density, line temperature, and line
pressure.

b) Verify that the referred density range of the selected table is adequate for your application.

4. If you chose a C table, enter Thermal Expansion Coefficient (TEC) for your process fluid.

5. Set Reference Temperature to the temperature to which density will be corrected in referred density
calculations. If you choose Other, select the temperature measurement unit and enter the reference
temperature.

4.7.2 Configure petroleum measurement using the Field
Communicator
Procedure

1. Choose Online → Configure → Manual Setup → Measurements → Petroleum Measurement.

2. Specify the API table to use.

a) Open the Petroleum Measurement Source menu and select the API table number.
Depending on your choice, you may be prompted to enter a reference temperature or a thermal
expansion coefficient.

b) Enter the API table letter.

These two parameters uniquely specify the API table.

3. Determine how the transmitter will obtain temperature data for the petroleum measurement
calculations, and perform the required setup.

Option Setup

Temperature data from
the sensor

a. Choose Online → Configure → Manual Setup → Measurements →
External Inputs

b. Set External Temperature to Disabled

A user-configured static
temperature value

a. Choose Online → Configure → Manual Setup → Measurements →
External Inputs

b. Set External Temperature to Enabled

c. Set Correction Temperature to the value to be used.

A value written by
digital communications

a. Choose Online → Configure → Manual Setup → Measurements →
External Inputs

b. Set External Temperature to Enabled

c. Hook up the AO Function block of the transmitter to the input of the
external device to write the external temperature to the transmitter.
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4.7.3 API tables supported by the petroleum measurement
application
The API tables listed here are supported by the petroleum measurement application.

Table
name Process fluid CTL source data Reference temperature Density unit

5A Generalized crude and
JP4

Observed density and
observed temperature

60 °F (configurable) Degrees API

Range: 0 to 100

5B Generalized products Observed density and
observed temperature

60 °F (configurable) Degrees API

Range: 0 to 85

5D Lubricating oils Observed density and
observed temperature

60 °F (configurable) Degrees API

Range: −10 to +45

6C Liquids with a constant
density base or known
thermal expansion
coefficient

User-supplied reference
density (or thermal
expansion coefficient)
and observed
temperature

60 °F (configurable) Degrees API

23A Generalized crude and
JP4

Observed density and
observed temperature

60 °F (configurable) Relative density

Range: 0.6110 to 1.0760

23B Generalized products Observed density and
observed temperature

60 °F (configurable) Relative density

Range: 0.6535 to 1.0760

23D Lubricating oils Observed density and
observed temperature

60 °F (configurable) Relative density

Range: 0.8520 to 1.1640

24C Liquids with a constant
density base or known
thermal expansion
coefficient

User-supplied reference
density (or thermal
expansion coefficient)
and observed
temperature

60 °F (configurable) Relative density

53A Generalized crude and
JP4

Observed density and
observed temperature

15 °C (configurable) Base density

Range: 610 to
1075 kg/m3

53B Generalized products Observed density and
observed temperature

15 °C (configurable) Base density

Range: 653 to
1075 kg/m3

53D Lubricating oils Observed density and
observed temperature

15 °C (configurable) Base density

Range: 825 to
1164 kg/m3

54C Liquids with a constant
density base or known
thermal expansion
coefficient

User-supplied reference
density (or thermal
expansion coefficient)
and observed
temperature

15 °C (configurable) Base density in kg/m3
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Restriction
These tables are not appropriate for the following process fluids: propane and propane mixes, butane and
butane mixes, butadiene and butadiene mixes, isopentane, LNG, LPG, NGL, ethylene, propylene, cyclohexane,
aeromatics, asphalts, and road tars.

4.8 Set up concentration measurement
This section guides you through loading and setting up a concentration matrix used for measurement. It does
not cover building a concentration matrix.

The concentration measurement application calculates concentration data from process temperature and
density. Micro Motion provides a set of concentration matrices that provide the reference data for several
standard industry applications and process fluids. If desired, you can build a custom matrix for your process
fluid, or purchase a custom matrix from Micro Motion.

Note
Concentration matrices can be made available on your transmitter either by loading an existing matrix from a
file or by building a new matrix. Up to 6 matrices can be available on your transmitter, but only 1 can be used
for measurement at any given time. For detailed information on building a matrix, see the Micro Motion
Enhanced Density Application Manual.

Prerequisites

Before you can configure concentration measurement:

• The concentration measurement application must be purchased on your transmitter.

• The concentration matrix you want to use must be available on your transmitter, or it must be available as
a file on your computer.

• You must know the derived variable that your matrix is designed for.

• You must know the density unit used by your matrix.

• You must know the temperature unit used by your matrix.

• The concentration measurement application must be unlocked.

4.8.1 Configure concentration measurement using ProLink III
Procedure

1. Choose Device Tools → Configuration → Process Measurement → Density and set Density Unit to
the density unit used by your matrix.

2. Choose Device Tools → Configuration → Process Measurement → Temperature and set
Temperature Unit to the temperature unit used by your matrix.

3. Choose Device Tools → Configuration → Process Measurement → Concentration Measurement.

4. Set Derived Variable to the derived variable that your matrix is designed for, and click Apply.

Important
• All concentration matrices on your transmitter must use the same derived variable. If you are using

one of the standard matrices from Micro Motion, set Derived Variable to Mass Concentration
(Density). If you are using a custom matrix, see the reference information for your matrix.
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• If you change the setting of Derived Variable, all existing concentration matrices will be deleted
from transmitter memory. Set Derived Variable before loading concentration matrices.

5. Load one or more matrices.

a) Set Matrix Being Configured to the location to which the matrix will be loaded.

b) Click Load Matrix from a File, navigate to the matrix file on your computer, and load it.

c) Repeat until all required matrices are loaded.

6. Configure or review matrix data.

a) If necessary, set Matrix Being Configured to the matrix you want to configure or review, and
click Change Matrix.

b) Set Concentration Unit to the label that will be used for the concentration unit.

c) If you set Concentration Unit to Special, enter the custom label.

d) If desired, change the matrix name.

e) Review the data points for this matrix.

f) Do not change Reference Temperature or Curve Fit Maximum Order.

g) If you changed any matrix data, click Apply.

7. Set up extrapolation alarms.

Each concentration matrix is built for a specific density range and a specific temperature range. If
process density or process temperature goes outside the range, the transmitter will extrapolate
concentration values. However, extrapolation may affect accuracy. Extrapolation alarms are used to
notify the operator that extrapolation is occurring.

a) If necessary, set Matrix Being Configured to the matrix you want to view, and select Change
Matrix.

b) Set Extrapolation Alarm Limit to the point, in percent, at which an extrapolation alarm will be
posted.

c) Enable or disable the high and low limit alarms for temperature and density, as desired, and
select Apply.

Example

If Extrapolation Alarm Limit is set to 5%, High Extrapolation Limit (Temperature) is enabled, and the
matrix is built for a temperature range of 40 °F (4.4 °C) to 80 °F (26.7 °C), an extrapolation alarm will be
posted if process temperature goes above 82 °F (27.8 °C).

Concentration process variables are now available on the transmitter. You can view and report them in the
same way that you view and report other process variables.
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4.8.2 Configure concentration measurement using the Field
Communicator
Procedure

1. Choose Online → Configure → Manual Setup → Measurements → External Outputs.

2. Set Pressure Compensation to Enabled.

3. Enter Flow Cal Pressurefor your sensor.

The calibration pressure is the pressure at which your sensor was calibrated, and defines the pressure at
which there is no pressure effect. If the data is unavailable, enter 20 PSI.

4. Enter Dens Press Factor for your sensor.

The density factor is the change in fluid density, in g/cm3/PSI. When entering the value, reverse the
sign.

Example

If the density factor is 0.000006 g/com3/PSI, enter -0.000006 g/cm3/PSI.

5. Determine how the transmitter will obtain pressure data, and perform the required setup.

Option Setup

A user-configured static pressure value a. Set Pressure Unit to the desired unit.
b. Set Compensation Pressure to the desired
value.

A value written by digital communications a. Choose Pressure Unit to the desired unit.
b. Perform the necessary host programming and
communications setup to write pressure data to
the transmitter at appropriate intervals .

Postrequisites

If you are using an external pressure value, verify the setup by choosing Service Tools → Variables → External
Variables and checking the value displayed for External Pressure.

4.8.3 Standard matrices for the concentration measurement
application
The standard concentration matrices available from Micro Motion are applicable for a variety of process fluids.
These matrices are included in the ProLink III installation folder.

Tip
If the standard matrices are not appropriate for your application, you can build a custom matrix or purchase a
custom matrix from Micro Motion.

Configuration and Use Manual Configure process measurement
20000326 August 2022

Configuration and Use Manual 41



Matrix name Description Density unit
Temperature
unit

Derived variable

Deg Balling Matrix represents percent extract, by
mass, in solution, based on °Balling.
For example, if a wort is 10 °Balling and
the extract in solution is 100% sucrose,
the extract is 10% of the total mass.

g/cm3 °F Mass
Concentration
(Density)

Deg Brix Matrix represents a hydrometer scale
for sucrose solutions that indicates the
percent by mass of sucrose in solution
at a given temperature. For example,
40 kg of sucrose mixed with 60 kg of
water results in a 40 °Brix solution.

g/cm3 °C Mass
Concentration
(Density)

Deg Plato Matrix represents percent extract, by
mass, in solution, based on °Plato. For
example, if a wort is 10 °Plato and the
extract in solution is 100% sucrose, the
extract is 10% of the total mass.

g/cm3 °F Mass
Concentration
(Density)

HFCS 42 Matrix represents a hydrometer scale
for HFCS 42 (high-fructose corn syrup)
solutions that indicates the percent by
mass of HFCS in solution.

g/cm3 °C Mass
Concentration
(Density)

HFCS 55 Matrix represents a hydrometer scale
for HFCS 55 (high-fructose corn syrup)
solutions that indicates the percent by
mass of HFCS in solution.

g/cm3 °C Mass
Concentration
(Density)

HFCS 90 Matrix represents a hydrometer scale
for HFCS 90 (high-fructose corn syrup)
solutions that indicates the percent by
mass of HFCS in solution.

g/cm3 °C Mass
Concentration
(Density)

4.8.4 Derived variables and calculated process variables
The concentration measurement application calculates a different set of process variables from each derived
variable. The process variables are then available for viewing or reporting.

Derived
variable

Description

Calculated process variables

Density
at
reference
temp

Standard
volume
flow rate

Specific
gravity

Concentration
Net mass
flow rate

Net
volume
flow rate

Density
at Reference

Mass/unit volume,
corrected to a given
reference temperature

✓ ✓
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Derived
variable

Description

Calculated process variables

Density
at
reference
temp

Standard
volume
flow rate

Specific
gravity

Concentration
Net mass
flow rate

Net
volume
flow rate

Specific Gravity The ratio of the
density of a process
fluid at a given
temperature to the
density of water at a
given temperature

Note
The two given
temperature
conditions do not
need to be the same.

✓ ✓ ✓

Mass
Concentration
(Density)

The percent mass of
solute or of material in
suspension in the total
solution, derived from
reference density

✓ ✓ ✓ ✓

Mass
Concentration
(Specific
Gravity)

The percent mass of
solute or of material in
suspension in the total
solution, derived from
specific gravity

✓ ✓ ✓ ✓ ✓

Volume
Concentration
(Density)

The percent volume of
solute or of material in
suspension in the total
solution, derived from
reference density

✓ ✓ ✓ ✓

Volume
Concentration
(Specific
Gravity)

The percent volume of
solute or of material in
suspension in the total
solution, derived from
specific gravity

✓ ✓ ✓ ✓ ✓

Concentration
(Density)

The mass, volume,
weight, or number of
moles of solute or of
material in suspension
in proportion to the
total solution, derived
from reference density

✓ ✓ ✓

Concentration
(Specific
Gravity)

The mass, volume,
weight, or number of
moles of solute or of
material in suspension
in proportion to the
total solution, derived
from specific gravity

✓ ✓ ✓ ✓
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4.9 Set up concentration measurement using a basic FF
host
This section guides you through most of the tasks related to setting up and implementing the concentration
measurement application.

Restriction
This section does not cover building a concentration matrix. See Micro Motion Enhanced Density Application
Manual for detailed information on building a matrix.

4.9.1 Set reference temperature values for specific gravity using a
basic FF host
When Derived Variable is set to any option based on specific gravity, you must set the reference temperature
for water, then verify the density of water at the configured reference temperature. These values affect
specific gravity measurement.

To check the setting of Derived Variable, read the value of the Derived Variable parameter in the
Concentration Measuremnt TB.

Table 4-2: Fieldbus codes for derived variable options (Derived Variable parameter)

Fieldbus code Derived variable

1 Density at reference temperature

2 Specific gravity

3 Mass concentration (density)

4 Mass concentration (specific gravity)

5 Volume concentration (density)

6 Volume concentration (specific gravity)

7 Concentration (density)

8 Concentration (specific gravity)

Important
Do not change the setting of Derived Variable. If you change the setting of Derived Variable, all existing
concentration matrices will be deleted from transmitter memory.

Procedure

Write the desired values into the appropriate parameters in the Concentration Measuremnt TB for Reference
Temperature, Water Reference Temperature, and Water Reference Density.

The transmitter automatically calculates the density of water at the specified temperature. The new value will
be displayed the next time that transmitter memory is read. You can enter a different value if you want to.
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4.9.2 Modify matrix names and labels using a basic FF host
For convenience, you can change the name of a concentration matrix and the label used for its measurement
unit. This does not affect measurement.

Procedure

1. Choose the matrix you want to modify by writing to the Matrix Being Configured parameter in the
Concentration Measuremnt TB. Each saved matrix has a unique value of 0 through 5.

2. Write the desired values into the Matrix Name and Concentration Unit parameters in the
Concentration Measuremnt TB.

Table 4-3: Concentration unit codes

Fieldbus code Unit

1110 degTwad

1426 degBrix

1111 degBaum hv

1112 degBaum It

1343 % sol/wt

1344 % sol/vol

1427 degBall

1428 proof/vol

1429 proof/mass

1346 % plato

253 special

3. Write a value into the Special Concentration Unit Label parameter if Concentration Unit is set to code
253 (special).

4.9.3 Modify extrapolation alerts for concentration measurement
using a basic FF host
You can enable and disable extrapolation alerts, and set extrapolation alert limits. These parameters control
the behavior of the concentration measurement application but do not affect measurement directly.

Each concentration matrix is built for a specific density range and a specific temperature range. If line density
or line temperature goes outside the range, the transmitter will extrapolate concentration values. However,
extrapolation may affect accuracy. Extrapolation alerts are used to notify the operator that extrapolation is
occurring.

Each concentration matrix has its own extrapolation alert limits.

Procedure

1. Choose the matrix you want to configure using the Active Matrix parameter in the Concentration
Measuremnt TB. Each saved matrix has a unique value of 0 through 5.

2. Write the desired values into the appropriate parameters in the Concentration Measuremnt TB.
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Parameter name Description

Extrapolation Limit Extrapolation Alert Limit The point, in percent, at which an
extrapolation alert will be posted.

Density Low Enable low density extrapolation alarm (write 1 to enable; 0 to
disable).

Density High Enable high density extrapolation alarm (write 1 to enable; 0 to
disable).

Temperature Low Enable low temperature extrapolation alarm (write 1 to enable; 0
to disable).

Temperature High Enable high temperature extrapolation alarm (write 1 to enable; 0
to disable).

Extrapolation alert in action

If the following conditions exist, the high temperature extrapolation alert will be posted when the line
temperature exceeds 82 °F (27.8 °C):

• The Extrapolation Alert Limit is set to 5%

• The high temperature alarm is enabled

• The active matrix is built for a temperature range of 40 °F (4.4 °C) to 80 °F (26.7 °C)

4.9.4 Select the active concentration matrix using a basic FF host
You must select the concentration matrix to be used for measurement. Although the transmitter can store up
to six concentration matrices, only one matrix can be used for measurement at any one time.

Procedure

Choose the matrix you want to use by writing to the Active Matrix parameter in the Concentration
Measuremnt TB. Each saved matrix has a unique value of 0 through 5.

4.10 Configure pressure compensation
Pressure compensation adjusts process measurement to compensate for the pressure effect on the sensor.
The pressure effect is the change in the sensor’s sensitivity to flow and density caused by the difference
between the calibration pressure and the process pressure.

Tip
Not all sensors or applications require pressure compensation. The pressure effect for a specific sensor model
can be found in the product data sheet located at Emerson.com. If you are uncertain about implementing
pressure compensation, contact customer service.

Prerequisites

You will need the flow factor, density factor, and calibration pressure values for your sensor.

• For the flow factor and density factor, see the product data sheet for your sensor.

• For the calibration pressure, see the calibration sheet for your sensor. If the data is unavailable, use 20 PSI.
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4.10.1 Configure pressure compensation using ProLink III
Procedure

1. Choose Device Tools → Configuration → Process Measurement → Pressure Compensation.

2. Set Pressure Unit to the appropriate unit.

If you will use an external pressure value, set Pressure Unit to match the pressure unit used by the
external pressure device.

3. Enter Flow Calibration Pressure for your sensor.

The calibration pressure is the pressure at which your sensor was calibrated, and defines the pressure at
which there is no pressure effect. If the data is unavailable, enter 20 PSI.

4. Enter Flow Factor for your sensor.

The flow factor is the percent change in the flow rate per PSI. When entering the value, reverse the
sign.

Example

If the flow factor is 0.000004 % per PSI, enter −0.000004 % per PSI.

5. Enter Density Factor for your sensor.

The density factor is the change in fluid density, in g/cm3/PSI. When entering the value, reverse the
sign.

Example

If the density factor is −0.000006 g/cm3/PSI, enter +0.000006 g/cm3/PSI.

Postrequisites

If you are using an external pressure value, verify the setup by checking the External Pressure value displayed
in the Inputs area of the main window.

4.10.2 Configure pressure compensation using the Field
Communicator
Procedure

1. Choose Online → Configure → Manual Setup → Measurements → External Inputs.

2. Set Pressure Compensation to Enabled.

3. Enter Flow Cal Pressure for your sensor.

The calibration pressure is the pressure at which your sensor was calibrated, and defines the pressure at
which there is no pressure effect. If the data is unavailable, enter 20 PSI.

4. Enter Flow Press Factor for your sensor.

The flow factor is the percent change in the flow rate per PSI. When entering the value, reverse the
sign.
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Example

If the flow factor is −0.0002 % per PSI, enter +0.0002 %  per  PSI.

5. Enter Dens Press Factor for your sensor.

The density factor is the change in fluid density, in g/cm3/PSI. When entering the value, reverse the
sign.

Example

If the density factor is −0.000006 g/cm3/PSI, enter +0.000006 g/cm3/PSI.

6. Determine how the transmitter will obtain pressure data, and perform the required setup.

Option Setup

A user-configured static
pressure value

a. Set Pressure Unit to the desired unit.

b. Set Compensation Pressure to the desired value.

A value written by
digital communications

a. Set Pressure Unit to the desired unit.

b. Perform the necessary host programming and communications setup
to write pressure data to the transmitter at appropriate intervals.

Postrequisites

If you are using an external pressure value, verify the setup by choosing Service Tools → Variables → External
Variables and checking the value displayed for External Pressure.

4.10.3 Options for Pressure Measurement Unit
The transmitter provides a standard set of measurement units for Pressure Measurement Unit. Different
communications tools may use different labels for the units. In most applications, Pressure Measurement
Unit should be set to match the pressure measurement unit used by the remote device.

Unit description

Label

Display ProLink III Field Communicator

Feet water @ 68 °F FTH2O Ft Water @ 68 °F ftH2O (68°F)

Inches water @ 4 °C INW4C In Water @ 4 °C inH2O (4°C)

Inches water @ 60 °F INW60 In Water @ 60 °F inH2O@60°F

Inches water @ 68 °F INH2O In Water @ 68 °F inH2O (68°F)

Millimeters water @ 4 °C mmW4C mm Water @ 4 °C mmH2O (4°C)

Millimeters water @ 68 °F mmH2O mm Water @ 68°F mmH2O (68°F)

Millimeters mercury @ 0 °C mmHG mm Mercury @ 0 °C mmHg (0°C)

Inches mercury @ 0 °C INHG In Mercury @ 0°C inHg (0°C)

Pounds per square inch PSI PSI psi
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Unit description

Label

Display ProLink III Field Communicator

Bar BAR bar bar

Millibar mBAR millibar mbar

Grams per square centimeter G/SCM g/cm2 g/cm2

Kilograms per square centimeter KG/SCM kg/cm2 kg/cm2

Pascals PA pascals Pa

Kilopascals KPA Kilopascals kPa

Megapascals MPA Megapascals MPa

Torr @ 0 °C TORR Torr @ 0°C torr

Atmospheres ATM atms atm
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5 Configure device options and preferences

5.1 Configure the transmitter display
You can control the process variables shown on the display and a variety of display behaviors.

5.1.1 Configure the language used for the display
Display OFF-LINE MAINT → OFF-LINE CONFG → DISPLAY → LANG

ProLink III Device Tools → Configuration → Transmitter Display → General

Field Communicator Configure → Manual Setup → Display → Language

Fieldbus host LDO TB → UI_Language (OD Index 24)

Display Language controls the language used for process data and menus on the display.

Procedure

Select the language you want to use.
The languages available depend on your transmitter model and version.

5.1.2 Configure the process variables and diagnostic variables
shown on the display

Display Not available

ProLink III Device Tools → Configuration → Transmitter Display → Display Variables

Field Communicator Configure → Manual Setup → Display → Display Variables

Fieldbus host LDO TB → LDO_VAR_1_CODE (OD Index 25) to

LDO TB → LDO_VAR_15_CODE (OD Index 39)

You can control the process variables and diagnostic variables shown on the display, and the order in which
they appear. The display can scroll through up to 15 variables in any order you choose. In addition, you can
repeat variables or leave slots unassigned.

Restriction
Display Variable 1 must be set to a process variable.

Note
If you configure a display variable as a volume process variable and then change Volume Flow Type, the
display variable is automatically changed to the equivalent process variable. For example, Volume Flow Rate
would be changed to Gas Standard Volume Flow Rate.

Procedure

For each display variable you want to change, assign the process variable you want to use.
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Default display variable configuration

Display variable Process variable assignment

Display Variable 1 Mass flow

Display Variable 2 Mass total

Display Variable 3 Volume flow

Display Variable 4 Volume total

Display Variable 5 Density

Display Variable 6 Temperature

Display Variable 7 Drive gain

Display Variable 8 None

Display Variable 9 None

Display Variable 10 None

Display Variable 11 None

Display Variable 12 None

Display Variable 13 None

Display Variable 14 None

Display Variable 15 None

5.1.3 Configure the number of decimal places (precision) shown on
the display

Display Not available

ProLink III Device Tools → Configuration → Transmitter Display → Display Variables

Field Communicator Configure → Manual Setup → Display → Decimal Places

Fieldbus host LDO TB → FBUS_UI_ProcVarIndex (OD Index 40)

LDO TB → UI_NumDecimals (OD Index 41)

You can specify the number of decimal places (precision) that are shown on the display for each process
variable or diagnostic variable. You can set the precision independently for each variable.

The display precision does not affect the actual value of the variable or the value used in calculations.

Procedure

1. Select a variable.

2. Set Number of Decimal Places to the number of decimal places you want shown when the process
variable or diagnostic variable appears on the display.

For temperature and density process variables, the default value is 2 decimal places. For all other
variables, the default value is 4 decimal places. The range is 0 to 5.
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Tip
The lower the precision, the greater the change must be for it to be reflected on the display. Do not set
the precision too low or too high to be useful.

5.1.4 Configure the refresh rate of data shown on the display
Display OFF-LINE MAINT → OFF-LINE CONFG → DISPLAY → RATE

ProLink III Device Tools → Configuration → Transmitter Display → Display Variables

Field Communicator Configure → Manual Setup → Display → Display Variable Menu Features → Refresh Rate

Fieldbus host LDO TB → UI_UpdatePeriodmsec (OD Index 42)

You can set Refresh Rate to control how frequently data is refreshed on the display.

Procedure

Set Refresh Rate to the desired value.

The default value is 200 milliseconds. The range is 100 milliseconds to 10,000 milliseconds (10 seconds).

5.1.5 Enable or disable automatic scrolling through the display
variables

Display OFF-LINE MAINT → OFF-LINE CONFG → DISPLAY → AUTO SCRLL

ProLink III Device Tools → Configuration → Transmitter Display → General

Field Communicator Configure → Manual Setup → Display → Display Variable Menu Features → Auto Scroll

Fieldbus host LDO TB → EN_LDO_AUTO_SCROLL (OD Index 16)

You can configure the display to automatically scroll through the configured display variables or to show a
single display variable until the operator activates Scroll. When you set automatic scrolling, you can also
configure the length of time each display variable is displayed.

Procedure

1. Enable or disable Auto Scroll as desired.

Option Description

Enabled The display automatically scrolls through each display variable as specified by Scroll
Rate. The operator can move to the next display variable at any time using Scroll.

Disabled
(default)

The display shows Display Variable 1 and does not scroll automatically. The
operator can move to the next display variable at any time using Scroll.

2. If you enabled Auto Scroll, set Scroll Rate as desired.

The default value is 10  seconds.
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Tip
Scroll Rate may not be available until you apply Auto Scroll.

5.1.6 Enable or disable the display backlight
Display OFF-LINE MAINT → OFF-LINE CONFG → DISPLAY → BKLT

ProLink III Device Tools → Configuration → Transmitter Display → General

Field Communicator Configure → Manual Setup → Display → Backlight

Fieldbus host LDO TB → LDO_BACKLIGHT_ON (OD Index 23)

You can enable or disable the display backlight.

Procedure

Enable or disable Backlight.

The default setting is Enabled.

5.1.7 Enable or disable Status LED Blinking
Display Not available

ProLink III Device Tools → Configuration → Transmitter Display → General

Field Communicator Configure → Manual Setup → Display → Display Variable Menu Features → Status LED Blinking

Fieldbus host LDO TB → UI_EnableStatusLedBlinking (OD Index 43)

By default, the status LED blinks (flashes) to indicate unacknowledged alerts. If you disable Status LED
Blinking, the status LED does not blink, whether alerts are acknowledged or not. It still changes color to
indicate active alerts.

Procedure

Enable or disable Status LED Blinking.

The default setting is Enabled.

5.2 Enable or disable operator actions from the display
You can configure the transmitter to let the operator perform specific actions using the display.

5.2.1 Enable or disable Totalizer Start/Stop from the display
Display OFF-LINE MAINT → OFF-LINE CONFG → DISPLAY → TOTALS STOP

ProLink III Device Tools → Configuration → Totalizer Control Methods

Field Communicator Configure → Manual Setup → Display → Display Variable Menu Features → Start/Stop Totalizers

Fieldbus host LDO TB → EN_LDO_TOT_START_STOP (OD Index 15)
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You can control whether or not the operator is able to start and stop totalizers and inventories from the
display.

Restriction
• You cannot start and stop totalizers individually from the display. All totalizers are started or stopped

together.

• You cannot start or stop inventories separately from totalizers. When a totalizer is started or stopped, the
associated inventory is also started or stopped.

• If the petroleum measurement application is installed, the operator must enter the off-line password to
perform this function, even if the off-line password is not enabled.

Procedure

1. Ensure that at least one totalizer is configured as a display variable.

2. Enable or disable Totalizer Reset as desired.

Option Description

Enabled Operators can start and stop totalizers and inventories from the display, if at least
one totalizer is configured as a display variable.

Disabled (default) Operators cannot start and stop totalizers and inventories from the display.

5.2.2 Enable or disable Totalizer Reset from the display
Display OFF-LINE MAINT → OFF-LINE CONFG → DISPLAY → TOTALS RESET

ProLink III Device Tools → Configuration → Totalizer Control Methods

Field Communicator Configure → Manual Setup → Display → Display Variable Menu Features → Totalizer Reset

Fieldbus host LDO TB → EN_LDO_TOT_RESET (OD Index 14)

You can configure whether or not the operator is able to reset totalizers from the display.

Restriction
• This parameter does not apply to inventories. You cannot reset inventories from the display.

• You cannot use the display to reset all totalizers as a group. You must reset totalizers individually.

• If the petroleum measurement application is installed, the operator must enter the off-line password to
perform this function, even if the off-line password is not enabled.

Procedure

1. Ensure that the totalizers you want to reset have been configured as display variables.

If the totalizer is not configured as a display variable, the operator will not be able to reset it.

2. Enable or disable resetting the totalizer as desired.
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Option Description

Enabled Operators can reset a totalizer from the display, if the totalizer is configured as a
display variable.

Disabled (default) Operators cannot reset totalizers from the display.

5.2.3 Enable or disable the Acknowledge All Alerts display
command

Display OFF-LINE MAINT → OFF-LINE CONFG → DISPLAY → ALERT

ProLink III Device Tools → Configuration → Transmitter Display → Ack All

Field Communicator Configure → Manual Setup → Display → Offline Variable Menu Features → Acknowledge All

Fieldbus host LDO TB → EN_LDO_ACK_ALL_ALARMS (OD Index 20)

You can configure whether or not the operator can use a single command to acknowledge all alerts from the
display.

Procedure

1. Ensure that the alert menu is accessible from the display.

To acknowledge alerts from the display, operators must have access to the alert menu.

2. Enable or disable Acknowledge All Alerts as desired.

Option Description

Enabled (default) Operators can use a single display command to acknowledge all alerts at once.

Disabled Operators cannot acknowledge all alerts at once. Each alert must be
acknowledged separately.

5.3 Configure security for the display menus
Display OFF-LINE MAINT → OFF-LINE CONFG → DISPLAY

ProLink III Device Tools → Configuration → Transmitter Display → Display Security

Field Communicator Configure → Manual Setup → Display → Offline Variable Menu Features

Fieldbus host LDO TB → EN_LDO_OFFLINE_PWD (OD Index 18)

LDO TB → LDO_OFFLINE_PWD ( OD Index 21)

You can control operator access to different sections of the display off-line menu. You can also configure a
password to control access.

Procedure

1. To control operator access to the maintenance section of the off-line menu, enable or disable Off-Line
Menu.
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Option Description

Disabled Operator cannot access the maintenance section of the off-line menu.

2. To control operator access to the alert menu, enable or disable Alert Menu.

Option Description

Enabled (default) Operator can access the alert menu. This access is required to view and
acknowledge alerts, but is not required for Smart Meter Verification (if applicable),
configuration, or calibration.

Disabled Operator cannot access the alert menu.

Note
The transmitter status LED changes color to indicate that there are active alerts, but does not show
specific alerts.

3. To require a password for access to the maintenance section of the off-line menu and the Smart Meter
Verification menu, enable or disable Off-Line Password.

Option Description

Enabled Operator is prompted for the off-line password at entry to the Smart Meter
Verification menu (if applicable), or entry to the maintenance section of the
off-line menu.

Disabled (default) No password is required for entry to the Smart Meter Verification menu (if
applicable) or entry to the maintenance section of the off-line menu.

4. To require a password to access the alert menu, enable or disable Alert Password.

Option Description

Enabled Operator is prompted for the off-line password at entry to the alert menu.

Disabled (default) No password is required for entry to the alert menu.

If both Off-Line Password and Alert Password are enabled, the operator is prompted for the off-line
password to access the off-line menu, but is not prompted thereafter.

5. Set Off-Line Password to the desired value.

The default value is 1234. The range is 0000 to 9999.

The same value is used for both the off-line password and the alert password.

Tip
Record your password for future reference.
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5.4 Configure response time parameters
You can configure the rate at which process data is polled and process variables are calculated.

5.5 Configure alert handling
The alert handling parameters control the transmitter’s response to process and device conditions.

5.5.1 Configure Fault Timeout
Display Not available

ProLink III Device Tools → Configuration → Fault Processing

Field Communicator Configure → Alert Setup → Alert Severity → Fault Timeout

Fieldbus host Diag TB → LAST_MEASURED_VALUE_FAULT_TIMEOUT (OD Index 22)

Fault Timeout controls the delay before fault actions are performed.

Restriction
Fault Timeout is applied only to the following alerts (listed by Status Alert Code): A003, A004, A005, A008,
A016, A017, A033, A036. For all other alerts, fault actions are performed as soon as the alert is detected.

Procedure

Set Fault Timeout as desired.

The default value is 0 seconds. The range is 0 to 60 seconds.

If you set Fault Timeout to 0, fault actions are performed as soon as the alert condition is detected.

The fault timeout period begins when the transmitter detects an alert condition. During the fault timeout
period, the transmitter continues to report its last valid measurements.

If the fault timeout period expires while the alert is still active, the fault actions are performed. If the alert
condition clears before the fault timeout expires, no fault actions are performed.

5.5.2 Configure Status Alert Severity
Display Not available

ProLink III Device Tools → Configuration → Alert Severity

Field Communicator Configure → Alert Setup → Alert Severity → Set Alert Severity

Fieldbus host Diag TB → ALARM_INDEX (OD Index 23)

Diag TB → ALARM_SEVERITY (OD Index 24)

Use Status Alert Severity to control the fault actions that the transmitter performs when it detects an alert
condition.

Restriction
• For some alerts, Status Alert Severity is not configurable.

• For some alerts, Status Alert Severity can be set only to two of the three options.
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Tip
Use the default settings for Status Alert Severity unless you have a specific requirement to change them.

Procedure

1. Select a status alert.

2. For the selected status alert, set Status Alert Severity as desired.

Option Description

Fault Actions when fault is detected:
• The alert is posted to the Alert List.

• Outputs go to the configured fault action (after Fault Timeout has expired, if
applicable).

• Digital communications go to the configured fault action (after Fault Timeout has
expired, if applicable).

• The status LED (if available) changes to red or yellow (depending on alert severity).

Actions when alert clears:
• Outputs return to normal behavior.

• Digital communications return to normal behavior.

• The status LED (if available) returns to green and may or may not flash.

Informational Actions when fault is detected:
• The alert is posted to the Alert List.

• The status LED (if available) changes to red or yellow (depending on alert severity).

Actions when alert clears:
• The status LED (if available) returns to green and may or may not flash.

Status alerts and options for Status Alert Severity
Table 5-1: Status alerts and Status Alert Severity 

Alert code Status message Default severity Notes Configurable?

A001 EEPROM Error (Core
Processor)

Fault No

A002 RAM Error (Core Processor) Fault No

A003 No Sensor Response Fault Yes

A004 Temperature Overrange Fault No

A005 Mass Flow Rate Overrange Fault Yes

A006 Characterization Required Fault Yes

A008 Density Overrange Fault Yes

A009 Transmitter Initializing/
Warming Up

Fault Yes
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Table 5-1: Status alerts and Status Alert Severity (continued)

Alert code Status message Default severity Notes Configurable?

A010 Calibration Failure Fault No

A011 Zero Calibration Failed:
Low

Fault Yes

A012 Zero Calibration Failed:
High

Fault Yes

A013 Zero Calibration Failed:
Unstable

Fault Yes

A014 Transmitter Failure Fault No

A016 Sensor RTD Failure Fault Yes

A018 EEPROM Error
(Transmitter)

Fault No

A019 RAM Error (Transmitter) Fault No

A020 Calibration Factors Missing Fault Yes

A021 Incorrect Sensor Type (K1) Fault No

A026 Sensor/Transmitter
Communications Failure

Fault No

A031 Low Power Fault Applies only to flowmeters with the
enhanced core processor.

No

A032 Meter Verification in
Progress: Outputs to Fault

Varies Applies only to transmitters with
Smart Meter Verification.

If outputs are set to Last Measured
Value, severity is Info. If outputs are
set to Fault, severity is Fault.

No

A033 Insufficient Right/Left
Pickoff Signal

Fault Applies only to flowmeters with the
enhanced core processor.

Yes

A034 Meter Verification Failed Fault Applies only to transmitters with
Smart Meter Verification.

Yes

A035 Meter Verification Aborted Fault Applies only to transmitters with
Smart Meter Verification.

Yes

A102 Drive Overrange Informational Yes

A104 Calibration in Progress Informational Can be set to either Informational
or Ignore, but cannot be set to
Fault.

Yes

A105 Slug Flow Informational Yes

A107 Power Reset Occurred Informational Normal transmitter behavior;
occurs after every power cycle.

Yes

A116 Temperature Overrange
(Petroleum)

Informational Applies only to transmitters with
the petroleum measurement
application.

Yes
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Table 5-1: Status alerts and Status Alert Severity (continued)

Alert code Status message Default severity Notes Configurable?

A117 Density Overrange
(Petroleum)

Informational Applies only to transmitters with
the petroleum measurement
application.

Yes

A120 Curve Fit Failure
(Concentration)

Informational Applies only to transmitters with
the concentration measurement
application.

No

A121 Extrapolation Alarm
(Concentration)

Informational Applies only to transmitters with
the concentration measurement
application.

Yes

A128 Factory Configuration Data
Invalid

Fault No

A129 Factory Config ChkSum
Error

Fault No

A131 Meter Verification in
Progress: Outputs to Last
Measured Value

Informational Applies only to transmitters with
Smart Meter Verification.

Yes

5.6 Configure informational parameters
The informational parameters can be used to identify or describe your meter. They are not used in process
measurement and they are not required.

5.6.1 Configure Sensor Serial Number
Display Not available

ProLink III Device Tools → Configuration → Informational Parameters → Sensor

Field Communicator Configure → Manual Setup → Info Parameters → Sensor Information → Sensor Serial Number

Fieldbus host Device Info TB → SENSOR_SN (OD Index 20)

Sensor Serial Number lets you store the serial number of the sensor component of your flowmeter in
transmitter memory. This parameter is not used in processing and is not required.

Procedure

1. Obtain the sensor serial number from your sensor tag.

2. Enter the serial number in the Sensor Serial Number field.

5.6.2 Configure Sensor Material
Display Not available

ProLink III Device Tools → Configuration → Informational Parameters → Sensor

Field Communicator Configure → Manual Setup → Info Parameters → Sensor Information → Tube Wetted Material

Fieldbus host Device Info TB → SENSOR_MATERIAL (OD Index 23)
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Sensor Material lets you store the type of material used for your sensor’s wetted parts in transmitter
memory. This parameter is not used in processing and is not required.

Procedure

1. Obtain the material used for your sensor’s wetted parts from the documents shipped with your sensor,
or from a code in the sensor model number.

To interpret the model number, refer to the product data sheet for your sensor.

2. Set Sensor Material to the appropriate option.

5.6.3 Configure Sensor Liner Material
Display Not available

ProLink III Device Tools → Configuration → Informational Parameters → Sensor

Field Communicator Configure → Manual Setup → Info Parameters → Sensor Information → Tube Lining

Fieldbus host Device Info TB  → SENSOR_LINER (OD Index 24)

Sensor Liner Material lets you store the type of material used for your sensor liner in transmitter memory.
This parameter is not used in processing and is not required.

Procedure

1. Obtain your sensor’s liner material from the documents shipped with your sensor, or from a code in the
sensor model number.

To interpret the model number, refer to the product data sheet for your sensor.

2. Set Sensor Liner Material to the appropriate option.

5.6.4 Configure Sensor Flange Type
Display Not available

ProLink III Device Tools → Configuration → Informational Parameters → Sensor

Field Communicator Configure → Manual Setup → Info Parameters → Sensor Information → Sensor Flange

Fieldbus host Device Info TB → SENSOR_END (OD Index 25)

Sensor Flange Type lets you store your sensor’s flange type in transmitter memory. This parameter is not
used in processing and is not required.

Procedure

1. Obtain your sensor’s flange type from the documents shipped with your sensor, or from a code in the
sensor model number.

To interpret the model number, refer to the product data sheet for your sensor.

2. Set Sensor Flange Type to the appropriate option.

5.6.5 Configure Descriptor
Display Not available
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ProLink III Device Tools → Configuration → Informational Parameters → Transmitter

Field Communicator Configure → Manual Setup → Info Parameters → Transmitter Info → Descriptor

Fieldbus host Device Info TB → DESCRIPTION (OD Index 19)

Descriptor lets you store a description in transmitter memory. The description is not used in processing and is
not required.

Procedure

Enter a description for the transmitter or device
You can use up to 16 characters for the description.
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6 Complete the configuration

6.1 Back up transmitter configuration
ProLink III provides a configuration upload/download function which allows you to save configuration sets to
your PC. This allows you to back up and restore your transmitter configuration. This is also a convenient way
to replicate a configuration across multiple devices.

Restriction
This function is not available with any other communications tools.

 CAUTION
The FF host “owns” the function blocks and engineering units. Using any communication tool to change
the function blocks can cause a database mismatch. A database mismatch can cause the transmitter to go
Out of Service (OOS).

Procedure

To back up the transmitter configuration using ProLink III:

a) Choose Device Tools → Configuration Transfer → Save or Load Configuration Data.

b) In the Configuration group box, select the configuration data you want to save.

c) Click Save, then specify a file name and location on your computer.

d) Click Start Save.

The backup file is saved to the specified name and location. It is saved as a text file and can be read using any
text editor.

6.2 Return function blocks to In Service (Auto) mode
Display Not available

ProLink III Not available

Field Communicator Overview → Mode

Fieldbus host All TBs → MODE_BLOCK (OD Index Number 005)

After modifying function block parameters, the fieldbus function blocks must be placed in service (Auto)
mode before you return the device to operation.
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7 Transmitter operation

7.1 Record the process variables
Micro Motion suggests that you make a record of specific process variable measurements, including the
acceptable range of measurements, under normal operating conditions. This data will help you recognize
when the process or diagnostic variables are unusually high or low, and may help you diagnose and
troubleshoot application issues.

Procedure

Record the following process and diagnostic variables, under normal operating conditions.

Variable

Measurement

Typical average Typical high Typical low

Flow rate

Density

Temperature

Tube frequency

Pickoff voltage

Drive gain

7.2 View process variables
Display Scroll to the desired process variable. If AutoScroll is enabled, you can wait until the process variable is

displayed. See View process variables using the display for more information.

ProLink III View the desired variable on the main screen under Process Variables. See View process variables and other
data using ProLink III for more information.

Field Communicator Overview → Shortcuts → Variables → Process Variables

Process variables provide information about the state of the process fluid, such as flow rate, density, and
temperature, as well as running totals. Process variables can also provide data about flowmeter operation,
such as drive gain and pickoff voltage. This information can be used to understand and troubleshoot your
process.

7.2.1 View process variables using the display
Procedure

View the desired process variables.

The display shows the configured display variables. For each display variable, the display reports the
abbreviated name of the process variable (for example, DENS for density), the current value of that process
variable, and the associated unit of measure (for example, G/CM3).
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If Auto Scroll is enabled, the display cycles through the display variables, showing each display variable for a
user-specified number of seconds. Whether or not Auto Scroll is enabled, you can activate Select to move to
the next display variable.

Figure 7-1: Transmitter display features
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A. Status LED
B. Display (LCD panel)
C. Process variable
D. Scroll optical switch
E. Optical switch indicator: turns red when either Scroll or Select is activated
F. Select optical switch
G. Unit of measure for process variable
H. Current value of process variable

7.2.2 View process variables and other data using ProLink III
Monitor process variables, diagnostic variables, and other data to maintain process quality.

ProLink III automatically displays process variables, diagnostic variables, and other data on the main screen.

Tip
ProLink III allows you to choose the process variables that appear on the main screen. You can also choose
whether to view data in Analog Gauge view or digital view, and you can customize the gauge settings. For
more information, see the Prolink III user manual.
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7.2.3 View process variables using the Field Communicator
Monitor process variables to maintain process quality.

Procedure

• To view current values of basic process variables, choose Overview.

• To view a more complete set of process variables, plus the current state of the outputs, choose Service
Tools → Variables.

7.3 View transmitter status using the status LED
The status LED shows the current alert condition of the transmitter. The status LED is located on the face of
the transmitter.

Procedure

Observe the status LED.

• If your transmitter has a display, you can view the status LED with the transmitter housing cover in place.

• If your transmitter does not have a display, it does not have a status LED. This option is not available.

To interpret the status LED, see the following table.

Restriction
If LED Blinking is disabled, the status LED will flash only during calibration. It will not flash to indicate an
unacknowledged alarm.

LED state Description Recommendation

Solid green No alerts are active. Continue with configuration or process
measurement.

Flashing green (if
enabled)

Unacknowledged corrected condition (no
alert)

Continue with configuration or process
measurement. Acknowledge the alert if you
choose.

Solid yellow One or more low-severity alerts are active.

A low severity alarm can mean one or more
process variables is at a set output level (i.e.
simulation or two phase timeout).

A low-severity alert condition does not affect
measurement accuracy or output behavior.
You can continue with configuration or
process measurement, but Micro Motion still
recommends identifying and resolving the
alert condition.

Flashing yellow (if
enabled)

Calibration in progress.

One or more low-severity alerts are active and
have not been acknowledged.

A low-severity alert condition does not affect
measurement accuracy or output behavior.
You can continue with configuration or
process measurement, but Micro Motion still
recommends identifying and resolving the
alert condition.

Solid red One or more high-severity alerts are active. A high-severity alert condition affects
measurement accuracy and output behavior.
Resolve the alert condition before continuing.
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LED state Description Recommendation

Flashing red (if
enabled)

One or more high-severity alerts are active
and have not been acknowledged.

A high-severity alert condition affects
measurement accuracy and output behavior.
Resolve the alert condition before continuing.
Acknowledge the alert if you choose.

7.4 View and acknowledge status alerts
The transmitter posts status alerts whenever a process variable exceeds its defined limits or the transmitter
detects a fault condition. You can view active alerts, and you can acknowledge alerts. Acknowledging alerts is
not required.

7.4.1 View and acknowledge alerts using the display
You can view a list containing all alerts that are active, or inactive but unacknowledged. From this list, you can
acknowledge individual alerts.

Prerequisites

Operator access to the alert menu must be enabled (default setting). If operator access to the alert menu is
disabled, you must use another method to view or acknowledge status alerts.

Note
Only Fault and Informational alerts are listed. The transmitter automatically filters out alerts with Status Alert
Severity set to Ignore.

Procedure

See Figure 7-2.
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Figure 7-2: Using the display to view and acknowledge the status alerts (alarms)
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Postrequisites

• To clear the following alerts, you must correct the problem, acknowledge the alert, then power-cycle the
transmitter: A001, A002, A010, A011, A012, A013, A018, A019, A022, A023, A024, A025, A028, A029,
A031.

• For all other alerts:
— If the alert is inactive when it is acknowledged, it will be removed from the list.

— If the alert is active when it is acknowledged, it will be removed from the list when the alert condition
clears.

Related information

Alert data in transmitter memory

7.4.2 View and acknowledge alerts using ProLink III
You can view a list containing all alerts that are active, or inactive but unacknowledged. From this list, you can
acknowledge individual alerts or choose to acknowledge all alerts at once.

Procedure

1. View alerts on the ProLink III Device Tools → Alerts tab.

All active or unacknowledged alerts are listed, and displayed according to the following categories:

Category Description

Failed: Fix Now A meter failure has occurred and must be addressed immediately.

Maintenance: Fix Soon A condition has occurred that can be fixed at a later time.

Advisory: Informational A condition has occurred, but requires no maintenance from you.

Notes
• All fault alerts are displayed in the Failed: Fix Now category.

• All information alerts are displayed in either the Maintenance: Fix Soon category or the Advisory:
Informational category. The category assignment is hard-coded.

• The transmitter automatically filters out alerts with Alert Severity set to Ignore.

2. To acknowledge a single alert, check the Ack checkbox for that alert. To acknowledge all alerts at once,
click Ack All.

Postrequisites

• To clear the following alerts, you must correct the problem, acknowledge the alert, then power-cycle the
transmitter: A001, A002, A010, A011, A012, A013, A018, A019, A022, A023, A024, A025, A028, A029,
A031.

• For all other alerts:
— If the alert is inactive when it is acknowledged, it will be removed from the list.

— If the alert is active when it is acknowledged, it will be removed from the list when the alert condition
clears.
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Related information

Alert data in transmitter memory

7.4.3 View alerts using the Field Communicator
You can view a list containing all alerts that are active, or inactive but unacknowledged.

Procedure

• To view active or unacknowledged alerts, choose Overview  → Device Status or Service Tools → Alerts.

All active alerts and unacknowledged alerts are listed.

Note
Only Fault and Information alerts are listed. The transmitter automatically filters out alerts with Status
Alert Severity set to ignore.

• To refresh the list, choose Service Tools → Alerts → Refresh Alerts.

7.4.4 View alerts using a fieldbus host
Whenever an alert condition occurs, the transmitter sets the fieldbus output status to Bad or Uncertain. It
also posts a Field Diagnostics alert. You can determine which alert and alert condition is active and use this
information to choose the appropriate response.

Procedure

• To read alert status for an AI function block or the AO function block, read the BLOCK_ERR index (OD Index
6).

• To obtain more detailed information about active alerts:

a) Identify the active alerts by reading the following parameters from the resource block:

— FD_FAIL_ACTIVE (OD Index 43)

— FD_OFFSPEC_ACTIVE (OD Index 44)

— FD_MAINT_ACTIVE (OD Index 45)

— FD_CHECK_ACTIVE (OD Index 46)

b) For each active alert, obtain the alert detail by reading the status words (OD Index 17, 18, 19, 20,
120) from the Diagnostic transducer block.

Related information

Alert data in transmitter memory
Resource block
Meter verification transducer block

7.4.5 Alert data in transmitter memory
The transmitter maintains three sets of data for every alert that is posted.

For each alert occurrence, the following three sets of data are maintained in transmitter memory:

• Alert List
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• Alert Statistics

• Recent Alerts

Alert data structure Transmitter action if condition occurs

Contents Clearing

Alert List As determined by the alert status bits, a list of:
• All currently active alerts

• All previously active alerts that have not
been acknowledged

Cleared and regenerated with every
transmitter power cycle

Alert Statistics One record for each alert (by alert number)
that has occurred since the last master reset.
Each record contains:
• A count of the number of occurrences

• Timestamps for the most recent posting
and clearing

Not cleared; maintained across transmitter
power cycles

Recent Alerts 50 most recent alert postings or alert clearings Not cleared; maintained across transmitter
power cycles

7.5 Read totalizer and inventory values
Display To read a totalizer or inventory value from the display, it must be configured as a display variable.

ProLink III View the desired variable on the main screen under Process Variables.

Field Communicator Service Tools → Variables → Totalizer Control

Totalizers keep track of the total amount of mass or volume measured by the transmitter since the last
totalizer reset. Inventories keep track of the total amount of mass or volume measured by the transmitter
since the last inventory reset.

Tip
You can use the inventories to keep a running total of mass or volume across multiple totalizer resets.

7.6 Start and stop totalizers and inventories
Display See Start and stop totalizers and inventories using the display .

ProLink III Device Tools → Totalizer Control → Totalizer and Inventories → Start All Totals

Device Tools → Totalizer Control → Totalizer and Inventories → Stop All Totals

Field Communicator Service Tools → Variables → Totalizer Control → All Totalizers → Start Totalizers
Service Tools → Variables → Totalizer Control → All Totalizers → Stop Totalizers
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When you start a totalizer, it tracks process measurement. In a typical application, its value increases with
flow. When you stop a totalizer, it stops tracking process measurement and its value does not change with
flow. Inventories are started and stopped automatically, when totalizers are started and stopped.

Important
Totalizers and inventories are started or stopped as a group. When you start any totalizer, all other totalizers
and all inventories are started simultaneously. When you stop any totalizer, all other totalizers and all
inventories are stopped simultaneously. You cannot start or stop inventories directly.

7.6.1 Start and stop totalizers and inventories using the display
Prerequisites

• The Totalizer Start/Stop display function must be enabled.

• At least one totalizer must be configured as a display variable.

Procedure

• To start all totalizers and inventories using the display:

Note
If the PLC is connected and communicating, the start/stop and reset totalizers commands might be
overriding any totalizer commands from the local display or from ProLink III.

a) Scroll until the word TOTAL appears in the lower left corner of the display.

Important
Because all totalizers are started or stopped together, it does not matter which total you use.

b) Select.

c) Scroll until START appears beneath the current totalizer value.
Exit displays beneath the current totalizer value.

d) Select.

e) Select again to confirm.

f) Scroll to EXIT.

• To stop all totalizers and inventories using the display:

a) Scroll until the word TOTAL appears in the lower left corner of the display.

Important
Because all totalizers are started or stopped together, it does not matter which total you use.

b) Select.

c) Scroll until STOP appears beneath the current totalizer value.

d) Select.

e) Select again to confirm.

f) Scroll to EXIT.
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7.7 Reset totalizers
Display See Reset totalizers using the display

ProLink III Device Tools → Totalizer Control → Totalizer and Inventories → Reset Mass Total

Device Tools → Totalizer Control → Totalizer and Inventories → Reset Volume Total

Device Tools → Totalizer Control → Totalizer and Inventories → Reset Gas Total

Device Tools → Totalizer Control → Totalizer and Inventories → Reset All Totals

Field Communicator Service Tools → Variables → Totalizer Control → Mass → Mass Total

Service Tools → Variables → Totalizer Control → Gas Standard Volume → Volume Total

Service Tools → Variables → Totalizer Control → Gas Standard Volume → GSV Total

Service Tools → Variables → Totalizer Control → All Totalizers → Reset All Totals

When you reset a totalizer, the transmitter sets its value to 0. It does not matter whether the totalizer is
started or stopped. If the totalizer is started, it continues to track process measurement.

Tip
When you reset a single totalizer, the values of other totalizers are not reset. Inventory values are not reset.

7.7.1 Reset totalizers using the display
Prerequisites

• The Totalizer Reset display function must be enabled.

• The totalizer that you want to reset must be configured as a display variable. For example:

— If you want to reset the mass totalizer, Mass Total must be configured as a display variable.

— If you want to reset the volume totalizer, Volume Total must be configured as a display variable.

Procedure

• To reset the mass totalizer:

a) Scroll until the mass totalizer value appears.

b) Select.
Exit displays beneath the current totalizer value.

c) Scroll until Reset displays beneath the current totalizer value.

d) Select.
Reset and Yes? alternately flash beneath the current totalizer value.

e) Select again to confirm.

f) Scroll to EXIT.

g) Select.

• To reset the volume totalizer:

a) Scroll until the volume totalizer value appears.

b) Select.
Exit displays beneath the current totalizer value.
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c) Scroll until Reset displays beneath the current totalizer value.

d) Select.
Reset and Yes? alternately flash beneath the current totalizer value.

e) Select again to confirm.

f) Scroll to EXIT.

g) Select.

• To reset the gas standard volume totalizer:

a) Scroll until the gas standard volume totalizer value appears.

b) Select.
Exit displays beneath the current totalizer value.

c) Scroll until Reset displays beneath the current totalizer value.

d) Select.
Reset and Yes? alternately flash beneath the current totalizer value.

e) Select again to confirm.

f) Scroll to EXIT.

g) Select.

7.8 Reset inventories
ProLink III Device Tools → Totalizer Control → Totalizer and Inventories → Reset Mass Inventory

Device Tools → Totalizer Control → Totalizer and Inventories → Reset Volume Inventory

Device Tools → Totalizer Control → Totalizer and Inventories → Reset Gas Inventory

Device Tools → Totalizer Control → Totalizer and Inventories → Reset All Inventories

When you reset an inventory, the transmitter sets its value to 0. It does not matter whether the inventory is
started or stopped. If the inventory is started, it continues to track process measurement.

Tip
Mass and volume inventory totals cannot be set separately. They can only be reset together simultaneously.

Prerequisites

To use ProLink III to reset the inventories, the feature must be enabled.

To enable inventory reset in ProLink III:

1. Choose Tools > Options.

2. Select Reset Inventories from ProLink III.

3. Select OK.

Once enabled, this feature remains enabled until it is disabled.
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8 Measurement support

8.1 Options for measurement support
Micro Motion provides several measurement support procedures to help you evaluate and maintain your
flowmeter's accuracy.

The following methods are available:

• Smart Meter Verification (SMV) evaluates the structural integrity of the sensor tubes by comparing current
tube stiffness to the stiffness measured at the factory. Stiffness is defined as the load per unit deflection, or
force divided by displacement. Because a change in structural integrity changes the sensor’s response to
mass and density, this value can be used as an indicator of measurement performance.

• Meter validation compares flowmeter measurements reported by the transmitter to an external
measurement standard. Meter validation requires one data point.

• Calibration establishes the relationship between a process variable and the signal produced at the sensor.
You can calibrate the flowmeter for zero, density, and temperature. Density and temperature calibration
require two data points (low and high) and an external measurement for each.

Tip
• Perform SMV at regular intervals to get the best data on your meter's performance.

• To prove the meter against a regulatory standard, or to correct measurement error, use meter validation
and meter factors.

• Before performing a field calibration, contact customer support to see if there is an alternative. In many
cases, field calibrations have a negative effect on measurement accuracy.

8.2 Use Smart Meter Verification
Smart Meter Verification™ provides in-process flow meter health verification by analyzing the meter
components related to measurement performance. You can run Smart Meter Verification without stopping
the process. Use this section to run a Smart Meter Verification test, view and interpret the results, set up
automatic execution, and check if a field reference point has been established.

8.2.1 SMV requirements
To use SMV, the transmitter must be paired with an 800 enhanced core processor.

See Table 8-1 for the minimum version of the transmitter, an 800 enhanced core processor, and
communication tool needed to support SMV. (If you are going to perform SMV using the display, only the
transmitter and enhanced core processor versions apply.)

Table 8-1: Minimum SMV version

Item Minimum version (legacy) Minimum basic SMV transmitter

Transmitter 6.0 9.0

Enhanced core processor 3.6 4.4

ProLink III 1.0 4.0
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Table 8-1: Minimum SMV version (continued)

Item Minimum version (legacy) Minimum basic SMV transmitter

Field Communicator FOUNDATION Fieldbus device
description: device rev 6, DD rev 1

FOUNDATION Fieldbus device
description: device rev 9, DD rev 1

8.2.2 SMV test preparation

Prerequisites

The following information pertains to the transmitter when connected to an 800 enhanced core processor
greater than or equal to v4.7 .

• To avoid or reduce corrosion, erosion, and other process effects, make sure the sensor tube material is
compatible with the process fluid in use. For more information, see the Micro Motion Corrosion Guide.

• Important
Micro Motion highly recommends:
— Running the first Smart Meter Verification test when the flow meter is installed in the pipeline

according to the installation instructions, and the process is running at its normal operating conditions

— Running all tests thereafter at similar operating conditions

• The Smart Meter Verification test runs best when process conditions are stable. If process conditions are
too unstable, the test will abort. To maximize process stability:
— Maintain a constant fluid temperature and pressure.

— Maintain a constant flow rate. If possible, stop flow through the sensor. The sensor should be full of
process fluid.

— Avoid changes to fluid composition; for example, two-phase flow or settling.

• For all applications, run Smart Meter Verification while commissioning the meter at normal operating
conditions and then run it regularly. Micro Motion also recommends using Smart Meter Verification results
along with other diagnostics like drive gain and density to help determine the health of a sensor.

• In certain scenarios, Smart Meter Verification field upgrades for pre-installed meters are possible. Contact
factory support to discuss pre-installed meter upgrades.

8.2.3 Smart Meter Verification capabilities

Capability
Basic Professional

Included Licensed

Calibration coefficients audit • •

Zero audit • •

Electronics verification • •

Automatic test scheduler • •

History of previous 20 results • •
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Capability
Basic Professional

Included Licensed

Verification report •(1)

(1) Create and export with Prolink III, web page, or AMS SNAP-ON.

8.2.4 Run SMV

Run an SMV test using the display

Procedure

1. Navigate to the Smart Meter Verification menu.

Figure 8-1: SMV – Top-level menu

Scroll and Select simultaneously 
for 4 seconds

ENTER METER VERFY

Scroll

RUN VERFY RESULTS READ SCHEDULE VERFY

Select

EXITScroll Scroll Scroll

Scroll Select

Select Select Select

2. Choose Run Verify.

3. Choose Outputs and select the desired output behavior.

Option Description

Continue
Measuring

During the test, all outputs will continue to report their assigned process variable. The
test will run for approximately 90 seconds.

Fault During the test, all outputs will go to their configured fault action. The test will run for
approximately 140 seconds.

Last Value During the test, all outputs will report the last measured value of their assigned process
variable. The test will run for approximately 140 seconds.

While the test is in progress, dots traverse the display and test progress is shown.

Postrequisites

View the test results and take any appropriate actions.
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SMV flowchart: Running a test using the display

Figure 8-2: Running an SMV test using the display
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Run an SMV test using ProLink III

Procedure

1. Choose Device Tools → Diagnostics → Meter Verification → Run Test.

You may need to wait a few seconds while ProLink III synchronizes its database with the transmitter
data.

2. Enter any desired information on the Test Definition screen, and click Next.

All information on this screen is optional.

3. Choose the desired output behavior.

Option Description

Continue
Measuring

During the test, all outputs will continue to report their assigned process variable.
The test will run for approximately 90 seconds.

Held at Last Value During the test, all outputs will report the last measured value of their assigned
process variable. The test will run for approximately 140 seconds.
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Option Description

Held at Fault During the test, all outputs will go to their configured fault action. The test will run
for approximately 140 seconds.

4. Press Start.
Test progress is displayed on the screen.

Postrequisites

View the test results and take any appropriate actions. You can also print the report.

Run an SMV test using the Field Communicator

Procedure

1. Navigate to the Smart Meter Verification menu:
• Overview → Shortcuts → Meter Verification

• Service Tools → Maintenance → Routine Maintenance → Meter Verification

2. Choose Manual Verification.

3. Choose Start.

4. Set output behavior as desired, and press OK if prompted.

Option Description

Continue Measuring During the test, all outputs will continue to report their assigned process
variable. The test will run for approximately 90 seconds.

Outputs Held at Last
Value

During the test, all outputs will report the last measured value of their
assigned process variable. The test will run for approximately 140 seconds.

Outputs Held at Fault During the test, all outputs will go to their configured fault action. The test
will run for approximately 140 seconds.

Test progress is displayed on the screen.

Postrequisites

View the test results and take any appropriate actions.

8.2.5 View test data
You can view the results of the current test. You can also view results from previous tests.

Important
You can view previous test results and see detailed test reports only if SMV is licensed.

The transmitter stores the following information about the previous twenty SMV tests:

• Powered-on hours at the time of the test.

• Test result (Pass, Fail, Abort).

• Abort code, if applicable.
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In addition, ProLink III provides a detailed test reporting and analysis framework. This information is stored on
the PC where ProLink III is installed for tests that were run only on that PC. It includes:

• Timestamp from the PC clock

• Current flowmeter identification data

• Current flow and density configuration parameters

• Current zero values

• Current process values for mass flow rate, volume flow rate, density, temperature, and external pressure

• Customer and test descriptions (if entered by the user)

You can use ProLink III to run a test that displays a test result chart and a test report at the completion of the
test. On-screen directions are provided to manipulate the test data or export the data to a CSV file for offline
analysis.

View test result data using the display

Procedure

1. If you have just run a test, results are displayed automatically at the end of the test.

2. If SMV is licensed, and you want to view results from previous tests:

a) Navigate to the Smart Meter Verification menu.

Figure 8-3: SMV – Top-level menu
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b) Scroll to Results Read and press Select.
The runcount of the most recent test is displayed.

c) To view data for this test, press Select, then press Scroll to scroll through test data.

d) To select a different test, press Scroll, then press Select when the transmitter displays Results
More?. When the desired test appears, as identified by runcount, press Select.
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SMV flowchart: Viewing test results using the display

Figure 8-4: Viewing SMV test results using the display
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Note
If you have a basic (unlicensed version) of SMV, you will not be prompted for results.

View test result data using ProLink III

Prerequisites

You can view test result data only if your SMV is licensed and only for tests that were run on the PC you are
currently using.

Procedure

1. Choose Device Tools → Diagnostics → Meter Verification and click Previous Test Results.
The chart shows test results for all tests stored in the ProLink III database.
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2. (Optional) Click Next to view and print a test report.

3. (Optional) Click Export Data to CSV File to save the data to a file on your PC.

View test result data using the Field Communicator

Prerequisites

You can view test result data only if your SMV is licensed.

Procedure

1. Navigate to the Smart Meter Verification menu:
• Overview → Shortcuts → Meter Verification

• Service Tools → Maintenance → Routine Maintenance → Meter Verification

2. (Optional) If the Field Communicator database is out of date, choose Upload Results Data from
Device.

3. To view data from the most recent test, choose Most Recent Test Results.

4. To view data for all tests in the Field Communicator database:

a) Press Show Results Table.
Data from the most recent test is displayed.

b) Press OK to scroll through data from previous tests.

c) To exit the results table, press Abort.

Interpreting Smart Meter Verification results
When the Smart Meter Verification Basic or Professional test is completed, the result is reported as Pass, Fail,
or Abort. (Some tools report the Fail result as Advisory instead.)

Pass The meter is performing within factory specifications.

Abort When you execute a Smart Meter Verification Basic or Professional test, the test performs a self-
diagnostic check to ensure that the flow meter is stable prior to running the test. In the rare case that
this check reveals an issue, Smart Meter Verification will report an abort code.

If you manually cancel an in-process Smart Meter Verification Basic or Professional test, the test
result displays Abort Code 1: User-Initiated Abort. In this case, you can restart Smart
Meter Verification without any further action. In the rare case any other abort occurs, contact factory
support.

In all cases where a Smart Meter Verification Professional test aborts, no report will be generated.

Fail If a Smart Meter Verification Basic or Professional test ran at normal operating conditions while
conditions were stable and failed, see Resolve a failed Smart Meter Verification test.
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8.2.6 Resolving a failed Smart Meter Verification test
Use this procedure if a Smart Meter Verification Basic or Professional test ran at normal operating conditions
while conditions were stable and failed.

Procedure

1. Verify the sensor by performing a visual inspection, density verification, or field proving.

2. If possible, run Smart Meter Verification Professional with Prolink III Basic or Professional and save the
results as follows:

• In a .csv file

• In a report

3. Contact the factory for further evaluation and instructions.

8.2.7 Schedule automatic execution of the SMV test
You can set up and run a single test at a user-defined future time. You can also set up and run tests on a
regular schedule.

Manage scheduled test execution using the display

Procedure

1. Navigate to the Smart Meter Verification menu.

Figure 8-5: SMV – Top-level menu
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2. Scroll to Schedule Verfy and press Select.

3. To schedule a single test or the first test in recurring execution:

a) Scroll to Set Next and press Select.

b) Enter the number of hours that the transmitter will wait before beginning the test.

4. To schedule recurring execution:

a) Scroll to Set Recur and press Select.

b) Enter the number of hours that will elapse between tests.

5. To disable scheduled execution:
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• To disable execution of a single scheduled test, set Set Next to 0.

• To disable recurring execution, set Set Recur to 0.

• To disable all scheduled execution, choose Turn Off Sched when you enter the Smart Meter
Verification menu.

SMV flowchart: Scheduling test execution using the display

Figure 8-6: Scheduling SMV test execution using the display
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Manage scheduled test execution using ProLink III

Procedure

1. Choose Device Tools → Diagnostics → Meter Verification → Schedule Meter Verification.

2. To schedule a single test or the first test in recurring execution, specify a value for Hours Until Next
Run.

3. To schedule recurring execution, specify a value for Hours Between Recurring Runs.

4. To disable scheduled execution:
• To disable execution of a single scheduled test, set Hours Until Next Run to 0.

• To disable recurring execution, set Hours Between Recurring Runs to 0.

• To disable all scheduled execution, click Disable Scheduled Execution.

8.3 Zero the meter
Display OFFLINE MAINT → ZERO → CAL ZERO → CAL/YES?

To restore the zero value set at the factory: OFFLINE MAINT → ZERO → RESTORE ZERO → RESTORE/YES?
This function requires the enhanced core processor.

ProLink III Device Tools → Calibration → Zero Verification and Calibration → Calibrate Zero

Field Communicator Service Tools → Maintenance → Zero Calibration → Perform Auto Zero

Zeroing the meter establishes a baseline for process measurement by analyzing the sensor's output when
there is no flow through the sensor tubes.

Prerequisites

Verify the zero and prepare the meter using the procedures in Verify the zero.

Procedure

Zero the meter.

If necessary, modify Zero Time. Zero Time controls the amount of time the transmitter takes to determine its
zero-flow reference point. The default Zero Time is 20 seconds. For most applications, the default Zero Time
is appropriate.

Postrequisites

Restore normal flow through the sensor by opening the valves. Verify that the sensor tubes are full.

Need help?
If the zero fails:

• Verify that there is no flow through the sensor, then retry.

• Remove or reduce sources of electromechanical noise, then retry.

• Set Zero Time to a lower value, then retry.

• If the zero continues to fail, contact customer service.
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8.4 Validate the meter
Display OFF-LINE MAINT → Config MTR F

ProLink III Device Tools → Configuration → Process Measurement → Flow

Device Tools → Configuration → Process Measurement → Density

Field Communicator Configure → Manual Setup → Measurements → Flow

Configure → Manual Setup → Measurements → Density

Meter validation compares flowmeter measurements reported by the transmitter to an external
measurement standard. If the transmitter value for mass flow, volume flow, or density measurement is
significantly different from the external measurement standard, you may want to adjust the corresponding
meter factor. The flowmeter’s actual measurement is multiplied by the meter factor, and the resulting value
is reported and used in further processing.

Prerequisites

Identify the meter factor(s) that you will calculate and set. You may set any combination of the three meter
factors: mass flow, volume flow, and density. Note that all three meter factors are independent:

• The meter factor for mass flow affects only the value reported for mass flow.

• The meter factor for density affects only the value reported for density.

Important
To adjust volume flow, you must set the meter factor for volume flow. Setting a meter factor for mass flow
and a meter factor for density will not produce the desired result. The volume flow calculations are based on
original mass flow and density values, before the corresponding meter factors have been applied.

If you plan to calculate the meter factor for volume flow, be aware that validating volume in the field may be
expensive, and the procedure may be hazardous for some process fluids. Therefore, because volume is
inversely proportional to density, an alternative to direct measurement is to calculate the meter factor for
volume flow from the meter factor for density. See Alternate method for calculating the meter factor for
volume flow for instructions on this method.

Obtain a reference device (external measurement device) for the appropriate process variable.

Important
For good results, the reference device must be highly accurate.

Procedure

1. Determine the meter factor as follows:

a) Set the meter factor to 1 to take a sample measurement.

b) Measure the same sample using the reference device.

c) Calculate the meter factor using the following formula:NewMeterFactor = ConfiguredMeterFactor × ReferenceMeasurementFlowmeterMeasurement
2. Ensure that the calculated meter factor does not fall outside 0.98 and 1.02. If the meter factor is

outside these limits, contact customer service.

3. Configure the meter factor in the transmitter.
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Calculating the meter factor for mass flow

The flowmeter is installed and validated for the first time. The mass flow measurement from the transmitter is
250.27 lb. The mass flow measurement from the reference device is 250 lb. The mass flow meter factor is
calculated as follows: MeterFactorMassFlow = 1 × 250250.27 = 0.9989
The first meter factor for mass flow is 0.9989.

One year later, the flowmeter is validated again. The mass flow measurement from the transmitter is
250.07 lb. The mass flow measurement from the reference device is 250.25 lb. The new mass flow meter
factor is calculated as follows:MeterFactorMassFlow = 0.9989 × 250.25250.07 = 0.9996
The new meter factor for mass flow is 0.9996.

8.4.1 Alternate method for calculating the meter factor for volume
flow
The alternate method for calculating the meter factor for volume flow is used to avoid the difficulties that
may be associated with the standard method.

This alternate method is based on the fact that volume is inversely proportional to density. It provides partial
correction of the volume flow measurement by adjusting for the portion of the total offset that is caused by
the density measurement offset. Use this method only when a volume flow reference is not available, but a
density reference is available.

Procedure

1. Calculate the meter factor for density, using the standard method.

2. Calculate the meter factor for volume flow from the meter factor for density:MeterFactorVolume = 1MeterFactorDensity
The following equation is mathematically equivalent to the first equation. You may use whichever
version you prefer.MeterFactorVolume = ConfiguredMeterFactorDensity × DensityFlowmeterDensityReferenceDevice

3. Ensure that the calculated meter factor does not fall outside 0.98 and 1.02. If the meter factor is
outside these limits, contact customer service.

4. Configure the meter factor for volume flow in the transmitter.
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8.5 Perform a (standard) D1 and D2 density calibration
Density calibration establishes the relationship between the density of the calibration fluids and the signal
produced at the sensor. Density calibration includes the calibration of the D1 (low-density) and D2 (high-
density) calibration points.

Important
Micro Motion flow meters are calibrated at the factory, and normally do not need to be calibrated in the field.
Calibrate the flow meter only if you must do so to meet regulatory requirements. Contact customer support
before calibrating the flow meter.

Tip
Use meter validation and meter factors, rather than calibration, to prove the meter against a regulatory
standard or to correct measurement error.

Prerequisites

• During density calibration, the sensor must be completely filled with the calibration fluid, and flow
through the sensor must be at the lowest rate allowed by your application. This is usually accomplished by
closing the shutoff valve downstream from the sensor, then filling the sensor with the appropriate fluid.

• D1 and D2 density calibration require a D1 (low-density) fluid and a D2 (high-density) fluid. You may use
air and water.

• If LD Optimization is enabled on your meter, disable it. To do this using a field communicator, choose
Configure → Manual Setup → Measurements → Optional Setup → LD Optimization. LD Optimization is
used only with large sensors in hydrocarbon applications. If you are not using a field communicator,
contact Emerson before continuing.

• The calibrations must be performed without interruption, in the order shown. Make sure that you are
prepared to complete the process without interruption.

• Before performing the calibration, record your current calibration parameters. You can do this by saving
the current configuration to a file on the PC. If the calibration fails, restore the known values.

Restriction
For T-Series sensors, the D1 calibration must be performed on air and the D2 calibration must be performed
on water.

8.5.1 Perform a D1 and D2 density calibration using ProLink III
Procedure

1. Read the Prerequisites in Perform a (standard) D1 and D2 density calibration if you have not already
done so.

2. See the following figure.
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8.5.2 Perform a D1 and D2 density calibration using a field
communicator
Procedure

1. Read the Prerequisites in Perform a (standard) D1 and D2 density calibration if you have not already
done so.
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2. See the following figure.

8.6 Perform temperature calibration
Temperature calibration establishes the relationship between the temperature of the calibration fluids and
the signal produced by the sensor.

Prerequisites

The temperature calibration is a two-part procedure: temperature offset calibration and temperature slope
calibration. The two parts must be performed without interruption, in the order shown. Ensure that you are
prepared to complete the process without interruption. You will need a low-temperature calibration fluid and
a high-temperature calibration fluid. You will not see the effect of the calibration until both the temperature
offset calibration and the temperature slope calibration are complete.

Important
Consult customer support before performing a temperature calibration. Under normal circumstances, the
temperature circuit is stable and should not need an adjustment.
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8.6.1 Perform temperature calibration using a fieldbus host
Procedure

1. Write the temperature units to be used for calibration to Calibration TB → CAL_TEMPERATURE_UNITS
(OD Index 56).

Code in decimal Description

1000 K

1001 degC

1002 degF

1003 degR

2. Fill the sensor with the low-temperature fluid.

3. Wait until the sensor achieves thermal equilibrium.

4. Enter the temperature of the low-temperature fluid: Calibration TB → TEMP_VALUE (OD Index 44).

5. Write 1 to Calibration TB → TEMP_LOW_CAL (OD Index 42) to start the temperature offset
calibration.

6. Monitor the calibration using Calibration TB → SNS_ZeroInProgress (OD Index 55).
• 0=No calibration in progress

• 1=Calibration in progress

When the calibration is complete, the updated temperature offset and temperature slope values are
stored in transmitter memory.

7. Fill the sensor with the high-temperature fluid.

8. Wait until the sensor achieves thermal equilibrium.

9. Enter the temperature of the high-temperature fluid: Calibration TB → TEMP_VALUE (OD Index 44).

10. Write 1 to Calibration TB → TEMP_HIGH_CAL (OD Index 43)to start the temperature slope
calibration.

11. Monitor the calibration using Calibration TB → SNS_ZeroInProgress (OD Index 55).
• 0=No calibration in progress

• 1=Calibration in progress

When the calibration is complete, the updated temperature offset and temperature slope values are stored in
transmitter memory. To read them:

• Temperature offset: Calibration TB → TEMP_OFFSET (OD Index 45)

• Temperature slope: Calibration TB → TEMP_SLOPE (OD Index 46)
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9 Troubleshooting

9.1 Density measurement problems
Problem Possible causes Recommended actions

Inaccurate density
reading

• Problem with process fluid

• Incorrect density calibration factors

• Wiring problem

• Incorrect grounding

• Two-phase flow

• Plugged or coated sensor tube

• Incorrect sensor orientation

• RTD failure

• Physical characteristics of sensor have
changed

• Check your process conditions against the
values reported by the device.

• Ensure that all of the calibration
parameters have been entered correctly.
See the sensor tag or the calibration sheet
for your meter.

• Check the wiring between the sensor and
the transmitter.

• Check the grounding of all components.

• Verify all of the characterization or
calibration parameters. See the sensor tag
or the calibration sheet for your meter.

• Check for two-phase flow.

• If two sensors with similar frequency are
too near each other, separate them.

• Purge the sensor tubes.

Unusually high density
reading

• Plugged or coated sensor tube

• Incorrect density calibration factors

• Incorrect temperature measurement

• RTD problem

• In high-frequency meters, this can indicate
erosion or corrosion

• In low-frequency meters, this can indicate
tube fouling

• Ensure that all of the calibration
parameters have been entered correctly.
See the sensor tag or the calibration sheet
for your meter.

• Verify all of the characterization or
calibration parameters. See the sensor tag
or the calibration sheet for your meter.

• Purge the sensor tubes.

• Check for coating in the flow tubes.

Unusually low density
reading

• Two-phase flow

• Ensure that all of the calibration
parameters have been entered correctly.
See the sensor tag or the calibration sheet
for your meter.

• In low-frequency meters, this can indicate
erosion or corrosion

• Check your process conditions against the
values reported by the device.

• Check for two-phase flow.

• Verify all of the characterization or
calibration parameters. See the sensor tag
or the calibration sheet for your meter.

• Check the wiring between the sensor and
the transmitter.

• Check for tube erosion, especially if the
process fluid is abrasive.
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9.2 Check the drive gain
Excessive or erratic drive gain may indicate any of a variety of process conditions or sensor problems.

To know whether your drive gain is excessive or erratic, you must collect drive gain data during the problem
condition and compare it to drive gain data from a period of normal operation.

Excessive (saturated) drive gain

Table 9-1: Possible causes and recommended actions for excessive (saturated) drive gain

Possible cause Recommended actions

Bent sensor tube Check the pickoff voltages (see Check the pickoff voltage). If either of them are close to
zero (but neither is zero), the sensor tubes may be bent. The sensor will need to be
replaced.

Cracked sensor tube Replace the sensor.

Core processor or module
failure

Contact customer support.

Flow rate out of range Ensure that the flow rate is within sensor limits.

Open drive or pickoff
sensor coil

Contact customer support.

Over-pressurized tubes Contact customer support.

Plugged sensor tube A dull, audible hum, and unusually high sensor vibration is usually accompanied by high,
even saturated, drive gain. Check the pickoff voltages (see Check the pickoff voltage). If
either of them are close to zero (but neither is zero), plugged tubes may be the source of
your problem. Purge the tubes. In extreme cases, you may need to replace the sensor.

Sensor case full of process
fluid

Replace the sensor.

Sensor imbalance Contact customer support.

Sensor tubes not
completely full

Correct process conditions so that the sensor tubes are full.

Two-phase flow Check for two-phase flow. See Check for two-phase flow (slug flow).

Vibrating element not free
to vibrate

Ensure that the vibrating element is free to vibrate.

Erratic drive gain

Table 9-2: Possible causes and recommended actions for erratic drive gain

Possible cause Recommended actions

Foreign material caught in sensor
tubes

• Purge the sensor tubes.

• Replace the sensor.

9.2.1 Collect drive gain data
Drive gain data can be used to diagnose a variety of process and equipment conditions. Collect drive gain data
from a period of normal operation, and use this data as a baseline for troubleshooting.
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Procedure

1. Navigate to the drive gain data.

2. Observe and record drive gain data over an appropriate period of time, under a variety of process
conditions.

9.3 Check for internal electrical problems
Shorts between sensor terminals or between the sensor terminals and the sensor case can cause the sensor to
stop working.

Possible cause Recommended action

Moisture inside the sensor junction box Ensure that the junction box is dry and no corrosion is
present.

Liquid or moisture inside the sensor case Contact customer support.

Internally shorted feedthrough Contact customer support.

Faulty cable Replace the cable.

Improper wire termination Verify wire terminations inside the sensor junction box. See
Micro Motion 9-Wire Flowmeter Cable Preparation and
Installation Manual Micro Motion 9-Wire Flow Meter Cable
Preparation and Installation Guide.

Shorts to the housing created by trapped or damaged
wires

Contact customer support.

Loose wires or connectors Contact customer support.

Liquid or moisture inside the housing Contact customer support.

9.3.1 Check the sensor coils
Checking the sensor coils can identify a cause for a no sensor response alert.

Restriction
This procedure applies only to 9-wire remote-mount transmitters and remote transmitters with remote core
processors.

Procedure

1. Disconnect power to the transmitter.

 WARNING
If the transmitter is in a hazardous area, wait five minutes after disconnecting the power. Failure to
do so could result in an explosion causing death or injury.

2. Unplug the terminal blocks from the terminal board on the core processor.

3. Using a digital multimeter (DMM), check the pickoff coils by placing the DMM leads on the unplugged
terminal blocks for each terminal pair. See the following table for a list of the coils. Record the values.
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Table 9-3: Coils and test terminal pairs

Coil Sensor model Terminal colors

Drive coil All Brown to red

Left pickoff coil (LPO) All Green to white

Right pickoff coil (RPO) All Blue to gray

Resistance temperature detector
(RTD)

All Yellow to violet

Lead length compensator (LLC) All except T-Series and CMF400 (see
note)

Yellow to orange

Composite RTD All CMFSs, T-Series, H300, and F300 Yellow to orange

Fixed resistor (see note) CMFS007, CMFS010, CMFS015,
CMF400, and F300

Yellow to orange

There should be no open circuits, that is, no infinite resistance readings. The left pickoff and right
pickoff readings should be the same or very close (±5  Ω). If there are any unusual readings, repeat the
coil resistance tests at the sensor junction box to eliminate the possibility of faulty cable. The readings
for each coil pair should match at both ends.

4. Test the terminals in the sensor junction box for shorts to case.

Test results will be inconclusive with nonconductive process fluids such as hydrocarbons.

a) Leave the terminal blocks disconnected.

b) Remove the lid of the junction box.

c) Testing one terminal at a time, place a DMM lead on the terminal and the other lead on the
sensor case.

With the DMM set to its highest range, there should be infinite resistance on each lead. If there is
any resistance at all, there is a short to case.

5. Test the resistance of junction box terminal pairs.

a) Test the brown terminal against all other terminals except the red one.

b) Test the red terminal against all other terminals except the brown one.

c) Test the green terminal against all other terminals except the white one.

d) Test the white terminal against all other terminals except the green one.

e) Test the blue terminal against all other terminals except the gray one.

f) Test the gray terminal against all other terminals except the blue one.

g) Test the orange terminal against all other terminals except the yellow and violet ones.

h) Test the yellow terminal against all other terminals except the orange and violet ones.

i) Test the violet terminal against all other terminals except the yellow and orange ones.

There should be infinite resistance for each pair. If there is any resistance at all, there is a short between
terminals.
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Postrequisites

To return to normal operation:

1. Plug the terminal blocks into the terminal board.

2. Replace the lid on the sensor junction box.

Important
When reassembling the meter components, be sure to grease all O-rings.

9.4 Flow measurement problems
Problem Possible causes Recommended actions

Non-zero flow reading
at no-flow conditions
or at zero offset

• Misaligned piping (especially in new
installations)

• Open or leaking valve

• Incorrect sensor zero

• If the reading is not excessively high,
review the live zero. You may need to
restore the factory zero.

• Check for open or leaking valves or seals.

• Check for mounting stress on the sensor
(e.g., sensor being used to support piping,
misaligned piping).

• Contact customer support.

Erratic non-zero flow
rate at no-flow
conditions

• Leaking valve or seal

• Two-phase flow

• Incorrect sensor orientation

• Wiring problem

• Vibration in pipeline at rate close to sensor
tube frequency

• Damping value too low

• Mounting stress on sensor

• Empty sensor when reading liquid volume
flow

• Verify that the sensor orientation is
appropriate for your application (refer to
the sensor installation manual).

• Check the drive gain and the pickoff
voltage.

• If the wiring between the sensor and the
transmitter includes a 9-wire segment,
verify that the 9-wire cable shields are
correctly grounded.

• Check the wiring between the sensor and
the transmitter.

• For sensors with a junction box, check for
moisture in the junction box.

• Purge the sensor tubes.

• Check for open or leaking valves or seals.

• Check for sources of vibration.

• Verify damping configuration.

• Verify that the measurement units are
configured correctly for your application.

• Check for two-phase flow.

• Check for radio frequency interference.

• Contact customer support.
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Problem Possible causes Recommended actions

Erratic non-zero flow
rate when flow is
steady

• Two-phase flow

• Damping value too low

• Plugged or coated sensor tube

• Output wiring problem

• Problem with receiving device

• Wiring problem

• Verify that the sensor orientation is
appropriate for your application (refer to
the sensor installation manual).

• Check the drive gain and the pickoff
voltage.

• If the wiring between the sensor and the
transmitter includes a 9-wire segment,
verify that the 9-wire cable shields are
correctly grounded.

• Check for air entrainment, tube fouling,
flashing, or tube damage.

• Check the wiring between the sensor and
the transmitter.

• For sensors with a junction box, check for
moisture in the junction box.

• Purge the sensor tubes.

• Check for open or leaking valves or seals.

• Check for sources of vibration.

• Verify damping configuration.

• Verify that the measurement units are
configured correctly for your application.

• Check for two-phase flow.

• Check for radio frequency interference.

• Contact customer support.

Inaccurate flow rate or
batch total

• Wiring problem

• Inappropriate measurement unit

• Incorrect flow calibration factor

• Incorrect meter factor

• Incorrect density calibration factors

• Incorrect grounding

• Two-phase flow

• Problem with receiving device

• Incorrect sensor zero

• Incorrect measurement unit configured for
a process variable - for example, selecting
g/min instead of USGPM

• Check the wiring between the sensor and
the transmitter.

• Verify that the measurement units are
configured correctly for your application.

• Verify all of the characterization or
calibration parameters. See the sensor tag
or the calibration sheet for your meter.

• Perform a bucket test to verify batch totals.

• Zero the meter.

• Check the grounding of all components.

• Check for two-phase flow.

• Verify the receiving device, and the wiring
between the transmitter and the receiving
device.

• Check sensor coil resistance and for shorts
to case.

• Replace the transmitter.
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9.5 Check grounding
The sensor and the transmitter must be grounded.

Prerequisites

You will need an:

• Installation manual for your sensor

• Installation manual for your transmitter (remote-mount installations only)

Procedure

Refer to the sensor and transmitter installation manuals for grounding requirements and instructions.

9.6 Check the pickoff voltage
If the pickoff voltage readings are unusually low, you may have any of a variety of process or equipment
problems.

To know whether your pickoff voltage is unusually low, you must collect pickoff voltage data during the
problem condition and compare it to pickoff voltage data from a period of normal operation.

Drive gain and pickoff voltage are inversely proportional. As drive gain increases, pickoff voltages decrease
and vice versa.

Table 9-4: Possible causes and recommended actions for low pickoff voltage

Possible cause Recommended actions

Faulty wiring runs between the sensor and transmitter Verify wiring between sensor and transmitter.

Process flow rate beyond the limits of the sensor Verify that the process flow rate is not out of range of the
sensor.

Sensor tubes are not vibrating • Check for plugging or deposition.

• Ensure that the vibrating element is free to vibrate (no
mechanical binding).

• Verify wiring.

Moisture in the sensor electronics Eliminate the moisture in the sensor electronics.

The sensor is damaged, or sensor magnets may have
become demagnetized

Replace the sensor.

9.6.1 Collect pickoff voltage data
Pickoff voltage data can be used to diagnose a variety of process and equipment conditions. Collect pickoff
voltage data from a period of normal operation, and use this data as a baseline for troubleshooting.

Procedure

1. Navigate to the pickoff voltage data.

2. Observe and record data for both the left pickoff and the right pickoff, over an appropriate period of
time, under a variety of process conditions.
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9.7 Check power supply wiring
If the power supply wiring is damaged or improperly connected, the transmitter may not receive enough
power to operate properly.

Prerequisites

• You will need the installation manual for your transmitter.

• When using DC power, a minimum of 1.5 amps of startup current is required.

Procedure

1. Use a voltmeter to test the voltage at the transmitter power supply terminals.
• If the voltage is within the specified range, you do not have a power supply problem.

• If the voltage is low, ensure that the power supply is adequate at the source, the power cable is
sized correctly, there is no damage to the power cable, and an appropriate fuse is installed.

• If there is no power, continue with this procedure.

2.  WARNING
If the transmitter is in a hazardous area, wait five minutes after disconnecting the power. Failure to
do so could result in an explosion causing death or injury.

Before inspecting the power supply wiring, disconnect the power source.

3. Ensure that the terminals, wires, and wiring compartment are clean and dry.

4. Ensure that the power supply wires are connected to the correct terminals.

5. Ensure that the power supply wires are making good contact, and are not clamped to the wire
insulation.

6. Inspect the voltage label inside the wiring compartment.
The voltage supplied to the transmitter should match the voltage specified on the label.

7.  WARNING
If the transmitter is in a hazardous area, do not reapply power to the transmitter with the housing
cover removed. Reapplying power to the transmitter while the housing cover is removed could
cause an explosion.

Reapply power to the transmitter.

8. Test the voltage at the terminals.
If there is no power, contact customer service.

9.8 Check for radio frequency interference (RFI)
The transmitter Frequency Output or Discrete Output can be affected by radio frequency interference (RFI).
Possible sources of RFI include a source of radio emissions, or a large transformer, pump, or motor that can
generate a strong electromagnetic field. Several methods to reduce RFI are available. Use one or more of the
following suggestions, as appropriate to your installation.

Procedure

• Use shielded cable between the output and the receiving device.

Troubleshooting Configuration and Use Manual
August 2022 20000326

104 Micro Motion 2700 Transmitters with FOUNDATION Fieldbus



— Terminate the shielding at the receiving device. If this is impossible, terminate the shielding at the
cable gland or conduit fitting.

— Do not terminate the shielding inside the wiring compartment.

— 360-degree termination of shielding is unnecessary.

• Eliminate the RFI source.

• Move the transmitter.

9.9 Check for two-phase flow (slug flow)
Two-phase flow can cause rapid changes in the drive gain. This can cause a variety of measurement issues.

Procedure

1. Check for two-phase flow alerts (e.g., A105).
If the transmitter is not generating two-phase flow alerts, verify that two-phase flow limits have been
set. If limits are set, two-phase flow is not the source of your problem.

2. Check the process for cavitation, flashing, or leaks.

3. Monitor the density of your process fluid output under normal process conditions.

4. Check the settings of Two-Phase Flow Low Limit, Two-Phase Flow High Limit, and Two-Phase Flow
Timeout.

Tip
You can reduce the occurrence of two-phase flow alerts by setting Two-Phase Flow Low Limit to a
lower value, Two-Phase Flow High Limit to a higher value, or Two-Phase Flow Timeout to a higher
value. Micro Motion recommends leaving the Two-Phase Flow High Limit at the default value.

9.10 Status alerts, causes, and recommendations
Not all of these alerts may apply to your type of transmitter.

9.10.1 A001
Alert

EEPROM Error

Cause

The transmitter has detected a problem communicating with the sensor.

Recommended actions

1. Cycle power to the meter.

2. Replace the core processor.

3. Contact customer support.
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9.10.2 A002
Alert

RAM Error

Cause

The transmitter has detected a problem communicating with the sensor.

Recommended actions

1. Cycle power to the meter.

2. Replace the core processor.

3. Contact customer support.

9.10.3 A003
Alert

No Sensor Response

Cause

The transmitter is not receiving one or more basic electrical signals from the sensor.

This alert often occurs in conjunction with Alert 102.

Recommended actions

1. Check the drive gain and the pickoff voltage.

2. Check the wiring between the sensor and the transmitter.

3. Verify that internal wiring is secure and that there are no internal electrical problems.

4. Check the integrity of the sensor tubes.

5. Perform sensor coil resistence checks.

9.10.4 A004
Alert

Temperature Overrange

Cause

The RTD resistance is out of range for the sensor. The tube RTD resistance is out of range for the sensor.

Recommended actions

1. Check your process conditions against the values reported by the device.

2. Verify temperature characterization or calibration parameters.

3. Verify that internal wiring is secure and that there are no internal electrical problems.

4. Check the wiring between the sensor and the transmitter.

5. Contact customer support.

Troubleshooting Configuration and Use Manual
August 2022 20000326

106 Micro Motion 2700 Transmitters with FOUNDATION Fieldbus



9.10.5 A006
Alert

Characterization Required

Cause

• Calibration factors have not been entered

• The sensor type is incorrect

• The calibration factors are incorrect for the sensor type

Recommended actions

1. Verify all of the characterization or calibration parameters.

See the sensor tag or the calibration sheet for your meter.

2. Verify the setting of the Sensor Type parameter.

3. If Sensor Type = Curved Tube, ensure that no parameters specific to Straight Tube have been set.

4. Verify that internal wiring is secure and that there are no internal electrical problems.

5. Replace the core processor.

6. Contact customer support.

9.10.6 A008
Alert

Density Overrange

Cause

The line density is greater than 10 g/cm3 (10000 kg/m3).

Recommended actions

1. If other alerts are present, resolve those alert conditions first. If the current alert persists, continue
with the following steps.

2. Check for air in the flow tubes, tubes not filled, foreign material in the tubes, coating in the tubes,
or other process problems.

3. Check for two-phase flow.

4. Verify all of the characterization or calibration parameters.

See the sensor tag or the calibration sheet for your meter.

5. Check the drive gain and the pickoff voltage.

6. Perform Smart Meter Verification.

7. Perform density calibration.

8. Contact customer support.
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9.10.7 A009
Alert

Transmitter Initializing/Warming Up

Cause

Transmitter is in power-up mode.

This alert often occurs in conjunction with Alert 14.

Recommended actions

1. Allow the meter to complete its power-up sequence. The alert should clear automatically.

2. If other alerts are present, resolve those alert conditions first. If the current alert persists, continue
with the following steps.

3. Verify that the tubes are full of process fluid.

4. Check the wiring between the sensor and the transmitter.

5. Verify that the transmitter is receiving sufficient power. If using DC power, verify that there is a
minimum of 1.5 amps of startup current available.

Option Description

If no Correct the problem and cycle power to the meter.

If yes The transmitter probably has an internal power issue. Replace the transmitter.

6. Ensure that the process fluid is stable.

Check for two-phase flow, high process noise, or a fast transition between two fluids of different
densities.

9.10.8 A010
Alert

Calibration Failure

Cause

There are many possible causes. This alert will not clear until you cycle power to the meter.

Recommended actions

1. Ensure that your calibration procedure meets the documented requirements, cycle power to the
meter, then retry the procedure.

2. If this alert appears during zeroing:

a) Verify that there is no flow through the sensor.

b) Cycle power to the meter.

c) Retry the procedure.
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9.10.9 A011
Alert

Zero Calibration Failed: Low

Cause

There are many possible causes, such as:

• Too much flow, especially reverse flow through the sensor during a calibration procedure

• A zero result occurred that is too low.

This alert is accompanied by A010, and will not clear until you cycle power to the meter.

Recommended actions

1. Verify that there is no flow through the sensor.

2. Cycle power to the meter.

3. Retry the procedure.

9.10.10 A012
Alert

Zero Calibration Failed: High

Cause

There are many possible causes, such as:

• Too much flow, especially forward flow through the sensor during a calibration procedure

• A zero result occurred that is too high.

This alert is accompanied by A010, and will not clear until you cycle power to the meter.

Recommended actions

1. Verify that there is no flow through the sensor.

2. Cycle power to the meter.

3. Retry the procedure.

9.10.11 A013
Alert

Zero Calibration Failed: Unstable

Cause

There was too much process instability during the calibration procedure.

This alert will not clear until you cycle power to the meter.
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Recommended actions

1. Remove or reduce sources of electromechanical noise.

Example

Pumps, vibration, or pipe stress

2. Cycle power to the meter.

3. Retry the procedure.

9.10.12 A014
Alert

Transmitter Failure

Cause

There are many possible causes.

Recommended actions

1. Ensure that all wiring compartment covers are installed correctly

2. Ensure that all transmitter wiring meets specifications and that all cable shields are properly
terminated.

3. Check the grounding of all components.

4. Evaluate the environment for sources of high electromagnetic interference (EMI) and relocate the
transmitter or wiring as necessary.

5. Contact customer support.

9.10.13 A016
Alert

Sensor Temperature (RTD) Failure

Cause

The value computed for the resistance of the line RTD is outside limits.

Recommended actions

1. Check your process conditions against the values reported by the device.

2. Check the wiring between the sensor and the transmitter.

3. Verify that internal wiring is secure and that there are no internal electrical problems.

4. Contact customer support.

9.10.14 A017
Alert

Sensor Case Temperature (RTD) Failure
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Cause

The values computed for the resistance of the meter and case RTDs are outside limits.

Recommended actions

1. Check your process conditions against the values reported by the device.

Temperature should be between -200 °F (-129 °C) and +400 °F (+204 °C).

2. Verify all of the characterization or calibration parameters.

See the sensor tag or the calibration sheet for your meter.

3. Check the wiring between the sensor and the transmitter.

4. Verify that internal wiring is secure and that there are no internal electrical problems.

5. Contact customer support.

9.10.15 A020
Alert

Calibration Factors Missing

Cause

Some calibration factors have not been entered or are incorrect.

Recommended actions

1. Verify all of the characterization or calibration parameters.

See the sensor tag or the calibration sheet for your meter.

2. Verify the setting of the Sensor Type parameter.

3. If Sensor Type = Curved Tube, ensure that no parameters specific to Straight Tube have been set.

9.10.16 A021
Alert

Transmitter/Sensor/Software Mismatch

Cause

The configured board type does not match the physical board, or the configured sensor type does not match
the physical sensor.

Recommended actions

1. Verify all of the characterization or calibration parameters. See the sensor tag or the calibration
sheet for your meter.

2. Ensure that the correct board is installed.

3. Verify the setting of the Sensor Type parameter.

4. If Sensor Type=Curved Tube, ensure that no parameters specific to Straight Tube have been set.
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9.10.17 A022
Alert

Configuration Database Corrupt

Cause

There has been an internal electronics failure.

Recommended actions

1. Cycle power to the meter.

2. Contact customer support.

9.10.18 A023
Alert

Internal Totals Corrupt

Cause

There has been an internal electronics failure.

Recommended actions

1. Cycle power to the meter.

2. Contact customer support.

9.10.19 A024
Alert

Program Corrupt (Core Processor)

Cause

There has been an internal electronics failure.

Recommended actions

1. Cycle power to the meter.

2. Contact customer support.

9.10.20 A026
Alert

Sensor/Transmitter Communications Failure

Cause

The transmitter has lost communication with the core processor. There may be a problem with the wiring or
with either component.

This alert often occurs in conjunction with alerts A009 and A014.
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Recommended actions

1. Check the wiring between the sensor and the transmitter.

2. Check for noise in the wiring or in the transmitter environment.

3. Verify that internal wiring is secure and that there are no internal electrical problems.

4. Check the status LED on the core processor.

5. Check the resistance across core processor terminals.

6. If the alert persists:

a) Replace the core processor.

b) If that does not solve the problem, restore the original core processor and replace the
transmitter.

c) If that does not solve the problem, replace both the transmitter and the core processor.

9.10.21 A028
Alert

Core Processor Write Failure

Cause

There is an internal electronics failure.

Recommended actions

1. Cycle power to the meter.

2. Contact customer support.

9.10.22 A029
Alert

Internal Electronics Failure

Cause

This can indicate a loss of communication between the transmitter and the display module.

Recommended actions

1. Cycle power to the meter.

2. Replace the display module.

3. Contact customer support.

9.10.23 A030
Alert

Incorrect Board Type
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Cause

The loaded software is not compatible with the programmed board type.

Recommended actions

Contact customer support.

9.10.24 A031
Alert

Low Power

Cause

The transmitter is not receiving enough power.

This alert will not clear until you cycle power to the meter.

Recommended actions

1. Check the wiring between the transmitter and the core processor.

2. Cycle power to the meter.

3. Check the wiring of the transmitter.

4. Cycle power to the meter.

5. Verify that the transmitter is receiving sufficient power.

Option Description

If it is not a. Correct the problem.

b. Cycle power to the meter.

If it is The transmitter probably has an internal power issue. Replace the transmitter.

9.10.25 A032
Alert

Meter Verification in Progress: Outputs to Fault

Cause

A meter verification test is in progress, with outputs set to Fault.

Recommended actions

Allow the procedure to complete.

9.10.26 A033
Alert

Insufficient Pickoff Signal
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Cause

The signal from the sensor pickoff(s) is insufficient. This suggests that the sensor tubes or vibrating elements
are not vibrating. This alert often occurs in conjunction with Alert 102.

Recommended actions

1. Check for air in the flow tubes, tubes not filled, foreign material in the tubes, coating in the tubes,
or other process problems.

2. Check for foreign material in the process gas or fluid, coating, or other process problems.

3. Check for fluid separation by monitoring the density value and comparing the results against
expected density values.

4. Ensure that the sensor orientation is appropriate for your application.

Settling from a two-phase or three-phase fluid can cause this alert even if the flow tubes are full.

9.10.27 A035
Alert

Meter Verification Aborted

Cause

The meter verification test did not complete, possibly because of a manual abort.

Recommended actions

1. Verify that process conditions are stable, then retry the test.

2. Contact customer support.

9.10.28 A102
Alert

Drive Overrange

Cause

The drive power (current/voltage) is at its maximum.

Recommended actions

1. Check the drive gain and the pickoff voltage.

2. Check the wiring between the sensor and the transmitter.

3. Verify that internal wiring is secure and that there are no internal electrical problems.

4. Check for air in the flow tubes, tubes not filled, foreign material in the tubes, coating in the tubes,
or other process problems.

5. Check for fluid separation by monitoring the density value and comparing the results against
expected density values.

6. Ensure that the sensor orientation is appropriate for your application. Settling from a two-phase or
three-phase fluid can cause this alert even if the flow tubes are full.
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9.10.29 A103
Alert

Data Loss Possible (Totals and Inventories)

Cause

Totalizers are not properly saved. The device was unable to store the totalizers during the last power-down,
and must rely on the saved totals. The saved totals can be as much as two hours out of date.

Recommended actions

1. Check the wiring between the transmitter and the core processor, then cycle power to the meter.

2. Verify that the transmitter is receiving sufficient power.

Option Description

If it is not a. Correct the problem.

b. Cycle power to the meter.

If it is The transmitter probably has an internal power issue. Replace the transmitter.

9.10.30 A104
Alert

Calibration in Progress

Cause

A calibration procedure is in process.

Recommended actions

1. Allow the procedure to complete.

2. For zero calibration:

a) Abort the calibration.

b) Set Zero Time to a lower value.

c) Restart the calibration.

9.10.31 A105
Alert

Two-Phase Flow

Cause

The line density is outside the user-defined two-phase flow limits.
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Recommended actions

1. Check for two-phase flow.

2. Check the live density reading against the upper and lower two-phase flow limit settings.

9.10.32 A107
Alert

Power Reset Occurred

Cause

The transmitter has been restarted.

Recommended actions

No action is required.

If desired, you can set Alert Severity Level to Ignore.

9.10.33 A120
Alert

Curve Fit Failure (Concentration)

Cause

The transmitter was unable to calculate a valid concentration matrix from the current data.

Recommended actions

Verify the configuration of the concentration measurement application.

9.10.34 A121
Alert

Extrapolation Alert (Concentration)

Cause

The line density or line temperature is outside the range of the concentration matrix plus the configured
extrapolation limit.

Recommended actions

1. Check your process conditions against the values reported by the device.

2. Verify the configuration of the concentration measurement application.

9.10.35 A131
Alert

Meter Verification in Progress: Outputs to Last Measured Value
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Cause

A meter verification test is in progress, with outputs set to Last Measured Value.

Recommended actions

Allow the procedure to complete.

9.10.36 A132
Alert

Sensor Simulation Active

Cause

Sensor simulation is enabled.

Recommended actions

Disable sensor simulation.

9.10.37 A133
Alert

EEPROM Error (Display)

Cause

There is a memory error in the display module.

Recommended actions

1. Cycle power to the meter.

2. Replace the display module.

3. Contact customer support.

9.10.38 Density FD Calibration in Progress
Cause

A flowing density calibration is in progress.

Recommended actions

No action required.

9.10.39 Density D1 Calibration in Progress
Cause

A D1 density calibration is in progress.

Recommended actions

No action required.
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9.10.40 Density D2 Calibration in Progress
Cause

A D2 density calibration is in progress.

Recommended actions

No action required.

9.10.41 Density D3 Calibration in Progress
Cause

A D3 density calibration is in progress.

Recommended actions

No action required.

9.10.42 Density D4 Calibration in Progress
Cause

A D4 density calibration is in progress.

Recommended actions

No action required.

9.10.43 Zero Calibration in Progress
Cause

A zero calibration is in progress.

Recommended actions

No action required.

9.10.44 Reverse Flow
Cause

Flow through the device is in the reverse direction (against the flow arrow).

Recommended actions

No action is required.
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9.11 Temperature measurement problems
Problem Possible causes Recommended actions

Temperature reading
significantly different
from process
temperature

• RTD failure

• Incorrect compensation factors

• Line temperature in bypass does not match
temperature in main line

• Verify that the temperature compensation
factors match the value on the sensor tag
or calibration sheet.

• If Alert A004, A016, or A017 is active,
perform the actions recommended for that
alert.

Temperature reading
slightly different from
process temperature

• Sensor temperature not yet equalized

• Sensor leaking heat

• If the error is within the temperature
specification for the sensor, there is no
problem. If the temperature measurement
is outside the specification, contact
customer support.

• The temperature of the fluid may be
changing rapidly. Allow sufficient time for
the sensor to equalize with the process
fluid.

• The electrical connection between the RTD
and the sensor may be damaged. This may
require replacing the sensor.
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A Transducer blocks and views
List of transducer blocks

The fieldbus interface is implemented via the following transducer blocks.

Table A-1: Transducer blocks

Transducer block Description

Measurement Configuration parameters and data for mass flow rate, volume flow rate,
density, and temperature

Calibration Calibration parameters and data for mass flow, auto zero, density, T-Series
coefficients, temperature, pressure compensation, and temperature
compensation

Diagnostics Diagnostic parameters for slug flow setup, alarm status, general diagnostics,
and meter fingerprinting

Device information Contains informational static data such as software revisions, serial numbers,
and sensor data

Local display Contains local display (LDO) configuration data

Petroleum measurement Contains PM process variables and configuration data

Concentration measurement Contains concentration measurement process variables and configuration data

Density Viscosity meter Contains parameters and data for the Density Viscosity meters

A.1 Descriptions of transducer block table entries
Use the following definitions for the transducer block details tables:

# Index of the FOUNDATION Fieldbus parameter in the object dictionary

Name Name of the fieldbus parameter used in the code

Description Provides a description of the parameter.

Msg type
VAR Variable — a variable value

ENUM Enumeration — a value from a discrete list

METHOD Method — initiates an action within the device

STR String — a length of ASCII characters (letters, numerals,
symbols, and punctuation marks)

ARR Array — data structure that contains an organized group of
elements

REC Record — a record defined by the FOUNDATION Fieldbus
organization — see section 5.13 of FF-890-1.3

Data type (size in
bytes)

The FOUNDATION Fieldbus data type. The size of the data in bytes is in parenthesis. For
example, FLOAT (4) would mean the variable is a float of size 4 bytes.
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Store The class of memory required, and the update rate in Hz if applicable.

Dynamic Cyclic data, parameter updated periodically

Dynamic/20 Cyclic data, parameter updated periodically in 20 Hz

Nonvolatile Nonvolatile parameter that must be saved on the Model 2700
transmitter.

Static Acyclic data, parameter changed on a deliberate write

Access The type of access allowed for the parameter.

Table A-2: Access

Read only Read only access is allowed for the parameter

RW in any mode Read/write, with the transducer block in any mode

RW (OOS) Read/write, with the transducer block in Out of Service (OOS)
mode

RW (Auto) Read/write, with the transducer block in Auto mode

List of values The list of valid values to write to an enumerated parameter. This field is not applicable
for read only parameters. Valid value ranges for variable type parameters are specified in
the tables.

Definitions for view list

Up to four views are defined for each transducer block.

View Description

VIEW 1 Access to the dynamic operating parameters of the transducer block

VIEW 2 Access to the static operating parameters of the transducer block

VIEW 3 Access to all the dynamic parameters of the transducer block

VIEW 4 Access to static parameters not included in VIEW 2

The number in the cell represents the size of the parameter in bytes. The maximum size of a view is 122 bytes.

Use the following definitions for the transducer block views tables:

View and size
in view

The views that contain the parameter, and the size of the parameter in the view, in bytes.
The number in the cell indicates that the variable is contained in that particular view. The
number is the size of the parameter in bytes.
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A.2 Measurement transducer blocks

A.2.1 View list for the measurement transducer block
The following table lists the parameters contained in the measurement transducer block for measurement
parameters.

Four views are defined for the measurement transducer block. The table also shows the applicable views for
each parameter, and the size of the parameter in that view, in bytes.

Table A-3: Measurement transducer block parameters view list

Index Name View

1 2 3 4

0 BLOCK_STRUCTURE — — — —

1 ST_REV 2 2 2 2

2 TAG_DESC — — — —

3 STRATEGY — — — 2

4 ALERT_KEY — — — 1

5 MODE_BLK 4 — 4 —

6 BLOCK_ERR 2 — 2 —

7 UPDATE_EVT — — — —

8 BLOCK_ALM — — — —

9 TRANSDUCER_DIRECTORY — — — —

10 TRANSDUCER_TYPE 2 2 2 2

11 TRANSDUCER_TYPE_VER 2 2 2 2

12 XD_ERROR 1 — 1 —

13 COLLECTION_DIRECTORY — — — —

14 MFLOW — — — —

15 MFLOW_UNITS 5 2 5 —

16 MFLOW_SPECIAL_UNIT_BASE — — — 2

17 MFLOW_SPECIAL_UNIT_TIME — — — 2

18 MFLOW_SPECIAL_UNIT_CONV — — — 4

19 MFLOW_SPECIAL_UNIT_STR — — — 8

20 TEMPERATURE 5 — 5 —

21 TEMPERATURE_UNITS — 2 — —

22 DENSITY 5 — 5 —

23 DENSITY_UNITS — 2 — —

24 VOLUME_FLOW 5 — 5 —

25 VOLUME_FLOW_UNITS — 2 — —
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Table A-3: Measurement transducer block parameters view list (continued)

Index Name View

1 2 3 4

26 VOL_SPECIAL_UNIT_BASE — — — 2

27 VOL _SPECIAL_UNIT_TIME — — — 2

28 VOL _SPECIAL_UNIT_CONV — — — 4

29 VOL _SPECIAL_UNIT_STR — — — 8

30 MASS_TOT_INV_SPECIAL_ STR — — — 8

31 VOLUME_TOT_INV_ SPECIAL_ STR — — — 8

32 FLOW_DAMPING — 4 — —

33 TEMPERATURE_DAMPING — 4 — —

34 DENSITY_DAMPING — 4 — —

35 MFLOW_M_FACTOR — 4 — —

36 DENSITY_M_FACTOR — 4 — —

37 VOL_M_FACTOR — 4 — —

38 MASS_LOW_CUT — 4 — —

39 VOLUME_FLOW_LOW_CUTOFF — 4 — —

40 DENSITY_LOW_CUTOFF — 4 — —

41 FLOW_DIRECTION — 2 — —

42 HIGH_MASS_LIMIT — 4 — —

43 HIGH_TEMP_LIMIT — 4 — —

44 HIGH_DENSITY_LIMIT — 4 — —

45 HIGH_VOLUME_LIMIT — 4 — —

46 LOW_MASS_LIMIT — 4 — —

47 LOW_TEMP_LIMIT — 4 — —

48 LOW_DENSITY_LIMIT — 4 — —

49 LOW_VOLUME_LIMIT — 4 — —

50 INTEGRATOR_FB_CONFIG — 2 — —

51 START_STOP_TOTALS — 2 — —

52 RESET_TOTALS — 2 — —

53 RESET_INVENTORIES — 2 — —

54 RESET_MASS_TOTAL — 2 — —

55 RESET_VOLUME_TOTAL — 2 — —

56 MASS_TOTAL 5 — 5 —

57 VOLUME_TOTAL 5 — 5 —
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Table A-3: Measurement transducer block parameters view list (continued)

Index Name View

1 2 3 4

58 MASS_INVENTORY 5 — 5 —

59 VOLUME_INVENTORY 5 — 5 —

60 MASS_TOT_INV_UNITS — 2 — —

61 VOLUME_TOT_INV_UNITS — 2 — —

62 GSV_Gas_Dens — 4 — —

63 GSV_Vol_Flow 5 — 5 —

64 GSV_Vol_Tot 5 — 5 —

65 GSV_Vol_Inv 5 — 5 —

66 SNS_EnableGSV — — — 2

67 SNS_GSV_FlowUnits — — — 2

68 SNS_GSV_TotalUnits — — — 2

69 SNS_GSVflowBaseUnit — — — 2

70 SNS_GSVflowBaseTime — — — 2

71 SNS_GSVflowFactor — — — 4

72 SNS_GSVflowText — — — 8

73 SNS_GSVtotText — — — 8

74 SNS_GSV_FlowCutoff — — — 2

75 SNS_ResetGSVolTotal — 2 — —

76 SNS_ResetAPIGSVInv — 2 — —

77 SNS_ResetMassInventory — 2 — —

78 SNS_ResetVolumeInventory — 2 — —

79 SNS_ActualFlowDirection — 2 — —

80 MEAS_SYS_AttachedCoreType — — — 2

81 CORE_SW_REV_MSTB — — — 2

A.2.2 Standard fieldbus parameters for measurement transducer
blocks
Index and name Description List of values

#0

BLOCK_STRUCTURE

The beginning of the transducer block.

Msg type = VAR
Data type = DS_64 (5)
Store = Static
Access = RW (OOS) or RW (Auto)
Available in Release 1.0

—
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Index and name Description List of values

#1

ST_REV

The revision level of the static data
associated with the function block.
Incremented with each write of static store.

Msg type = VAR
Data type = Unsigned16 (2)
Store = Static
Access = Read only
Available in Release 1.0

—

#2

TAG_DESC

The user description of the intended block
application.

Msg type = STR
Data type = OCTET STRING (32)
Store = Static
Access = RW (OOS) or RW (Auto)
Available in Release 1.0

Any 32 characters

#3

STRATEGY

Used to identify grouping of blocks. This
data is not checked or processed by the
block.

Msg type = VAR
Data type = Unsigned16 (2)
Store = Static
Access = RW (OOS) or RW (Auto)
Available in Release 1.0

—

#4

ALERT_KEY

The identification number of the plant unit.
This information may be used in the host
for sorting alarms, etc.

Msg type = VAR
Data type = Unsigned8 (1)
Store = Static
Access = RW (OOS) or RW (Auto)
Available in Release 1.0

1 to 255

#5

MODE_BLK

The actual, target, permitted, and normal
modes of the block.

Msg type = REC
Data type = DS-69 (4)
Store = Mixed
Access = RW (OOS) or RW (Auto)
Available in Release 1.0

See section 2.6 of FF-891

#6

BLOCK_ERR

The error status associated with the
hardware or software components
associated with a block.

Msg type = STR
Data type = BIT STRING (2)
Store = Dynamic/20
Access = Read only
Available in Release 1.0

See section 4.8 of FF-903
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Index and name Description List of values

#7

UPDATE_EVT

Occurs when a static parameter is changed
while a block mode is not in out of service
(OOS) mode, or when the mode changes
from OOS mode and one or more static
parameters changed while the block was
OOS.

Msg type = REC
Data type = DS-73
Store = Dynamic
Access = RW in any mode
Available in Release 1.0

—

#8

BLOCK_ALM

A predefined set of 16 conditions that may
occur within a block.

Msg type = REC
Data type = DS-72
Store = Dynamic
Access = RW in any mode
Available in Release 9.0

—

#9

TRANSDUCER_
DIRECTORY

A directory that specifies the number and
starting indices of the data collections in
the transducer block.

Msg type = VAR
Data type = Unsigned16 (2)
Store = Static
Access = RW (OOS)
Available in Release 9.0

—

#10

TRANSDUCER_
TYPE

Identifies the transducer that follows.

Msg type = VAR
Data type = Unsigned16 (2)
Store = Static
Access = RW (OOS)
Available in Release 9.0

—

#11

TRANSDUCER_
TYPE_VER

Identifies the version of the transducer
block. Format is XXYY where XX is the major
spec revision and YY is the manufacturer
revision.

Msg type = VAR
Data type = Unsigned16 (2)
Store = Static
Access = RW (OOS)
Available in Release 9.0

—

#12

XD_ERROR

Used for all config, H/W, connection failure
of system problems in the block.

Msg type = VAR
Data type = Unsigned8 (1)
Store = Dynamic
Access = RW (OOS)
Available in Release 1.0

0 = No Error
18 = Calibration Error
19 = Configuration Error
20 = Electronics Failure
21 = Sensor Failure
26 = Process Error
27 = Calibration in Progress
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Index and name Description List of values

#13

COLLECTION_
DIRECTORY

Used for all config, H/W, and connection
failures of system problems in the block.

Msg type = VAR
Data type = Unsigned32 (4)
Store = Static
Access = RW (OOS)
Available in Release 9.0

—

A.2.3 Process variables for measurement transducer blocks
Table A-4: Process variables for measurement transducer blocks

Index and name Description List of values HW

#14

MFLOW

Mass flow rate

Msg type = VAR
Data type = DS_65 (5)
Store = Dynamic/20
Access = Read
Available in Release 1.0

— 700
800

#15

MFLOW_UNITS

Standard or special mass flow rate
unit

Msg type = ENUM
Data type = Unsigned16 (2)
Store = Static
Access = R/W (OOS)
Available in Release 1.0

1318 = g/s
1319 = g/min
1320 = g/h
1322 = kg/s
1323 = kg/min
1324 = kg/h
1325 = kg/d
1327 = t/min
1328 = t/h
1329 = t/d
1330 = lb/s
1331 = lb/min
1332 = lb/h
1333 = lb/d
1335 = STon/min
1336 = STon/h
1337 = STon/d
1340 = LTon/h
1341 = LTon/d
253 = Special

700
800

#16

MFLOW_SPECIAL_UNIT_BA
SE

Base mass unit

Msg type = ENUM
Data type = Unsigned16 (2)
Store = Static
Access = RW (OOS)
Available in Release 1.0

1089 = g
1088 = kg
1092 = t
1094 = lb
1095 = STon
1096 = Lton

700
800
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Table A-4: Process variables for measurement transducer blocks (continued)

Index and name Description List of values HW

#17

MFLOW_SPECIAL_UNIT_TI
ME

Base time unit for special mass unit

Msg type = ENUM
Data type = Unsigned16 (2)
Store = Static
Access = RW (OOS)
Available in Release 1.0

1058 = min
1054 = s
1059 = h
1060 = d

700
800

#18

MFLOW_SPECIAL_UNIT_CO
NV

Special mass unit conversion factor

Msg type = VAR
Data type = FLOAT (4)
Store = Static
Access = RW (OOS)
Available in Release 1.0

— 700
800

#19

MFLOW_SPECIAL_UNIT_ST
R

Special mass flow unit string

Msg type = STR
Data type = VISIBLE STRING (8)
Store = Static
Access = RW (OOS)
Available in Release 1.0

Any 8 characters 700
800

#20

TEMPERATURE

The error status associated with the
hardware or software components
associated with a block.

Msg type = VAR
Data type = DS-65 (5)
Store = Dynamic/20
Access = Read
Available in Release 1.0

— 700
800
CDM
FDM
FVM

#21

TEMPERATURE_UNITS

Temperature unit

Msg type = ENUM
Data type = Unsigned16 (2)
Store = Static
Access = R/W (OOS)
Available in Release 1.0

1000 = K
1001 = Deg C
1002 = Deg F
1003 = Deg R

700
800
CDM
FDM
FVM

#22

DENSITY

Density

Msg type = VAR
Data type = DS-65 (5)
Store = Dynamic/20
Access = Read
Available in Release 1.0

— 700
800
CDM
FDM
FVM
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Table A-4: Process variables for measurement transducer blocks (continued)

Index and name Description List of values HW

#23

DENSITY_UNITS

Density unit

Msg type = ENUM
Data type = Unsigned16 (2)
Store = Static
Access = R/W (OOS)
Available in Release 1.0

1097 = kg/m3
1100 = g/cm3
1103 = kg/L
1104 = g/ml
1105 = g/L
1106 = lb/in3
1107 = lb/ft3
1108 = lb/gal
1109 = STon/yd3
1113 = DegAPI [700, 800](1)

1114 = SGU [700, 800]
253 = Special [CDM, FDM, FVM]

700
800
CDM
FDM
FVM

#24

VOLUME_FLOW

Volume flow rate

Msg type = VAR
Data type = DS-65 (5)
Store = Dynamic/20
Access = Read
Available in Release 1.0

— 700
800
CDM (2.0 and
above)

#25

VOLUME_FLOW_UNITS

Standard or special volume flow
rate unit

Msg type = ENUM
Data type = Unsigned16 (2)
Store = Static
Access = RW (OOS)
Available in Release 1.0

1347 = m3/s
1348 = m 3/min
1349 = m3/h
1350 = m3/d
1351 = L/s
1352 = L/min
1353 = L/h
1355 = ML/d
1356 = CFS
1357 = CFM
1358 = CFH
1359 = ft3/d
1362 = gal/s
1363 = GPM
1364 = gal/h
1365 = gal/d
1366 = Mgal/d
1367 = ImpGal/s
1368 = ImpGal/m
1369 = ImpGal/h
1370 = Impgal/d
1371 = bbl/s
1372 = bbl/min
1373 = bbl/h
1374 = bbl/d
1631 = barrel (US Beer)/d
1632 = barrel (US Beer)/h
1633 = barrel (US Beer)/min
1634 = barrel (US Beer)/s
253 = Special [not applicable for
CDM]

700
800
CDM (2.0 and
above)
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Table A-4: Process variables for measurement transducer blocks (continued)

Index and name Description List of values HW

#26

VOL_SPECIAL_UNIT_BASE

Base volume unit

Msg type = ENUM
Data type = Unsigned16 (2)
Store = Static
Access = RW (OOS)
Available in Release 1.0

1048 = gallons
1038 = L
1049 = ImpGal
1043 = ft³
1034 = m³
1051 = bbl

700
800

#27

VOL_SPECIAL_UNIT_TIME

Base time unit for special volume
unit

Msg type = ENUM
Data type = Unsigned16 (2)
Store = Static
Access = RW (OOS)
Available in Release 1.0

1058 = min
1054 = s
1059 = h
1060 = d

700
800

#28

VOL_SPECIAL_UNIT_CONV

Special volume unit conversion
factor

Msg type = VAR
Data type = FLOAT (4)
Store = Static
Access = RW (OOS)
Available in Release 1.0

— 700
800

#29

VOL_SPECIAL_UNIT_STR

Special volume unit string

Msg type = STR
Data type = VISIBLE STRING (8)
Store = Static
Access = RW (OOS)
Available in Release 1.0

Any 8 characters 700
800

#30

MASS_TOT_INV_SPECIAL_
STR

Special mass total and inventory
unit string

Msg type = STR
Data type = VISIBLE STRING (8)
Store = Static
Access = RW (OOS)
Available in Release 1.0

Any 4 characters 700
800

#31

VOLUME_TOT_INV_
SPECIAL_ STR

Special volume total and inventory
unit string

Msg type = STR
Data type = VISIBLE STRING (8)
Store = Static
Access = RW (OOS)
Available in Release 1.0

Any 4 characters 700
800

#32

FLOW_DAMPING

Flow rate (mass and volume)
internal damping in seconds

Msg type = VAR
Data type = FLOAT (4)
Store = Static
Access = RW (OOS)
Available in Release 1.0

— 700
800
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Table A-4: Process variables for measurement transducer blocks (continued)

Index and name Description List of values HW

#33

TEMPERATURE_DAMPING

Temperature internal damping in
seconds

Msg type = VAR
Data type = FLOAT (4)
Store = Static
Access = RW (OOS)
Available in Release 1.0

— 700
800
CDM
FDM
FVM

#34

DENSITY_DAMPING

Density internal damping in
seconds

Msg type = VAR
Data type = FLOAT (4)
Store = Static
Access = RW (OOS)
Available in Release 1.0

— 700
800
CDM
FDM
FVM

#35

MFLOW_M_FACTOR

Mass rate factor

Msg type = VAR
Data type = FLOAT (4)
Store = Static
Access = RW (OOS)
Available in Release 1.0

— 700
800

#36

DENSITY_M_FACTOR

Density factor

Msg type = VAR
Data type = FLOAT (4)
Store = Static
Access = RW (OOS)
Available in Release 1.0

— 700
800

#37

VOL_M_FACTOR

Volume rate factor

Msg type = VAR
Data type = FLOAT (4)
Store = Static
Access = RW (OOS)
Available in Release 1.0

— 700
800

#38

MASS_LOW_CUT

Mass flow cutoff for internal
totalizers

Msg type = VAR
Data type = FLOAT (4)
Store = Static
Access = RW (OOS)
Available in Release 1.0

— 700
800

#39

VOLUME_FLOW_LOW_CUT
OFF

Volume flow cutoff for internal
totalizers

Msg type = VAR
Data type = FLOAT (4)
Store = Static
Access = RW (OOS)
Available in Release 1.0

— 700
800
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Table A-4: Process variables for measurement transducer blocks (continued)

Index and name Description List of values HW

#40

DENSITY_LOW_CUTOFF

Density cutoff for internal totalizers

Msg type = VAR
Data type = FLOAT (4)
Store = Static
Access = RW (OOS)
Available in Release 1.0

— 700
800
CDM
FDM
FVM

#41

FLOW_DIRECTION

Flow direction

Msg type = ENUM
Data type = Unsigned16 (2)
Store = Static
Access = RW in any mode
Available in Release 1.0

0 = Forward Only
1 = Reverse Only
2 = Bi-Directional
3 = Absolute Value
4 = Negate/Forward Only
5 = Negate/Bi-Dir

700
800
CDM

#42

HIGH_MASS_LIMIT

High mass flow limit of sensor

Msg type = VAR
Data type = FLOAT (4)
Store = Static
Access = Read only
Available in Release 1.0

— 700
800

#43

HIGH_TEMP_LIMIT

High temperature limit of sensor

Msg type = VAR
Data type = FLOAT (4)
Store = Static
Access = Read only
Available in Release 1.0

— 700
800
CDM
FDM
FVM

#44

HIGH_DENSITY_LIMIT

High density limit of sensor in g/cc

Msg type = VAR
Data type = FLOAT (4)
Store = Static
Access = Read only
Available in Release 1.0

— 700
800
CDM
FDM
FVM

#45

HIGH_VOLUME_LIMIT

High volume flow limit of sensor

Msg type = VAR
Data type = FLOAT (4)
Store = Static
Access = Read only
Available in Release 1.0

— 700
800

#46

LOW_MASS_LIMIT

Low mass flow limit of sensor

Msg type = VAR
Data type = FLOAT (4)
Store = Static
Access = Read only
Available in Release 1.0

— 700
800
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Table A-4: Process variables for measurement transducer blocks (continued)

Index and name Description List of values HW

#47

LOW_TEMP_LIMIT

Low temperature limit of sensor

Msg type = VAR
Data type = FLOAT (4)
Store = Static
Access = Read only
Available in Release 1.0

— 700
800
CDM
FDM
FVM

#48

LOW_DENSITY_LIMIT

Low density limit of sensor in g/cc

Msg type = VAR
Data type = FLOAT (4)
Store = Static
Access = Read only
Available in Release 1.0

— 700
800
CDM
FDM
FVM

#49

LOW_VOLUME_LIMIT

Low volume flow limit of sensor

Msg type = VAR
Data type = FLOAT (4)
Store = Static
Access = Read only
Available in Release 1.0

— 700
800

(1) The list within the square bracket contains cores that support this value.

A.2.4 Totalizers for measurement transducer blocks
Table A-5: Totalizers for measurement transducer blocks

Index and name Description List of values HW

#50

INTEGRATOR_
FB_CONFIG

Configuration of integrator
function block

Msg type = ENUM
Data type = Unsigned16 (2)
Store = Static
Access = R/W in any mode
Available in Release 1.0

0 = Standard
1 = Internal Mass Total
2 = Internal Vol Total
3 = Internal Mass Inv.
4 = Internal Vol Inv.
5 = Int Gas Vol Tot
6 = Int Gas Vol Inv
7 = Int API Vol Tot
8 = Int API Vol Inv
9 = Int ED Std Vol Tot
10= Int ED Std Vol Inv
11= Int ED Net Mass Tot
12= Int ED Net Mass Inv
13= Int ED Net Vol Tot
14= Int ED Net Vol Inv

700
800

#51

START_STOP_TOTALS

Starts and stops all totalizers

Msg type = VAR
Data type = DS-66 (2)
Store = —
Access = R/W in any mode
Available in Release 1.0

Value part of DS-66
0 = Stop Totals
1 = Start Totals

700
800
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Table A-5: Totalizers for measurement transducer blocks (continued)

Index and name Description List of values HW

#52

RESET_TOTALS

Reset all totals

Msg type = VAR
Data type = DS-66 (2)
Store = —
Access = R/W in any mode
Available in Release 1.0

Value part of DS-66
1 = Reset

700
800

#53

RESET_INVENTORIES

Reset all inventories

Msg type = METHOD
Data type = Unsigned16 (2)
Store = —
Access = R/W in any mode
Available in Release 1.0

Value part of DS-66
1 = Reset

700
800

#54

RESET_MASS_TOTAL

Reset mass total

Msg type = VAR
Data type = DS-66 (2)
Store = Dynamic/20
Access = Read only
Available in Release 1.0

Value part of DS-66
1 = Reset

700
800

#55

RESET_VOLUME_TOTAL

Reset volume total

Msg type = VAR
Data type = DS-66 (2)
Store = —
Access = Read only
Available in Release 1.0

Value part of DS-66
1 = Reset

700
800

#56

MASS_TOTAL

Mass total

Msg type = VAR
Data type = DS-65 (5)
Store = Dynamic/20
Access = Read only
Available in Release 1.0

— 700
800

#57

VOLUME_TOTAL

Volume total

Msg type = VAR
Data type = DS-65 (5)
Store = Dynamic/20
Access = Read only
Available in Release 1.0

— 700
800

#58

MASS_INVENTORY

Mass inventory

Msg type = VAR
Data type = DS-65 (5)
Store = Dynamic/20
Access = Read only
Available in Release 1.0

— 700
800
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Table A-5: Totalizers for measurement transducer blocks (continued)

Index and name Description List of values HW

#59

VOLUME_INVENTORY

Volume inventory

Msg type = VAR
Data type = DS-65 (5)
Store = Dynamic/20
Access = Read only
Available in Release 1.0

— 700
800

#60

MASS_TOT_INV_UNITS

Standard or special mass total and
mass inventory unit

Msg type = ENUM
Data type = Unsigned16 (2)
Store = Static
Access = Read only
Available in Release 1.0

1089 = g
1088 = kg
1092 = t
1094 = lb
1095 = STon
1096 = Lton
253 = Special units

700
800

#61

VOLUME_TOT_INV_
UNITS

Standard or special volume total or
mass inventory unit

Msg type = ENUM
Data type = Unsigned16 (2)
Store = Static
Access = Read only
Available in Release 1.0

1034 = m3
1036 = cm3
1038 = L
1043 = ft3
1048 = gallon
1049 = ImpGal
1051 = bbl
253 = Special units

700
800

A.2.5 Gas process variables for measurement tranducer blocks
Table A-6: Gas process variables for measurement transducer blocks

Index and name Description List of values HW

#62

GSV_Gas_Dens

Gas density used to calculate
reference volume gas flow and
totals

Msg type = VAR
Data type = FLOAT (4)
Store = Static
Access = R/W (OOS)
Available in Release 3.0

— 700
800

#63

GSV_Vol_Flow

Reference volume gas flow rate
(not valid when API or ED is
enabled)

Msg type = VAR
Data type = DS-65 (5)
Store = Dynamic/20
Access = Read only
Available in Release 3.0

— 700
800
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Table A-6: Gas process variables for measurement transducer blocks (continued)

Index and name Description List of values HW

#64

GSV_Vol_Tot

Reference volume gas total (not
valid when petroleum
measurement or concentration
measurement is enabled)

Msg type = VAR
Data type = DS-65 (5)
Store = Dynamic/20
Access = Read only
Available in Release 3.0

— 700
800

#65

GSV_Vol_Inv

Reference volume gas inventory
(not valid when petroleum
measurement or concentration
measurement is enabled)

Msg type = VAR
Data type = DS-65 (5)
Store = Dynamic/20
Access = Read only
Available in Release 3.0

— 700
800

#66

SNS_EnableGSV

Enable/Disable gas standard
volume flow and totals

Msg type = ENUM
Data type = Unsigned16 (2)
Store = Static
Access = R/W (OOS)
Available in Release 4.0

0 = disabled (liquid)
1 = enabled (gas)

800

#67

SNS_GSV_FlowUnits

Gas standard volume flow
engineering units

Msg type = ENUM
Data type = Unsigned16 (2)
Store = Static
Access = R/W (OOS)
Available in Release 4.0

1723 = SCFS
1722 = SCFD
1360 = SCFM
1361 = SCFH
1522 = Nm3/s
1523 = Nm3/min
1524 = Nm3/h
1525 = Nm3/d
1527 = Sm3/s
1528 = Sm3/min
1529 = Sm3/h
1530 = Sm3/d
1532 = NL/s
1533 = NL/min
1534 = NL/h
1535 = NL/d
1537 = SL/s
1538 = SL/min
1539 = SL/h
1540 = SL/d
253 = Special

800
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Table A-6: Gas process variables for measurement transducer blocks (continued)

Index and name Description List of values HW

#68

SNS_GSV_TotalUnits

Gas standard volume total and
inventory engineering units

Msg type = ENUM
Data type = Unsigned16 (2)
Store = Static
Access = Read only
Available in Release 4.0

1053 = SCF
1521 = Nm3
1526 = Sm3
1531 = NL
1536 = SL
253 = Special units

800

#69

SNS_GSVflowBaseUnit

Base gas standard volume unit

Msg type = ENUM
Data type = Unsigned16 (2)
Store = Static
Access = R/W OOS
Available in Release 4.0

1521 = Nm3
1531 = NL
1053 = SCF
1536 = SL
1526 = Sm3

800

#70

SNS_GSVflowBaseTime

Base time unit for special gas
standard volume unit

Msg type = ENUM
Data type = Unsigned16 (2)
Store = Static
Access = R/W OOS
Available in Release 4.0

1058 = min
1054 = s
1059 = h
1060 = d

800

#71

SNS_GSVflowFactor

Special gas standard volume unit
conversion factor

Msg type = VAR
Data type = FLOAT (4)
Store = Static
Access = R/W OOS
Available in Release 4.0

— 800

#72

SNS_GSVflowText

Special gas standard volume unit
string

Msg type = STR
Data type = VISIBLE STRING (8)
Store = Static
Access = R/W OOS
Available in Release 4.0

Any 8 characters 800

#73

SNS_GSVtotText

Special gas standard volume total
and inventory unit string

Msg type = STR
Data type = VISIBLE STRING (8)
Store = Static
Access = R/W OOS
Available in Release 4.0

Any 8 characters 800

#74

SNS_GSV_FlowCutoff

Gas standard volume low flow
cutoff

Msg type = VAR
Data type = FLOAT (4)
Store = Static
Access = R/W OOS
Available in Release 4.0

Must be >= 0.0 700
800
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Table A-6: Gas process variables for measurement transducer blocks (continued)

Index and name Description List of values HW

#75

SNS_ResetGSVolTotal

Reset gas standard volume total

Msg type = VAR
Data type = DS-66 (2)
Store = Static
Access = R/W in any mode
Available in Release 4.0

Value part of DS-66
1 = Reset

800

#76

SNS_ResetAPIGSVInv

Reset gas standard volume
inventory

Msg type = METHOD
Data type = Unsigned16 (2)
Store = Static
Access = R/W in any mode
Available in Release 4.0

1 = Reset 700
800

A.2.6 Other additions for measurement transducer blocks
Table A-7: Other additions for measurement transducer blocks

Index and name Description List of values HW

#77

SNS_ResetMass
Inventory

Reset mass inventory

Msg type = METHOD
Data type = Unsigned16 (2)
Store = Static
Access = R/W in any mode
Available in Release 4.0

1 = Reset 700
800

#78

SNS_ResetVolume
Inventory

Reset volume inventory

Msg type = METHOD
Data type = Unsigned16 (2)
Store = Static
Access = R/W in any mode
Available in Release 4.0

1 = Reset 700
800

#79

SNS_ActualFlowDirection

Indicates whether flow is moving in
the forward or reverse direction

Msg type = VAR
Data type = DS-66 (2)
Store = —
Access = Read only
Available in Release 7.0

Value part of DS-66
0 = Forward or Zero Flow
1 = Reverse Flow

700
800
CDM

#80

MEAS_SYS_AttachedCoreTy
pe

Indicates the attached core type

Msg type = ENUM
Data type = Unsigned16 (2)
Store = Static
Access = Read only
Available in Release 8.0

0 = CORE_UNKNOWN
1 = CORE_700
2 = CORE_ECP
3 = CORE_S
4 = CORE_DENSITY
5 = CORE_DEN_CDM
6 = CORE_DEN_FDM
7 = CORE_DEN_FVM

700
800
CDM
FDM
FVM
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Table A-7: Other additions for measurement transducer blocks (continued)

Index and name Description List of values HW

#81

CORE_SW_REV_MSTB

Model 700 transmitter software
revision

Msg type = VAR
Data type = Unsigned16 (2)
Store = Static
Access = Read only
Available in Release 9.0

— 700
800
CDM
FDM
FVM

A.3 Calibration transducer blocks

A.3.1 View list for calibration transducer block
The following table lists the parameters contained in the transducer block for calibration parameters.

Four views are defined for the calibration transducer block. The table also shows the applicable views for each
parameter, and the size of the parameter in that view, in bytes.

Index Name View

1 2 3 4

0 BLOCK_STRUCTURE — — — —

1 ST_REV 2 2 2 2

2 TAG_DESC — — — —

3 STRATEGY — — — 2

4 ALERT_KEY — — — 1

5 MODE_BLK 4 — 4 —

6 BLOCK_ERR 2 — 2 —

7 UPDATE_EVT — — — —

8 BLOCK_ALM — — — —

9 TRANSDUCER_DIRECTORY — — — —

10 TRANSDUCER_TYPE 2 2 2 2

11 TRANSDUCER_TYPE_VER 2 2 2 2

12 XD_ERROR 1 — 1 —

13 COLLECTION_DIRECTORY — — — —

14 MASS_FLOW_GAIN — 4 — —

15 MASS_FLOW_T_COMP — 4 — —

16 ZERO_CAL — 2 — —

17 ZERO_TIME — 2 — —

18 ZERO_STD_DEV — — 4 —
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Index Name View

1 2 3 4

19 ZERO_OFFSET — — 4 —

20 ZERO_FAILED_VALUE — — 4 —

21 LOW_DENSITY_CAL — 2 — —

22 HIGH_DENSITY_CAL — 2 — —

23 FLOWING_DENSITY_CAL — 2 — —

24 D3_DENSITY_CAL — 2 — —

25 D4_DENSITY_CAL — 2 — —

26 K1 — 4 — —

27 K2 — 4 — —

28 FD — 4 — —

29 K3 — 4 — —

30 K4 — 4 — —

31 D1 — 4 — —

32 D2 — 4 — —

33 FD_VALUE — 4 — —

34 D3 — 4 — —

35 D4 — 4 — —

36 DENS_T_COEFF — 4 — —

37 T_FLOW_TG_COEFF — 4 — —

38 T_FLOW_FQ_COEFF — 4 — —

39 T_DENSITY_TG_COEFF — 4 — —

40 T_DENSITY_FQ_COEFF1 — 4 — —

41 T_DENSITY_FQ_COEFF2 — 4 — —

42 TEMP_LOW_CAL — 2 — —

43 TEMP_HIGH_CAL — 2 — —

44 TEMP_VALUE — 4 — —

45 TEMP_OFFSET — — 4 —

46 TEMP_SLOPE — — 4 —

47 PRESSURE_COMP 5 — 5 —

48 PRESSURE_UNITS — 2 — —

49 ENABLE_PRESSURE_COMP — — — 2

50 PRESSURE_FACTOR_FLOW — — — 4

51 PRESSURE_FACTOR_DENS — — — 4
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Index Name View

1 2 3 4

52 PRESSURE_FLOW_CAL — — — 4

53 SNS_PuckEnableExtTemp — 2 — —

54 SNS_ExternalTempInput 5 — — —

55 SNS_ZeroInProgress — — — 2

56 CAL_TEMPERATURE_UNITS 2 — — —

57 PRESSURE_TYPE — — — 2

58 PRESSURE_INPUT_TYPE — — — 2

A.3.2 Standard fieldbus parameters for calibration transducer
blocks
Index and name Description List of values

#0

BLOCK_STRUCTURE

The beginning of the transducer block.

Msg type = VAR
Data type = DS_64 (5)
Store = Static
Access = RW (OOS) or RW (Auto)
Available in Release 1.0

—

#1

ST_REV

The revision level of the static data
associated with the function block.
Incremented with each write of static store.

Msg type = VAR
Data type = Unsigned16 (2)
Store = Static
Access = Read only
Available in Release 1.0

—

#2

TAG_DESC

The user description of the intended block
application.

Msg type = STR
Data type = OCTET STRING (32)
Store = Static
Access = RW (OOS) or RW (Auto)
Available in Release 1.0

Any 32 characters

#3

STRATEGY

Used to identify grouping of blocks. This
data is not checked or processed by the
block.

Msg type = VAR
Data type = Unsigned16 (2)
Store = Static
Access = RW (OOS) or RW (Auto)
Available in Release 1.0

—
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Index and name Description List of values

#4

ALERT_KEY

The identification number of the plant unit.
This information may be used in the host
for sorting alarms, etc.

Msg type = VAR
Data type = Unsigned8 (1)
Store = Static
Access = RW (OOS) or RW (Auto)
Available in Release 1.0

1 to 255

#5

MODE_BLK

The actual, target, permitted, and normal
modes of the block.

Msg type = REC
Data type = DS-69 (4)
Store = Mixed
Access = RW (OOS) or RW (Auto)
Available in Release 1.0

See section 2.6 of FF-891

#6

BLOCK_ERR

The error status associated with the
hardware or software components
associated with a block.

Msg type = STR
Data type = BIT STRING (2)
Store = Dynamic/20
Access = Read only
Available in Release 1.0

See section 4.8 of FF-903

#7

UPDATE_EVT

Occurs when a static parameter is changed
while a block mode is not in out of service
(OOS) mode, or when the mode changes
from OOS mode and one or more static
parameters changed while the block was
OOS.

Msg type = REC
Data type = DS-73
Store = Dynamic
Access = RW in any mode
Available in Release 1.0

—

#8

BLOCK_ALM

A predefined set of 16 conditions that may
occur within a block.

Msg type = REC
Data type = DS-72
Store = Dynamic
Access = RW in any mode
Available in Release 9.0

—

#9

TRANSDUCER_
DIRECTORY

A directory that specifies the number and
starting indices of the data collections in
the transducer block.

Msg type = VAR
Data type = Unsigned16 (2)
Store = Static
Access = RW (OOS)
Available in Release 9.0

—
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Index and name Description List of values

#10

TRANSDUCER_
TYPE

Identifies the transducer that follows.

Msg type = VAR
Data type = Unsigned16 (2)
Store = Static
Access = RW (OOS)
Available in Release 9.0

—

#11

TRANSDUCER_
TYPE_VER

Identifies the version of the transducer
block. Format is XXYY where XX is the major
spec revision and YY is the manufacturer
revision.

Msg type = VAR
Data type = Unsigned16 (2)
Store = Static
Access = RW (OOS)
Available in Release 9.0

—

#12

XD_ERROR

Used for all config, H/W, connection failure
of system problems in the block.

Msg type = VAR
Data type = Unsigned8 (1)
Store = Dynamic
Access = RW (OOS)
Available in Release 1.0

0 = No Error
18 = Calibration Error
19 = Configuration Error
20 = Electronics Failure
21 = Sensor Failure
26 = Process Error
27 = Calibration in Progress

#13

COLLECTION_
DIRECTORY

Used for all config, H/W, and connection
failures of system problems in the block.

Msg type = VAR
Data type = Unsigned32 (4)
Store = Static
Access = RW (OOS)
Available in Release 9.0

—

A.3.3 Calibration transducer blocks
Table A-8: Calibration transducer blocks

Index and name Description List of values HW

#14

MASS_FLOW_GAIN

Flow calibration factor

Msg type = VAR
Data type = FLOAT (4)
Store = Static
Access = R/W (OOS)
Available in Release 1.0

— 700
800
CDM
FDM
FVM

#15

MASS_FLOW_T_COMP

Temperature coefficient for flow

Msg type = VAR
Data type = FLOAT (4)
Store = Static
Access = R/W (OOS)
Available in Release 1.0

— 700
800
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Table A-8: Calibration transducer blocks (continued)

Index and name Description List of values HW

#16

ZERO_CAL

Perform auto zero

Msg type = VAR
Data type = DS-66 (2)
Store = —
Access = R/W (OOS)
Available in Release 1.0

Value part of DS-66
0 = Abort Zero Cal
1 = Start Zero Cal

700
800
CDM

#17

ZERO_TIME

Maximum zeroing time

Msg type = VAR
Data type = Unsigned16 (2)
Store = Static
Access = R/W (OOS)
Available in Release 1.0

— 700
800
CDM

#18

ZERO_STD_DEV

Standard deviation of auto zero

Msg type = VAR
Data type = FLOAT (4)
Store = Static
Access = Read only
Available in Release 1.0

— 700
800
CDM

#19

ZERO_OFFSET

Present flow signal offset at zero
flow in µsec

Msg type = VAR
Data type = FLOAT (4)
Store = Static
Access = R/W (OOS)
Available in Release 1.0

— 700
800
CDM

#20

ZERO_FAILED_VALUE

Value of the zero if the zero
calibration failed

Msg type = VAR
Data type = FLOAT (4)
Store = Static
Access = Read only
Available in Release 1.0

— 700
800
CDM

#21

LOW_DENSITY_CAL

Perform low-density calibration

Msg type = METHOD
Data type = Unsigned16 (2)
Store = —
Access = R/W (OOS)
Available in Release 1.0

0 = None
1 = Start Cal

700
800

#22

HIGH_DENSITY_CAL

Perform high-density calibration

Msg type = METHOD
Data type = Unsigned16 (2)
Store = —
Access = R/W (OOS)
Available in Release 1.0

0 = None
1 = Start Cal

700
800
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Table A-8: Calibration transducer blocks (continued)

Index and name Description List of values HW

#23

FLOWING_DENSITY_CAL

Perform flowing-density
calibration

Msg type = METHOD
Data type = Unsigned16 (2)
Store = —
Access = R/W in any mode
Available in Release 1.0

0 = None
1 = Start Cal

700
800

#24

D3_DENSITY_CAL

Perform third point calibration

Msg type = METHOD
Data type = Unsigned16 (2)
Store = —
Access = R/W (OOS)
Available in Release 1.0

0 = None
1 = Start Cal

700
800

#25

D4_DENSITY_CAL

Perform fourth point calibration

Msg type = METHOD
Data type = Unsigned16 (2)
Store = —
Access = R/W (OOS)
Available in Release 1.0

0 = None
1 = Start Cal

700
800

#26

K1

Density calibration constant 1
(msec)

Msg type = VAR
Data type = FLOAT (4)
Store = Static
Access = R/W (OOS)
Available in Release 1.0

— 700
800

#27

K2

Density calibration constant 2
(msec)

Msg type = VAR
Data type = FLOAT (4)
Store = Static
Access = R/W (OOS)
Available in Release 1.0

— 700
800

#28

FD

Flowing density calibration
constant

Msg type = VAR
Data type = FLOAT (4)
Store = Static
Access = R/W (OOS)
Available in Release 1.0

— 700
800

#29

K3

Density calibration constant 3
(msec)

Msg type = VAR
Data type = FLOAT (4)
Store = Static
Access = R/W (OOS)
Available in Release 1.0

— 700
800
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Table A-8: Calibration transducer blocks (continued)

Index and name Description List of values HW

#30

K4

Density calibration constant 4
(msec)

Msg type = VAR
Data type = FLOAT (4)
Store = Static
Access = R/W (OOS)
Available in Release 1.0

— 700
800

#31

D1

Density 1 (g/cc)

Msg type = VAR
Data type = FLOAT (4)
Store = Static
Access = R/W (OOS)
Available in Release 1.0

— 700
800

#32

D2

Density 2 (g/cc)

Msg type = VAR
Data type = FLOAT (4)
Store = Static
Access = R/W (OOS)
Available in Release 1.0

— 700
800

#33

FD_VALUE

Flowing density (g/cc)

Msg type = VAR
Data type = FLOAT (4)
Store = Static
Access = R/W in any mode
Available in Release 1.0

— 700
800

#34

D3

Density 3 (g/cc)

Msg type = VAR
Data type = FLOAT (4)
Store = Static
Access = R/W (OOS)
Available in Release 1.0

— 700
800

#35

D4

Density 4 (g/cc)

Msg type = VAR
Data type = FLOAT (4)
Store = Static
Access = R/W (OOS)
Available in Release 1.0

— 700
800

#36

DENS_T_COEFF

Density temperature coefficient

Msg type = VAR
Data type = FLOAT (4)
Store = Static
Access = R/W (OOS)
Available in Release 1.0

— 700
800
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Table A-8: Calibration transducer blocks (continued)

Index and name Description List of values HW

#37

T_FLOW_TG_COEFF

T-Series: Flow TG Coefficient (FTG)

Msg type = VAR
Data type = FLOAT (4)
Store = Static
Access = R/W (OOS)
Available in Release 1.0

— 700
800

#38

T_FLOW_FQ_COEFF

T-Series: Flow FQ Coefficient (FFQ)

Msg type = VAR
Data type = FLOAT (4)
Store = Static
Access = R/W (OOS)
Available in Release 1.0

— 700
800

#39

T_DENSITY_TG_COEFF

T-Series: Density TG Coefficient
(DTG)

Msg type = VAR
Data type = FLOAT (4)
Store = Static
Access = R/W (OOS)
Available in Release 1.0

— 700
800

#40

T_DENSITY_FQ_COEFF1

T-Series: Density FQ Coefficient #1
(DFQ1)

Msg type = VAR
Data type = FLOAT (4)
Store = Static
Access = R/W (OOS)
Available in Release 1.0

— 700
800

#41

T_DENSITY_FQ_COEFF2

T-Series: Density FQ Coefficient #2
(DFQ2)

Msg type = VAR
Data type = FLOAT (4)
Store = Static
Access = R/W (OOS)
Available in Release 1.0

— 700
800

#42

TEMP_LOW_CAL

Perform temperature calibration
at the low point (point 1)

Msg type = METHOD
Data type = Unsigned16 (2)
Store = —
Access = R/W (OOS)
Available in Release 1.0

0 = None
1 = Start Cal

700
800
CDM
FDM
FVM

#43

TEMP_HIGH_CAL

Perform temperature calibration
at the high point (point 2)

Msg type = METHOD
Data type = Unsigned16 (2)
Store = —
Access = R/W (OOS)
Available in Release 1.0

0 = None
1 = Start Cal

700
800
CDM
FDM
FVM
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Table A-8: Calibration transducer blocks (continued)

Index and name Description List of values HW

#44

TEMP_VALUE

Temperature value for
temperature calibrations (in degC)

Msg type = VAR
Data type = FLOAT (4)
Store = Static
Access = R/W (OOS)
Available in Release 1.0

— 700
800
CDM
FDM
FVM

#45

TEMP_OFFSET

Temperature calibration offset

Msg type = VAR
Data type = FLOAT (4)
Store = Static
Access = R/W (OOS)
Available in Release 1.0

— 700
800
FDM
FVM

#46

TEMP_SLOPE

Temperature calibration slope

Msg type = VAR
Data type = FLOAT (4)
Store = Static
Access = R/W (OOS)
Available in Release 1.0

— 700
800
FDM
FVM

A.3.4 Pressure compensation for calibration transducer blocks
Table A-9: Pressure compensation for calibration transducer blocks

Index and name Description List of values HW

#47

PRESSURE_COMP

Pressure

Msg type = VAR
Data type = DS-65 (5)
Store = Dynamic/20
Access = R/W in any mode
Available in Release 2.0

— 700
800
CDM
FDM
FVM

#48

PRESSURE_UNITS

Pressure unit

Msg type = ENUM
Data type = Unsigned16 (2)
Store = Static
Access = R/W (OOS)
Available in Release 2.0

1148 = inH2O (68°F)
1724 = InH2O@60°F
1156 = inHg (0°C)
1154 = ftH2O (68°F)
1151 = mmH2O (68°F)
1158 = mmHg (0°C)
1141 = psi
1137 = bar
1138 = mbar
1144 = g/cm2
1145 = kg/cm2
1130 = Pa
1132 = MPa
1133 = kPa
1139 = torr
1140 = atm
1147 = inH2O (4°C)
1150 = mmH2O (4°C)

700
800
CDM
FDM
FVM
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Table A-9: Pressure compensation for calibration transducer blocks (continued)

Index and name Description List of values HW

#49

ENABLE_PRESSURE_COMP

Enable/Disable pressure
compensation

Msg type = ENUM
Data type = Unsigned16 (2)
Store = Static
Access = R/W (OOS)
Available in Release 2.0

0= disabled
1 = enabled

700
800

#50

PRESSURE_FACTOR_FLOW

Pressure correction factor for flow

Msg type = VAR
Data type = FLOAT (4)
Store = Static
Access = R/W (OOS)
Available in Release 2.0

— 700
800

#51

PRESSURE_FACTOR_DENS

Pressure correction factor for
density

Msg type = VAR
Data type = FLOAT (4)
Store = Static
Access = R/W (OOS)
Available in Release 2.0

— 700
800

#52

PRESSURE_FLOW_CAL

Flow calibration pressure

Msg type = VAR
Data type = FLOAT (4)
Store = Static
Access = R/W (OOS)
Available in Release 2.0

— 700
800

A.3.5 Temperature compensation for calibration transducer blocks
Table A-10: Temperature compensation for calibration transducer blocks

Index and name Description List of values HW

#53

SNS_
PuckEnableExtTemp

Enable/Disable temperature
compensation

Msg type = METHOD
Data type = Unsigned16 (2)
Store = Static
Access = R/W (OOS)
Available in Release 4.0

0 = disabled
1 = enabled

700
800
CDM
FDM
FVM

#54

SNS_
ExternalTempInput

External temperature

Msg type = VAR
Data type = DS-65 (5)
Store = Static
Access = R/W in any mode
Available in Release 4.0

— 700
800
CDM
FDM
FVM
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A.3.6 Other additions for calibration transducer blocks
Table A-11: Other additions for calibration transducer blocks

Index and name Description List of values HW

#55

SNS_
ZeroInProgress

Indicates whether a zero
calibration, density calibration, or
temperature calibration is running.

Msg type = VAR
Data type = DS-66 (2)
Store = —
Access = Read only
Available in Release 7.0

Value part of DS-66
0 = Not Running
1 = Calibration Running

700
800
CDM
FDM
FVM

#56

CAL_TEMPERATURE_
UNITS

Temperature unit

Msg type = ENUM
Data type = Unsigned16 (2)
Store = Static
Access = R/W (OOS)
Available in Release 8.0

1000 = K
1001 = Deg C
1002 = Deg F
1003 = Deg R

700
800
CDM
FDM
FVM

#57

PRESSURE_TYPE

Pressure yype

Msg type = VAR
Data type = Unsigned16 (2)
Store = Static
Access = R/W (OOS)
Available in Release 9.0

0 = Gauge
1 = Absolute

CDM
FDM
FVM

#58

PRESSURE_INPUT_TYPE

Pressure input type

Msg type = VAR
Data type = Unsigned16 (2)
Store = Static
Access = R/W (OOS)
Available in Release 9.0

1 = Digital Comm
2 = Fixed

CDM
FDM
FVM

A.4 Diagnostics transducer blocks

A.4.1 View list for diagnostic transducer block
The following table lists the parameters contained in the transducer block for diagnostic parameters.

Six views are defined for the diagnostics transducer block. The table also shows the applicable views for each
parameter, and the size of the parameter in that view, in bytes.

Index Name View

1 2 3 4 4_1 4_2

0 BLOCK_STRUCTURE — — — — — —

1 ST_REV 2 2 2 2 2 2

2 TAG_DESC — — — — — —

3 STRATEGY — — — 2 — —

4 ALERT_KEY — — — 1 — —
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Index Name View

1 2 3 4 4_1 4_2

5 MODE_BLK 4 — 4 — — —

6 BLOCK_ERR 2 — 2 — — —

7 UPDATE_EVT — — — — — —

8 BLOCK_ALM — — — — — —

9 TRANSDUCER_DIRECTORY — — — — — —

10 TRANSDUCER_TYPE 2 2 2 2 — —

11 TRANSDUCER_TYPE_VER 2 2 2 2 — —

12 XD_ERROR 1 — 1 — — —

13 COLLECTION_DIRECTORY — — — — — —

14 SLUG_TIME — — — 4 — —

15 SLUG_LOW_LIMIT — — — 4 — —

16 SLUG_HIGH_LIMIT — — — 4 — —

17 ALARM1_STATUS 2 — 2 — — —

18 ALARM2_STATUS 2 — 2 — — —

19 ALARM3_STATUS 2 — 2 — — —

20 ALARM4_STATUS 2 — 2 — — —

21 FAULT_LIMIT — 2 — — — —

22 LAST_MEASURED_VALUE_
FAULT_TIMEOUT

— 2 — — — —

23 ALARM_INDEX — — — 2 — —

24 ALARM_SEVERITY — — — 2 — —

25 DRIVE_GAIN 5 — 5 — — —

26 TUBE_FREQUENCY — — 4 — — —

27 LIVE_ZERO — — 4 — — —

28 LEFT_PICKUP_VOLTAGE — — 4 — — —

29 RIGHT_PICKUP_VOLTAGE — — 4 — — —

30 BOARD_TEMPERATURE — — 4 — — —

31 ELECT_TEMP_MAX — — 4 — — —

32 ELECT_TEMP_MIN — — 4 — — —

33 ELECT_TEMP_AVG — — 4 — — —

34 SENSOR_TEMP_MAX — — 4 — — —

35 SENSOR_TEMP_MIN — — 4 — — —

36 SENSOR_TEMP_AVG — — 4 — — —

37 RTD_RESISTANCE_CABLE — — 4 — — —
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Index Name View

1 2 3 4 4_1 4_2

38 RTD_RESISTANCE_METER — — 4 — — —

39 CP_POWER_CYCLE — — 2 — — —

40 MFP_SAVE_FACTORY — — — 2 — —

41 MFP_RESET_STATS — — — 2 — —

42 EN_MFP — — — 2 — —

43 MFP_UNITS — — — 2 — —

44 MFP_TV_INDEX — — — 2 — —

45 MFP_TYPE — — — 2 — —

46 MFP_TV_INST — — 4 — — —

47 MFP_TV_INST — — 4 — — —

48 MFP_TV_STD_DEV — — 4 — — —

49 MFP_TV_MAX — — 4 — — —

50 MFP_TV_MIN — — 4 — — —

51 DIAG_FEATURE_KEY — — — 2 — —

52 SYS_PowerOnTimeSec — — 4 — — —

53 SNS_InputVoltage — — 4 — — —

54 SNS_TargetAmplitude — — 4 — — —

55 SNS_CaseRTDRes — — 4 — — —

56 SYS_RestoreFactoryConfig — 2 — — — —

57 SNS_FlowZeroRestore — 2 — — — —

58 SNS_AutoZeroFactory — 2 — — — —

59 SYS_ResetPowerOnTime — 2 — — — —

60 FRF_EnableFCFValidation — 2 — — — —

61 FRF_FaultAlarm — 2 — — — —

62 FRF_StiffnessLimit — 4 — — — —

63 FRF_AlgoState — — — — 2 —

64 FRF_AbortCode — — — — 2 —

65 FRF_StateAtAbort — — — — 2 —

66 FRF_Progress — — — — 2 —

67 FRF_StiffOutLimLpo — — — — 2 —

68 FRF_StiffOutLimRpo — — — — 2 —

69 FRF_StiffnessLpo_mean — — — — 4 —

70 FRF_StiffnessRpo_mean — — — — 4 —

Configuration and Use Manual Transducer blocks and views
20000326 August 2022

Configuration and Use Manual 153



Index Name View

1 2 3 4 4_1 4_2

71 FRF_Damping_mean — — — — 4 —

72 FRF_MassLpo_mean — — — — 4 —

73 FRF_MassRpo_mean — — — — 4 —

74 FRF_StiffnessLpo_stddev — — — — 4 —

75 FRF_StiffnessRpo_stddev — — — — 4 —

76 FRF_Damping_stddev — — — — 4 —

77 FRF_MassLpo_stddev — — — — 4 —

78 FRF_MassRpo_stddev — — — — 4 —

79 FRF_StiffnessLpo_air — — — — 4 —

80 FRF_StiffnessRpo_air — — — — 4 —

81 FRF_Damping_air — — — — 4 —

82 FRF_MassLpo_air — — — — 4 —

83 FRF_MassRpo_air — — — — 4 —

84 FRF_StiffnessLpo_
water

— — — — 4 —

85 FRF_StiffnessRpo_
water

— — — — 4 —

86 FRF_Damping_water — — — — 4 —

87 FRF_MassLpo_water — — — — 4 —

88 FRF_MassRpo_water — — — — 4 —

89 ALERT_TIMEOUT — 2 — — — —

90 FRF_FCFValidCounter — — — — 2 —

91 FRF_StartMeterVer — — — — — 2

92 FRF_MV_Index — — — — — 2

93 FRF_MV_Counter — — — — — 2

94 FRF_MV_Status — — — — — 2

95 FRF_MV_Time — — — — — 4

96 FRF_MV_LPO_Norm — — — — — 4

97 FRF_MV_RPO_Norm — — — — — 4

98 FRF_DriveCurr — — — — — 4

99 FRF_DL_T — — — — — 4

100 FRF_Temp — — — — — 4

101 FRF_Density — — — — — 4

102 FRF_DriveFreq — — — — — 4
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Index Name View

1 2 3 4 4_1 4_2

103 FRF_LpoFilt — — — — — 4

104 FRF_RpoFilt — — — — — 4

105 FRF_DataSetSelIndex — — — — — 4

106 FRF_MV_FirstRun_Time — — — — — 4

107 FRF_MV_Elapse_Time — — — — — 4

108 FRF_MV_Time_Left — — — — — 4

109 FRF_ToneLevel — — — — — 4

110 FRF_ToneRampTime — — — — — 4

111 FRF_BlCoeff — — — — — 4

112 FRF_DriveTarget — — — — — 4

113 FRF_DrivePCoeff — — — — — 4

114 FRF_ToneSpacingMult — — — — — 4

115 FRF_Freq_DriftLimit — — — — — 4

116 FRF_Max_Current_mA — — — — — 4

117 FRF_KFQ2 — — — — — 4

118 SYS_AnalogOutput_Fault 2 — — — — —

119 SNS_MV_Failed 2 — — — — —

120 ALARM5_STATUS 2 — — — — —

121 DIAG_TEMPERATURE_UNIT
S

2 — — — — —

122 DIAG_MASSFLOW_UNITS 2 — — — — —

123 DIAG_SYS_AttachedCoreTy
pe

— 2 — — — —

124 DIAG_FRF_OUTPUT_STATES — — — 2 — —

125 DIAG_FRF_LPO_METER_FAC
TOR

— — — 4 — —

126 DIAG_FRF_RPO_METER_FA
CTOR

— — — 4 — —

127 DIAG_FRF_LPO_CI_SPREAD — — — 4 — —

128 DIAG_FRF_RPO_CI_SPREAD — — — 4 — —

129 DIAG_FRF_SYMMETRY_CI_S
PREAD

— — — 4 — —
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A.4.2 Standard fieldbus parameters for diagnostic transducer
blocks
Index and name Description List of values

#0

BLOCK_STRUCTURE

The beginning of the transducer block.

Msg type = VAR
Data type = DS_64 (5)
Store = Static
Access = RW (OOS) or RW (Auto)
Available in Release 1.0

—

#1

ST_REV

The revision level of the static data
associated with the function block.
Incremented with each write of static store.

Msg type = VAR
Data type = Unsigned16 (2)
Store = Static
Access = Read only
Available in Release 1.0

—

#2

TAG_DESC

The user description of the intended block
application.

Msg type = STR
Data type = OCTET STRING (32)
Store = Static
Access = RW (OOS) or RW (Auto)
Available in Release 1.0

Any 32 characters

#3

STRATEGY

Used to identify grouping of blocks. This
data is not checked or processed by the
block.

Msg type = VAR
Data type = Unsigned16 (2)
Store = Static
Access = RW (OOS) or RW (Auto)
Available in Release 1.0

—

#4

ALERT_KEY

The identification number of the plant unit.
This information may be used in the host
for sorting alarms, etc.

Msg type = VAR
Data type = Unsigned8 (1)
Store = Static
Access = RW (OOS) or RW (Auto)
Available in Release 1.0

1 to 255

#5

MODE_BLK

The actual, target, permitted, and normal
modes of the block.

Msg type = REC
Data type = DS-69 (4)
Store = Mixed
Access = RW (OOS) or RW (Auto)
Available in Release 1.0

See section 2.6 of FF-891
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Index and name Description List of values

#6

BLOCK_ERR

The error status associated with the
hardware or software components
associated with a block.

Msg type = STR
Data type = BIT STRING (2)
Store = Dynamic/20
Access = Read only
Available in Release 1.0

See section 4.8 of FF-903

#7

UPDATE_EVT

Occurs when a static parameter is changed
while a block mode is not in out of service
(OOS) mode, or when the mode changes
from OOS mode and one or more static
parameters changed while the block was
OOS.

Msg type = REC
Data type = DS-73
Store = Dynamic
Access = RW in any mode
Available in Release 1.0

—

#8

BLOCK_ALM

A predefined set of 16 conditions that may
occur within a block.

Msg type = REC
Data type = DS-72
Store = Dynamic
Access = RW in any mode
Available in Release 9.0

—

#9

TRANSDUCER_
DIRECTORY

A directory that specifies the number and
starting indices of the data collections in
the transducer block.

Msg type = VAR
Data type = Unsigned16 (2)
Store = Static
Access = RW (OOS)
Available in Release 9.0

—

#10

TRANSDUCER_
TYPE

Identifies the transducer that follows.

Msg type = VAR
Data type = Unsigned16 (2)
Store = Static
Access = RW (OOS)
Available in Release 9.0

—

#11

TRANSDUCER_
TYPE_VER

Identifies the version of the transducer
block. Format is XXYY where XX is the major
spec revision and YY is the manufacturer
revision.

Msg type = VAR
Data type = Unsigned16 (2)
Store = Static
Access = RW (OOS)
Available in Release 9.0

—
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Index and name Description List of values

#12

XD_ERROR

Used for all config, H/W, connection failure
of system problems in the block.

Msg type = VAR
Data type = Unsigned8 (1)
Store = Dynamic
Access = RW (OOS)
Available in Release 1.0

0 = No Error
18 = Calibration Error
19 = Configuration Error
20 = Electronics Failure
21 = Sensor Failure
26 = Process Error
27 = Calibration in Progress

#13

COLLECTION_
DIRECTORY

Used for all config, H/W, and connection
failures of system problems in the block.

Msg type = VAR
Data type = Unsigned32 (4)
Store = Static
Access = RW (OOS)
Available in Release 9.0

—

A.4.3 Slug flow setup for diagnostic transducer blocks
Table A-12: Slug flow setup for diagnostic transducer blocks

Index and name Description List of values HW

#14

SLUG_TIME

Slug duration in seconds

Msg type = VAR
Data type = FLOAT (4)
Store = Static
Access = R/W in any mode
Available in Release 1.0

— 700
800
CDM
FDM
FVM

#15

SLUG_LOW_LIMIT

Low density limit in g/cc

Msg type = VAR
Data type = FLOAT (4)
Store = Static
Access = R/W in any mode
Available in Release 1.0

— 700
800
CDM
FDM
FVM

#16

SLUG_HIGH_LIMIT

High density limit in g/cc

Msg type = VAR
Data type = FLOAT (4)
Store = Static
Access = R/W in any mode
Available in Release 1.0

— 700
800
CDM
FDM
FVM
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A.4.4 Alarm status for diagnostic transducer blocks
Table A-13: Alarm status for diagnostic transducer blocks

Index and name Description List of values HW

#17

ALARM1_STATUS

Status Word 1

Msg type = ENUM
Data type = BIT STRING (2)
Store = Dynamic/20
Access = Read only
Available in Release 1.0

0x0001 = Transmitter Fail
0x0002 = Sensor Fail
0x0004 = EEPROM error (CP)
0x0008 = RAM error (CP)
0x0010= Boot Fail (CP)
0x0020 = Uncofig – FloCal
0x0040 = Uncofig – K1
0x0080 = Input Overrange
0x0100 = Temp. Overrange
0x0200 = Dens. Overrange
0x0800 = Cal Failed
0x1000= Xmitter Init
0x2000 = Sns/Xmitter comm fault
0x8000 = Xmitter Not
Characterized

700
800
CDM
FDM
FVM

#18

ALARM2_STATUS

Status Word 2

Msg type = ENUM
Data type = BIT STRING (2)
Store = Dynamic/20
Access = Read only
Available in Release 1.0

0x0001 = Line RTD Over
0x0002 = Meter RTD Over
0x0004 = CP Exception
0x0008 = API: Temp OOL
0x0010= API:Density OOL
0x0020 = ED: Unable to fit curve
data
0x0040 = ED: Extrapolation alarm
0x0080 = Not Used
0x0100 = EEPROM err
0x0200 = RAM err
0x0400 = Factoy Config err
0x0800 = Low Power
0x1000= Tube not full
0x2000 = Meter Verification
Aborted
0x4000 = Meter Verification
Failed
0x8000 = Not Used

700
800
CDM
FDM
FVM
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Table A-13: Alarm status for diagnostic transducer blocks (continued)

Index and name Description List of values HW

#19

ALARM3_STATUS

Status Word 3

Msg type = ENUM
Data type = BIT STRING (2)
Store = Dynamic/20
Access = Read only
Available in Release 1.0

0x0001 = Drive Overrange
0x0002 = Slug Flow
0x0004 = Cal in Progress
0x0008 = Data Loss Possible
0x0010 = Upgrade Series 2000
0x0020 = Simulation Mode
0x0080 = Warming Up
0x0100 = Power Reset
0x0200 = Reverse Flow
0x0400 = AI/AO Simulation Active
0x0800 =Meter Verification/
Outputs Fixed
0x1000= Meter Verification In
Progress
0x2000 = Not Used
0x4000 = Not Used
0x8000 = Not Used

700
800
CDM
FDM
FVM

#20

ALARM4_STATUS

Status Word 4

Msg type = ENUM
Data type = BIT STRING (2)
Store = Dynamic/20
Access = Read only
Available in Release 1.0

0x0001 = Cal Fail: Low
0x0002 = Cal Fail: High
0x0004 = Cal Fail: Noisy
0x0008 = Auto Zero IP
0x0010 = D1 Cal in Progress
0x0020 = D2 Cal in Progress
0x0040 = FD Cal in Progress
0x0080 = Temp slope Cal in
Progress
0x0100 = Temp offset Cal in
Progress
0x0200 = D3 Cal in Progress
0x0400 = D4 Cal in Progress
0x0800 = Factory configuration
invalid
0x1000 = Factory configuration
data checksum invalid
0x2000 = Core EEPROM DB
corrupt
0x4000 = Core EEPROM Totals
corrupt
0x8000 = Core EEPROM Program
corrupt

700
800
CDM
FDM
FVM

#21

FAULT_LIMIT

Fault limit code

Msg type = ENUM
Data type = Unsigned16 (2)
Store = Static
Access = RW (OOS)
Available in Release 1.0

0 = Upscale
1 = Downscale
2 = Zero
3 = NAN
4 = Flow goes to zero
5 = None

700
800
CDM
FDM
FVM
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Table A-13: Alarm status for diagnostic transducer blocks (continued)

Index and name Description List of values HW

#22

LAST_MEASURED_
VALUE_FAULT_TIMEOUT

Last measure value fault timeout

Msg type = VAR
Data type = Unsigned16 (2)
Store = Static
Access = RW in any mode
Available in Release 1.0

— 700
800
CDM
FDM
FVM
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Table A-13: Alarm status for diagnostic transducer blocks (continued)

Index and name Description List of values HW

#23

ALARM_INDEX

Alarm index

Msg type = ENUM
Data type = Unsigned16 (2)
Store = Static
Access = RW in any mode
Available in Release 3.0

0 = No Alarm
1 = A001 - (E)EPROM Error (CP)
2 = A002 - RAM Error (CP)
3 = A003 - Sensor Failure
4 = A004 - Temperature Sensor
Failure
5 = A005 - Mass Flow Outside
Limits
6 = A006 - Characterization
Required
8 = A008 - Density Overrange
9 = A009 - Transmitter
Initializing/Warming Up
10 = A010 - Calibration Failure
11 = A011 - Zero Too Low
12 = A012 - Zero Too High
13 = A013 - Zero Too Noisy
14 = A014 - Transmitter Failure
16 = A016 - Line RTD
Temperature Out-of-Range
17 = A017 - Meter RTD
Temperature Out-of-Range
18 = A018 - (E)EPROM Checksum
Error (2000)
19 = A019 - RAM or ROM Test
Error (2000)
20 = A020 - Calibration Factors
Unentered (FlowCal)
21 = A021 - Incorrect Sensor Type
(K1)
22 = A022 - Core EEPROM DB
Corrupt
23 = A023 - Core EEPROM Totals
Corrupt
24 = A024 - Core EEPROM
Program Corrupt
25 = A025 - Protected Boot Sector
Fault (CP)
26 = A026 - Sensor/Transmitter
Communication Error
28 = A028 - Core Processor Write
Failure
31 = A031 - Low Power
32 = A032 - Meter Verification/
Outputs in Fault
33 = A033 - Insufficient Pickoff
Signal
34 = A034 - Meter Verification
Failed
35 = A035 - Meter Verification
Aborted
36 = A036 - Viscosity Out of
Limits

700
800
CDM
FDM
FVM
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Table A-13: Alarm status for diagnostic transducer blocks (continued)

Index and name Description List of values HW

37 = A037 - Sensor Check Failed
38 = A038 - Time Period Out of
Range
42 = A102 - Drive Overrange/
Partially Full Tube
43 = A103 - Data Loss Possible
44 = A104 - Calibration in
Progress
45 = A105 - Two-Phase Flow
47 = A107:Power Reset Occurred
60 = A120 - ED: Unable to Fit
Curve Data
56 = A116 - API: Temperature
Outside Standard Range
57 = A117 - API: Density Outside
Standard Range
61 = A121 - ED: Extrapolation
Alarm
62 = A122 - API:Pressure Out of
Range
68 = A128 - Factory configuration
invalid
69 = A129 - Factory configuration
checksum invalid
71 = A131 - Meter Verification/
Outputs at Last Value
72 = A132 - Sensor Simulation
Mode Active
74 = A134 - Tube-Case
Temperature Difference Out of
Range
77 = A137 - API Non Conversion

#24

ALARM_SEVERITY

Alarm severity

Msg type = ENUM
Data type = Unsigned16 (2)
Store = Static
Access = RW (OOS)
Available in Release 3.0

0 = Ignore
1 = Info
2 = Fault

700
800
CDM
FDM
FVM

A.4.5 Device diagnostics from diagnostics transducer block
Table A-14: Device diagnostics from diagnostics transducer block

Index and name Description List of
values

HW

#25

DRIVE_GAIN

Drive gain

Msg type = VAR
Data type = DS-65 (5)
Store = Dynamic/20
Access = Read only
Available in Release 1.0

— 700
800
CDM
FDM
FVM
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Table A-14: Device diagnostics from diagnostics transducer block (continued)

Index and name Description List of
values

HW

#26

TUBE_
FREQUENCY

Raw tube period

Msg type = VAR
Data type = FLOAT (4)
Store = Dynamic/20
Access = Read only
Available in Release 1.0

— 700
800
CDM
FDM
FVM

#27

LIVE_ZERO

Live zero (mass flow)

Msg type = VAR
Data type = FLOAT (4)
Store = Dynamic/20
Access = Read only
Available in Release 1.0

— 700
800

#28

LEFT_PICKUP_
VOLTAGE

Left pickoff voltage

Msg type = VAR
Data type = FLOAT (4)
Store = Dynamic/20
Access = Read only
Available in Release 1.0

— 700
800
CDM
FDM
FVM

#29

RIGHT_PICKUP_
VOLTAGE

Right pickoff voltage

Msg type = VAR
Data type = FLOAT (4)
Store = Dynamic/20
Access = Read only
Available in Release 1.0

— 700
800
CDM
FVM

#30

BOARD_
TEMPERATURE

Board temperature in degC

Msg type = VAR
Data type = FLOAT (4)
Store = Dynamic/20
Access = Read only
Available in Release 1.0

— 700
800
CDM
FDM
FVM

#31

ELECT_TEMP_
MAX

Maximum electronics temperature

Msg type = VAR
Data type = FLOAT (4)
Store = Dynamic/20
Access = Read only
Available in Release 2.0

— 700
800
CDM
FDM
FVM

#32

ELECT_TEMP_
MIN

Minimum electronics temperature

Msg type = VAR
Data type = FLOAT (4)
Store = Dynamic/20
Access = Read only
Available in Release 2.0

— 700
800
CDM
FDM
FVM
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Table A-14: Device diagnostics from diagnostics transducer block (continued)

Index and name Description List of
values

HW

#33

ELECT_TEMP_
AVG

Average electronics temperature

Msg type = VAR
Data type = FLOAT (4)
Store = Dynamic/20
Access = Read only
Available in Release 2.0

— 700
800
CDM
FDM
FVM

#34

SENSOR_TEMP_
MAX

Maximum sensor temperature

Msg type = VAR
Data type = FLOAT (4)
Store = Dynamic/20
Access = Read only
Available in Release 3.0

— 700
800
CDM
FDM
FVM

#35

SENSOR_TEMP_
MIN

Minimum sensor temperature

Msg type = VAR
Data type = FLOAT (4)
Store = Dynamic/20
Access = Read only
Available in Release 3.0

— 700
800
CDM
FDM
FVM

#36

SENSOR_TEMP_
AVG

Average sensor temperature

Msg type = VAR
Data type = FLOAT (4)
Store = Dynamic/20
Access = Read only
Available in Release 3.0

— 700
800
CDM
FDM
FVM

#37

RTD_RESISTANCE_
CABLE

9-wire cable RTD resistance in ohms

Msg type = VAR
Data type = FLOAT (4)
Store = Dynamic/20
Access = Read only
Available in Release 3.0

— 700
800
CDM
FDM
FVM

#38

RTD_RESISTANCE_
METER

Meter RTD resistance in ohms

Msg type = VAR
Data type = FLOAT (4)
Store = Dynamic/20
Access = Read only
Available in Release 3.0

— 700
800
CDM
FDM
FVM

#39

CP_POWER_
CYCLE

Number of core processor power cycles

Msg type = VAR
Data type = Unsigned16 (2)
Store = Dynamic
Access = Read only
Available in Release 3.0

— 700
800
CDM
FDM
FVM
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A.4.6 Meter fingerprinting for diagnostic transducer blocks
Table A-15: Meter fingerprinting for diagnostic transducer blocks

Index and name Description List of values HW

#40

MFP_SAVE_FACTORY

Save factory calibration meter
fingerprint

Msg type = ENUM
Data type = Unsigned16 (2)
Store = Static
Access = R/W in any mode
Available in Release 3.0

0x0000 = no action
0x0001 = save

700
800

#41

MFP_RESET_STATS

Reset meter current fingerprint
statistics

Msg type = ENUM
Data type = Unsigned16 (2)
Store = Static
Access = R/W in any mode
Available in Release 3.0

0x0000 = no action
0x0001 = save

700
800

#42

EN_MFP

Enable/Disable meter fingerprinting

Msg type = ENUM
Data type = Unsigned16 (2)
Store = Static
Access = R/W in any mode
Available in Release 3.0

0x0000 = disabled
0x0001 = enabled

700
800

#43

MFP_UNITS

Meter fingerprint in SI (0) or English
(1) units

Msg type = ENUM
Data type = Unsigned16 (2)
Store = Static
Access = R/W in any mode
Available in Release 3.0

0x0000 = SI
0x0001 = English

700

#44

MFP_TV_INDEX

Meter fingerprint transmitter
variable index

Msg type = VAR
Data type = Unsigned16 (2)
Store = Static
Access = R/W in any mode
Available in Release 3.0

0 = Mass Flow Rate
1 = Temperature
3 = Density
5 = Volume Flow Rate
46 = Raw Tube Frequency
47 = Drive Gain
48 = Case Temperature
49 = LPO Amplitude
50 = RPO Amplitude
51 = Board Temperature
52 = Input Voltage
54 = Live Zero

700

#45

MFP_TYPE

Fingerprint type

Msg type = ENUM
Data type = Unsigned16 (2)
Store = Static
Access = R/W in any mode
Available in Release 3.0

0 = Current
1 = Factory Cal
2 = Installation
3 = Last Zero

700
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Table A-15: Meter fingerprinting for diagnostic transducer blocks (continued)

Index and name Description List of values HW

#46

MFP_TYPE

Transmitter variable, instantaneous
(only valid for current print)

Msg type = VAR
Data type = FLOAT (4)
Store = Dynamic
Access = Read only
Available in Release 3.0

— 700

#47

MFP_TV_STD_DEV

Transmitter variable, average (1-
min rolling)

Msg type = VAR
Data type = FLOAT (4)
Store = Dynamic
Access = Read only
Available in Release 3.0

— 700

#48

MFP_TV_AVG

Transmitter variable, std dev (1-min
rolling)

Msg type = VAR
Data type = FLOAT (4)
Store = Dynamic
Access = Read only
Available in Release 3.0

— 700

#49

MFP_TV_MAX

Transmitter variable, maximum
(since last statistics reset)

Msg type = VAR
Data type = FLOAT (4)
Store = Dynamic
Access = Read only
Available in Release 3.0

— 700

#50

MFP_TV_MIN

Transmitter variable, minimum
(since last statistics reset)

Msg type = VAR
Data type = FLOAT (4)
Store = Dynamic
Access = Read only
Available in Release 3.0

— 700

A.4.7 Other additions for diagnostics transducer blocks
Table A-16: Other additions for diagnostics transducer blocks

Index and name Description List of values HW

#51

DIAG_FEATURE_KEY

Enabled features

Msg type = STR
Data type = BIT STRING (2)
Store = Static
Access = Read only
Available in Release 4.0

0x0000 = standard
0x0800 = Meter verification
0x0008 = Enhhanced density
0x0010 = API

700
800
CDM
FDM
FVM
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Table A-16: Other additions for diagnostics transducer blocks (continued)

Index and name Description List of values HW

#52

SYS_PowerOnTimeSec

Power on time (seconds since last
reset)

Msg type = VAR
Data type = Unsigned32 (4)
Store = Dynamic
Access = Read only
Available in Release 4.0

— 700
800
CDM
FDM
FVM

#53

SNS_InputVoltage

Input voltage (volts)

Msg type = VAR
Data type = FLOAT (4)
Store = Dynamic
Access = Read only
Available in Release 4.0

— 700
800
CDM
FDM
FVM

#54

SNS_TargetAmplitude

Actual target amplitude (mV/Hz)
(pre 700 2.1, actual & override)

Msg type = VAR
Data type = FLOAT (4)
Store = Dynamic
Access = Read only
Available in Release 4.0

— 700
800
CDM
FDM
FVM

#55

SNS_CaseRTDRes

Case RTD resistance (ohms)

Msg type = VAR
Data type = FLOAT (4)
Store = Dynamic
Access = Read only
Available in Release 4.0

— 700
800

#56

SYS_RestoreFactoryConfig

Restore factory configuration

Msg type = METHOD
Data type = Unsigned16 (2)
Store = Static
Access = R/W (OOS)
Available in Release 4.0

0 = no action
1 = Restore

700
800
CDM
FDM
FVM

#57

SNS_FlowZeroRestore

Restore factory zero

Msg type = METHOD
Data type = Unsigned16 (2)
Store = Static
Access = R/W (OOS)
Available in Release 4.0

0 = no action
1 = Restore

800

#58

SNS_AutoZeroFactory

Factory flow signal offset at zero
flow (units of uSec)

Msg type = VAR
Data type = FLOAT (4)
Store = Static
Access = Read only
Available in Release 4.0

— 800
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Table A-16: Other additions for diagnostics transducer blocks (continued)

Index and name Description List of values HW

#59

SYS_ResetPowerOnTime

Reset power-on time

Msg type = METHOD
Data type = Unsigned16 (2)
Store = Static
Access = R/W (OOS)
Available in Release 4.0

0 = no action
1 = Reset

800
CDM
FDM
FVM

#60

FRF_EnableFCFValidation

Start/Stop meter verification -
(applicable only if meter verification
is enabled)

Msg type = METHOD
Data type = Unsigned16 (2)
Store = Static
Access = R/W (OOS)
Available in Release 4.0

0= Disabled
1 = Fixed output mode
2 = Factory air verification
3 = Factory water verification
4 = Special debug mode
5 = Abort
6 = Continue measurement
mode

800

#61

FRF_FaultAlarm

The state of the outputs when the
meter verification routine is running
- (applicable only if meter
verification is enabled)

Msg type = ENUM
Data type = Unsigned16 (2)
Store = Static
Access = R/W in any mode
Available in Release 4.0

0 = Last Value
1 = Fault

800

#62

FRF_StiffnessLimit

The setpoint of the stiffness limit.
Represents percentage - (applicable
only if meter verification is enabled)

Msg type = VAR
Data type = FLOAT (4)
Store = Static
Access = R/W in any mode
Available in Release 4.0

— 800

#63

FRF_AlgoState

The current state of the meter
verification routine

Msg type = VAR
Data type = Unsigned16 (2)
Store = Static
Access = Read only
Available in Release 4.0

1 through 18 800
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Table A-16: Other additions for diagnostics transducer blocks (continued)

Index and name Description List of values HW

#64

FRF_AbortCode

The reason the meter verification
routine aborted

Msg type = ENUM
Data type = Unsigned16 (2)
Store = Static
Access = Read only
Available in Release 4.0

0 = No error
1 = Manual abort
2 = Watchdog timeout
3 = Frequency drift
4 = High peak drive voltage
5 = High drive current standard
deviation
6 = High drive current mean
value
7 = Drive loop reported error
8 = High delta T standard
deviation
9 = High delta T value
10 = State running

800

#65

FRF_StateAtAbort

The state of the meter verification
routine when it aborted

Msg type = VAR
Data type = Unsigned16 (2)
Store = Static
Access = Read only
Available in Release 4.0

1 through 18 800

#66

FRF_Progress

Progress (% complete)

Msg type = VAR
Data type = Unsigned16 (2)
Store = Static
Access = Read only
Available in Release 4.0

— 800

#67

FRF_StiffOutLimLpo

Is the LPO stiffness out of limits?

Msg type = VAR
Data type = Unsigned16 (2)
Store = Static
Access = Read only
Available in Release 4.0

— 800

#68

FRF_StiffOutLimRpo

Is the RPO stiffness out of limits?

Msg type = VAR
Data type = Unsigned16 (2)
Store = Static
Access = Read only
Available in Release 4.0

— 800

#69

FRF_StiffnessLpo_mean

The current LPO stiffness calculated
as a mean

Msg type = VAR
Data type = FLOAT (4)
Store = Static
Access = Read only
Available in Release 4.0

— 800
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Table A-16: Other additions for diagnostics transducer blocks (continued)

Index and name Description List of values HW

#70

FRF_StiffnessRpo_mean

The current RPO stiffness calculated
as a mean

Msg type = VAR
Data type = FLOAT (4)
Store = Static
Access = Read only
Available in Release 4.0

— 800

#71

FRF_Damping_mean

The current damping calculated as
a mean

Msg type = VAR
Data type = FLOAT (4)
Store = Static
Access = Read only
Available in Release 4.0

— 800

#72

FRF_MassLpo_mean

The current LPO mass calculated as
a mean

Msg type = VAR
Data type = FLOAT (4)
Store = Static
Access = Read only
Available in Release 4.0

— 800

#73

FRF_MassRpo_mean

The current RPO mass calculated as
a mean

Msg type = VAR
Data type = FLOAT (4)
Store = Static
Access = Read only
Available in Release 4.0

— 800

#74

FRF_StiffnessLpo_stddev

The current LPO stiffness calculated
as a standard deviation

Msg type = VAR
Data type = FLOAT (4)
Store = Static
Access = Read only
Available in Release 4.0

— 800

#75

FRF_StiffnessRpo_stddev

The current RPO stiffness calculated
as a standard deviation

Msg type = VAR
Data type = FLOAT (4)
Store = Static
Access = Read only
Available in Release 4.0

— 800
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Table A-16: Other additions for diagnostics transducer blocks (continued)

Index and name Description List of values HW

#76

FRF_Damping_stddev

The current damping calculated as
a standard deviation

Msg type = VAR
Data type = FLOAT (4)
Store = Static
Access = Read only
Available in Release 4.0

— 800

#77

FRF_MassLpo_stddev

The current LPO mass calculated as
a standard deviation

Msg type = VAR
Data type = FLOAT (4)
Store = Static
Access = Read only
Available in Release 4.0

— 800

#78

FRF_MassRpo_stddev

The current RPO mass calculated as
a standard deviation

Msg type = VAR
Data type = FLOAT (4)
Store = Static
Access = Read only
Available in Release 4.0

— 800

#79

FRF_StiffnessLpo_air

The LPO stiffness calculated as a
mean during Factory Cal of Air

Msg type = VAR
Data type = FLOAT (4)
Store = Static
Access = Read only
Available in Release 4.0

— 800

#80

FRF_StiffnessRpo_air

The RPO stiffness calculated as a
mean during Factory Cal of Air

Msg type = VAR
Data type = FLOAT (4)
Store = Static
Access = Read only
Available in Release 4.0

— 800

#81

FRF_Damping_air

The damping calculated as a mean
during Factory Cal of Air

Msg type = VAR
Data type = FLOAT (4)
Store = Static
Access = Read only
Available in Release 4.0

— 800
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Table A-16: Other additions for diagnostics transducer blocks (continued)

Index and name Description List of values HW

#82

FRF_MassLpo_air

The LPO mass calculated as a mean
during Factory Cal of Air

Msg type = VAR
Data type = FLOAT (4)
Store = Static
Access = Read only
Available in Release 4.0

— 800

#83

FRF_MassRpo_air

The RPO mass calculated as a mean
during Factory Cal of Air

Msg type = VAR
Data type = FLOAT (4)
Store = Static
Access = Read only
Available in Release 4.0

— 800

#84

FRF_StiffnessLpo_water

The LPO stiffness calculated as a
mean during Factory Cal of Water

Msg type = VAR
Data type = FLOAT (4)
Store = Static
Access = Read only
Available in Release 4.0

— 800

#85

FRF_StiffnessRpo_water

The RPO stiffness calculated as a
mean during Factory Cal of Water

Msg type = VAR
Data type = FLOAT (4)
Store = Static
Access = Read only
Available in Release 4.0

— 800

#86

FRF_Damping_water

The damping calculated as a mean
during Factory Cal of Water

Msg type = VAR
Data type = FLOAT (4)
Store = Static
Access = Read only
Available in Release 4.0

— 800

#87

FRF_MassLpo_water

The LPO mass calculated as a mean
during Factory Cal of Water

Msg type = VAR
Data type = FLOAT (4)
Store = Static
Access = Read only
Available in Release 4.0

— 800
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Table A-16: Other additions for diagnostics transducer blocks (continued)

Index and name Description List of values HW

#88

FRF_MassRpo_water

The RPO mass calculated as a mean
during Factory Cal of Water

Msg type = VAR
Data type = FLOAT (4)
Store = Static
Access = Read only
Available in Release 4.0

— 800

#89

ALERT_TIMEOUT

Alert timeout

Msg type = VAR
Data type = Unsigned16 (2)
Store = Static
Access = R/W in any mode
Available in Release 4.0

0 to 300 seconds 700
800
CDM
FDM
FVM

#90

FRF_FCFValidCounter

Counts the number of times the
meter verification algorithm has run
successfully

Msg type = VAR
Data type = Unsigned16 (2)
Store = Static
Access = Read only
Available in Release 5.0

— 800

#91

FRF_StartMeterVer

Start on-line meter verification -
equivalent to Reg 3000 = 6 -
applicable only if meter verification
is enabled)

Msg type = VAR
Data type = DS-66 (2)
Store = Static
Access = R/W in any mode
Available in Release 6.0

Value part of DS-66
0 = no action
1 = start meter verification in
continue measurement mode

800

#92

FRF_MV_Index

FCF Datalog Index (0-19, 0 = most
recent run)

Msg type = VAR
Data type = Unsigned16 (2)
Store = Static
Access = R/W in any mode
Available in Release 6.0

— 800

#93

FRF_MV_Counter

FCF Datalog Item 1: Run Number

Msg type = VAR
Data type = Unsigned16 (2)
Store = Static
Access = R/W in any mode
Available in Release 6.0

— 800
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Table A-16: Other additions for diagnostics transducer blocks (continued)

Index and name Description List of values HW

#94

FRF_MV_Status

FCF Datalog Item 2: Status; Abort
states are compressed to fit into 3
bits

Msg type = VAR
Data type = Unsigned16 (2)
Store = Static
Access = Read only
Available in Release 6.0

Bit 7 = FCF pass/fail
Bits 6-4 = state
Bits 3-0 = abort code

800

#95

FRF_MV_Time

FCF Datalog Item 3: Time Initiated

Msg type = VAR
Data type = Unsigned32 (4)
Store = Static
Access = Read only
Available in Release 6.0

— 800

#96

FRF_MV_LPO_Norm

FCF Datalog Item 4: LPO
Normalized Data

Msg type = VAR
Data type = FLOAT (4)
Store = Static
Access = Read only
Available in Release 6.0

— 800

#97

FRF_MV_RPO_Norm

FCF Datalog Item 5: RPO
Normalized Data

Msg type = VAR
Data type = FLOAT (4)
Store = Static
Access = Read only
Available in Release 6.0

— 800

#98

FRF_DriveCurr

Drive current

Msg type = VAR
Data type = FLOAT (4)
Store = Static
Access = Read only
Available in Release 6.0

— 800

#99

FRF_DL_T

Delta T

Msg type = VAR
Data type = FLOAT (4)
Store = Static
Access = Read only
Available in Release 6.0

— 800

#100

FRF_Temp

Temperature

Msg type = VAR
Data type = FLOAT (4)
Store = Static
Access = Read only
Available in Release 6.0

— 800
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Table A-16: Other additions for diagnostics transducer blocks (continued)

Index and name Description List of values HW

#101

FRF_Density

Density

Msg type = VAR
Data type = FLOAT (4)
Store = Static
Access = Read only
Available in Release 6.0

— 800

#102

FRF_DriveFreq

Drive frequency

Msg type = VAR
Data type = FLOAT (4)
Store = Static
Access = Read only
Available in Release 6.0

— 800

#103

FRF_LpoFilt

LPO filter

Msg type = VAR
Data type = FLOAT (4)
Store = Static
Access = Read only
Available in Release 6.0

— 800

#104

FRF_RpoFilt

RPO filter

Msg type = VAR
Data type = FLOAT (4)
Store = Static
Access = Read only
Available in Release 6.0

— 800

#105

FRF_DataSetSelIndex

FCF verification data set selection

Msg type = VAR
Data type = Unsigned16 (2)
Store = Static
Access = R/W in any mode
Available in Release 6.0

0 = Current data means
1 = Current data standard
deviations
2 = Factory calibration of air
means
3 = Factory calibration of water
means
4 = Running average data
5 = Standard error of the
estimate

800

#106

FRF_MV_FirstRun_Time

FCF timers: time until first run in
hours (applicable only if meter
verification feature is enabled)

Msg type = VAR
Data type = FLOAT (4)
Store = Static
Access = R/W in any mode
Available in Release 7.0

— 800
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Table A-16: Other additions for diagnostics transducer blocks (continued)

Index and name Description List of values HW

#107

FRF_MV_Elapse_Time

FCF timers: time between each run
after the first run initiated in hours
(applicable only if meter verification
feature is enabled)

Msg type = VAR
Data type = FLOAT (4)
Store = Static
Access = R/W in any mode
Available in Release 7.0

— 800

#108

FRF_MV_Time_Left

FCF timers: time until next run in
hours

Msg type = VAR
Data type = FLOAT (4)
Store = Static
Access = Read only
Available in Release 7.0

— 800

#109

FRF_ToneLevel

FRF tone level (mA) (applicable only
if meter verification feature is
enabled)

Msg type = VAR
Data type = FLOAT (4)
Store = Static
Access = R/W (OOS)
Available in Release 7.0

— 800

#110

FRF_ToneRampTime

Tone ramp time in seconds
(applicable only if meter verification
feature is enabled)

Msg type = VAR
Data type = FLOAT (4)
Store = Static
Access = R/W (OOS)
Available in Release 7.0

— 800

#111

FRF_BlCoeff

BL coefficient (applicable only if
meter verification feature is
enabled)

Msg type = VAR
Data type = FLOAT (4)
Store = Static
Access = R/W (OOS)
Available in Release 7.0

— 800

#112

FRF_DriveTarget

FRF drive target (applicable only if
meter verification feature is
enabled)

Msg type = VAR
Data type = FLOAT (4)
Store = Static
Access = R/W (OOS)
Available in Release 7.0

— 800
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Table A-16: Other additions for diagnostics transducer blocks (continued)

Index and name Description List of values HW

#113

FRF_DrivePCoeff

FRF drive P coefficient (applicable
only if meter verification feature is
enabled)

Msg type = VAR
Data type = FLOAT (4)
Store = Static
Access = R/W (OOS)
Available in Release 7.0

— 800

#114

FRF_ToneSpacingMult

Tone spacing multiplier (applicable
only if meter verification feature is
enabled)

Msg type = VAR
Data type = FLOAT (4)
Store = Static
Access = R/W (OOS)
Available in Release 7.0

— 800

#115

FRF_Freq_DriftLimit

Frequency drift limit (applicable
only if meter verification feature is
enabled)

Msg type = VAR
Data type = FLOAT (4)
Store = Static
Access = R/W (OOS)
Available in Release 7.0

— 800

#116

FRF_Max_Current_mA

Maximum sensor current
(applicable only if meter verification
feature is enabled)

Msg type = VAR
Data type = FLOAT (4)
Store = Static
Access = R/W (OOS)
Available in Release 7.0

— 800

#117

FRF_KFQ2

KFQ2 linear density correction for
stiffness value

Msg type = VAR
Data type = FLOAT (4)
Store = Static
Access = R/W (OOS)
Available in Release 7.0

— 800

#118

SYS_AnalogOutput_Fault

Indicates if a critical fault is present

Msg type = VAR
Data type = DS-66 (2)
Store = —
Access = Read only
Available in Release 7.0

Value part of DS-66
0 = No critical fault
1 = Critical fault present

700
800
CDM
FDM
FVM
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Table A-16: Other additions for diagnostics transducer blocks (continued)

Index and name Description List of values HW

#119

SNS_MV_Failed

Indicates if meter verification failed

Msg type = VAR
Data type = DS-66 (2)
Store = —
Access = Read only
Available in Release 7.0

Value part of DS-66
0 = Meter verification did not fail
1 = Meter verification failed

800

#120

ALARM5_STATUS

Status Word 5

Msg type = ENUM
Data type = BIT STRING (2)
Store = Dynamic/20
Access = Read only
Available in Release 8.0

0x0001 = Viscosity out of limits
0x0002 = Sensor check fail
0x0004 = PM: pressure out of
range
0x0008 = Incorrect display type
0x0010 = Incorrect board type
0x0020 = Time period out of
limits
0x0040 = Case/Meter
temperature differential out of
range
0x0080 = API non-convergence
0x0100 = Not used
0x0200 = Not used
0x0400 = Not used
0x0800 = Not used
0x1000 = Not used
0x2000 = Not used
0x4000 = Not used
0x8000 = Not used

CDM
FDM
FVM

#121

DIAG_TEMPERATURE_UNIT
S

Temperature unit

Msg type = ENUM
Data type = Unsigned16 (2)
Store = Static
Access = R/W (OOS)
Available in Release 8.0

1000 = K
1001 = Deg C
1002 = Deg F
1003 = Deg R

700
800
CDM
FDM
FVM
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Table A-16: Other additions for diagnostics transducer blocks (continued)

Index and name Description List of values HW

#122

DIAG_MASSFLOW_UNITS

Mass flow unit

Msg type = ENUM
Data type = Unsigned16 (2)
Store = Static
Access = Read only
Available in Release 8.0

1318 = g/s
1319 = g/min
1320 = g/h
1322 = kg/s
1323 = kg/min
1324 = kg/h
1325 = kg/d
1327 = t/min
1328 = t/h
1329 = t/d
1330 = lb/s
1331 = lb/min
1332 = lb/h
1333 = lb/d
1335 = STon/min
1336 = STon/h
1337 = STon/d
1340 = LTon/h
1341 = LTon/d
253 = Special

700
800

#123

DIAG_SYS_AttachedCoreTy
pe

Indicates the attached core type

Msg type = ENUM
Data type = Unsigned16 (2)
Store = Static
Access = Read only
Available in Release 8.0

0 = CORE_UNKNOWN
1 = CORE_700
2 = CORE_ECP
3 = CORE_S
4 = CORE_DENSITY
5 = CORE_DEN_CDM
6 = CORE_DEN_FDM
7 = CORE_DEN_FVM

700
800
CDM
FDM
FVM

#124

DIAG_FRF_OUTPUT_STATE
S

Indexed by R2984

Msg type = VAR
Data type = Unsigned16 (2)
Store = Static
Access = Read only
Available in Release 8.0

— 800

#125

DIAG_FRF_LPO_METER_FA
CTOR

Indexed by R2984

Msg type = VAR
Data type = FLOAT (4)
Store = Static
Access = Read only
Available in Release 8.0

— 800

#126

DIAG_FRF_RPO_METER_FA
CTOR

Indexed by R2984

Msg type = VAR
Data type = FLOAT (4)
Store = Static
Access = Read only
Available in Release 8.0

— 800

Transducer blocks and views Configuration and Use Manual
August 2022 20000326

180 Micro Motion 2700 Transmitters with FOUNDATION Fieldbus



Table A-16: Other additions for diagnostics transducer blocks (continued)

Index and name Description List of values HW

#127

DIAG_FRF_LPO_CI_SPREAD

Indexed by R2984

Msg type = VAR
Data type = FLOAT (4)
Store = Static
Access = Read only
Available in Release 8.0

— 800

#128

DIAG_FRF_RPO_CI_SPREAD

Indexed by R2984

Msg type = VAR
Data type = FLOAT (4)
Store = Static
Access = Read only
Available in Release 8.0

— 800

#129

DIAG_FRF_SYMMETRY_CI_S
PREAD

Indexed by R2984

Msg type = VAR
Data type = FLOAT (4)
Store = Static
Access = Read only
Available in Release 8.0

— 800

A.5 Device information transducer blocks

A.5.1 View list for device information transducer block
The following table lists the parameters contained in the tranducer block for device information parameters.

Four views are defined for the device information tranducer block. The table also shows the applicable views
for each parameter, and the size of the parameter in that view, in bytes.

Index Name View

1 2 3 4

0 BLOCK_STRUCTURE — — — —

1 ST_REV 2 2 2 2

2 TAG_DESC — — — —

3 STRATEGY — — — 2

4 ALERT_KEY — — — 1

5 MODE_BLK 4 — 4 —

6 BLOCK_ERR 2 — 2 —

7 UPDATE_EVT — — — —

8 BLOCK_ALM — — — —

9 TRANSDUCER_DIRECTORY — — — —

10 TRANSDUCER_TYPE 2 2 2 2

11 TRANSDUCER_TYPE_VER 2 2 2 2
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Index Name View

1 2 3 4

12 XD_ERROR 1 — 1 —

13 COLLECTION_DIRECTORY — — — —

14 SERIAL_NUMBER — 4 — —

15 OPTION_BOARD_CODE — — — 2

16 700_SW_REV — 2 — —

17 2700_SW_REV — 2 — —

18 CEQ_NUMBER — 2 — —

19 DESCRIPTION — — — 16

20 SENSOR_SN — 4 — —

21 SENSOR_TYPE — — — 16

22 SENSOR_TYPE_CODE — — — 2

23 SENSOR_MATERIAL — — — 2

24 SENSOR_LINER — — — 2

25 SENSOR_END — — — 2

26 MASS_MIN_RANGE — — — 4

27 TEMP_MIN_RANGE — — — 4

28 DENSITY_MIN_RANGE — — — 4

29 VOLUME_MIN_RANGE — — — 4

30 SNS_PuckDeviceTypeCode — — — 2

31 AI_SIMULATE_MODE — — — 2

32 SNS_DeviceID — — — 4

33 SYS_DeviceType — — — 2

34 SYS_ManufacturerID — — — 2

35 DEV_SYS_AttachedCoreType — 2 — —

A.5.2 Standard fieldbus parameters for device information
transducer blocks
Index and name Description List of values

#0

BLOCK_STRUCTURE

The beginning of the transducer block.

Msg type = VAR
Data type = DS_64 (5)
Store = Static
Access = RW (OOS) or RW (Auto)
Available in Release 1.0

—
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Index and name Description List of values

#1

ST_REV

The revision level of the static data
associated with the function block.
Incremented with each write of static store.

Msg type = VAR
Data type = Unsigned16 (2)
Store = Static
Access = Read only
Available in Release 1.0

—

#2

TAG_DESC

The user description of the intended block
application.

Msg type = STR
Data type = OCTET STRING (32)
Store = Static
Access = RW (OOS) or RW (Auto)
Available in Release 1.0

Any 32 characters

#3

STRATEGY

Used to identify grouping of blocks. This
data is not checked or processed by the
block.

Msg type = VAR
Data type = Unsigned16 (2)
Store = Static
Access = RW (OOS) or RW (Auto)
Available in Release 1.0

—

#4

ALERT_KEY

The identification number of the plant unit.
This information may be used in the host
for sorting alarms, etc.

Msg type = VAR
Data type = Unsigned8 (1)
Store = Static
Access = RW (OOS) or RW (Auto)
Available in Release 1.0

1 to 255

#5

MODE_BLK

The actual, target, permitted, and normal
modes of the block.

Msg type = REC
Data type = DS-69 (4)
Store = Mixed
Access = RW (OOS) or RW (Auto)
Available in Release 1.0

See section 2.6 of FF-891

#6

BLOCK_ERR

The error status associated with the
hardware or software components
associated with a block.

Msg type = STR
Data type = BIT STRING (2)
Store = Dynamic/20
Access = Read only
Available in Release 1.0

See section 4.8 of FF-903
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Index and name Description List of values

#7

UPDATE_EVT

Occurs when a static parameter is changed
while a block mode is not in out of service
(OOS) mode, or when the mode changes
from OOS mode and one or more static
parameters changed while the block was
OOS.

Msg type = REC
Data type = DS-73
Store = Dynamic
Access = RW in any mode
Available in Release 1.0

—

#8

BLOCK_ALM

A predefined set of 16 conditions that may
occur within a block.

Msg type = REC
Data type = DS-72
Store = Dynamic
Access = RW in any mode
Available in Release 9.0

—

#9

TRANSDUCER_
DIRECTORY

A directory that specifies the number and
starting indices of the data collections in
the transducer block.

Msg type = VAR
Data type = Unsigned16 (2)
Store = Static
Access = RW (OOS)
Available in Release 9.0

—

#10

TRANSDUCER_
TYPE

Identifies the transducer that follows.

Msg type = VAR
Data type = Unsigned16 (2)
Store = Static
Access = RW (OOS)
Available in Release 9.0

—

#11

TRANSDUCER_
TYPE_VER

Identifies the version of the transducer
block. Format is XXYY where XX is the major
spec revision and YY is the manufacturer
revision.

Msg type = VAR
Data type = Unsigned16 (2)
Store = Static
Access = RW (OOS)
Available in Release 9.0

—

#12

XD_ERROR

Used for all config, H/W, connection failure
of system problems in the block.

Msg type = VAR
Data type = Unsigned8 (1)
Store = Dynamic
Access = RW (OOS)
Available in Release 1.0

0 = No Error
18 = Calibration Error
19 = Configuration Error
20 = Electronics Failure
21 = Sensor Failure
26 = Process Error
27 = Calibration in Progress
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Index and name Description List of values

#13

COLLECTION_
DIRECTORY

Used for all config, H/W, and connection
failures of system problems in the block.

Msg type = VAR
Data type = Unsigned32 (4)
Store = Static
Access = RW (OOS)
Available in Release 9.0

—

A.5.3 Transmitter data for device information transducer blocks
Table A-17: Transmitter data for device information transducer blocks

Index and name Description List of values HW

#14

SERIAL_NUMBER

Serial number of this device

Msg type = VAR
Data type = Unsigned32 (4)
Store = Static
Access = R/W in any mode
Available in Release 1.0

0 700
800
CDM
FDM
FVM

#15

OPTION_BOARD_CODE

Code for the output option board

Msg type = VAR
Data type = Unsigned16 (2)
Store = Static
Access = Read only
Available in Release 1.0

20 = FOUNDATION Fieldbus 700
800
CDM
FDM
FVM

#16

700_SW_REV

Model 700 transmitter software
revision

Msg type = VAR
Data type = Unsigned16 (2)
Store = Static
Access = Read only
Available in Release 1.0

— 700
800
CDM
FDM
FVM

#17

2700_SW_REV

Model 2700 transmitter software
revision

Msg type = VAR
Data type = Unsigned16 (2)
Store = Static
Access = Read only
Available in Release 1.0

— 700
800
CDM
FDM
FVM

#18

CEQ_NUMBER

Model 2700 transmitter CEQ
number

Msg type = VAR
Data type = Unsigned16 (2)
Store = Static
Access = Read only
Available in Release 3.0

— 700
800
CDM
FDM
FVM
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Table A-17: Transmitter data for device information transducer blocks (continued)

Index and name Description List of values HW

#19

DESCRIPTION

User text

Msg type = STR
Data type = VISIBLE STRING (16)
Store = Static
Access = R/W in any mode
Available in Release 3.0

— 700
800
CDM
FDM
FVM

A.5.4 Sensor data for device information transducer blocks
Table A-18: Sensor data for device information transducer blocks

Index and name Description List of values HW

#20

SENSOR_SN

Sensor serial number

Msg type = VAR
Data type = Unsigned32 (4)
Store = Static
Access = R/W in any mode
Available in Release 1.0

0 700
800
CDM
FDM
FVM

#21

SENSOR_TYPE

Sensor type (i.e. F200, CMF025)

Msg type = STR
Data type = VISIBLE STRING (16)
Store = Static
Access = Read only
Available in Release 1.0

— 700
800
CDM
FDM
FVM

#22

SENSOR_TYPE_CODE

Sensor type code

Msg type = ENUM
Data type = Unsigned16 (2)
Store = Static
Access = R/W in any mode
Available in Release 3.0

0 = Curve tube
1 = Straight tube

700
800
CDM
FDM
FVM

#23

SENSOR_MATERIAL

Sensor material

Msg type = ENUM
Data type = Unsigned16 (2)
Store = Static
Access = R/W in any mode
Available in Release 1.0

3 = Hastelloy C-22 [CP, ECP, CDM,
FDM](1)

4 = Monel [CP, ECP]
5 = Tantalum [CP, ECP]
6 = Titanium [CP, ECP, FDM]
19 = 316L stainless steel
23 = Inconel [CP, ECP]
252 = Unknown
253 = Special

700
800
CDM
FDM
FVM

#24

SENSOR_LINER

Liner material

Msg type = ENUM
Data type = Unsigned16 (2)
Store = Static
Access = R/W in any mode
Available in Release 1.0

10 = PTFE (teflon) [CP, ECP](1)

11 = Halar [CP, ECP]
16 = Tefzel [CP, ECP]
251 = None [CP, ECP, CDM]
252 = Unknown [CP, ECP, CDM]
253 = Special [CP, ECP, CDM]

700
800
CDM
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Table A-18: Sensor data for device information transducer blocks (continued)

Index and name Description List of values HW

#25

SENSOR_END

Flange type

Msg type = ENUM
Data type = Unsigned16 (2)
Store = Static
Access = R/W in any mode
Available in Release 1.0

0 = ANSI 150 [CP, ECP, FDM,
FVM](1)

1 = ANSI 300
2 = ANSI 600
5 = PN 40
7 = JIS 10K [CP, ECP]
8 = JIS 20K [CP, ECP]
9 = ANSI 900 [CP, ECP, CDM,
FDM]
10 = Sanitary clamp fitting [CP,
ECP, FDM]
11 = Union [CP, ECP]
12 = PN 100 [CP, ECP, CDM]
13 = PN 16 [FDM, FVM]
14 = ANSI 1500 [FDM]
15 = Cone seat compression
fitting [FDM, FVM]
251 = None
252 = Unknown
253 = Special

700
800
CDM
FDM
FVM

#26

MASS_MIN_RANGE

Mass flow minimum range

Msg type = VAR
Data type = FLOAT (4)
Store = Static
Access = Read only
Available in Release 1.0

— 700
800
CDM

#27

TEMP_MIN_RANGE

Temperature minimum range

Msg type = VAR
Data type = FLOAT (4)
Store = Static
Access = Read only
Available in Release 1.0

— 700
800
CDM
FDM
FVM

#28

DENSITY_MIN_RANGE

Density minimum range (g/cc)

Msg type = VAR
Data type = FLOAT (4)
Store = Static
Access = Read only
Available in Release 1.0

— 700
800
CDM
FDM
FVM

#29

VOLUME_MIN_RANGE

Volume flow minimum range

Msg type = VAR
Data type = FLOAT (4)
Store = Static
Access = Read only
Available in Release 1.0

— 700
800
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Table A-18: Sensor data for device information transducer blocks (continued)

Index and name Description List of values HW

#30

SNS_PuckDeviceTypeCode

Device type for the attached core
processor

Msg type = ENUM
Data type = Unsigned16 (2)
Store = Static
Access = Read only
Available in Release 4.0

40 = 700 [CP](1)

50 = 800 [ECP]
61 = Density

700
800
CDM
FDM
FVM

#31

AI_SIMULATE_MODE

AI simulate mode

Msg type = ENUM
Data type = Unsigned16 (2)
Store = Static
Access = R/W in any mode
Available in Release 4.0

0 = disabled
1 = enabled

700

#32

SNS_DeviceID

Core processor unique ID

Msg type = VAR
Data type = Unsigned32 (4)
Store = Static
Access = Read only
Available in Release 5.0

— —

#33

SYS_DeviceType

Transmitter device type

Msg type = VAR
Data type = Unsigned16 (2)
Store = Static
Access = Read only
Available in Release 5.0

— 700
800
CDM
FDM
FVM

#34

SYS_ManufacturerID

Manufacturer ID

Msg type = VAR
Data type = Unsigned16 (2)
Store = Static
Access = Read only
Available in Release 8.0

— 700
800
CDM
FDM
FVM

#35

DEV_SYS_Attached
CoreType

Indicates the attached core type

Msg type = ENUM
Data type = Unsigned16 (2)
Store = Static
Access = Read only
Available in Release 8.0

0 = CORE_UNKNOWN
1 = CORE_700
2 = CORE_ECP
3 = CORE_S
4 = CORE_DENSITY
5 = CORE_DEN_CDM
6 = CORE_DEN_FDM
7 = CORE_DEN_FVM

700
800
CDM
FDM
FVM

(1) The list within the square bracket contains cores that support this value.
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A.6 Local display transducer blocks

A.6.1 View list for local display transducer block
The following table lists the parameters contained in the transducer block for local display parameters.

Four views are defined for the local display transducer block. The table also shows the applicable views for
each parameter, and the size of the parameter in that view, in bytes.

Index Name View

1 2 3 4

0 BLOCK_STRUCTURE — — — —

1 ST_REV 2 2 2 2

2 TAG_DESC — — — —

3 STRATEGY — — — 2

4 ALERT_KEY — — — 1

5 MODE_BLK 4 — 4 —

6 BLOCK_ERR 2 — 2 —

7 UPDATE_EVT — — — —

8 BLOCK_ALM — — — —

9 TRANSDUCER_DIRECTORY — — — —

10 TRANSDUCER_TYPE 2 2 2 2

11 TRANSDUCER_TYPE_VER 2 2 2 2

12 XD_ERROR 1 — 1 —

13 COLLECTION_DIRECTORY — — — —

14 EN_LDO_TOT_RESET — — — 2

15 EN_LDO_TOT_START_STOP — — — 2

16 EN_LDO_AUTO_SCROLL — — — 2

17 EN_LDO_OFFLINE_MENU — — — 2

18 EN_LDO_OFFLINE_PWD — — — 2

19 EN_LDO_ALARM_MENU — — — 2

20 EN_LDO_ACK_ALL_ALARMS — — — 2

21 LDO_OFFLINE_PWD — 2 — —

22 LDO_SCROLL_RATE — — — 2

23 LDO_BACKLIGHT_ON — — — 2

24 UI_Language — — — 2

25 LDO_VAR_1_CODE — — — 2

26 LDO_VAR_2_CODE — — — 2
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Index Name View

1 2 3 4

27 LDO_VAR_3_CODE — — — 2

28 LDO_VAR_4_CODE — — — 2

29 LDO_VAR_5_CODE — — — 2

30 LDO_VAR_6_CODE — — — 2

31 LDO_VAR_7_CODE — — — 2

32 LDO_VAR_8_CODE — — — 2

33 LDO_VAR_9_CODE — — — 2

34 LDO_VAR_10_CODE — — — 2

35 LDO_VAR_11_CODE — — — 2

36 LDO_VAR_12_CODE — — — 2

37 LDO_VAR_13_CODE — — — 2

38 LDO_VAR_14_CODE — — — 2

39 LDO_VAR_15_CODE — — — 2

40 FBUS_UI_ProcVarIndex — — — 2

41 UI_NumDecimals — — — 2

42 UI_UpdatePeriodmsec — — — 2

43 UI_EnableStatusLedBlinking — — — 2

44 UI_EnableAlarmPassword — — — 2

45 LDO_FEATURE_KEY — — — —

46 LDO_SYS_AttachedCoreType — 2 — —

A.6.2 Standard fieldbus parameters for local display transducer
blocks
Index and name Description List of values

#0

BLOCK_STRUCTURE

The beginning of the transducer block.

Msg type = VAR
Data type = DS_64 (5)
Store = Static
Access = RW (OOS) or RW (Auto)
Available in Release 1.0

—
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Index and name Description List of values

#1

ST_REV

The revision level of the static data
associated with the function block.
Incremented with each write of static store.

Msg type = VAR
Data type = Unsigned16 (2)
Store = Static
Access = Read only
Available in Release 1.0

—

#2

TAG_DESC

The user description of the intended block
application.

Msg type = STR
Data type = OCTET STRING (32)
Store = Static
Access = RW (OOS) or RW (Auto)
Available in Release 1.0

Any 32 characters

#3

STRATEGY

Used to identify grouping of blocks. This
data is not checked or processed by the
block.

Msg type = VAR
Data type = Unsigned16 (2)
Store = Static
Access = RW (OOS) or RW (Auto)
Available in Release 1.0

—

#4

ALERT_KEY

The identification number of the plant unit.
This information may be used in the host
for sorting alarms, etc.

Msg type = VAR
Data type = Unsigned8 (1)
Store = Static
Access = RW (OOS) or RW (Auto)
Available in Release 1.0

1 to 255

#5

MODE_BLK

The actual, target, permitted, and normal
modes of the block.

Msg type = REC
Data type = DS-69 (4)
Store = Mixed
Access = RW (OOS) or RW (Auto)
Available in Release 1.0

See section 2.6 of FF-891

#6

BLOCK_ERR

The error status associated with the
hardware or software components
associated with a block.

Msg type = STR
Data type = BIT STRING (2)
Store = Dynamic/20
Access = Read only
Available in Release 1.0

See section 4.8 of FF-903
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Index and name Description List of values

#7

UPDATE_EVT

Occurs when a static parameter is changed
while a block mode is not in out of service
(OOS) mode, or when the mode changes
from OOS mode and one or more static
parameters changed while the block was
OOS.

Msg type = REC
Data type = DS-73
Store = Dynamic
Access = RW in any mode
Available in Release 1.0

—

#8

BLOCK_ALM

A predefined set of 16 conditions that may
occur within a block.

Msg type = REC
Data type = DS-72
Store = Dynamic
Access = RW in any mode
Available in Release 9.0

—

#9

TRANSDUCER_
DIRECTORY

A directory that specifies the number and
starting indices of the data collections in
the transducer block.

Msg type = VAR
Data type = Unsigned16 (2)
Store = Static
Access = RW (OOS)
Available in Release 9.0

—

#10

TRANSDUCER_
TYPE

Identifies the transducer that follows.

Msg type = VAR
Data type = Unsigned16 (2)
Store = Static
Access = RW (OOS)
Available in Release 9.0

—

#11

TRANSDUCER_
TYPE_VER

Identifies the version of the transducer
block. Format is XXYY where XX is the major
spec revision and YY is the manufacturer
revision.

Msg type = VAR
Data type = Unsigned16 (2)
Store = Static
Access = RW (OOS)
Available in Release 9.0

—

#12

XD_ERROR

Used for all config, H/W, connection failure
of system problems in the block.

Msg type = VAR
Data type = Unsigned8 (1)
Store = Dynamic
Access = RW (OOS)
Available in Release 1.0

0 = No Error
18 = Calibration Error
19 = Configuration Error
20 = Electronics Failure
21 = Sensor Failure
26 = Process Error
27 = Calibration in Progress
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Index and name Description List of values

#13

COLLECTION_
DIRECTORY

Used for all config, H/W, and connection
failures of system problems in the block.

Msg type = VAR
Data type = Unsigned32 (4)
Store = Static
Access = RW (OOS)
Available in Release 9.0

—

A.6.3 Local display transducer blocks
Table A-19: Local display transducer blocks

Index and name Description List of values HW

#14

EN_LDO_TOT_RESET

Enable/Disable LDO totalizer reset

Msg type = ENUM
Data type = Unsigned16 (2)
Store = Static
Access = R/W in any mode
Available in Release 1.0

0 = Disable
1 = Enable

700
800

#15

EN_LDO_TOT_START_
STOP

Enable/Disable LDO totalizer start/
stop option

Msg type = ENUM
Data type = Unsigned16 (2)
Store = Static
Access = R/W in any mode
Available in Release 3.0

0 = Disable
1 = Enable

700
800

#16

EN_LDO_AUTO_SCROLL

Enable/Disable LDO auto scroll
feature

Msg type = ENUM
Data type = Unsigned16 (2)
Store = Static
Access = R/W in any mode
Available in Release 1.0

0 = Disable
1 = Enable

700
800
CDM
FDM
FVM

#17

EN_LDO_OFFLINE_MENU

Enable/Disable LDO offline menu
feature

Msg type = ENUM
Data type = Unsigned16 (2)
Store = Static
Access = R/W in any mode
Available in Release 1.0

0 = Disable
1 = Enable

700
800
CDM
FDM
FVM

#18

EN_LDO_OFFLINE_PWD

Enable/Disable LDO offline password

Msg type = ENUM
Data type = Unsigned16 (2)
Store = Static
Access = R/W in any mode
Available in Release 1.0

0 = Disable
1 = Enable

700
800
CDM
FDM
FVM
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Table A-19: Local display transducer blocks (continued)

Index and name Description List of values HW

#19

EN_LDO_ALARM_MENU

Enable/Disable LDO alarm menu

Msg type = ENUM
Data type = Unsigned16 (2)
Store = Static
Access = R/W in any mode
Available in Release 1.0

0 = Disable
1 = Enable

700
800
CDM
FDM
FVM

#20

EN_LDO_ACK_
ALL_ALARMS

Enable/Disable LDO acknowledge all
alarms feature

Msg type = ENUM
Data type = Unsigned16 (2)
Store = Static
Access = R/W in any mode
Available in Release 1.0

0 = Disable
1 = Enable

700
800
CDM
FDM
FVM

#21

LDO_OFFLINE_PWD

LDO offline password

Msg type = VAR
Data type = Unsigned16 (2)
Store = Static
Access = R/W in any mode
Available in Release 1.0

0 - 9999 700
800
CDM
FDM
FVM

#22

LDO_SCROLL_RATE

LDO scroll rate

Msg type = VAR
Data type = Unsigned16 (2)
Store = Static
Access = R/W in any mode
Available in Release 1.0

1 - 30 700
800
CDM
FDM
FVM

#23

LDO_BACKLIGHT_ON

LDO backlight control

Msg type = ENUM
Data type = Unsigned16 (2)
Store = Static
Access = R/W in any mode
Available in Release 3.0

0 = off
1 = on

700
800
CDM
FDM
FVM

#24

UI_Language

Display the language selection

Msg type = ENUM
Data type = Unsigned16 (2)
Store = Static
Access = R/W in any mode
Available in Release 4.0

0 = English
1 = German
2 = French
3 = Reserved
4 = Spanish

700
800
CDM
FDM
FVM
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Table A-19: Local display transducer blocks (continued)

Index and name Description List of values HW

#25 LDO_VAR_1_CODE
#26 LDO_VAR_2_CODE
#27 LDO_VAR_3_CODE
#28 LDO_VAR_4_CODE
#29 LDO_VAR_5_CODE
#30 LDO_VAR_6_CODE
#31 LDO_VAR_7_CODE
#32 LDO_VAR_8_CODE
#33 LDO_VAR_9_CODE
#34 LDO_VAR_10_CODE
#35 LDO_VAR_11_CODE
#36 LDO_VAR_12_CODE
#37 LDO_VAR_13_CODE
#38 LDO_VAR_14_CODE
#39 LDO_VAR_15_CODE

Displays the variable associated with
the code on the LDO

Msg type = ENUM
Data type = Unsigned16 (2)
Store = Static
Access = R/W in any mode
Available in Release 1.0 (4.0 for R/W)

0 = Mass Flow Rate [700, 800](1)

1 = Temperature
2 = Mass Total [700, 800]
3 = Density
4 = Mass Inventory [700, 800]
5 = Volume Flow Rate [700, 800]
6 = Volume Total [700, 800]
7 = Volume Inventory [700, 800]
15 = API: Corr Density
16 = API: Corr Vol Flow [700, 800]
17 = API: Corr Vol Total [700, 800]
18 = API: Corr Vol Inv [700, 800]
19 = API: Avg Density [700, 800]
20 = API: Avg Temp [700, 800]
21 = ED: Density At Ref
22 = ED: Density [SGU]
23 = ED: Std Vol Flow Rate [700,
800]
24 = ED: Std Vol Total [700, 800]
25 = ED: Std Vol Inventory [700,
800]
26 = ED: Net Mass Flow [700,
800]
27 = ED: Net Mass Total [700,
800]
28 = ED: Net Mass Inv [700, 800]
29 = ED: Net Vol Flow Rate [700,
800]
30 = ED: Net Vol Total [700, 800]
31 = ED: Net Vol Inventory [700,
800]
32 = ED: Concentration
33 = API: CTL [700, 800]
46 = Raw Tube Frequency [700,
800]
47 = Drive Gain
48 = Case Temperature [700,
800, CDM]
49 = LPO Amplitude [700,800,
CDM]
50 = RPO Amplitude
51 = Board Temperature
53 = Ext. Input Pressure
55 = Ext. Input Temp
56 = ED: Density (Baume) [700,
800]
62 = Gas Std Vol Flow [700, 800]
63 = Gas Std Vol Total [700, 800]
64 = Gat Std Vol Inventory [700,
800]
69 = Live Zero [700, 800]
159 = User Defined Equation
[CDM, FDM, FVM]

700
800
CDM
FDM
FVM

Configuration and Use Manual Transducer blocks and views
20000326 August 2022

Configuration and Use Manual 195



Table A-19: Local display transducer blocks (continued)

Index and name Description List of values HW

161 = Tube-Case Temperature
Differential [CDM]
168 = Quality Factor [FVM]
162 = Dynamic Viscosity [FVM]
163 = Kinematic Viscosity [FVM]
164 = Base Viscosity [FVM]
166 = CCAI [FVM]
167 = CII [FVM]
208 = Mass Flow Velocity [CDM]
215 = Time Period (upper 3 db
point) [CDM, FDM, FVM]
251 = None (not allowed on
LDO_VAR_1_CODE)

#40

FBUS_UI_ProcVarIndex

Process variable code

Msg type = ENUM
Data type = Unsigned16 (2)
Store = Static
Access = R/W in any mode
Available in Release 1.0 (4.0 for R/W)

Same as LDO_VAR_X_CODE 700
800
CDM
FDM
FVM

#41

UI_NumDecimals

The number of digits displayed to the
right of the decimal point for the
process variable selected with index
34

Msg type = ENUM
Data type = Unsigned16 (2)
Store = Static
Access = R/W in any mode
Available in Release 4.0

0 - 5 700
800
CDM
FDM
FVM

#42

UI_UpdatePeriodmsec

The period in milliseconds in which
the display is updated

Msg type = VAR
Data type = Unsigned16 (2)
Store = Static
Access = R/W in any mode
Available in Release 4.0

100 - 10000 700
800
CDM
FDM
FVM

#43

UI_EnableStatusLedBlinking

Enable/Disable display status LED
blinking

Msg type = ENUM
Data type = Unsigned16 (2)
Store = Static
Access = R/W in any mode
Available in Release 4.0

0 = Disable
1 = Enable

700
800
CDM
FDM
FVM

#44

UI_EnableAlarmPassword

Enable/Disable display alarm screen
password

Msg type = ENUM
Data type = Unsigned16 (2)
Store = Static
Access = R/W in any mode
Available in Release 4.0

0 = Disable
1 = Enable

700
800
CDM
FDM
FVM
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Table A-19: Local display transducer blocks (continued)

Index and name Description List of values HW

#45

LDO_FEATURE_KEY

Enabled features

Msg type = STR
Data type = BIT STRING (2)
Store = Static
Access = Read only
Available in Release 8.0

0x0000 = standard
0x0800 = Meter verification
0x0008 = Enhanced density
0x0010 = API

700
800
CDM
FDM
FVM

#46

LDO_SYS_AttachedCoreType

Indicates the attached core type

Msg type = ENUM
Data type = Unsigned16 (2)
Store = Static
Access = Read only
Available in Release 8.0

0 = CORE_UNKNOWN,
1 = CORE_700
2 = CORE_ECP
3 = CORE_S
4 = CORE_DENSITY
5 = CORE_DEN_CDM
6 = CORE_DEN_FDM
7 = CORE_DEN_FVM

700
800
CDM
FDM
FVM

(1) The list within the square bracket contains cores that support this value.

A.7 Petroleum measurement transducer blocks

A.7.1 View list for petroleum measurement transducer block
The following table lists the parameters contained in the transducer block for petroleum measurement
parameters.

Four views are defined for the petroleum measurement transducer block. The table also shows the applicable
views for each parameter, and the size of the parameter in that view, in bytes.

Index Name View

1 2 3 4

0 BLOCK_STRUCTURE — — — —

1 ST_REV 2 2 2 2

2 TAG_DESC — — — —

3 STRATEGY — — — 2

4 ALERT_KEY — — — 1

5 MODE_BLK 4 — 4 —

6 BLOCK_ERR 2 — 2 —

7 UPDATE_EVT — — — —

8 BLOCK_ALM — — — —

9 TRANSDUCER_DIRECTORY — — — —

10 TRANSDUCER_TYPE 2 2 2 2

11 TRANSDUCER_TYPE_VER 2 2 2 2

12 XD_ERROR 1 — 1 —
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Index Name View

1 2 3 4

13 COLLECTION_DIRECTORY — — — —

14 API_Corr_Density 5 — 5 —

15 API_Corr_Vol_Flow 5 — 5 —

16 API_Ave_Corr_Density 5 — 5 —

17 API_Ave_Corr_Temp 5 — 5 —

18 API_CTL 5 — 5 —

19 API_Corr_Vol_Total 5 — 5 —

20 API_Corr_Vol_Inv 5 — 5 —

21 API_Reset_Vol_Total — 2 — —

22 EN_API — — — 2

23 API_Ref_Temp — — — 4

24 API_TEC — — — 4

25 API_Table_Type — — — 2

26 API_FEATURE_KEY — — — 2

27 SNS_ResetAPIGSVInv — 2 — —

28 API_TEMPERATURE_UNITS 2 — — —

29 API_DENSITY_UNITS 2 — — —

30 API_VOL_FLOW_UNITS 2 — — —

31 APIRefPress 4 — — —

32 PM_SYS_AttachedCoreType — — — 2

33 API_PressureUnit 2 — — —

A.7.2 Standard fieldbus parameters for petroleum measurement
transducer blocks
Index and name Description List of values

#0

BLOCK_STRUCTURE

The beginning of the transducer block.

Msg type = VAR
Data type = DS_64 (5)
Store = Static
Access = RW (OOS) or RW (Auto)
Available in Release 1.0

—
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Index and name Description List of values

#1

ST_REV

The revision level of the static data
associated with the function block.
Incremented with each write of static store.

Msg type = VAR
Data type = Unsigned16 (2)
Store = Static
Access = Read only
Available in Release 1.0

—

#2

TAG_DESC

The user description of the intended block
application.

Msg type = STR
Data type = OCTET STRING (32)
Store = Static
Access = RW (OOS) or RW (Auto)
Available in Release 1.0

Any 32 characters

#3

STRATEGY

Used to identify grouping of blocks. This
data is not checked or processed by the
block.

Msg type = VAR
Data type = Unsigned16 (2)
Store = Static
Access = RW (OOS) or RW (Auto)
Available in Release 1.0

—

#4

ALERT_KEY

The identification number of the plant unit.
This information may be used in the host
for sorting alarms, etc.

Msg type = VAR
Data type = Unsigned8 (1)
Store = Static
Access = RW (OOS) or RW (Auto)
Available in Release 1.0

1 to 255

#5

MODE_BLK

The actual, target, permitted, and normal
modes of the block.

Msg type = REC
Data type = DS-69 (4)
Store = Mixed
Access = RW (OOS) or RW (Auto)
Available in Release 1.0

See section 2.6 of FF-891

#6

BLOCK_ERR

The error status associated with the
hardware or software components
associated with a block.

Msg type = STR
Data type = BIT STRING (2)
Store = Dynamic/20
Access = Read only
Available in Release 1.0

See section 4.8 of FF-903
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Index and name Description List of values

#7

UPDATE_EVT

Occurs when a static parameter is changed
while a block mode is not in out of service
(OOS) mode, or when the mode changes
from OOS mode and one or more static
parameters changed while the block was
OOS.

Msg type = REC
Data type = DS-73
Store = Dynamic
Access = RW in any mode
Available in Release 1.0

—

#8

BLOCK_ALM

A predefined set of 16 conditions that may
occur within a block.

Msg type = REC
Data type = DS-72
Store = Dynamic
Access = RW in any mode
Available in Release 9.0

—

#9

TRANSDUCER_
DIRECTORY

A directory that specifies the number and
starting indices of the data collections in
the transducer block.

Msg type = VAR
Data type = Unsigned16 (2)
Store = Static
Access = RW (OOS)
Available in Release 9.0

—

#10

TRANSDUCER_
TYPE

Identifies the transducer that follows.

Msg type = VAR
Data type = Unsigned16 (2)
Store = Static
Access = RW (OOS)
Available in Release 9.0

—

#11

TRANSDUCER_
TYPE_VER

Identifies the version of the transducer
block. Format is XXYY where XX is the major
spec revision and YY is the manufacturer
revision.

Msg type = VAR
Data type = Unsigned16 (2)
Store = Static
Access = RW (OOS)
Available in Release 9.0

—

#12

XD_ERROR

Used for all config, H/W, connection failure
of system problems in the block.

Msg type = VAR
Data type = Unsigned8 (1)
Store = Dynamic
Access = RW (OOS)
Available in Release 1.0

0 = No Error
18 = Calibration Error
19 = Configuration Error
20 = Electronics Failure
21 = Sensor Failure
26 = Process Error
27 = Calibration in Progress
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Index and name Description List of values

#13

COLLECTION_
DIRECTORY

Used for all config, H/W, and connection
failures of system problems in the block.

Msg type = VAR
Data type = Unsigned32 (4)
Store = Static
Access = RW (OOS)
Available in Release 9.0

—

A.7.3 Process variables for petroleum measurement transducer
blocks
Table A-20: Process variables for petroleum measurement transducer blocks

Index and name Description List of values HW

#14

API_Corr_Density

Temperature-corrected density

Msg type = VAR
Data type = DS-65 (5)
Store = Dynamic/20
Access = Read only
Available in Release 3.0

— 700
800
CDM
FDM
FVM

#15

API_Corr_Vol_Flow

Temperature-corrected (standard)
volume flow

Msg type = VAR
Data type = DS-65 (5)
Store = Dynamic/20
Access = Read only
Available in Release 3.0

— 700
800

#16

API_Ave_Corr_Density

Batch weighted average density

Msg type = VAR
Data type = DS-65 (5)
Store = Dynamic/20
Access = Read only
Available in Release 3.0

— 700
800
CDM
FDM
FVM

#17

API_Ave_Corr_Temp

Batch weighted average
temperature

Msg type = VAR
Data type = DS-65 (5)
Store = Dynamic/20
Access = Read only
Available in Release 3.0

— 700
800
CDM
FDM
FVM

#18

API_CTL

CTL

Msg type = VAR
Data type = DS-65 (5)
Store = Dynamic/20
Access = Read only
Available in Release 3.0

— 700
800
CDM
FDM
FVM
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Table A-20: Process variables for petroleum measurement transducer blocks (continued)

Index and name Description List of values HW

#19

API_Corr_Vol_Total

Temperature-corrected (standard)
volume total

Msg type = VAR
Data type = DS-65 (5)
Store = Dynamic/20
Access = Read only
Available in Release 3.0

— 700
800

#20

API_Corr_Vol_Inv

Temperature-corrected (standard)
volume inventory

Msg type = VAR
Data type = DS-65 (5)
Store = Dynamic/20
Access = Read only
Available in Release 3.0

— 700
800

#21

API_Reset_Vol_Total

Reset API reference volume total

Msg type = VAR
Data type = DS-66 (2)
Store = —
Access = R/W in any mode
Available in Release 3.0

Value part of DS-66
0 = No effect
1 = Reset

700
800

A.7.4 Setup data for petroleum measurement transducer blocks
Table A-21: Setup data for petroleum measurement transducer blocks

Index and name Description List of values HW

#22

EN_API

Enable/Disable petroleum
measurement

Msg type = ENUM
Data type = Unsigned16 (2)
Store = Static
Access = Read only
Available in Release 3.0

0 = disabled
1 = enabled

700
800
CDM
FDM
FVM

#23

API_Ref_Temp

Petroleum measurement reference
temperature

Msg type = VAR
Data type = FLOAT (4)
Store = Static
Access = R/W (OOS)
Available in Release 3.0

— 700
800
CDM
FDM
FVM

#24

API_TEC

Petroleum measurement thermal
expansion coeff

Msg type = VAR
Data type = FLOAT (4)
Store = Static
Access = R/W (OOS)
Available in Release 3.0

— 700
800
CDM
FDM
FVM
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Table A-21: Setup data for petroleum measurement transducer blocks (continued)

Index and name Description List of values HW

#25

API_Table_Type

Petroleum measurment 2540 CTL
table type

Msg type = ENUM
Data type = Unsigned16 (2)
Store = Static
Access = R/W (OOS)
Available in Release 3.0

17 = Table 5A
18 = Table 5B
19 = Table 5D
36 = Table 6C
49 = Table 23A
50 = Table 23B
51 = Table 23D
68 = Table 24C
81 = Table 53A
82 = Table 53B
83 = Table 53D
100 = Table 54C
53 = Table 23E [CDM, FDM,
FVM](1)

69 = Table 24E [CDM, FDM, FVM]

700
800
CDM
FDM
FVM

#26

API_FEATURE_KEY

Enabled features

Msg type = STR
Data type = BIT STRING (2)
Store = Static
Access = Read only
Available in Release 3.0

0x0000 = standard
0x0800 = Meter verification
0x0008 = Enhanced density
0x0010 = API

700
800
CDM
FDM
FVM

#27

SNS_ResetAPIGSVInv

Reset PM/GSV inventory

Msg type = METHOD
Data type = Unsigned16 (2)
Store = Static
Access = R/W in any mode
Available in Release 4.0

0 = No effect
1 = Reset

700
800

#28

API_TEMPERATURE_UNITS

Temperature unit

Msg type = ENUM
Data type = Unsigned16 (2)
Store = Dynamic
Access = Read only
Available in Release 4.0

1000 = K
1001 = Deg C
1002 = Deg F
1003 = Deg R

700
800
CDM
FDM
FVM

#29

API_DENSITY_UNITS

Density unit

Msg type = ENUM
Data type = Unsigned16 (2)
Store = Dynamic
Access = R/W (OOS)
Available in Release 4.0

1097 = kg/m3
1100 = g/cm3
1103 = kg/L
1104 = g/ml
1105 = g/L
1106 = lb/in3
1107 = lb/ft3
1108 = lb/gal
1109 = Ston/yd3
1113 = DegAPI
1114 = SGU

700
800
CDM
FDM
FVM
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Table A-21: Setup data for petroleum measurement transducer blocks (continued)

Index and name Description List of values HW

#30

API_VOL_FLOW_UNITS

Standard or special volume flow rate
unit

Msg type = ENUM
Data type = Unsigned16 (2)
Store = Dynamic
Access = Read only
Available in Release 6.0

1347 = m3/s
1348 = m 3/min
1349 = m3/h
1350 = m3/d
1351 = L/s
1352 = L/min
1353 = L/h
1355 = ML/d
1356 = CFS
1357 = CFM
1358 = CFH
1359 = ft3/d
1362 = gal/s
1363 = GPM
1364 = gal/h
1365 = gal/d
1366 = Mgal/d
1367 = ImpGal/s
1368 = ImpGal/m
1369 = ImpGal/h
1370 = Impgal/d
1371 = bbl/s
1372 = bbl/min
1373 = bbl/h
1374 = bbl/d
1631 = barrel(US Beer)/d
1632 = barrel(US Beer)/h
1633 = barrel(US Beer)/min
1634 = barrel(US Beer)/s
253 = Special [700, 800](1)

700
800

#31

APIRefPress

Alternate pressure

Msg type = VAR
Data type = FLOAT (4)
Store = Dynamic
Access = R/W (OOS)
Available in Release 8.0

— CDM
FDM
FVM

#32

PM_SYS_AttachedCoreType

Indicates the attached core type

Msg type = ENUM
Data type = Unsigned16 (2)
Store = Static
Access = Read only
Available in Release 8.0

0 = CORE_UNKNOWN
1 = CORE_700
2 = CORE_ECP
3 = CORE_S
4 = CORE_DENSITY
5 = CORE_DEN_CDM
6 = CORE_DEN_FDM
7 = CORE_DEN_FVM

700
800
CDM
FDM
FVM
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Table A-21: Setup data for petroleum measurement transducer blocks (continued)

Index and name Description List of values HW

#33

API_PressureUnit

Pressure units

Msg type = ENUM
Data type = Unsigned16 (2)
Store = Static
Access = R/W (OOS)
Available in Release 8.0

1148 = inH2O (68°F)
1724 = InH2O@60°F
1156 = inHg (0°C)
1154 = ftH2O (68°F)
1151 = mmH2O (68°F)
1158 = mmHg (0°C)
1141 = psi
1137 = bar
1138 = mbar
1144 = g/cm2
1145 = kg/cm2
1130 = Pa
1132 = MPa
1133 = kPa
1139 = torr
1140 = atm
1147 = inH2O (4°C)
1150 = mmH2O (4°C)

700
800
CDM
FDM
FVM

#34

API_VOL_TOT_UNITS

Volume flow total unit

Msg type = ENUM
Data type = Unsigned16 (2)
Store = Dynamic
Access = Read only
Available in Release 8.0

1034 = m3
1036 = cm3
1038 = L
1043 = ft3
1048 = gallon
1049 = ImpGal
1051 = bbl
253 = Special units.

(1) The list within the square bracket contains cores that support this value.

A.8 Concentration measurement transducer blocks

A.8.1 View list for concentration measurement transducer block
The following table lists the parameters contained in the transducer block for concentration measurement
parameters.

Four views are defined for the concentration measurement transducer block. The table also shows the
applicable views for each parameter, and the size of the parameter in that view, in bytes.

Index Name View

1 2 3 4

0 BLOCK_STRUCTURE — — — —

1 ST_REV 2 2 2 2

2 TAG_DESC — — — —

3 STRATEGY — — — 2

4 ALERT_KEY — — — 1

5 MODE_BLK 4 — 4 —
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Index Name View

1 2 3 4

6 BLOCK_ERR 2 — 2 —

7 UPDATE_EVT — — — —

8 BLOCK_ALM — — — —

9 TRANSDUCER_DIRECTORY — — — —

10 TRANSDUCER_TYPE 2 2 2 2

11 TRANSDUCER_TYPE_VER 2 2 2 2

12 XD_ERROR 1 — 1 —

13 COLLECTION_DIRECTORY — — — —

14 ED_Ref_Dens 5 — 5 —

15 ED_Spec_Grav 5 — 5 —

16 ED_Std_Vol_Flow 5 — 5 —

17 ED_Net_Mass_Flow 5 — 5 —

18 ED_Net_Vol_Flow 5 — 5 —

19 ED_Conc 5 — 5 —

20 ED_Baume 5 — 5 —

21 ED_Std_Vol_Total 5 — 5 —

22 ED_Std_Vol_Inv 5 — 5 —

23 ED_Net_Mass_Total 5 — 5 —

24 ED_Net_Mass_Inv 5 — 5 —

25 ED_Net_Vol_Total 5 — 5 —

26 ED_Net_Vol_Inv 5 — 5 —

27 ED_Reset_Std_Vol_Total — 2 — —

28 ED_Reset_Net_Mass_Total — 2 — —

29 ED_Reset_Net_Vol_Total — 2 — —

30 EN_ED — — — 2

31 ED_Curve_Lock — — — 2

32 ED_Mode — — — 2

33 ED_Active_Curve — — — 2

34 ED_Curve_Index — — — 2

35 ED_Temp_Index — — — 2

36 ED_Conc_Index — — — 2

37 ED_Temp_ISO — — — 4

38 ED_Dens_At_Temp_ISO — — — 4
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Index Name View

1 2 3 4

39 ED_Dens_At_Temp_Coeff — — — 4

40 ED_Conc_Label_55 — — — 4

41 ED_Dens_At_Conc — — — 4

42 ED_Dens_At_Conc_Coeff — — — 4

43 ED_Conc_Label_51 — — — 4

44 ED_Ref_Temp — — — 4

45 ED_SG_Water_Ref_Temp — — — 4

46 ED_SG_Water_Ref_Dens — — — 4

47 ED_Slope_Trim — — — 4

48 ED_Slope_Offset — — — 4

49 ED_Extrap_Alarm_Limit — — — 4

50 ED_Curve_Name — — — 12

51 ED_Max_Fit_Order — — — 2

52 ED_Fit_Results — — 2 —

53 ED_Conc_Unit_Code — 2 — —

54 ED_Expected_Acc — 4 — —

55 ED_FEATURE_KEY — — — 2

56 SNS_ResetEDVolInv — 2 — —

57 SNS_ResetEDNetMassInv — 2 — —

58 SNS_ResetEDNetVolInv — 2 — —

59 SNS_ED_ResetFlag — 2 — —

60 SNS_ED_EnableDensLowExtrap — — — 2

61 SNS_ED_EnableDensHighExtrap — — — 2

62 SNS_ED_EnableTempLowExtrap — — — 2

63 SNS_ED_EnableTempHighExtrap — — — 2

64 ED_TEMPERATURE_UNITS 2 — — —

65 ED_DENSITY_UNITS 2 — — —

66 ED_VOL_FLOW_UNITS 2 — — —

67 ED_Increment_Curve — — 2 —

68 DEN_SelectConcEqn — — — 2

69 DEN_Enable_CMAutoswitch — 2 — —

70 ED_SYS_AttachedCoreType — 2 — —

71 SNS_ED_ConcUnits_SpecialUnit — 8 — —
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Index Name View

1 2 3 4

72 ED_MASSFLOW_UNITS — — 2 —

73 ED_VOL_TOT_UNITS — — 2 —

74 ED_MASS_TOT_UNITS — — 2 —

A.8.2 Standard fieldbus parameters for concentration
measurement transducer blocks
Index and name Description List of values

#0

BLOCK_STRUCTURE

The beginning of the transducer block.

Msg type = VAR
Data type = DS_64 (5)
Store = Static
Access = RW (OOS) or RW (Auto)
Available in Release 1.0

—

#1

ST_REV

The revision level of the static data
associated with the function block.
Incremented with each write of static store.

Msg type = VAR
Data type = Unsigned16 (2)
Store = Static
Access = Read only
Available in Release 1.0

—

#2

TAG_DESC

The user description of the intended block
application.

Msg type = STR
Data type = OCTET STRING (32)
Store = Static
Access = RW (OOS) or RW (Auto)
Available in Release 1.0

Any 32 characters

#3

STRATEGY

Used to identify grouping of blocks. This
data is not checked or processed by the
block.

Msg type = VAR
Data type = Unsigned16 (2)
Store = Static
Access = RW (OOS) or RW (Auto)
Available in Release 1.0

—

#4

ALERT_KEY

The identification number of the plant unit.
This information may be used in the host
for sorting alarms, etc.

Msg type = VAR
Data type = Unsigned8 (1)
Store = Static
Access = RW (OOS) or RW (Auto)
Available in Release 1.0

1 to 255
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Index and name Description List of values

#5

MODE_BLK

The actual, target, permitted, and normal
modes of the block.

Msg type = REC
Data type = DS-69 (4)
Store = Mixed
Access = RW (OOS) or RW (Auto)
Available in Release 1.0

See section 2.6 of FF-891

#6

BLOCK_ERR

The error status associated with the
hardware or software components
associated with a block.

Msg type = STR
Data type = BIT STRING (2)
Store = Dynamic/20
Access = Read only
Available in Release 1.0

See section 4.8 of FF-903

#7

UPDATE_EVT

Occurs when a static parameter is changed
while a block mode is not in out of service
(OOS) mode, or when the mode changes
from OOS mode and one or more static
parameters changed while the block was
OOS.

Msg type = REC
Data type = DS-73
Store = Dynamic
Access = RW in any mode
Available in Release 1.0

—

#8

BLOCK_ALM

A predefined set of 16 conditions that may
occur within a block.

Msg type = REC
Data type = DS-72
Store = Dynamic
Access = RW in any mode
Available in Release 9.0

—

#9

TRANSDUCER_
DIRECTORY

A directory that specifies the number and
starting indices of the data collections in
the transducer block.

Msg type = VAR
Data type = Unsigned16 (2)
Store = Static
Access = RW (OOS)
Available in Release 9.0

—

#10

TRANSDUCER_
TYPE

Identifies the transducer that follows.

Msg type = VAR
Data type = Unsigned16 (2)
Store = Static
Access = RW (OOS)
Available in Release 9.0

—
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Index and name Description List of values

#11

TRANSDUCER_
TYPE_VER

Identifies the version of the transducer
block. Format is XXYY where XX is the major
spec revision and YY is the manufacturer
revision.

Msg type = VAR
Data type = Unsigned16 (2)
Store = Static
Access = RW (OOS)
Available in Release 9.0

—

#12

XD_ERROR

Used for all config, H/W, connection failure
of system problems in the block.

Msg type = VAR
Data type = Unsigned8 (1)
Store = Dynamic
Access = RW (OOS)
Available in Release 1.0

0 = No Error
18 = Calibration Error
19 = Configuration Error
20 = Electronics Failure
21 = Sensor Failure
26 = Process Error
27 = Calibration in Progress

#13

COLLECTION_
DIRECTORY

Used for all config, H/W, and connection
failures of system problems in the block.

Msg type = VAR
Data type = Unsigned32 (4)
Store = Static
Access = RW (OOS)
Available in Release 9.0

—

A.8.3 Process variables for concentration measurement transducer
blocks
Table A-22: Process variables for concentration measurement transducer blocks

Index and name Description List of values HW

#14

ED_Ref_Dens

Density at reference

Msg type = VAR
Data type = DS-65 (5)
Store = Dynamic/20
Access = Read only
Available in Release 3.0

— 800
CDM
FDM
FVM

#15

ED_Spec_Grav

Density (fixed special gravity units)

Msg type = VAR
Data type = DS-65 (5)
Store = Dynamic/20
Access = Read only
Available in Release 3.0

— 800
CDM
FDM
FVM

#16

ED_Std_Vol_Flow

Standard volume flow rate

Msg type = VAR
Data type = DS-65 (5)
Store = Dynamic/20
Access = Read only
Available in Release 3.0

— 800
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Table A-22: Process variables for concentration measurement transducer blocks (continued)

Index and name Description List of values HW

#17

ED_Net_Mass_Flow

Net mass flow rate

Msg type = VAR
Data type = DS-65 (5)
Store = Dynamic/20
Access = Read only
Available in Release 3.0

— 800
CDM
FDM
FVM

#18

ED_Net_Vol_Flow

Net volume flow rate

Msg type = VAR
Data type = DS-65 (5)
Store = Dynamic/20
Access = Read only
Available in Release 3.0

— 800
CDM
FDM
FVM

#19

ED_Conc

Concentration

Msg type = VAR
Data type = DS-65 (5)
Store = Dynamic/20
Access = Read only
Available in Release 3.0

— 800
CDM
FDM
FVM

#20

ED_Baume

Density (fixed baume units)

Msg type = VAR
Data type = DS-65 (5)
Store = Dynamic/20
Access = Read only
Available in Release 3.0

— 800

A.8.4 Totals for concentration measurement transducer blocks
Table A-23: Totals for concentration measurement transducer blocks

Index and name Description List of values HW

#21

ED_Std_Vol_Total

Standard volume total

Msg type = VAR
Data type = DS-65 (5)
Store = Dynamic/20
Access = Read only
Available in Release 3.0

— 800

#22

ED_Std_Vol_Inv

Standard volume inventory

Msg type = VAR
Data type = DS-65 (5)
Store = Dynamic/20
Access = Read only
Available in Release 3.0

— 800
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Table A-23: Totals for concentration measurement transducer blocks (continued)

Index and name Description List of values HW

#23

ED_Net_Mass_Total

Net mass total

Msg type = VAR
Data type = DS-65 (5)
Store = Dynamic/20
Access = Read only
Available in Release 3.0

— 800

#24

ED_Net_Mass_Inv

Net mass inventory

Msg type = VAR
Data type = DS-65 (5)
Store = Dynamic/20
Access = Read only
Available in Release 3.0

— 800

#25

ED_Net_Vol_Total

Net volume total

Msg type = VAR
Data type = DS-65 (5)
Store = Dynamic/20
Access = Read only
Available in Release 3.0

— 800

#26

ED_Net_Vol_Inv

Net volume inventory

Msg type = VAR
Data type = DS-65 (5)
Store = Dynamic/20
Access = Read only
Available in Release 3.0

— 800

#27

ED_Reset_Std_Vol_Total

Reset concentration measurement
standard volume total

Msg type = VAR
Data type = DS-66 (2)
Store = —
Access = R/W in any mode
Available in Release 3.0

Value part of DS-66
1 = Reset

700
800

#28

ED_Reset_Net_Mass_Total

Reset concentration measurement
net mass total

Msg type = VAR
Data type = DS-66 (2)
Store = —
Access = R/W in any mode
Available in Release 3.0

Value part of DS-66
1 = Reset

700
800

#29

ED_Reset_Net_Vol_Total

Reset concentration measurement
net volume total

Msg type = VAR
Data type = DS-66 (2)
Store = —
Access = R/W in any mode
Available in Release 3.0

Value part of DS-66
1 = Reset

700
800
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A.8.5 Setup data for concentration measurement transducer blocks
Table A-24: Setup data for concentration measurement transducer blocks

Index and name Description List of values HW

#30

EN_ED

Enable/Disable enhanced density

Msg type = ENUM
Data type = Unsigned16 (2)
Store = Static
Access = Read only
Available in Release 3.0

0 = disabled
1 = enabled

700
800
CDM
FDM
FVM

#31

ED_Curve_Lock

Lock enhanced density tables

Msg type = ENUM
Data type = Unsigned16 (2)
Store = Static
Access = R/W (OOS)
Available in Release 3.0

0 = not locked
1 = locked

700

#32

ED_Mode

Enhanced density mode

Msg type = ENUM
Data type = Unsigned16 (2)
Store = Static
Access = R/W (OOS)
Available in Release 3.0

0 = None
1= Dens @ Ref Temp
2= Specific Gravity
3= Mass Conc (Dens)
4=Mass Conc (SG)
5= Volume Conc (Dens)
6= Volume Conc (SG)
7= Concentration (Dens)
8 = Concentration (SG)

700
800
CDM
FDM
FVM

#33

ED_Active_Curve

Active calculation curve

Msg type = VAR
Data type = Unsigned16 (2)
Store = Static
Access = R/W in any mode
Available in Release 3.0

0 - 5 700
800
CDM
FDM
FVM

#34

ED_Curve_Index

Curve configuration index (n)

Msg type = VAR
Data type = Unsigned16 (2)
Store = Static
Access = R/W in any mode
Available in Release 3.0

0 - 5 700
800
CDM
FDM
FVM

#35

ED_Temp_Index

Curven temperature isotherm index
(x-axis)

Msg type = VAR
Data type = Unsigned16 (2)
Store = Static
Access = R/W in any mode
Available in Release 3.0

0 - 5 700
800
CDM
FDM
FVM

#36

ED_Conc_Index

Curven concentration index (y-axis)

Msg type = VAR
Data type = Unsigned16 (2)
Store = Static
Access = R/W in any mode
Available in Release 3.0

0 - 5 700
800
CDM
FDM
FVM
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Table A-24: Setup data for concentration measurement transducer blocks (continued)

Index and name Description List of values HW

#37

ED_Temp_ISO

Curven (6x5) temperature
isothermx value (x-axis)

Msg type = VAR
Data type = FLOAT (4)
Store = Static
Access = R/W (OOS)
Available in Release 3.0

— 700
800
CDM
FDM
FVM

#38

ED_Dens_At_Temp_ISO

Curven (6x5) density @ temperature
isothermx, concentrationY

Msg type = VAR
Data type = FLOAT (4)
Store = Static
Access = R/W (OOS)
Available in Release 3.0

— 700
800
CDM
FDM
FVM

#39

ED_Dens_At_Temp_Coeff

Curven (6x5) Coeff @ temperature
isothermX, concentrationY

Msg type = VAR
Data type = FLOAT (4)
Store = Static
Access = R/W (OOS)
Available in Release 3.0

— 700
800
CDM
FDM
FVM

#40

ED_Conc_Label_55

Curven (6x5) concentrationY value
(label for y-axis)

Msg type = VAR
Data type = FLOAT (4)
Store = Static
Access = R/W (OOS)
Available in Release 3.0

— 700
800
CDM
FDM
FVM

#41

ED_Dens_At_Conc

Curven (5x1) density at
concentrationY (at ref temp)

Msg type = VAR
Data type = FLOAT (4)
Store = Static
Access = R/W (OOS)
Available in Release 3.0

— 700
800
CDM
FDM
FVM

#42

ED_Dens_At_Conc_Coeff

Curven (5x1) coeff at
concentrationY (at ref temp)

Msg type = VAR
Data type = FLOAT (4)
Store = Static
Access = R/W (OOS)
Available in Release 3.0

— 700
800
CDM
FDM
FVM
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Table A-24: Setup data for concentration measurement transducer blocks (continued)

Index and name Description List of values HW

#43

ED_Conc_Label_51

Curven (5x1) concentrationY value
(y-axis)

Msg type = VAR
Data type = FLOAT (4)
Store = Static
Access = R/W (OOS)
Available in Release 3.0

— 700
800
CDM
FDM
FVM

#44

ED_Ref_Temp

Curven reference temperature

Msg type = VAR
Data type = FLOAT (4)
Store = Static
Access = R/W (OOS)
Available in Release 3.0

— 700
800
CDM
FDM
FVM

#45

ED_SG_Water_Ref_Temp

Curven specific gravity water
reference temperature

Msg type = VAR
Data type = FLOAT (4)
Store = Static
Access = R/W (OOS)
Available in Release 3.0

— 700
800
CDM
FDM
FVM

#46

ED_SG_Water_Ref_Dens

Curven specific gravity water
reference density

Msg type = VAR
Data type = FLOAT (4)
Store = Static
Access = R/W (OOS)
Available in Release 3.0

— 700
800
CDM
FDM
FVM

#47

ED_Slope_Trim

Curven slope trim

Msg type = VAR
Data type = FLOAT (4)
Store = Static
Access = R/W (OOS)
Available in Release 3.0

> 0.8 700
800
CDM
FDM
FVM

#48

ED_Slope_Offset

Curven offset trim

Msg type = VAR
Data type = FLOAT (4)
Store = Static
Access = R/W (OOS)
Available in Release 3.0

— 700
800
CDM
FDM
FVM

#49

ED_Extrap_Alarm_Limit

Curven extrapolation alarm limit: %

Msg type = VAR
Data type = FLOAT (4)
Store = Static
Access = R/W in any mode
Available in Release 3.0

— 700
800
CDM
FDM
FVM
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Table A-24: Setup data for concentration measurement transducer blocks (continued)

Index and name Description List of values HW

#50

ED_Curve_Name

Curven ASCII string – name of curve
– 12 characters supported

Msg type = VAR
Data type = VISIBLE STRING (12)
Store = Static
Access = R/W in any mode
Available in Release 3.0

— 700
800
CDM
FDM
FVM

#51

ED_Max_Fit_Order

Maximum fit order for 5x5 curve

Msg type = VAR
Data type = Unsigned16 (2)
Store = Static
Access = R/W (OOS)
Available in Release 3.0

2, 3, 4, 5 (Accepts only enum
values)

700
800
CDM
FDM
FVM

#52

ED_Fit_Results

Curven curve fit results

Msg type = ENUM
Data type = Unsigned16 (2)
Store = Dynamic
Access = Read only
Available in Release 3.0

0 = Good
1 = Poor
2 = Failed
3 = Empty

700
800
CDM
FDM
FVM

#53

ED_Conc_Unit_Code

Curven concentration units code

Msg type = ENUM
Data type = Unsigned16 (2)
Store = Static
Access = R/W (OOS)
Available in Release 3.0

1110 = Degrees Twaddell
1426= Degrees Brix
1111= Deg Baume (heavy)
1112= Deg Baume (light)
1343=% sol/wt
1344=% sol/vol
1427= Degrees Balling
1428= Proof Per Volume
1429 = Proof Per mass
1346 = Percent Plato
253 = Special Unit
255 = Special Concentration
Unit [CDM, FDM, FVM]

700
800
CDM
FDM
FVM

#54

ED_Expected_Acc

Curven curve fit expected accuracy

Msg type = VAR
Data type = FLOAT (4)
Store = Static
Access = Read only
Available in Release 3.0

— 700
800
CDM
FDM
FVM

#55

ED_FEATURE_KEY

Enabled features

Msg type = STR
Data type = BIT STRING (2)
Store = Static
Access = Read only
Available in Release 3.0

0x0000 = standard
0x0800 = Meter verification
0x0008 = Enhanced density
0x0010 = API

700
800
CDM
FDM
FVM

Transducer blocks and views Configuration and Use Manual
August 2022 20000326

216 Micro Motion 2700 Transmitters with FOUNDATION Fieldbus



A.8.6 Other additions for concentration measurement transducer
blocks
Table A-25: Other additions for concentration measurement transducer blocks

Index and name Description List of values HW

#56

SNS_ResetEDVolInv

Reset concentration measurement
volume inventory

Msg type = METHOD
Data type = Unsigned16 (2)
Store = Static
Access = R/W in any mode
Available in Release 4.0

0 = No effect
1 = Reset

700
800

#57

SNS_ResetEDNetMassInv

Reset concentration measurement
net mass inventory

Msg type = METHOD
Data type = Unsigned16 (2)
Store = Static
Access = R/W in any mode
Available in Release 4.0

0 = No effect
1 = Reset

700
800

#58

SNS_ResetEDNetVolInv

Reset concentration measurement
net volume inventory

Msg type = METHOD
Data type = Unsigned16 (2)
Store = Static
Access = R/W in any mode
Available in Release 4.0

0 = No effect
1 = Reset

700
800

#59

SNS_ED_ResetFlag

Reset all enhanced density curve
information

Msg type = METHOD
Data type = Unsigned16 (2)
Store = Static
Access = R/W (OOS)
Available in Release 4.0

1 = Reset 800
CDM
FDM
FVM

#60

SNS_ED_EnableDensLow
Extrap

Enable low density extrapolation
alarm

Msg type = ENUM
Data type = Unsigned16 (2)
Store = Static
Access = R/W in any mode
Available in Release 4.0

1 = Enable 800
CDM
FDM
FVM

#61

SNS_ED_EnableDensHighExtra
p

Enable high density extrapolation
alarm

Msg type = ENUM
Data type = Unsigned16 (2)
Store = Static
Access = R/W in any mode
Available in Release 4.0

1 = Enable 800
CDM
FDM
FVM
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Table A-25: Other additions for concentration measurement transducer blocks (continued)

Index and name Description List of values HW

#62

SNS_ED_EnableTempLow
Extrap

Enable low temperature
extrapolation alarm

Msg type = ENUM
Data type = Unsigned16 (2)
Store = Static
Access = R/W in any mode
Available in Release 4.0

1 = Enable 800
CDM
FDM
FVM

#63

SNS_ED_EnableTempHigh
Extrap

Enable high temperature
extrapolation alarm

Msg type = ENUM
Data type = Unsigned16 (2)
Store = Static
Access = R/W in any mode
Available in Release 4.0

1 = Enable 800
CDM
FDM
FVM

#64

ED_TEMPERATURE_UNITS

Temperature unit

Msg type = ENUM
Data type = Unsigned16 (2)
Store = Dynamic
Access = Read only
Available in Release 6.0

1000 = K
1001 = Deg C
1002 = Deg F
1003 = Deg R

700
800
CDM
FDM
FVM

#65

ED_DENSITY_UNITS

Density unit

Msg type = ENUM
Data type = Unsigned16 (2)
Store = Dynamic
Access = Read only
Available in Release 6.0

1097 = kg/m3
1100 = g/cm3
1103 = kg/L
1104 = g/ml
1105 = g/L
1106 = lb/in3
1107 = lb/ft3
1108 = lb/gal
1109 = Ston/yd3
1113 = DegAPI (not for density
and viscosity)
1114 = SGU (not for density and
viscosity)
253 = Special [CDM, FDM, FVM]

700
800
CDM
FDM
FVM
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Table A-25: Other additions for concentration measurement transducer blocks (continued)

Index and name Description List of values HW

#66

ED_VOL_FLOW_UNITS

Standard or special volume flow rate
unit

Msg type = ENUM
Data type = Unsigned16 (2)
Store = Dynamic
Access = Read only
Available in Release 6.0

1347 = m3/s
1348 = m 3/min
1349 = m3/hr
1350 = m3/day
1351 = L/s
1352 = L/min
1353 = L/hr
1355 = Ml/day
1356 = CFS
1357 = CFM
1358 = CFH
1359 = ft3/day / standard cubic
ft. per day
1362 = gal/s
1363 = GPM
1364 = gal/hour
1365 = gal/day
1366 = Mgal/day
1367 = ImpGal/s
1368 = ImpGal/min
1369 = ImpGal/hr
1370 = Impgal/day
1371 = bbl/s
1372 = bbl/min
1373 = bbl/hr
1374 = bbl/day
1631 = barrel (US beer) per day
1632 = barrel (US beer) per hour
1633 = barrel (US beer) per
minute
1634 =barrel (US Beer) per
second
253 = Special units [700, 800]

700
800
CDM

#67

ED_Increment_Curve

Increment the active curve to the
next one

Msg type = VAR
Data type = DS-66 (2)
Store = —
Access = R/W in any mode
Available in Release 7.0

Value part of DS-66
0 = None
1 = Increment

700
800

#68

DEN_SelectConcEqn

Select predefined concentration
equations

Msg type = VAR
Data type = Unsigned16 (2)
Store = Static
Access = R/W
Available in Release 8.0

0 = Concentration Matrix
1 = degreeBaume
2 = degeeTwaddle
3 = degreePlato
4 = degBrix

CDM
FDM
FVM
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Table A-25: Other additions for concentration measurement transducer blocks (continued)

Index and name Description List of values HW

#69

DEN_Enable_CMAutoswitch

Enable concentration measurement
curve auto-switching

Msg type = VAR
Data type = Unsigned16 (2)
Store = —
Access = R/W
Available in Release 8.0

0 = disabled
1 = enabled

CDM
FDM
FVM

#70

ED_SYS_AttachedCoreType

Indicates the attached core type

Msg type = ENUM
Data type = Unsigned16 (2)
Store = Static
Access = Read only
Available in Release 8.0

0 = CORE_UNKNOWN
1 = CORE_700
2 = CORE_ECP
3 = CORE_S
4 = CORE_DENSITY
5 = CORE_DEN_CDM
6 = CORE_DEN_FDM
7 = CORE_DEN_FVM

700
800
CDM
FDM
FVM

#71

SNS_ED_ConcUnits_SpecialUni
t

Curven concentration units special
unit label

Msg type = STR
Data type = Visible String
Store = Static
Access = R/W (OOS)
Available in Release 8.0

— 700
800
CDM
FDM
FVM

#72

ED_MASSFLOW_UNITS

Mass flow unit

Msg type = ENUM
Data type = Unsigned16 (2)
Store = Dynamic
Access = R/W (OOS)
Available in Release 8.0

1318 = g/s
1319 = g/min
1320 = g/hr
1322 = kg/s
1323 = kg/min
1324 = kg/hr
1325 = kg/day
1327 = t/min
1328 = t/h
1329 = t/d
1330 = lb/s
1331 = lb/min
1332 = lb/hr
1333 = lb/day
1335 = Ston/min
1336 = Ston/hr
1337 = Ston/day
1340 = Lton/hr
1341 = Lton/day
253 = Special units

800
CDM

#73

ED_VOL_TOT_UNITS

Volume flow total unit

Msg type = ENUM
Data type = Unsigned16 (2)
Store = Dynamic
Access = Read only
Available in Release 9.0

1034 = m3
1036 = cm3
1038 = L
1043 = ft3
1048 = gallon
1049 = ImpGal
1051 = bbl
253 = Special units.

700
800
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Table A-25: Other additions for concentration measurement transducer blocks (continued)

Index and name Description List of values HW

#74

ED_MASS_TOT_UNITS

Standard or special mass total and
mass inventory unit

Msg type = ENUM
Data type = Unsigned16 (2)
Store = Dynamic
Access = Read only
Available in Release 9.0

1089 = g
1088 = kg
1092 = t
1094 = lb
1095 = STon
1096 = Lton
253 = Special units

700
800
CDM
FDM
FVM

A.9 Density viscosity meter transducer blocks

A.9.1 View list for density viscosity meter transducer block
The following table lists the parameters contained in the transducer block for density viscosity meter
parameters.

Eight views are defined for the density viscosity meter transducer block. The table also shows the applicable
views for each parameter, and the size of the parameter in that view, in bytes.

Index Name View

1 2 3 4_1 4_2 4_3 4_4 4_5

0 BLOCK_STRUCTURE — — — — — — — —

1 ST_REV 2 2 2 2 2 2 2 2

2 TAG_DESC — — — — — — — —

3 STRATEGY — — — 2 — — — —

4 ALERT_KEY — — — 1 — — — —

5 MODE_BLK 4 — 4 — — — — —

6 BLOCK_ERR 2 — 2 — — — — —

7 UPDATE_EVT — — — — — — — —

8 BLOCK_ALM — — — — — — — —

9 TRANSDUCER_
DIRECTORY

— — — — — — — —

10 TRANSDUCER_TYPE 2 2 2 2 — — — —

11 TRANSDUCER_TYPE_
VER

2 2 2 2 — — — —

12 XD_ERROR 1 — 1 — — — — —

13 COLLECTION_
DIRECTORY

— — — — — — — —

14 SNS_FlowZeroRestore
Previous

— — — — — — — —

15 DEN_StartHealthCheck — — — 2 — — — —
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Index Name View

1 2 3 4_1 4_2 4_3 4_4 4_5

16 DEN_Compression
FilterParameter

— — — — 4 — — —

17 DEN_VelocityOOR 2 — 2 — — — — —

18 DEN_UseUserSensor
CheckValue

— — — — — — — —

19 DEN_StartDensOffset
Cal

— — — — — — — —

20 DEN_TineType — — — — — — — —

21 DEN_StartViscScale
Cal

— — — — — — — —

22 SNS_EnableIntExt
Temp

— — — — — — — —

23 DensityOffset — — — 2 — — — —

24 TemperatureOffset — — — 2 — — — —

25 DensityScaleFactor — — — 2 — — — —

26 TemperatureScale
Factor

— — — 2 — — — —

27 FlowSwitchHysterisis — — — 4 — — — —

28 FlowRateSwitch
Threshold

— — — — — — — —

29 SYS_WtMeasSw
Version

— — — — — — — —

30 DEN_K0 — 4 — — — — — —

31 DEN_K1 — 4 — — — — — —

32 DEN_K2 — 4 — — — — — —

33 DEN_K18 — 4 — — — — — —

34 DEN_K19 — 4 — — — — — —

35 DEN_KV4 — 4 — — — — — —

36 DEN_KV5 — 4 — — — — — —

37 DEN_KV6 — 4 — — — — — —

38 DEN_CalibrationStatus — — — 1 — — — —

39 DEN_KV_Index — — — — — 1 — —

40 DEN_KV_Crossover — — — — — 4 — —

41 DEN_A1 — — — 4 — — — —

42 DEN_A2 — — — 4 — — — —

43 DEN_A3 — — — 4 — — — —
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Index Name View

1 2 3 4_1 4_2 4_3 4_4 4_5

44 DEN_A4 — — — 4 — — — —

45 DEN_A5 — — — 4 — — — —

46 DEN_A6 — — — 4 — — — —

47 DEN_A7 — — — 4 — — — —

48 DEN_A8 — — — 4 — — — —

49 DEN_A9 — — — 4 — — — —

50 DEN_DensityOffset — — — 4 — — — —

51 DEN_DensityMeter
Factor

— — — — 4 — — —

52 DEN_Velocity 5 — 5 — — — — —

53 DEN_FixedVelocity — — — 4 — — — —

54 DEN_VelocityUnits — 2 — — — — — —

55 DEN_VelocityCutoff — — — — 4 — — —

56 DEN_VelocityCutoff — — — — 4 — — —

57 DEN_VelocityLoLim — — — — 4 — — —

58 DEN_VelocitySpan — — — — 4 — — —

59 DEN_VelocityDamping — — — — 4 — — —

60 DEN_TimePeriodB 4 — 4 — — — — —

61 DEN_TimePeriodA 4 — 4 — — — — —

62 DEN_SpecialEqnOutput 5 — 5 — — — — —

63 DEN_ProgrammableConstA — — — — 4 — — —

64 DEN_ProgrammableConstB — — — — 4 — — —

65 DEN_ProgrammableConstC — — — — 4 — — —

66 DEN_ProgrammableConstE — — — — 4 — — —

67 DEN_ProgrammableConstF — — — — 4 — — —

68 DEN_ProgrammableValA — — — — 4 — — —

69 DEN_ProgrammableValB — — — — 4 — — —

70 DEN_ProgrammableValC — — — — 4 — — —

71 DEN_ProgrammableValD — — — — 4 — — —

72 DEN_ProgrammableValE — — — — 4 — — —

73 DEN_ProgrammableValF — — — — 4 — — —

74 DEN_SpecialEqnSlotA — — — — 2 — — —

75 DEN_SpecialEqnSlotB — — — — 2 — — —

76 DEN_SpecialEqnSlotC — — — — 2 — — —
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Index Name View

1 2 3 4_1 4_2 4_3 4_4 4_5

77 DEN_SpecialEqnSlotD — — — — 2 — — —

78 DEN_SpecialEqnSlotE — — — — 2 — — —

79 DEN_SpecialEqnSlotF — — — — 2 — — —

80 DEN_ProgAirWaterDensity — 4 — — — — — —

81 DEN_UserBaseDensity — 4 — — — — — —

82 DEN_SpecialEqnLabel — — — — — 8 — —

83 DEN_DensitySpecUnitLabel — — — — — 8 — —

84 DEN_DensitySpecUnitBaseU
nits

— 2 — — — — — —

85 DEN_KinViscSpecialUnitBase
Units

— 2 — — — — — —

86 DEN_DensitySpecUnitConvF
actor

— 4 — — — — — —

87 DEN_QualityFactor 5 — 5 — — — — —

88 DEN_DynamicViscosity 5 — 5 — — — — —

89 DEN_KinematicViscosity 5 — 5 — — — — —

90 DEN_DynamicViscosityUnits — 2 — — — — — —

91 DEN_KinematicViscosityUnit
s

— 2 — — — — — —

92 VISC_RANGE_SEL_INDEX — — — — — 2 — —

93 DEN_V0 — — — — — 4 — —

94 DEN_V1 — — — — — 4 — —

95 DEN_V2 — — — — — 4 — —

96 DEN_ViscRangeScale — — — — — 4 — —

97 ViscRangeSwitchIndex — — — — — 2 — —

98 DEN_ViscRangeLimit — — — — — 4 — —

99 DEN_ViscHysteresis — — — — — 4 — —

100 DEN_ViscosityOffset — — — — — 4 — —

101 DEN_DynViscSpecialUnitLab
el

— — — — — 8 — —

102 DEN_KinViscSpecialUnitLabe
l

— — — — — 8 — —

103 DEN_DynViscSpecialUnitCon
vFactor

— — — — — 4 — —

104 DEN_KinViscSpecialUnitCon
vFactor

— — — — — 4 — —
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Index Name View

1 2 3 4_1 4_2 4_3 4_4 4_5

105 DEN_DynViscSpecialUnitBas
eUnits

— 2 — — — — — —

106 DEN_ReferenceViscosity 5 — 5 — — — — —

107 DEN_CAII 5 — 5 — — — — —

108 DEN_TubeCaseTempDiff 5 — 5 — — — — —

109 DEN_AverageTimePeriod — — — — — — 4 —

110 DEN_TimePeriodStablity — — — — — — 4 —

111 DEN_HealthCheckResult — — — — — — 2 —

112 DEN_HealthCheckFailureBits — — — — — — 2 —

113 DEN_LabDensity — — — — — — 4 —

114 DEN_ReferredViscMethod — — — — — — 2 —

115 MBUS_Visc_CurveIndex — — — — — — 2 —

116 MBUS_Visc_TempIndex — — — — — — 2 —

117 DEN_RefVisc_Mat_MaxFitOr
der

— — — — — — 2 —

118 EN_RefVisc_Mat_TempISO — — — — — — 4 —

119 DEN_RefVisc_Mat_ViscAtTe
mpISO

— — — — — — 4 —

120 DEN_RefTemp1 — — — — — — 4 —

121 DEN_RefTemp2 — — — — — — 4 —

122 DEN_RefVisc_Mat_FitAccura
cy

— — — — — — 4 —

123 DEN_RefVisc_Mat_FitResults — — — — — — 2 —

124 REF_VISC_INPUT_SOURCE — — — — — — 2 —

125 DEN_RefVisc_ASTM_NumCu
rves

— — — — — — 4 —

126 DEN_RefVisc_ASTM_TempIS
O

— — — — — — 4 —

127 DEN_RefVisc_ASTM_ViscAtT
empISO

— — — — — — 4 —

128 DEN_BaseDensityForSensor
Check

— — — — — — 4 —

129 DEN_ElevationAboveSeaLev — — — — — — — 2

130 DEN_LabViscosity — — — — — — — 4

131 DEN_CII 5 — 5 — — — — —

132 DEN_TemperatureCheckAve
rage

— — — — — — — 4
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Index Name View

1 2 3 4_1 4_2 4_3 4_4 4_5

133 DEN_DriveGainAverage — — — — — — — 4

134 DEN_DriveGainStability — — — — — — — 4

135 DEN_TemperatureCheckSta
bility

— — — — — — — 4

136 DEN_CaseTemperatureAver
age

— — — — — — — 4

137 DEN_CaseTemperatureStabi
lity

— — — — — — — 4

138 DEN_SpecialEquationType — — — — — 2 — —

139 DEN_Legacy_K0 — — — — — — — 4

140 DEN_Legacy_K1 — — — — — — — 4

141 DEN_Legacy_K2 — — — — — — — 4

142 DEN_Legacy_K18 — — — — — — — 4

143 DEN_Legacy_K19 — — — — — — — 4

144 DEN_Legacy_K20A — — — — — — — 4

145 DEN_Legacy_K20B — — — — — — — 4

146 DEN_Legacy_K21A — — — — — — — 4

147 DEN_Legacy_K21B — — — — — — — 4

148 DEN_Legacy_K20_K21_Inde
x

— 2 — — — — — —

149 DEN_Legacy_K0_K1_K2_Ind
ex

— 2 — — — — — —

150 DEN_TPA_Microsec 5 — 5 — — — — —

151 DEN_TPB_Microsec 5 — 5 — — — — —

152 SNS_EnablePM — — — — — — — 2

153 SNS_EnableCM — — — — — — — 2

154 DEN_PressureOffset — — — — — — — 4

155 DEN_Legacy_K22 — — — — — — — 4

156 DEN_Legacy_K23 — — — — — — — 4

157 DEN_KDV_CalIndex — — — — — — — 2

158 DEN_TempDiffAverage — — — — — 4 — —

159 DEN_TempDiffStability — — — — — 4 — —

160 DEN_EnableExtTempModulu
s

— — — — — 2 — —

161 DEN_EnableExtTempForVisc — — — — — — 2 —
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Index Name View

1 2 3 4_1 4_2 4_3 4_4 4_5

162 SYS_AttachedCoreType — — — — — — 2 —

163 DEN_SecBaseViscosity 5 — 5 — — — — —

164 DEN_RefViscUnits — 2 — — — — — —

165 DEN_TEMPERATURE_UNITS — — 2 — — — — —

166 DENSITY_UNITS — — 2 — — — — —

167 PRESSURE_UNITS — — 2 — — — — —

168 DEN_ProductCode — — — — — — — —

169 Velocity_Switch_Status — — 2 — — — — —

170 DEN_RefWaterDensity — — — — — — 4 —

171 DEN_RefTemperature — — — — — — 4 —

172 DEN_RefPressure — — — — — — 4 —

173 DEN_Fluid_Option — — — — — 2 — —

174 DEN_StartInlineCal — — — — — 2 — —

175 DEN_CalculatedWaterDens — — — — — — — 4

176 DEN_InlineCalResult — — — — — — — 2

177 DEN_InlineCalResultValue — — — — — 4 — —

A.9.2 Standard fieldbus parameters for density viscosity meter
transducer blocks
Index and name Description List of values

#0

BLOCK_STRUCTURE

The beginning of the transducer block.

Msg type = VAR
Data type = DS_64 (5)
Store = Static
Access = RW (OOS) or RW (Auto)
Available in Release 1.0

—

#1

ST_REV

The revision level of the static data
associated with the function block.
Incremented with each write of static store.

Msg type = VAR
Data type = Unsigned16 (2)
Store = Static
Access = Read only
Available in Release 1.0

—
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Index and name Description List of values

#2

TAG_DESC

The user description of the intended block
application.

Msg type = STR
Data type = OCTET STRING (32)
Store = Static
Access = RW (OOS) or RW (Auto)
Available in Release 1.0

Any 32 characters

#3

STRATEGY

Used to identify grouping of blocks. This
data is not checked or processed by the
block.

Msg type = VAR
Data type = Unsigned16 (2)
Store = Static
Access = RW (OOS) or RW (Auto)
Available in Release 1.0

—

#4

ALERT_KEY

The identification number of the plant unit.
This information may be used in the host
for sorting alarms, etc.

Msg type = VAR
Data type = Unsigned8 (1)
Store = Static
Access = RW (OOS) or RW (Auto)
Available in Release 1.0

1 to 255

#5

MODE_BLK

The actual, target, permitted, and normal
modes of the block.

Msg type = REC
Data type = DS-69 (4)
Store = Mixed
Access = RW (OOS) or RW (Auto)
Available in Release 1.0

See section 2.6 of FF-891

#6

BLOCK_ERR

The error status associated with the
hardware or software components
associated with a block.

Msg type = STR
Data type = BIT STRING (2)
Store = Dynamic/20
Access = Read only
Available in Release 1.0

See section 4.8 of FF-903

#7

UPDATE_EVT

Occurs when a static parameter is changed
while a block mode is not in out of service
(OOS) mode, or when the mode changes
from OOS mode and one or more static
parameters changed while the block was
OOS.

Msg type = REC
Data type = DS-73
Store = Dynamic
Access = RW in any mode
Available in Release 1.0

—
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Index and name Description List of values

#8

BLOCK_ALM

A predefined set of 16 conditions that may
occur within a block.

Msg type = REC
Data type = DS-72
Store = Dynamic
Access = RW in any mode
Available in Release 9.0

—

#9

TRANSDUCER_
DIRECTORY

A directory that specifies the number and
starting indices of the data collections in
the transducer block.

Msg type = VAR
Data type = Unsigned16 (2)
Store = Static
Access = RW (OOS)
Available in Release 9.0

—

#10

TRANSDUCER_
TYPE

Identifies the transducer that follows.

Msg type = VAR
Data type = Unsigned16 (2)
Store = Static
Access = RW (OOS)
Available in Release 9.0

—

#11

TRANSDUCER_
TYPE_VER

Identifies the version of the transducer
block. Format is XXYY where XX is the major
spec revision and YY is the manufacturer
revision.

Msg type = VAR
Data type = Unsigned16 (2)
Store = Static
Access = RW (OOS)
Available in Release 9.0

—

#12

XD_ERROR

Used for all config, H/W, connection failure
of system problems in the block.

Msg type = VAR
Data type = Unsigned8 (1)
Store = Dynamic
Access = RW (OOS)
Available in Release 1.0

0 = No Error
18 = Calibration Error
19 = Configuration Error
20 = Electronics Failure
21 = Sensor Failure
26 = Process Error
27 = Calibration in Progress

#13

COLLECTION_
DIRECTORY

Used for all config, H/W, and connection
failures of system problems in the block.

Msg type = VAR
Data type = Unsigned32 (4)
Store = Static
Access = RW (OOS)
Available in Release 9.0

—
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A.9.3 Process variables for density viscosity transducer blocks
Table A-26: Process variables for density viscosity transducer blocks

Index and name Description List of values HW

#14

SNS_FlowZeroRestorePrevious

Restore previous zero

Msg type = METHOD
Data type = Unsigned16 (2)
Store = Static
Access = R/W (OOS)
Available in Release 8.0

1 = Restore Previous
Zero
0 = None

800
CDM
FDM
FVM

#15

DEN_StartHealthCheck

Start sensor check

Msg type = METHOD
Data type = Unsigned16 (2)
Store = Static
Access = R/W (OOS)
Available in Release 8.0

0 = Abort
1 = Start

CDM
FDM
FVM

#16

DEN_CompressionFilter
Parameter

Viscosity compression filter parameter

Msg type = VAR
Data type = Float(4)
Store = Static
Access = R/W (OOS)
Available in Release 8.0

— FVM

#17

DEN_VelocityOOR

Velocity out of limit indication

Msg type = VAR
Data type = Unsigned16 (2)
Store = Dynamic
Access = Read only
Available in Release 8.0

1 = Velocity out of
limit
0 = Velocity within
limit

CDM

#18

DEN_UseUserSensorCheck
Value

Curve configuration index (n)

Msg type = VAR
Data type = Unsigned16 (2)
Store = Static
Access = R/W (OOS)
Available in Release 8.0

1 = Use user sensor
check value
0 = Use factory sensor
check value

CDM
FDM
FVM

#19

DEN_StartDensOffsetCal

Start density offset calibration

Msg type = METHOD
Data type = Unsigned16 (2)
Store = Static
Access = R/W (OOS)
Available in Release 8.0

1 = Start density
offset calibration
0 = Stop density offset
calibration

CDM
FDM
FVM

#20

DEN_TineType

Fork tine length

Msg type = ENUM
Data type = Unsigned16 (2)
Store = Static
Access = R/W (OOS)
Available in Release 8.0

0 = SHORT_TINE
1 = LONG_TINE

FDM
FVM
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Table A-26: Process variables for density viscosity transducer blocks (continued)

Index and name Description List of values HW

#21

DEN_StartViscScaleCal

Start viscosity scale factor

Msg type = METHOD
Data type = Unsigned16 (2)
Store = Static
Access = R/W (OOS)
Available in Release 8.0

1 = Start viscosity
scale factor
0 = None

FVM

#22

SNS_EnableIntExtTemp

Enable/Disable external temp for
modulus comp

Msg type = VAR
Data type = Unsigned16 (2)
Store = Static
Access = R/W in any mode
Available in Release 8.0

0 = Disable
1 = Enable

CDM
FDM

#23

DensityOffset

Density offset

Msg type = VAR
Data type = Unsigned16 (2)
Store = Static
Access = R/W (OOS)
Available in Release 8.0

— CDM
FDM
FVM

#24

TemperatureOffset

Temperature offset

Msg type = VAR
Data type = Unsigned16 (2)
Store = Static
Access = R/W (OOS)
Available in Release 8.0

— CDM
FDM
FVM

#25

DensityScaleFactor

Densisty scale factor

Msg type = VAR
Data type = Unsigned16 (2)
Store = Static
Access = R/W (OOS)
Available in Release 8.0

— CDM
FDM
FVM

#26

TemperatureScaleFactor

Temperature scale factor

Msg type = VAR
Data type = Unsigned16 (2)
Store = Static
Access = R/W (OOS)
Available in Release 8.0

— CDM
FDM
FVM

#27

FlowSwitchHysterisis

Flow rate switch hysteresis

Msg type = VAR
Data type = Float(4)
Store = Static
Access = R/W in any mode
Available in Release 8.0

— CDM
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Table A-26: Process variables for density viscosity transducer blocks (continued)

Index and name Description List of values HW

#28

FlowRateSwitchThreshold

Flow rate switch set point

Msg type = VAR
Data type = Unsigned16 (2)
Store = Static
Access = R/W in any mode
Available in Release 8.0

— 800
CDM

#29

SYS_WtMeasSwVersion

Weights & Measures software version

Msg type = VAR
Data type = Unsigned16 (2)
Store = Static
Access = Read only
Available in Release 8.0

— CDM

#30

DEN_K0

K0, instrument calibration factor

Msg type = VAR
Data type = Float (4)
Store = Static
Access = R/W (OOS)
Available in Release 8.0

— FDM
FVM

#31

DEN_K1

K1, instrument calibration factor

Msg type = VAR
Data type = Float (4)
Store = Static
Access = R/W (OOS)
Available in Release 8.0

— FDM
FVM

#32

DEN_K2

K2, instrument calibration factor

Msg type = VAR
Data type = Float (4)
Store = Static
Access = R/W (OOS)
Available in Release 8.0

— FDM
FVM

#33

DEN_K18

K18, instrument calibration factor

Msg type = VAR
Data type = Float (4)
Store = Static
Access = R/W (OOS)
Available in Release 8.0

— FDM
FVM

#34

DEN_K19

K19, instrument calibration factor

Msg type = VAR
Data type = Float (4)
Store = Static
Access = R/W (OOS)
Available in Release 8.0

— FDM
FVM
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Table A-26: Process variables for density viscosity transducer blocks (continued)

Index and name Description List of values HW

#35

DEN_KV4

KV4, instrument calibration factor
(calibration range indexed by register
4022)

Msg type = VAR
Data type = Float (4)
Store = Static
Access = R/W (OOS)
Available in Release 8.0

— FVM

#36

DEN_KV5

KV5, instrument calibration factor
(calibration range indexed by register
4022)

Msg type = VAR
Data type = Float (4)
Store = Static
Access = R/W (OOS)
Available in Release 8.0

— FVM

#37

DEN_KV6

KV6, instrument calibration factor
(calibration range indexed by register
4022)

Msg type = VAR
Data type = Float (4)
Store = Static
Access = R/W (OOS)
Available in Release 8.0

— FVM

#38

DEN_CalibrationStatus

Density viscosity calibration status

Msg type = VAR
Data type = Unsigned8 (1)
Store = Static
Access = Read only
Available in Release 8.0

— CDM
FDM
FVM

#39

DEN_KV_Index

KV calibration factor index (0-1)

Msg type = ENUM (1)
Data type = Unsigned8 (1)
Store = Static
Access = R/W in any mode
Available in Release 8.0

0: Medium
1: High

FVM

#40

DEN_KV_Crossover

KV calibration crossover point (based on
quality factor)

Msg type = VAR
Data type = Float (4)
Store = Static
Access = R/W (OOS)
Available in Release 8.0

— FVM
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Table A-26: Process variables for density viscosity transducer blocks (continued)

Index and name Description List of values HW

#41

DEN_A1

A1, density calibration constant

Msg type = VAR
Data type = Float (4)
Store = Static
Access = R/W (OOS)
Available in Release 8.0

— CDM

#42

DEN_A2

A2, density calibration constant

Msg type = VAR
Data type = Float (4)
Store = Static
Access = R/W (OOS)
Available in Release 8.0

— CDM

#43

DEN_A3

A3, density calibration constant

Msg type = VAR
Data type = Float (4)
Store = Static
Access = R/W (OOS)
Available in Release 8.0

— CDM

#44

DEN_A4

A4, density calibration constant

Msg type = VAR
Data type = Float (4)
Store = Static
Access = R/W (OOS)
Available in Release 8.0

— CDM

#45

DEN_A5

A5, density calibration constant

Msg type = VAR
Data type = Float (4)
Store = Static
Access = R/W (OOS)
Available in Release 8.0

— CDM

#46

DEN_A6

A6, density calibration constant

Msg type = VAR
Data type = Float (4)
Store = Static
Access = R/W (OOS)
Available in Release 8.0

— CDM

#47

DEN_A7

A7, density calibration constant

Msg type = VAR
Data type = Float (4)
Store = Static
Access = R/W (OOS)
Available in Release 8.0

— CDM
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Table A-26: Process variables for density viscosity transducer blocks (continued)

Index and name Description List of values HW

#48

DEN_A8

A8, density calibration constant

Msg type = VAR
Data type = Float (4)
Store = Static
Access = R/W (OOS)
Available in Release 8.0

— CDM

#49

DEN_A9

A9, density calibration constant

Msg type = VAR
Data type = Float (4)
Store = Static
Access = R/W (OOS)
Available in Release 8.0

— CDM

#50

DEN_DensityOffset

Density offset

Msg type = VAR
Data type = Float (4)
Store = Static
Access = R/W (OOS)
Available in Release 8.0

— CDM
FDM
FVM

#51

DEN_DensityMeterFactor

Density meter factor

Msg type = VAR
Data type = Float (4)
Store = Static
Access = R/W (OOS)
Available in Release 8.0

— CDM
FDM
FVM

#52

DEN_Velocity

Flow velocity

Msg type = VAR
Data type = DS65
Store = Dynamic/20
Access = Read only
Available in Release 8.0

— CDM

#53

DEN_FixedVelocity

Fixed flow velocity value (m/sec)

Msg type = VAR
Data type = DS65
Store = Dynamic/20
Access = Read only
Available in Release 8.0

— CDM

#54

DEN_VelocityUnits

Flow velocity units

Msg type = VAR
Data type = Unsigned16 (2)
Store = Static
Access = R/W (OOS)
Available in Release 8.0

1061 = Meters/
Second
1067 = Feet/Second

CDM

Configuration and Use Manual Transducer blocks and views
20000326 August 2022

Configuration and Use Manual 235



Table A-26: Process variables for density viscosity transducer blocks (continued)

Index and name Description List of values HW

#55

DEN_VelocityCutoff

Flow velocity units

Msg type = VAR
Data type = Float (4)
Store = Static
Access = R/W (OOS)
Available in Release 8.0

— CDM

#56

DEN_VelocityHiLim

Flow velocity high limit

Msg type = VAR
Data type = Float (4)
Store = Static
Access = Read only
Available in Release 8.0

— CDM

#57

DEN_VelocityLoLim

Flow velocity low limit

Msg type = VAR
Data type = Float (4)
Store = Static
Access = Read only
Available in Release 8.0

— CDM

#58

DEN_VelocitySpan

Flow velocity span

Msg type = VAR
Data type = Float (4)
Store = Static
Access = Read only
Available in Release 8.0

— CDM

#59

DEN_VelocityDamping

Flow velocity damping

Msg type = VAR
Data type = Float (4)
Store = Static
Access = R/W (OOS)
Available in Release 8.0

— CDM

#60

DEN_TimePeriodB

Time period (u/sec) (upper 3dB point)

Msg type = VAR
Data type = Float (4)
Store = Dynamic/20
Access = Read only
Available in Release 8.0

— CDM
FDM
FVM

#61

DEN_TimePeriodA

Time period (u/sec) (lower 3dB point)

Msg type = VAR
Data type = Float (4)
Store = Dynamic/20
Access = Read only
Available in Release 8.0

— FVM
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Table A-26: Process variables for density viscosity transducer blocks (continued)

Index and name Description List of values HW

#62

DEN_SpecialEqnOutput

Special equation output

Msg type = VAR
Data type = DS65
Store = Dynamic/20
Access = Read only
Available in Release 8.0

— CDM
FDM
FVM

#63

DEN_ProgrammableConstA

Programmable constant A for special
equation

Msg type = VAR
Data type = Float (4)
Store = Static
Access = R/W (OOS)
Available in Release 8.0

— CDM
FDM
FVM

#64

DEN_ProgrammableConstB

Programmable constant B for special
equation

Msg type = VAR
Data type = Float (4)
Store = Static
Access = R/W (OOS)
Available in Release 8.0

— CDM
FDM
FVM

#65

DEN_ProgrammableConstC

Programmable constant C for special
equation (X for special equation type I)

Msg type = VAR
Data type = Float (4)
Store = Static
Access = R/W (OOS)
Available in Release 8.0

— CDM
FDM
FVM

#66

DEN_ProgrammableConstE

Programmable constant E for special
equation (Y for special equation type I)

Msg type = VAR
Data type = Float (4)
Store = Static
Access = R/W (OOS)
Available in Release 8.0

— CDM
FDM
FVM

#67

DEN_ProgrammableConstF

Programmable constant F for special
equation

Msg type = VAR
Data type = Float (4)
Store = Static
Access = R/W (OOS)
Available in Release 8.0

— CDM
FDM
FVM
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Table A-26: Process variables for density viscosity transducer blocks (continued)

Index and name Description List of values HW

#68

DEN_ProgrammableValA

Programmable constant A for special
equation - constants available for access
using pointers for special equations
(registers 4114-4119)

Msg type = VAR
Data type = Float (4)
Store = Static
Access = R/W (OOS)
Available in Release 8.0

— CDM
FDM
FVM

#69

DEN_ProgrammableValB

Programmable constant B for special
equation - constants available for access
using pointers for special equations
(registers 4114-4119)

Msg type = VAR
Data type = Float (4)
Store = Static
Access = R/W (OOS)
Available in Release 8.0

— CDM
FDM
FVM

#70

DEN_ProgrammableValC

Programmable constant C for special
equation - constants available for access
using pointers for special equations
(registers 4114-4119)

Msg type = VAR
Data type = Float (4)
Store = Static
Access = R/W (OOS)
Available in Release 8.0

— CDM
FDM
FVM

#71

DEN_ProgrammableValD

Programmable constant D for special
equation - constants available for access
using pointers for special equations
(registers 4114-4119)

Msg type = VAR
Data type = Float (4)
Store = Static
Access = R/W (OOS)
Available in Release 8.0

— CDM
FDM
FVM

#72

DEN_ProgrammableValE

Programmable constant E for special
equation - constants available for access
using pointers for special equations
(registers 4114-4119)

Msg type = VAR
Data type = Float (4)
Store = Static
Access = R/W (OOS)
Available in Release 8.0

— CDM
FDM
FVM
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Table A-26: Process variables for density viscosity transducer blocks (continued)

Index and name Description List of values HW

#73

DEN_ProgrammableValF

Programmable constant F for special
equation - constants available for access
using pointers for special equations
(registers 4114-4119)

Msg type = VAR
Data type = Float (4)
Store = Static
Access = R/W (OOS)
Available in Release 8.0

— CDM
FDM
FVM
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Table A-26: Process variables for density viscosity transducer blocks (continued)

Index and name Description List of values HW

#74

DEN_SpecialEqnSlotA

Pointer A for special equation

Msg type = ENUM
Data type = Unsigned16 (2)
Store = Static
Access = R/W (OOS)
Available in Release 8.0

1 = Temperature
3 = Density
5 = Volume Flow Rate
[CDM](1)

15 = PM: Corr Density
21 = CM: Density At
Ref
22 = CM: Density
[SGU]
26 = CM: Net Mass
Flow Rate [FDM and
FVM]
29 = CM: Net Volume
Flow Rate [FDM and
FVM]
32 = CM:
Concentration
47 = Drive Gain
48 = Case
Temperature [CDM]
50 = RPO Amplitude
[CDM]
51 = Board
Temperature
52 = Input Voltage
53 = Ext. Input
Pressure
55 = Ext. Input Temp
161 = Tube-Case
Temperature
Differential [CDM]
162 = Dynamic
Viscosity [FVM]
163 = Kinematic
Viscosity [FVM]
164 = Base Viscosity
[FVM]
168 = Quality Factor
[FVM]
208 = Mass Flow
Velocity [CDM]
215 = Time Period B
(Upper 3db point)
251 = None

CDM
FDM
FVM

#75

DEN_SpecialEqnSlotB

Pointer B for special equation

Msg type = ENUM
Data type = Unsigned16 (2)
Store = Static
Access = R/W (OOS)
Available in Release 8.0

See #74
DEN_SpecialEqnSlotA

CDM
FDM
FVM
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Table A-26: Process variables for density viscosity transducer blocks (continued)

Index and name Description List of values HW

#76

DEN_SpecialEqnSlotC

Pointer C for special equation

Msg type = ENUM
Data type = Unsigned16 (2)
Store = Static
Access = R/W (OOS)
Available in Release 8.0

See #74
DEN_SpecialEqnSlotA

CDM
FDM
FVM

#77

DEN_SpecialEqnSlotD

Pointer D for special equation

Msg type = ENUM
Data type = Unsigned16 (2)
Store = Static
Access = R/W (OOS)
Available in Release 8.0

See #74
DEN_SpecialEqnSlotA

CDM
FDM
FVM

#78

DEN_SpecialEqnSlotE

Pointer E for special equation

Msg type = ENUM
Data type = Unsigned16 (2)
Store = Static
Access = R/W (OOS)
Available in Release 8.0

See #74
DEN_SpecialEqnSlotA

CDM
FDM
FVM

#79

DEN_SpecialEqnSlotF

Pointer F for special equation

Msg type = ENUM
Data type = Unsigned16 (2)
Store = Static
Access = R/W (OOS)
Available in Release 8.0

See #74
DEN_SpecialEqnSlotA

CDM
FDM
FVM

#80

DEN_ProgAirWaterDensity

User-defined water density

Msg type = VAR
Data type = Float (4)
Store = Static
Access = R/W (OOS)
Available in Release 8.0

— CDM
FDM
FVM

#81

DEN_UserBaseDensity

User-defined base density

Msg type = VAR
Data type = Float (4)
Store = Static
Access = R/W (OOS)
Available in Release 8.0

— CDM
FDM
FVM

#82

DEN_SpecialEqnLabel

Special equation unit string

Msg type = STR
Data type = VISIBLE STRING
Store = Static
Access = R/W (OOS)
Available in Release 8.0

— CDM
FDM
FVM
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Table A-26: Process variables for density viscosity transducer blocks (continued)

Index and name Description List of values HW

#83

DEN_DensitySpecUnitLabel

Special density unit string

Msg type = STR
Data type = VISIBLE STRING
Store = Static
Access = R/W (OOS)
Available in Release 8.0

— CDM
FDM
FVM

#84

DEN_DensitySpecUnitBaseUnits

Base density unit for special density unit

Msg type = VAR
Data type = Unsigned16 (2)
Store = Static
Access = R/W (OOS)
Available in Release 8.0

1097 = kg/m3
1100 = g/cm3
1103 = kg/L
1104 = g/ml
1105 = g/L
1106 = lb/in3
1107 = lb/ft3
1108 = lb/gal
1109 = Ston/yd3
1113 = DegAPI
1114 = SGU

CDM
FDM
FVM

#85

DEN_KinViscSpecialUnit
BaseUnits

Base kinematic viscosity unit for special
kinematic viscosity unit

Msg type = VAR
Data type = Unsigned16 (2)
Store = Static
Access = R/W (OOS)
Available in Release 8.0

1164 = centistokes FVM

#86

DEN_DensitySpecUnitConvFactor

Special density unit conversion factor

Msg type = VAR
Data type = Float (4)
Store = Static
Access = R/W (OOS)
Available in Release 8.0

— CDM
FDM
FVM

#87

DEN_QualityFactor

Quality factor

Msg type = VAR
Data type = DS65
Store = Dynamic
Access = Read only
Available in Release 8.0

— FVM

#88

DEN_DynamicViscosity

Dynamic viscosity

Msg type = VAR
Data type = DS65
Store = Dynamic
Access = Read only
Available in Release 8.0

— FVM

#89

DEN_KinematicViscosity

Kinematic viscosity

Msg type = VAR
Data type = DS65
Store = Dynamic
Access = Read only
Available in Release 8.0

— FVM
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Table A-26: Process variables for density viscosity transducer blocks (continued)

Index and name Description List of values HW

#90

DEN_DynamicViscosityUnits

Dynamic viscosity unit

Msg type = VAR
Data type = Unsigned16 (2)
Store = Static
Access = R/W (OOS)
Available in Release 8.0

1159 = Pascal second
1162 = Centipoise
253=Special

FVM

#91

DEN_KinematicViscosityUnits

Kinematic viscosity unit

Msg type = VAR
Data type = Unsigned16 (2)
Store = Static
Access = R/W (OOS)
Available in Release 8.0

1164 =Centistokes
253 =Special

FVM

#92

VISC_RANGE_SEL_INDEX

Viscosity value range selection - Index for
DEN_V0,DEN_V1,DEN_V2,
DEN_ViscRangeScale

Msg type = ENUM
Data type = Unsigned16 (2)
Store = Static
Access = R/W (OOS)
Available in Release 8.0

0 = Ultra low
1 = Ultra low to low
2 = Low to medium
3 = Medium to high
4 = High

FVM

#93

DEN_V0

V0 at the selected range - Array of 4

Msg type = VAR
Data type = Float (4)
Store = Static
Access = R/W (OOS)
Available in Release 8.0

— FVM

#94

DEN_V1

V1 at the selected range - Array of 4

Msg type = VAR
Data type = Float (4)
Store = Static
Access = R/W (OOS)
Available in Release 8.0

— FVM

#95

DEN_V2

V2 at the selected range - Array of 4

Msg type = VAR
Data type = Float (4)
Store = Static
Access = R/W (OOS)
Available in Release 8.0

— FVM

#96

DEN_ViscRangeScale

Range scale at the selected range - Array
of 4

Msg type = VAR
Data type = Float (4)
Store = Static
Access = R/W (OOS)
Available in Release 8.0

— FVM
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Table A-26: Process variables for density viscosity transducer blocks (continued)

Index and name Description List of values HW

#97

ViscRangeSwitchIndex

Viscosity range switch setpoint index

Msg type = VAR
Data type = Unsigned16 (2)
Store = Static
Access = R/W (OOS)
Available in Release 8.0

0 = Ultra low
1 = Ultra low to low
2 = Low to medium
3 = Medium to high
4 = High

FVM

#98

DEN_ViscRangeLimit

Viscosity range switch setpoint (at the
index selected by register 4174)

Msg type = VAR
Data type = Float (4)
Store = Static
Access = R/W (OOS)
Available in Release 8.0

— FVM

#99

DEN_ViscHysteresis

Viscosity hysteresis

Msg type = VAR
Data type = Float (4)
Store = Static
Access = R/W (OOS)
Available in Release 8.0

— FVM

#100

DEN_ViscosityOffset

Viscosity offset

Msg type = VAR
Data type = Float (4)
Store = Static
Access = R/W (OOS)
Available in Release 8.0

— FVM

#101

DEN_DynViscSpecialUnitLabel

Special dynamic viscosity unit string

Msg type = STR
Data type = VISIBLE STRING
Store = Static
Access = R/W (OOS)
Available in Release 8.0

Visible string FVM

#102

DEN_KinViscSpecialUnitLabel

Special kinematic viscosity unit string

Msg type = STR
Data type = VISIBLE STRING
Store = Static
Access = R/W (OOS)
Available in Release 8.0

Visible string FVM

#103

DEN_DynViscSpecialUnit
ConvFactor

Special dynamic viscosity unit conversion
factor

Msg type = VAR
Data type = Float (4)
Store = Static
Access = R/W (OOS)
Available in Release 8.0

— FVM
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Table A-26: Process variables for density viscosity transducer blocks (continued)

Index and name Description List of values HW

#104

DEN_KinViscSpecialUnit
ConvFactor

Special kinematic viscosity unit
conversion factor

Msg type = VAR
Data type = Float (4)
Store = Static
Access = R/W (OOS)
Available in Release 8.0

— FVM

#105

DEN_DynViscSpecialUnit
BaseUnits

Base dynamic viscosity unit for special
dynamic viscosity unit

Msg type = VAR
Data type = Unsigned16 (2)
Store = Static
Access = R/W (OOS)
Available in Release 8.0

1162 = Centipoise FVM

#106

DEN_ReferenceViscosity

Primary referred viscosity

Msg type = VAR
Data type = DS65
Store = Dynamic
Access = Read only
Available in Release 8.0

— FVM

#107

DEN_CAII

Ignition Index (CCAI)

Msg type = VAR
Data type = DS65
Store = Dynamic
Access = Read only
Available in Release 8.0

— FVM

#108

DEN_TubeCaseTempDiff

Tube-case temperature differential

Msg type = VAR
Data type = DS65
Store = Dynamic
Access = Read only
Available in Release 8.0

— CDM

#109

DEN_AverageTimePeriod

Average time period on air/vacuum
(indexed by DEN_KDV_CalIndex)

Msg type = VAR
Data type = Float (4)
Store = Static
Access = Read only
Available in Release 8.0

— CDM
FDM
FVM

#110

DEN_TimePeriodStablity

Time period stablity on air/vacuum
(sensor check) (indexed by
DEN_KDV_CalIndex)

Msg type = VAR
Data type = Float (4)
Store = Static
Access = Read only
Available in Release 8.0

— CDM
FDM
FVM
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Table A-26: Process variables for density viscosity transducer blocks (continued)

Index and name Description List of values HW

#111

DEN_HealthCheckResult

Check results

Msg type = ENUM
Data type = Unsigned16 (2)
Store = Static
Access = Read only
Available in Release 8.0

0 = Good
2 = Fail
3 = Not Run
4 = In Progress
5 = No Factory Cal

CDM
FDM
FVM

#112

DEN_HealthCheckFailureBits

KDV failure bits

Msg type = VAR
Data type = BIT STRING
Store = Static
Access = Read only
Available in Release 8.0

Bit #0 - Corrected
time period average
out of range
Bit #1 - Corrected
time bit #1 - Period
stability out of range
Bit #2 - Temperature
stability out of range
Bit #3 - Drive gain
average out of range
Bit #4 - Case
temperature stability
out of range (tube
density only)

CDM
FDM
FVM

#113

DEN_LabDensity

Lab density for density offset calibration

Msg type = VAR
Data type = Float (4)
Store = Static
Access = R/W in any mode
Available in Release 8.0

— CDM
FDM
FVM

#114

DEN_ReferredViscMethod

Referred viscosity calculation method

Msg type = ENUM
Data type = Unsigned16 (2)
Store = Static
Access = R/W (OOS)
Available in Release 8.0

0 = referral matrix
1 = ASTM D341 single
curve
2 = ASTM D341
multiple curve

FVM

#115

MBUS_Visc_CurveIndex

Referred viscosity configuration curve
index (for matrix method n = 0-5 and for
ASTM method n = 0-7)

Msg type = VAR
Data type = Unsigned16 (2)
Store = Static
Access = R/W (OOS)
Available in Release 8.0

— FVM

#116

MBUS_Visc_TempIndex

Referred viscosity temperature isotherm
index (for matrix method n = 0-5 and for
ASTM method n = 0-1)

Msg type = VAR
Data type = Unsigned16 (2)
Store = Static
Access = R/W (OOS)
Available in Release 8.0

— FVM
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Table A-26: Process variables for density viscosity transducer blocks (continued)

Index and name Description List of values HW

#117

DEN_RefVisc_Mat_MaxFitOrder

Referred viscosity maximum fit order for
6x6 matrix (order = 2, 3, 4, 5)

Msg type = VAR
Data type = Unsigned16 (2)
Store = Static
Access = R/W (OOS)
Available in Release 8.0

— FVM

#118

EN_RefVisc_Mat_TempISO

Referred viscosity temperature isothermx
value (6x1) (indexed by register
MBUS_Visc_TempIndex)

Msg type = VAR
Data type = Float (4)
Store = Static
Access = R/W (OOS)
Available in Release 8.0

— FVM

#119

DEN_RefVisc_Mat_
ViscAtTempISO

Referred viscosity (6x6) @ temperature
isothermX, curven (indexed by
MBUS_Visc_CurveIndex and
MBUS_Visc_TempIndex)

Msg type = VAR
Data type = Float (4)
Store = Static
Access = R/W (OOS)
Available in Release 8.0

— FVM

#120

DEN_RefTemp1

Referred viscosity reference temperature
1

Msg type = VAR
Data type = Float (4)
Store = Static
Access = R/W (OOS)
Available in Release 8.0

— FVM

#121

DEN_RefTemp2

Referred viscosity reference temperature
2

Msg type = VAR
Data type = Float (4)
Store = Static
Access = R/W (OOS)
Available in Release 8.0

— FVM

#122

DEN_RefVisc_Mat_
FitAccuracy

Referred viscosity curve fit expected
accuracy

Msg type = VAR
Data type = Float (4)
Store = Static
Access = Read only
Available in Release 8.0

— FVM

Configuration and Use Manual Transducer blocks and views
20000326 August 2022

Configuration and Use Manual 247



Table A-26: Process variables for density viscosity transducer blocks (continued)

Index and name Description List of values HW

#123

DEN_RefVisc_Mat_
FitResults

Referred viscosity curve fit result

Msg type = ENUM
Data type = Unsigned16 (2)
Store = Static
Access = Read only
Available in Release 8.0

0 = Good
1 = Poor
2 = Failed
3 = Empty

FVM

#124

REF_VISC_INPUT_SOURCE

Referred viscosity input source selection
(for matrix method only)

Msg type = ENUM
Data type = Unsigned16 (2)
Store = Static
Access = R/W (OOS)
Available in Release 8.0

163 = Kinematic
162 = Dynamic

FVM

#125

DEN_RefVisc_ASTM_NumCurves

Number of ASTM reference curves (n =
2-8)

Msg type = VAR
Data type = Unsigned16 (2)
Store = Static
Access = R/W (OOS)
Available in Release 8.0

— FVM

#126

DEN_RefVisc_ASTM_TempISO

ASTM temperature value (2X8) @ point1
or point2 curve n (n = 0-7) (indexed by
MBUS_Visc_CurveIndex and
MBUS_Visc_TempIndex)

Msg type = VAR
Data type = Float (4)
Store = Static
Access = R/W (OOS)
Available in Release 8.0

— FVM

#127

DEN_RefVisc_ASTM_
ViscAtTempISO

ASTM referral viscosity (2X8) @
temperatureX , curve n (n = 0-7) (indexed
by MBUS_Visc_CurveIndex and
MBUS_Visc_TempIndex)

Msg type = VAR
Data type = Float (4)
Store = Static
Access = R/W (OOS)
Available in Release 8.0

— FVM

#128

DEN_BaseDensityFor
SensorCheck

Base density for sensor check

Msg type = VAR
Data type = Float (4)
Store = Static
Access = R/W (OOS)
Available in Release 8.0

— CDM
FDM
FVM
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Table A-26: Process variables for density viscosity transducer blocks (continued)

Index and name Description List of values HW

#129

DEN_ElevationAboveSeaLev

Elevation above sea level for Known
Density Verification

Msg type = ENUM
Data type = Unsigned16 (2)
Store = Static
Access = R/W (OOS)
Available in Release 8.0

0 = 0 feet or meters,
1= 1000 feet
2 = 2000 feet
3 = 3000 feet
4 = 4000 feet
5 = 5000 feet
6 = 6000 feet or
greater
7 = 500 meters
8 = 1000 meters
9 = 2000 meters or
greater

CDM
FDM
FVM

#130

DEN_LabViscosity

Lab viscosity for viscosity scaling factor
calibration

Msg type = VAR
Data type = Float (4)
Store = Static
Access = R/W (OOS)
Available in Release 8.0

— FVM

#131

DEN_CII

Ignition index (CII)

Msg type = VAR
Data type = DS65
Store = Dynamic/20
Access = Read only
Available in Release 8.0

— FVM

#132

DEN_TemperatureCheckAverage

Temperature average (sensor check)

Msg type = VAR
Data type = Float (4)
Store = Static
Access = Read only
Available in Release 8.0

— CDM
FDM
FVM

#133

DEN_DriveGainAverage

Drive gain average (sensor check)

Msg type = VAR
Data type = Float (4)
Store = Static
Access = Read only
Available in Release 8.0

— FVM

#134

DEN_DriveGainStability

Drive gain stability (sensor check)

Msg type = VAR
Data type = Float (4)
Store = Static
Access = Read only
Available in Release 8.0

— FVM
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Table A-26: Process variables for density viscosity transducer blocks (continued)

Index and name Description List of values HW

#135

DEN_TemperatureCheckStability

Temperature stability (sensor check)

Msg type = VAR
Data type = Float (4)
Store = Static
Access = Read only
Available in Release 8.0

— CDM
FDM
FVM

#136

DEN_CaseTemperatureAverage

Case temperature average (sensor check)

Msg type = VAR
Data type = Float (4)
Store = Static
Access = Read only
Available in Release 8.0

— CDM

#137

DEN_CaseTemperatureStability

Case temperature stability (sensor check)

Msg type = VAR
Data type = Float (4)
Store = Static
Access = Read only
Available in Release 8.0

— CDM

#138

DEN_SpecialEquationType

Special equation type

Msg type = ENUM
Data type = Unsigned16 (2)
Store = Static
Access = R/W (OOS)
Available in Release 8.0

0 - Type 1
1 - Type 2
2 - Quartic
99 - None

CDM
FDM
FVM

#139

DEN_Legacy_K0

K0 legacy calibration constant (indexed
by DEN_Legacy_K0_K1_K2_Index)

Msg type = VAR
Data type = Float (4)
Store = Static
Access = Read only
Available in Release 8.0

— CDM

#140

DEN_Legacy_K1

K1 legacy calibration constant (indexed
by DEN_Legacy_K0_K1_K2_Index)

Msg type = VAR
Data type = Float (4)
Store = Static
Access = Read only
Available in Release 8.0

— CDM

#141

DEN_Legacy_K2

K2 legacy calibration constant (indexed
by DEN_Legacy_K0_K1_K2_Index)

Msg type = VAR
Data type = Float (4)
Store = Static
Access = Read only
Available in Release 8.0

— CDM
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Table A-26: Process variables for density viscosity transducer blocks (continued)

Index and name Description List of values HW

#142

DEN_Legacy_K18

K18 legacy calibration constant

Msg type = VAR
Data type = Float (4)
Store = Static
Access = R/W (OOS)
Available in Release 8.0

— CDM

#143

DEN_Legacy_K19

K19 legacy calibration constant

Msg type = VAR
Data type = Float (4)
Store = Static
Access = R/W (OOS)
Available in Release 8.0

— CDM

#144

DEN_Legacy_K20A

K20A constant used to compute K20
(indexed by
DEN_Legacy_K20_K21_Index)

Msg type = VAR
Data type = Float (4)
Store = Static
Access = R/W (OOS)
Available in Release 8.0

— CDM

#145

DEN_Legacy_K20B

K20B constant used to compute K20
(indexed by
DEN_Legacy_K20_K21_Index)

Msg type = VAR
Data type = Float (4)
Store = Static
Access = R/W (OOS)
Available in Release 8.0

— CDM

#146

DEN_Legacy_K21A

K21A constant used to compute K21
(indexed by
DEN_Legacy_K20_K21_Index)

Msg type = VAR
Data type = Float (4)
Store = Static
Access = R/W (OOS)
Available in Release 8.0

— CDM

#147

DEN_Legacy_K21B

K21B constant used to compute K21
(indexed by
DEN_Legacy_K20_K21_Index)

Msg type = VAR
Data type = Float (4)
Store = Static
Access = R/W (OOS)
Available in Release 8.0

— CDM
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Table A-26: Process variables for density viscosity transducer blocks (continued)

Index and name Description List of values HW

#148

DEN_Legacy_K20_
K21_Index

Index for K20A, K20B, K21A, and K21B
legacy coefficients (0-3)

Msg type = VAR
Data type = Unsigned16 (2)
Store = Static
Access = R/W (OOS)
Available in Release 8.0

— CDM

#149

DEN_Legacy_K0_K1_
K2_Index

Index for K0, K1, and K2 legacy
coefficients (0-1)

Msg type = VAR
Data type = Unsigned16 (2)
Store = Static
Access = R/W (OOS)
Available in Release 8.0

— CDM

#150

DEN_TPA_Microsec

Time period A (in microseconds)

Msg type = VAR
Data type = DS65
Store = Dynamic
Access = Read only
Available in Release 8.0

— FVM

#151

DEN_TPB_Microsec

Time period B (in microseconds)

Msg type = VAR
Data type = DS65
Store = Dynamic
Access = Read only
Available in Release 8.0

— CDM
FDM
FVM

#152

SNS_EnablePM

User accessible enable PM

Msg type = VAR
Data type = Unsigned16 (2)
Store = Static
Access = R/W (OOS)
Available in Release 8.0

0 = Disable PM
1 = Enable PM

CDM
FDM
FVM

#153

SNS_EnablePM

User accessible enable CM

Msg type = VAR
Data type = Unsigned16 (2)
Store = Static
Access = R/W (OOS)
Available in Release 8.0

0 = Disable CM
1 = Enable CM

CDM
FDM
FVM

#154

DEN_PressureOffset

Pressure offset

Msg type = VAR
Data type = Float (4)
Store = Static
Access = R/W (OOS)
Available in Release 8.0

— CDM
FDM
FVM
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Table A-26: Process variables for density viscosity transducer blocks (continued)

Index and name Description List of values HW

#155

DEN_Legacy_K22

K22 legacy calibration coefficient

Msg type = VAR
Data type = Float (4)
Store = Static
Access = R/W (OOS)
Available in Release 8.0

— CDM

#156

DEN_Legacy_K23

K23 legacy calibration coefficient

Msg type = VAR
Data type = Float (4)
Store = Static
Access = R/W (OOS)
Available in Release 8.0

— CDM

#157

DEN_KDV_CalIndex

Index for KDV results

Msg type = VAR
Data type = Unsigned16 (2)
Store = Static
Access = R/W (OOS)
Available in Release 8.0

0 = Factory
1 = User

CDM
FDM
FVM

#158

DEN_TempDiffAverage

Temperature differential average (health
check)

Msg type = VAR
Data type = Float (4)
Store = Static
Access = Read only
Available in Release 8.0

— CDM

#159

DEN_TempDiffStability

Temperature differential stability (health
check)

Msg type = VAR
Data type = Float (4)
Store = Static
Access = Read only
Available in Release 8.0

— CDM

#160

DEN_EnableExtTempModulus

Enable external temperature for modulus
compensation

Msg type = VAR
Data type = Unsigned16 (2)
Store = Static
Access = R/W in any mode
Available in Release 8.0

0 = Disable
1 = Enable

CDM
FDM
FVM

#161

DEN_EnableExtTempForVisc

Enable external temperature for
reference viscosity

Msg type = VAR
Data type = Unsigned16 (2)
Store = Static
Access = R/W in any mode
Available in Release 8.0

0 = Disable
1 = Enable

FVM
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Table A-26: Process variables for density viscosity transducer blocks (continued)

Index and name Description List of values HW

#162

SYS_AttachedCoreType

Indicates the attached core type

Msg type = ENUM
Data type = Unsigned16 (2)
Store = Static
Access = Read only
Available in Release 8.0

0 = CORE_UNKNOWN
1 = CORE_700
2 = CORE_ECP
3 = CORE_S
4 = CORE_DENSITY
5 = CORE_DEN_CDM
6 = CORE_DEN_FDM
7 = CORE_DEN_FVM

700
800
CDM
FDM
FVM

#163

DEN_SecBaseViscosity

Secondary referred viscosity

Msg type = VAR
Data type = DS65
Store = Dynamic
Access = Read only
Available in Release 8.0

— FVM

#164

DEN_RefViscUnits

Unit for reference and secondary
reference viscosity

Msg type = VAR
Data type = Unsigned16 (2)
Store = Static
Access = R/W (OOS)
Available in Release 8.0

1164 = Centistokes
1162 = Centipoise

FVM

#165

DEN_TEMPERATURE_UNITS

Temperature unit

Msg type = ENUM
Data type = Unsigned16 (2)
Store = Static
Access = R/W (OOS)
Available in Release 8.0

1000 = K
1001 = Deg C
1002 = Deg F
1003 = Deg R

700
800
CDM
FDM
FVM

#166

DENSITY_UNITS

Density unit

Msg type = ENUM
Data type = Unsigned16 (2)
Store = Dynamic
Access = Read only
Available in Release 8.0

1097 = kg/m3
1100 = g/cm3
1103 = kg/L
1104 = g/ml
1105 = g/L
1106 = lb/in3
1107 = lb/ft3
1108 = lb/gal
1109 = Ston/yd3
1113 = DegAPI
1114 = SGU
253 = Special (only for
CDM, FDM, FVM)

700
800
CDM
FDM
FVM
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Table A-26: Process variables for density viscosity transducer blocks (continued)

Index and name Description List of values HW

#167

PRESSURE_UNITS

Pressure unit

Msg type = ENUM
Data type = Unsigned16 (2)
Store = Dynamic
Access = R/W (OOS)
Available in Release 8.0

1148 = inch water @
68F / inch water@60F
1156 = inch HG @ 0C
1154 = ft water @ 68F
1151 = mm water @
68F
1158 = mm HG @ 0C
1141 = psi
1137 = bar
1138 = millibar
1144 = g/cm2
1145 = kg/cm2
1130 = pascals
1132 = Megapascals
1133 = kilopascals
1139 = torr @ 0C
1140 = atmospheres
1147 = Inches water
@ 4 degrees Celsius
1150 = Millimeters
water @ 4 degrees
Celsius

700
800
CDM
FDM
FVM

#168

DEN_ProductCode

Product code

Msg type = STR
Data type = VISIBLE STRING (32)
Store = Static
Access = Read only
Available in Release 8.0

— 700
800
CDM
FDM
FVM

#169

Velocity_Switch_Status

Flow rate switch status

Msg type = VAR
Data type = Unsigned16 (2)
Store = Dynamic
Access = Read only
Available in Release 9.0

0 = Inactive
1 = Active

CDM

#170

DEN_RefWaterDensity

Reference water density for inline
calibration

Msg type = VAR
Data type = Float (4)
Store = Static
Access = R/W in any mode
Available in Release 9.0

— CDM
FDM
FVM

#171

DEN_RefTemperature

Reference temperature for inline
calibration

Msg type = VAR
Data type = Float (4)
Store = Static
Access = R/W in any mode
Available in Release 9.0

— CDM
FDM
FVM
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Table A-26: Process variables for density viscosity transducer blocks (continued)

Index and name Description List of values HW

#172

DEN_RefPressure

Reference pressure for inline calibration

Msg type = VAR
Data type = Float (4)
Store = Static
Access = R/W in any mode
Available in Release 9.0

— CDM
FDM
FVM

#173

DEN_Fluid_Option

Fluid for KDV on user fluid

Msg type = ENUM
Data type = Unsigned16 (2)
Store = Static
Access = R/W in any mode
Available in Release 9.0

0 = Water
1 = User Fluid

CDM
FDM
FVM

#174

DEN_StartInlineCal

Start inline calibration

Msg type = ENUM
Data type = Unsigned16 (2)
Store = Static
Access = R/W in any mode
Available in Release 9.0

0 = No Action,
1 = Start

CDM
FDM
FVM

#175

DEN_CalculatedWaterDens

Calculated water density after inline
calibration

Msg type = VAR
Data type = Float (4)
Store = Static
Access = Read only
Available in Release 9.0

— CDM
FDM
FVM

#176

DEN_InlineCalResult

Result of inline calibration

Msg type = ENUM
Data type = Unsigned16 (2)
Store = Static
Access = Read only
Available in Release 9.0

0 = Fail / Not Run
1 = Pass

CDM
FDM
FVM

#177

DEN_InlineCalResultValue

Inline calibration check result

Msg type = VAR
Data type = Float (4)
Store = Static
Access = Read only
Available in Release 9.0

— CDM
FDM
FVM

(1) The list within the square bracket contains cores that support this value.
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B Fieldbus channel references
Table B-1: Analog input function blocks

Channel
number

Channel description Valid unit code Core applicability

1 Mass Flow Measurement TB → Mass Flow Units 700
800

2 Temperature Measurement TB → Temperature Units 700
800
CDM
FDM
FVM

3 Density Measurement TB → Density Units 700
800
CDM
FDM
FVM

4 Volume Flow Measurement TB → Volume Flow Units 700
800

5 Drive Gain 1342 = % 700
800
CDM
FDM
FVM

7 API Corr Density Measurement TB → Density Units 700
800
CDM
FDM
FVM

8 API Corr Vol Flow Measurement TB → Volume Flow Units 700
800

9 API Avg Corr Density Measurement TB → Density Units 700
800

10 API Avg Corr Temp Measurement TB → Temperature Units 700
800

11 API CTL 1588 = No Units 700
800

12 ED Ref Density Measurement TB → Density Units 800
CDM
FDM
FVM

13 ED Specific Gravity Measurement TB → Density Units 800
CDM
FDM
FVM

14 ED Std Vol Flow Measurement TB → Volume Flow Units 800
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Table B-1: Analog input function blocks (continued)

Channel
number

Channel description Valid unit code Core applicability

15 ED Net Mass Flow Measurement TB → Mass Flow Units 800
CDM
FDM
FVM

16 ED Net Vol Flow Measurement TB → Volume Flow Units 800
CDM
FDM
FVM

17 ED Conc CM TB → Concentration Units 800
CDM
FDM
FVM

18 ED Baume 1111 = Deg Baume (heavy)
1112 = Deg Baume (light)

800

19 Std Gas Volume Flow Measurement TB → Gas Std Vol Flow
Units

Table B-2: Analog output function blocks

Channel
number

Channel description Valid unit code Core applicability

6 Pressure Cal TB → Pressure Units 700
800
CDM
FDM
FVM

20 Temperature Measurement TB → Temperature Units 700
800
CDM
FDM
FVM

Table B-3: Discrete input function blocks

Channel number Channel description Core applicability

21 SNS Actual Flow Direction 700
800
CDM

22 SNS ZeroInProgress 700
800
CDM
FDM
FVM
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Table B-3: Discrete input function blocks (continued)

Channel number Channel description Core applicability

23 SYS AnalogOutputFault 700
800
CDM
FDM
FVM

24 SNS MVFailed 800

Table B-4: Discrete output function blocks

Channel number Channel description Core applicability

25 Start Sensor Zero 700
800
CDM

26 Reset Mass Total 700
800

27 Reset Volume Total 700
800

28 Reset API Reference (Standard) Volume Total 700
800

29 Reset All Process Totals (not Inv) 700
800

30 Reset ED Reference Volume Total 700
800

31 Reset ED Net Mass Total 700
800

32 Reset ED Net Volume Total 700
800

33 Start/Stop All Totals (includes Inv) 700
800

34 Increment ED Curve 700
800

35 Reset Gas Standard Volume Total 800

36 Start Meter Verification in Continuous Measurement Mode 800

Table B-5: AI function blocks

Channel
number

Channel description Valid unit code Core applicability

37 Special Equation Output 1588 = No Units CDM
FDM
FVM

38 Time Period A 1057 - Micro Second
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Table B-5: AI function blocks (continued)

Channel
number

Channel description Valid unit code Core applicability

39 Time Period B 1057 - Micro Second CDM
FDM
FVM

40 Tube-case temperature differential Measurement TB → Temperature Units CDM

41 Dynamic Viscosity Orion TB → Dynamic Viscosity Unit FVM

42 Kinematic Viscosity Orion TB → Kinematic Viscosity Unit FVM

43 Base viscosity Orion TB → DEN_RefViscUnits FVM

44 Quality Factor 1588 = No Units FVM

45 Flow velocity Orion TB → Flow velocity units CDM
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C FOUNDATION Fieldbus function blocks

C.1 Analog Input (AI) function block

The Analog Input (AI) Function Block processes the measurement from the Transducer Block and makes it
available to other function blocks. The output value from the AI block is in engineering units and contains a
status indicating the quality of the measurement. The AI block supports alarming, signal scaling, signal
filtering, signal status calculation, mode control, and simulation. In Automatic mode, the block’s output
parameter (OUT) reflects the process variable (PV) value and status. In Manual mode, OUT may be set
manually. The Manual mode is reflected on the output status. A discrete output (OUT_D) is provided to
indicate whether a selected alarm condition is active. Alarm detection is based on the OUT value and user
specified alarm limits.

C.1.1 AI block configuration parameters
• CHANNEL: The CHANNEL value is used to select the measurement value. Configure the CHANNEL

parameter before configuring the XD_SCALE parameter.

• L_TYPE: Linearization type. Determines whether the field value is used directly (Direct), is converted
linearly (Indirect), or is converted with the square root (Indirect Square Root).

• XD_SCALE: The high and low scale values, engineering units code, and number of digits to the right of the
decimal point associated with the channel input value. The XD_SCALE units code must match the units
code of the measurement channel in the transducer block. If the units do not match, the block will not
transition to MAN or AUTO.

• OUT_SCALE: The high and low scale values, engineering units code, and number of digits to the right of
the decimal point associated with OUT when L_TYPE is not direct.

• SIMULATE: A group of data that contains the current transducer value and status, the simulated
transducer value and status, and the enable/disable bit.

• PV_FTIME: The time constant of the first-order PV filter. It is the time required for a 63% change in the IN
value.

• LOW_CUT: If percentage value of transducer input fails below this, PV = 0.
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• LOW_LIM: The setting for the alarm limit used to detect the LO alarm condition for process variable in EU
of PV_SCALE.

• LO_PRI: The priority of the LO alarm.

• HI_LIM: The setting for the alarm limit used to detect the HI alarm condition for process variable in EU of
PV_SCALE.

• HI_PRI: The priority of the HI alarm.

• ALARM_HYS: The percent amount the alarm value must return within the alarm limit before the
associated active alarm condition clears.

C.1.2 AI block modes
The AI Function Block supports three modes of operation as defined by the MODE_BLK parameter:

• Manual (Man): The block output (OUT) may be set manually.

• Automatic (Auto): OUT reflects the analog input measurement or the simulated value when simulation is
enabled.

• Out of Service (O/S): The block is not processed. FIELD_VAL and PV are not updated and the OUT status is
set to Bad: Out of Service. The BLOCK_ERR parameter shows Out of Service. In this mode, you can make
changes to all configured parameters. The target mode of a block may be restricted to one or more of the
supported modes.

C.1.3 AI block simulation
To support testing, either change the mode of the block to manual and adjust the output value, or enable
simulation through the configuration tool and manually enter a value for the measurement value and its
status. To enable simulation, the Simulation switch has to be ON. With simulation enabled, the actual
measurement value has no impact on the OUT value or the status.

Note
The transmitter has a simulation switch on the display. As a safety measure, the switch has to be reset every
time there is a power interruption. This measure is to prevent devices that went through simulation in the
staging process from being installed with simulation enabled.

C.1.4 AI block configuration
A minimum of four parameters are required to configure the AI Block: CHANNEL, L_TYPE, XD_SCALE, and
OUT_SCALE.

CHANNEL

Select the channel that corresponds to the desired sensor measurement. The following table provides a list of
AI Function block channel numbers and channel applicability depending upon attached core type to
transmitter. If a channel is not supported for the given core type, the channel value will not work for the
transmitter.

For example, Mass Flow is not a valid assignment for CDM, FDM and FVM core processors attached to the
transmitter. The AI Function block will not reject the assignment but the Mass Flow value will not update
these core processors.
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Table C-1: AI block channel definitions

Channel Description 700 800 CDM FDM FVM

1 Mass flow X X

2 Temperature X X X X X

3 Density X X X X X

4 Volume flow X X X (1)

5 Drive gain X X X X X

7 API Corr Density X X X X X

8 API Corr Vol Flow X X

9 API Avg Corr Density X X

10 API Avg Corr Temp X X

11 API CTL X X

12 ED Ref Density X X X X X

13 ED Specific Gravity X X X X X

14 ED Std Vol Flow X

15 ED Net Mass Flow X X X

16 ED Net Vol Flow X X X

17 ED Conc X X X X

18 ED Baume X

19 Std Gas Volume Flow X X

37 Special Equation Output X X X

39 Time Period B X X X

40 Tube-case Temperature Differential X

41 Dynamic Viscosity X

42 Kinematic Viscosity X

43 Base viscosity X

44 Quality Factor X

45 Flow velocity X

(1) This channel assignment is supported only by CDM software revision 2.0 and above.

L_TYPE

The L_TYPE parameter defines the relationship of the sensor measurement to the desired output of the AI
block. The relationship can be direct, indirect, or indirect square root.
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L_TYPE setting Reason for selecting

Direct Select direct when the desired output will be the same as the sensor measurement. This is
the most common configuration.

Indirect Select indirect when the desired output is a calculated measurement based on the sensor
measurement. The relationship between the sensor measurement and the calculated
measurement will be linear.

Indirect square root Select indirect square root when the desired output is an inferred measurement based on
the sensor measurement and the relationship between the sensor measurement and the
inferred measurement is square root.

XD_SCALE and OUT_SCALE

The XD_SCALE and OUT_SCALE each include three parameters 0%, 100%, and UNITS (engineering units). Set
these based on the L_TYPE parameter setting.

L_TYPE setting Scaling effect

Direct • (XD_SCALE) 0% = 0

• (XD_SCALE) 100% = desired upper range value

• (XD_SCALE) UNITS = desired flow units

Note
XD_SCALE units are written to transducer block units.

Indirect When an inferred measurement is made based on the sensor measurement, set the
XD_SCALE to represent the operating range that the sensor will see in the process.
Determine the inferred measurement values that correspond to the (XD_SCALE) 0% and
(XD_SCALE) 100% points and set these for the OUT_SCALE.

C.1.5 AI block filtering
The filtering feature changes the response time of the device to smooth variations in output readings caused
by rapid changes in input. Adjust the filter time constant (in seconds) using the PV_FTIME parameter. Set the
filter time constant to zero to disable the filter feature.

C.1.6 AI block signal conversion
Set the signal conversion type with the Linearization Type (L_TYPE) parameter. Choose from direct, indirect,
or indirect square root signal conversion with the L_TYPE parameter.

• Direct signal conversion allows the signal to pass through the accessed channel input value (or the
simulated value when simulation is enabled).

• Indirect signal conversion converts the signal linearly to the accessed channel input value (or the simulated
value when simulation is enabled) from its specified range (XD_SCALE) to the range and units of the PV
and OUT parameters (OUT_SCALE).
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• Indirect Square Root signal conversion takes the square root of the value computed with the indirect signal
conversion and scales it to the range and units of the PV and OUT parameters.

C.1.7 AI block alarm detection
A block alarm will be generated whenever the BLOCK_ERR has an error bit set. The types of block error for the
AI block are defined above. Process alarm detection is based on the OUT value.

Configure the alarm limits of the following standard alarms:

• High (HI_LIM)

• High high (HI_HI_LIM)

• Low (LO_LIM)

• Low low (LO_LO_LIM)

To avoid alarm chatter when the variable is oscillating around the alarm limit, an alarm hysteresis in percent of
the PV span can be set using the ALARM_HYS parameter. The priority of each alarm is set in the following
parameters:

• HI_PRI

• HI_HI_PRI

• LO_PRI

• LO_LO_PRI

Number Description

0 The priority of an alarm condition changes to 0 after the condition that caused the alarm is corrected.

1 An alarm condition with a priority of 1 is recognized by the system, but is not reported to the operator.

2 An alarm condition with a priority of 2 is reported to the operator, but does not require operator attention
(such as diagnostics and system alerts).

3–7 Alarm conditions of priority 3 to 7 are advisory alarms of increasing priority.

8–15 Alarm conditions of priority 8 to 15 are critical alarms of increasing priority.

C.1.8 AI block status handling
Normally, the status of the PV reflects the status of the measurement value, the operating condition of the
I/O card, and any active alarm condition. In Auto mode, OUT reflects the value and status quality of the PV. In
Man mode, the OUT status constant limit is set to indicate that the value is a constant and the OUT status is
Good. If the sensor limit exceeds the high or low range, PV status is set high or low and EU range status is set
to uncertain.

In the STATUS_OPTS parameter, select from the following options to control the status handling.
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Status handling setting Effect

Bad if limited Sets the OUT status quality to Bad when the value is higher or lower than the sensor limits.

Uncertain if limited Sets the OUT status quality to Uncertain when the value is higher or lower than the sensor
limits.

Uncertain if in manual
mode

Sets the OUT status quality to Uncertain when the mode is set to Manual.

C.1.9 AI block default configuration
AI1 (AI_2600_xxxx) AI2 (AI_2800_xxxx) AI3 (AI3000_xxxx) AI4 (AI_3200_xxxx

Channel Mass flow (1) Temperature (2) Density (3) Volume flow (4)

XD_SCALE

EU_100 100 100 100 100

EU_0 0 0 0 0

Unit_Index g/s degC g/cm³ L/s

Decimal 2 2 2 2

OUT_SCALE

EU_100 100 100 100 100

EU_0 0 0 0 0

Unit_Index % % % %

Decimal 0 0 0 0

L_TYPE Direct Direct Direct Direct

C.2 Analog Output (AO) function block

The AO block converts the FF value to a channel value by using two sets of scaling values. PV_SCALE is used to
convert the FF value in SP to percent. The IO_OPT Increase to Close may be used to reverse the output
direction. XD_SCALE is used to convert the percent FF value to the value for the channel, which should be
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given in the device manual. XD_SCALE high and low can be reversed to give reverse action, rather than using
Increase to Close. There are no nonlinear conversions, at this time. The block output is a copy of the value that
is sent to transducer processing via the channel. It may be linked to the input of a controller or control
selector to perform valve position control.

C.2.1 AO block configuration parameters
• CHANNEL: Defines the output that drives the field device. The block will be forced into OOS mode until a

channel number for an analog output is entered. Select the channel that corresponds to the desired sensor
measurement.

Table C-2: AO block channel definitions

Channel Description

28 Pressure

29 Temperature

30 Watercut

• PV_SCALE: PV_SCALE is used to convert the FF value in SP to percent. The units are usually percent.

• XD_SCALE: XD_SCALE is used to convert the percent FF value to the value for the channel, which should
be given in the device manual. Choose scaling units that are compatible with the transducer block
parameter. A configuration alarm is generated if the channel is not an analog output or the scaling limits
or units of XD_SCALE are not available from the transducer. The block will be forced into OOS mode until
the correct entries are made.

C.2.2 AO block modes
The AO function block supports following modes of operation defined by MODE_BLK parameter:

• Out of Service (O/S): The AO algorithm of the block is not executed. The last value is issued at OUT or the
determined value when the Fault State is activated.

• Manual (MAN): The user can directly enter the output value of the AO Block.

• Automatic (AUTO): The set point entered by the user is used over the SP parameter on implementation of
the AO Block.

• Cascade (CAS): The AO Function Block receives the set point directly from an upstream function block over
the CAS_IN parameter to calculate the output value internally. The AO Block is implemented.

• Remote Cascade (RCAS): The AO Function Block receives the set point directly from the host system over
the RCAS_IN parameter to calculate the output value internally. The AO Block is implemented.

C.2.3 AO block errors
The following conditions are reported in the BLOCK_ERR attribute:

• Block Configuration Error: The selected channel is incompatible with the engineering units selected in
XD_SCALE or the CHANNEL is zero.

• Link Configuration Error

• Simulate Active: Simulation is enabled and the block is using a simulated value in its execution.
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• Local Override: The output of the block is not responding to OUT because the resource block has been
placed into LO mode or fault state action is active.

• Device Fault State set:

• Output Failure: May be propagated backward as BAD, Device Failure

• Readback Check Failed: May be propagated backward as BAD, Sensor Failure

• Out-of-Service: The actual mode is out of service (OOS)

C.2.4 AO block simulation
When simulation is enabled, the last value of OUT is maintained and reflected in the field value of the
SIMULATE attribute. In this case, the PV and READBACK values and statuses are based on the SIMULATE value
and the status that you enter.

Note
The transmitter has a simulation Switch on the display. As a safety measure, the switch has to be reset every
time there is a power interruption. This measure is to prevent devices that went through simulation in the
staging process from being installed with simulation enabled.

C.2.5 AO block status handling
Output or readback fault detection are reflected in the status of PV, OUT, and BKCAL_OUT.

A limited SP condition is reflected in the BKCAL_OUT status. When simulation is enabled through the
SIMULATE attribute, you can set the value and status for PV and READBACK.

When the block is in Cas mode and the CAS_IN input goes bad, the block sheds mode to the next permitted
mode.

C.2.6 AO block default configuration
AO1 (AO_3400_xxxx) AO2 (AI_3600_xxxx)

Channel Pressure (28) Temperature (29)

XD_SCALE

EU_100 100 100

EU_0 0 0

Unit_Index Psi degC

Decimal 2 2

OUT_SCALE

EU_100 100 100

EU_0 0 0

Unit_Index % %

Decimal 0 0

L_TYPE Direct Direct
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C.3 Integrator (INT) Function Block

The Integrator (INT) function block integrates one or two variables over time. The block compares the
integrated or accumulated value to pre-trip and trip limits and generates discrete output signals when the
limits are reached.

The INT integrates one process value. Each input may be an analog value or a pulse count from a Pulse Input
block. Two inputs are provided so that a net total can be calculated.

The two inputs are added to produce a result that is used by the integrator. Options may be applied to limit
the result to positive or negative flow. The status of the result is the worse of the two inputs.

The integrator calculates three totals that are not visible from Fieldbus. Total is the true integration of the
signed value from the adder, regardless of status. Total is visible as the value of OUT. Atotal is the integration
of the absolute value from the adder, regardless of status. Rtotal is the integration of the absolute value from
the adder with bad status. The ratio of Rtotal to Atotal gives the approximate percent of Total that has good
status. This determines the status of OUT.

The integrator may be used in seven ways. It may count until is is reset (standard totalizer) or count until
periodically reset, or both. One of the other four ways is selected if the INT block is used as a batch ingredient
loader. The amount to be loaded is set in TOTAL_SP. The integrator may count up to TOTAL_SP or count
down to zero from TOTAL_SP. OUT_PTRIP turns on as the total approaches the set amount, possibly to
reduce flow for fine control of the total. OUT_TRIP turns on when the total equals TOTAL_SP, which may
automatically reset the integrator or not. Count up or count down and automatic reset or not are the four
ways to use the INT block as a batch ingredient loader.

The totals may be reset by an operator or a discrete input, if permitted. Reset causes data to be stored in
‘snapshot’ registers, where it can be read until the next reset command. There is an option to disable the reset
commands immediately after a successful reset, until the RESET_CONFIRM input is true. This option makes
sure that the values at the time of the last reset are not changed by another reset until after the user has read
them.

The block has no process alarms, but can generate a reset event.

This block is intended to have measurements that come from a process calculation path. It will work with
input from a control path. The block output starts a process calculation path.

The block is unusual because the status of the output has to be calculated. The output status is not directly
related to the status of the inputs. The output can be the input to another INT block.
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C.3.1 INT block configuration parameters
• INTEG_TYPE: The integration type parameter (INTEG_TYPE) defines the integrate up, integrate down, and

reset characteristics of the block.

INTEG_TYPE setting Description

UP_AUTO Integrates from zero to the setpoint and automatically resets when the SP is reached.

UP_DEM Integrates from zero to the setpoint and resets when RESET_IN or the operator
command to reset the integrator (OP_CMT_INT) transitions to True (1).

DN_AUTO Integrates from the setpoint to zero and automatically resets when zero is reached.

DN_DEM Integrates from the setpoint to zero and resets when RESET_IN or OP_CMD_INT
transitions to True.

PERIODIC Counts upward and resets periodically. The period is set by the CLOCK_PER attribute.

DEMAND Counts upward and is reset when RESET_IN or OP_CMD_INT transitions to True.

PER&DEM Counts upward and is reset periodically or by RESET_IN.

• INTEG_OPTS: The integration options parameter (INTEG_OPTS) defines the following options.

INTEG_OPTS setting Description

Input 1 accumulate The input value must be pulse count rather than rate. The accumulated pulse count
must be for the same block execution time as the Pulse Input block.

Input 2 accumulate The input value must be pulse count rather than rate. The accumulated pulse count
must be for the same block execution time as the Pulse Input block.

Flow forward The result of adder is limited to zero, when it would be negative.

Flow reverse The result of adder is limited to zero, when it would be positive.

Use Uncertain Integrate input even though the status of input is Uncertain.

Use Bad Integrate input even though the status of input is Bad.

Carry Carry the excess past the trip point into the next integration cycle as the initial value of
the integration.

Add zero if bad This option ignores Bad value at input. The input with Bad status is not integrated.

Confirm reset If the Confirm reset is set, the block shall not process subsequent reset at RESET_IN
until RESET_CONFIRM discrete input is TRUE.

Input 1 pass through This is special option only used for Emerson Integrator block to pass internal totals to
Integrator block.

• TIME_UNITn: The integrator requires units per second, so TIME_UNITn is used to convert rate units of
minutes, hours and days back to seconds. Minutes divides the input by 60, Hour by 3600, and Day by
86400 so that the result is engineering units per second.

• TPTAL_SP: The integrator may count up to TOTAL_SP or count down to zero from TOTAL_SP, depending
upon the INTEG_TYPE selection. Same units as OUT.

• UNIT_CONV: Factor to convert the engineering units of input 2 into the engineering units of input 1. It can
be any positive decimal number or fraction. It defaults to 1.

• PULSE_VALn: Factor to convert Inn pulses to engineering units to get a total in engineering units.
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• PRE_TRIP: Adjusts the amount of IN that will set OUT_PTRIP when the integration reaches (TOTAL_SP-
PRE_TRIP) when counting up or PRE_TRIP when counting down. Same units as OUT. It defaults to 0.

C.3.2 INT block other parameters
• IN_1: The main input to this block, normally a rate in units per TIME_UNIT of time. INTEG_OPTS allows the

input to come from a pulse input block or another INT block, using PULSE_VAL for scaling.

• IN_2: The second input, with the same characteristics as IN_1. This input allows for totalizing the
difference between (net) of two flows.

• RESET_IN: Momentary discrete input that resets the totalizers, if permitted. May not work if the type is
PERIODIC.

• RESET_CONFIRM: Momentary discrete input that enables the next Reset command, if the Confirm option
is set.

• OUT: The output that contains the value of the total register and a calculated status.

• OUT_PTRIP: The pre-trip discrete output.

• OUT_TRIP: The trip discrete output.

• PCT_INCL: Indicates the percentage of inputs with Good status compared to a total for all inputs.

• RTOTAL: Indicates the total of the absolute value of input values with Bad or Uncertain status, as chosen by
INTEG_OPTS. Same units as OUT.

• STOTAL: The read-only snapshot of TOTAL just before a reset. Same units as OUT.

• SRTOTAL: The read-only snapshot of RTOTAL just before a reset. Same units as OUT.

• N_RESET: Counts the number of resets. It can not be written or reset.

C.3.3 INT block modes
The Integrator function block supports the following modes:

• Manual (Man) – The integration calculations are not performed. OUT, OUT_TRIP, and OUT_PTRIP may be
set manually.

• Automatic (Auto) – The integration algorithm is performed and the result is written to OUT. Reset actions
depend on the integration type attribute (INTEG_TYPE) and the inputs.

• Out of Service (O/S) – The block does not execute. OUT status is set to Bad: Out of Service. The BLOCK_ERR
attribute shows Out of service.

The integrator initializes with the value in OUT when the mode changes from Manual to Automatic. The
Manual, Automatic, and Out of Service modes may be configured as permitted modes for operator entry.

C.3.4 INT block errors
The following conditions are reported in the BLOCK_ERR parameter:

• Block Configuration Error: INTEG_TYPE is still zero, TIME_UNITn is still zero.

• Out-of-Service: The actual mode is out of service (OOS).
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C.3.5 INT block status handling
The output status calculation is based on the accumulation of input statuses. The calculation includes the
accumulations for both input channels when IN_2 is enabled.

Each time the function block executes, the input status is accumulated as Good or Bad as per the input status.
The input as uncertain is considered as Bad input.

The output status is determined with the following logic:

• When less than 25% of the input status accumulation is Good, OUT status is set to Bad.

• When 25% to less than 50% of the input status accumulation is Good, OUT status is set to Uncertain.

• When 50% or more of the input status accumulation is Good, OUT status is set to Good.

The input status accumulation is reset when the integrator is reset.

C.3.6 INT block special mode
Enhanced FF host Overview → Totalizer Control → Configure Integrator Block

Fieldbus Host Measurement TB → INTEGRATOR_FB_CONFIG (OD Index 50)

Along with standard operation of integrating the process value at INn, the Integrator function block has one
special mode of operation: Input 1 pass through. In this special mode of operation, the device internal totals/
inventories are controlled through the Integrator block. The Integrator block passes through the device total/
inventory to output and the device total/inventory is reset by the RESET_IN input. To control the integrator
block mode there is one additional parameter in the Total-Inventory TB for each INT block. By default the
integrator function block operates in standard mode.

Fieldbus
code

Label Description

0 Standard Block is working as per configuration of function block parameters.

1 Internal Mass Total Block outputs internal mass total value and RESET_IN resets internal mass total

2 Internal Volume Total Block outputs internal volume total value and RESET_IN resets internal volume
total

3 Internal Mass
Inventory

Block outputs internal mass inventory value and RESET_IN resets internal mass
inventory

4 Internal Volume
Inventory

Block outputs internal volume inventory value and RESET_IN resets internal
volume inventory

5 Internal Gas Standard
Volume Total

Block outputs internal gas standard volume total value and RESET_IN resets
internal gas standard volume total

6 Internal Gas Standard
Volume Inventory

Block outputs internal gas standard volume inventory value and RESET_IN resets
gas standard volume inventory and internal API: temp corrected volume
inventory

7 Internal API: Temp
Corrected Volume
Total

Block outputs internal API: temp corrected volume total value and RESET_IN
resets internal API: temp corrected volume total
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Fieldbus
code

Label Description

8 Internal API: Temp
Corrected Volume
Inventory

Block outputs internal API: temp corrected volume inventory value and RESET_IN
resets gas standard volume inventory and internal API: temp corrected volume
inventory

9 Internal ED: Standard
Volume Total

Block outputs internal ED: standard volume total value and RESET_IN resets
internal ED: standard volume total

10 Internal ED: Standard
Volume Inventory

Block outputs internal ED: standard volume inventory value and RESET_IN resets
internal ED: standard volume inventory

11 Internal ED: Net Mass
Total

Block outputs internal ED: net mass total value and RESET_IN resets internal ED:
net mass total

12 Internal ED: Net Mass
Inventory

Block outputs internal ED: net mass inventory value and RESET_IN resets internal
ED: net mass inventory

13 Internal ED: Net
Volume Total

Block outputs internal ED: net volume total value and RESET_IN resets internal
ED: net volume total

14 Internal ED: Net
Volume Inventory

Block outputs internal ED: net volume inventory value and RESET_IN resets
internal ED: net volume inventory

C.3.7 INT block default configuration
ITB1 (INTEG_4000_6830) ITB2 (INTEG_4200_6830)

INTEG_TYPE Uninitialized Uninitialized

OUT_RANGE

EU_100 100 100

EU_0 0 0

Unit_Index % %

C.4 Discrete Input (DI) function block
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The Discrete Input (DI) function block processes a single discrete input from a field device and makes it
available to other function blocks. You can configure inversion and alarm detection on the input value. The
Discrete Input function block supports mode control, signal status propagation, and simulation.

C.4.1 DI block common configuration parameters
• CHANNEL: Defines the I/O input used for the field measurement.

Channel Description

31 Actual flow direction

32 Zero in progress

33 Analog output fault

34 Meter verification failed

• IO_OPTS: allows the option to have the value of FIELD_VAL_D be logically inverted before becoming the
PV_D, if the Invert option is selected.

• STATUS_OPTS: allows the option to have the status of OUT_D be Uncertain if Man mode. It also allows the
option to Propagate Fault Forward.

C.4.2 DI block modes
The DI function block supports following modes:

• Manual (MAN): The output (OUT_D) is disconnected from the field.

• Automatic (AUTO): The block algorithm determines OUT_D.

• Out of Service (O/S): The block is not processed. The output status is set to Bad: Out of Service. The
BLOCK_ERR attribute shows Out of Service.

C.4.3 DI block errors
The following conditions are reported in the BLOCK_ERR attribute:

• Simulate Active: Simulation is enabled and the block is using a simulated value in its execution.

• Input failure/process variable has Bad status: The hardware is bad, the configured channel is invalid, or a Bad
status is being simulated.

• Out-of-Service: The actual mode is out of service (OOS)

C.4.4 DI block simulation
When simulation is enabled, the value of SIMULATE is reflected in the field value of the OUT_D. With
simulation enabled, the actual measurement value has no impact on the OUT_D value or the status.

Note
The transmitter has a simulation switch on the display. As a safety measure, the switch has to be reset every
time there is a power interruption. This measure is to prevent devices that went through simulation in the
staging process from being installed with simulation enabled.
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C.4.5 DI block status handling
Under normal conditions, a Good: Non-cascade status is passed through to OUT_D. The block also supports
Status Action on Failure and Block Error indications.

C.4.6 DI block default configuration
DI1 (DI_4400_xxxx)

CHANNEL Analog Output Fault (33)

IO_OPTS 0x0000

STATUS_OPTS 0x0000

C.5 Discrete Output (DO) function block

The Discrete Output (DO) function block processes a discrete setpoint and saves it to a specified channel to
produce an output signal. The block supports mode control, output tracking, and simulation. There is no
process alarm detection in the block. In operation, the DO function block determines its setpoint, sets the
output, and, as an option, checks a feedback signal from the field device to confirm the physical output
operation.

C.5.1 DO block configuration
• CHANNEL: Selects transducer block input or output.

Channel Description

35 Start Sensor Zero

36 Increment CM Curve

37 Smart Meter Verification in Continuous Measurement Mode

38 Reset All Process Totals

39 Start/Stop All Totals

40 Reset Config Total 1
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Channel Description

41 Reset Config Total 2

42 Reset Config Total 3

43 Reset Config Total 4

44 Reset Config Total 5

45 Reset Config Total 6

46 Reset Config Total 7

• IO_OPTS: Options which the user may select to alter input and output block processing.
— Invert - Causes the SP_D value to be inverted before it becomes the output. May be used for normally

open solenoid valves and other inverted actuators.

— SP-PV Track in Man - The value of SP is set to the value of PV when the target mode is Man.

— SP-PV Track in LO or IMan - The value of SP is set to the value of PV when the actual mode is LO or IMan.

— SP Track Retained Target - The SP is set to the PV when the actual mode is LO, IMan or Man. This option
causes the value of the input selected by the retained target mode to be used instead of PV.

— Use PV for BKCAL_OUT - This only useful if BKCAL_OUT_D is connected to something.

— Fault State to value - Set SP_D and OUT_D to FSTATE_VAL_D when the block is in the fault state. If this
option is not selected then the output will freeze. The block mode will be LO either way.

— Use Fault State value on restart - Use the value of FSTATE_VAL_D for OUT_D and SP_D if the device is
restarted, otherwise use the non-volatile value. This will only be useful if the cascade input is bad at
startup.

— Target to Man if Fault State activated - Set the target mode to Man if Fault State is activated. This
latches an output block into the Man mode until an operator writes another target mode. Otherwise,
the mode is LO while fault state is active, and returns to the target mode when the block state returns
to normal.

• SIMULATE_D: Enables simulation.

• FSTATE_TIME: Time delay before Fault State is declared for this block if there is loss of communications to
CAS_IN or there is Good Control, Initiate Fault State status at CAS_IN when the target mode is Cas, or
there is Good Control, Initiate Fault State status at RCAS_IN when the target mode is RCas. Fault State
declared by the Resource Block is not delayed.

• CAS_IN_D: Connection to this block’s discrete SP from another discrete block’s output, active only in
Cascade mode. Always used for DO blocks.

C.5.2 DO block modes
The DO block supports the following modes:

• Manual (MAN): The block output (OUT_D) may be entered manually.

• Automatic (AUTO): The block algorithm uses the local setpoint value (SP_D) to determine OUT_D.

• Cascade (CAS): The block uses a setpoint supplied by another function block.

• RemoteCascade (RCAS): The block uses a setpoint supplied by a host computer.
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• Out of Service (O/S): The block is not processed and the output is not transferred to I/O. The BLOCK_ERR
attribute shows Out of service.

C.5.3 DO block errors
The following conditions are reported in the BLOCK_ERR attribute:

• Simulate Active: SIMULATE_D is enabled; therefore, PV_D is not real.

• Input failure/process variable has Bad status: The readback value is bad.

• Output Failure: The output hardware or the configured channel is invalid.

• Readback Failed: The hardware providing readback is bad.

• Out-of-Service: The block is not being processed.

C.5.4 DO block simulation
With SIMULATE_D enabled, the specified value and status is reflected in READBACK_D. If SIMULATE_D is not
enabled, and the mode is not Out of Service, the value of OUT_D is sent to the hardware

Note
The transmitter has a simulation Switch on the display. As a safety measure, the switch has to be reset every
time there is a power interruption. This measure is to prevent devices that went through simulation in the
staging process from being installed with simulation enabled.

C.5.5 DO block status handling
Under normal operating conditions, the output statuses (OUT_D and BKCAL_OUT_D) are Good: Cascade. If
the output hardware fails, the status of BKCAL_OUT_D is set to Bad: DeviceFail, and the BLOCK_ERR attribute
shows Output Failure. If the hardware used for output feedback fails, the status of READBACK_D and PV_D is
set to Bad: DeviceFail, and the BLOCK_ERR attribute shows Bad PV and Readback Failed.

C.5.6 DO block default configuration
DO1 (DO_4600_xxxx)

CHANNEL Start Sensor Zero (35)

IO_OPTS 0x0000
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D Using the transmitter display
This section explains how to use the 2700 display. Using the display, you can move through the menus,
configure the application, monitor and control the application, and perform maintenance and diagnostic
tasks.

D.1 Using the display

D.1.1 Components of the transmitter interface
The transmitter interface includes the status LED, the display (LCD panel), and two optical switches.

Figure D-1: Transmitter interface

A
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G

H

A. Status LED
B. Display (LCD panel)
C. Process variable
D. Scroll optical switch
E. Optical switch indicator
F. Select optical switch
G. Unit of measure for process variable
H. Current value of process variable

Note
Display refers to the display on the remotely mounted transmitter, not directly mounted to the meter. If there
is a display directly on the meter, it can only view process variables, and it cannot be used for any other
operation.
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D.1.2 Use the optical switches
Use the optical switches on the transmitter interface to control the transmitter display. The transmitter has
two optical switches: Scroll and Select.

Note
Display refers to the display on the remotely mounted transmitter, not directly mounted to the meter. If there
is a display directly on the meter, it can only view process variables, and it cannot be used for any other
operation.

Procedure

To activate an optical switch, block the light by holding your thumb or finger in front of the opening.

Tip
You can activate the optical switch through the lens. Do not remove the transmitter housing cover.

The optical switch indicator lights up when the transmitter senses that an optical switch has been activated.

Table D-1: Optical switch indicator and optical switch states

Optical switch indicator State of optical switches

Solid red One optical switch is activated.

Flickering red Both optical switches are activated.

D.1.3 Access and use the display menu system
The display menu system is used to perform various configuration, administrative, and maintenance tasks.

Prerequisites

To access the display menu system, operator access to either the Off-Line menu or the Alert menu must be
enabled. To access the complete menu system, operator access must be enabled for both the Off-Line menu
and the Alert menu.

Tip
The display menu system does not provide complete configuration, administrative, or maintenance
functions. For complete transmitter management, you must use another communications tool.

Note
Display refers to the display on the remotely mounted transmitter, not directly mounted to the meter. If there
is a display directly on the meter, it can only view process variables, and it cannot be used for any other
operation.

Procedure

1. At the transmitter display, activate theScroll and Select optical switches simultaneously until the
display changes.
You will enter the Off-Line menu at any of several locations, depending on several factors.

• If an alert is active and access to the Alert menu is enabled, you will see SEE ALERT.

• If no alert is active and Smart Meter Verification is enabled on the transmitter, you will see ENTER
METER VERFY.
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• If no alert is active and Smart Meter Verification is not enabled on the transmitter, you will see OFF-
LINE MAINT.

2. If CODE? appears on the display when you make a choice, enter the value that is configured for Off-Line
Password.

a) With the cursor flashing on the first digit, activate Scroll until the correct digit is displayed, then
activate Select.

b) Repeat this process for the second, third, and fourth digits.

Tip
If you do not know the correct value for Off-Line Password, wait 30 seconds. The password screen will
time out automatically and you will be returned to the previous screen.

3. Use the Scroll and Select optical switches to navigate to your destination in the display menu system.
• Use Scroll to move through a list of options.

• Use Select to choose the current option.

4. If Scroll flashes on the display, activate the Scroll optical switch, then the Select optical switch, and
then the Scroll optical switch again.

The display will prompt you through this sequence. The Scroll-Select-Scroll sequence is designed to
guard against accidental activation of the off-line menu. It is not designed as a security measure.

5. To exit a display menu and return to a higher-level menu:
• Activate Scroll until the EXIT option is displayed, then activate Select.

• If the EXIT option is not available, activate Scroll and Select simultaneously and hold until the
screen returns to the previous display.

6. To exit the display menu system, you can use either of the following methods:
• Exit each menu separately, working your way back to the top of the menu system.

• Wait two minutes until the display times out and returns to displaying process variable data.

Enter a floating-point value using the display
Certain configuration values (for example, Lower Range Value and Upper Range Value) are entered as
floating-point values. The display supports both decimal notation and exponential notation for floating-point
values.

The display allows you to enter a maximum of 8 characters, including the sign. The decimal point is not
counted as a character. Exponential notation is used to enter values that require more than 8 characters.

Enter a floating-point value using decimal notation

Decimal notation allows you to enter values between –9999999 and 99999999. You can use the decimal
point to enter values with a precision of 0 through 4 (4 characters to the right of the decimal point).

Decimal values entered via the display must meet the following requirements:

• They can contain a maximum of 8 digits, or 7 digits plus a minus sign (−) to indicate a negative number.

• They can contain a decimal point. The decimal point does not count as a digit. The decimal point must be
positioned so that the precision of the value does not exceed 4.

Configuration and Use Manual Using the transmitter display
20000326 August 2022

Configuration and Use Manual 281



When you first enter the configuration screen, the current configuration value is displayed in decimal
notation, and the active character is flashing. If the value is positive, no sign is displayed. If the value is
negative, a minus sign is displayed.

Note
Display refers to the display on the remotely mounted transmitter, not directly mounted to the meter. If there
is a display directly on the meter, it can only view process variables, and it cannot be used for any other
operation.

Procedure

• To change the value:

a) Activate Select until the digit you want to change is active (flashing).

Select moves the cursor one position to the left. From the leftmost position, Select moves the
cursor to the rightmost digit.

b) Activate Scroll to change the value of the active digit.

c) Repeat until all digits are set as desired.

• To change the sign of the value:
• If the current value is negative, activate Select until the minus sign is flashing, then activate Scroll until

the space is blank.

• If the current value is positive and there is a blank space at the left of the value, activate Select until the
cursor is flashing under the blank space, then activate Scroll until the minus sign appears.

• If the current value is positive and there is no blank space at the left of the value, activate Select until
the cursor is flashing under the leftmost digit, then activate Scroll until the minus sign appears.

• To move the decimal point:

a) Activate Select until the decimal point is flashing.

b) Activate Scroll.
The decimal point is removed from its current position.

c) Activate Select and watch the position of the decimal point.

As the cursor moves to the left, the decimal point will flash between each pair of digits, up to a
maximum precision of four (four digits to the right of the decimal point).

Tip
If the position is not valid, the decimal point is not displayed. Continue to activate Select until the
decimal point appears at the right of the displayed value.

d) When the decimal point is in the desired position, activate Scroll.
The decimal point is inserted at its current position.

• To save the displayed value to transmitter memory, activate Scroll and Select simultaneously and hold
until the display changes.
• If the displayed value is the same as the value in transmitter memory, you will be returned to the

previous screen.

• If the displayed value is not the same as the value in transmitter memory, SAVE/YES? flashes on the
display. Activate Select.
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• To exit the menu without saving the displayed value to transmitter memory, activate Scroll and Select
simultaneously and hold until the display changes.
• If the displayed value is the same as the value in transmitter memory, you will be returned to the

previous screen.

• If the displayed value is not the same as the value in transmitter memory, SAVE/YES? flashes on the
display. Activate Scroll.

Enter a floating-point value using exponential notation

Exponential notation is used to enter values that are larger than 99999999 or smaller than −9999999.

Exponential values entered via the display must be in the following form: SX.XXXEYY. In this string:

• S = Sign. A minus sign (−) indicates a negative number. A blank indicates a positive number.

• X.XXX = The 4-digit mantissa.

• E = The exponent indicator.

• YY = The 2-digit exponent.

Procedure

1. Switch from decimal notation to exponential notation.

a) Activate Select as required until the rightmost digit is flashing.

b) Activate Scroll until E is displayed.

c) Activate Select.

Tip
If you have modified the value in decimal notation without saving the changes to transmitter memory,
the changes will be lost when you switch to exponential notation. Save the decimal value before
switching to exponential notation.

2. Enter the exponent.

The first character may be a minus sign or any digit between 0 and 3. The second character may be any
digit between 0 and 9.

a) Activate Select to move the cursor to the rightmost character on the display.

b) Activate Scroll until the desired character is displayed.

c) Activate Select to move the cursor one position to the left.

d) Activate Scroll until the desired character is displayed.

3. Enter the mantissa.

The mantissa must be a 4-digit value with a precision of 3 (that is, all values between 0.000 and 9.999).

a) Activate Select to move the cursor to the rightmost digit in the mantissa.

b) Activate Scroll until the desired character is displayed.

c) Activate Select to move the cursor one digit to the left.

d) Activate Scroll until the desired character is displayed.

e) Activate Select to move the cursor one digit to the left.
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f) Activate Scroll until the desired character is displayed.

g) Activate Select to move the cursor one digit to the left.

h) Activate Scroll until the desired character is displayed.

4. Enter the sign.

a) Activate Select to move the cursor one digit to the left.

b) Activate Scroll until the desired character is displayed.

For positive numbers, select a blank space.

5. To save the displayed value to transmitter memory, activate Scroll and Select simultaneously and hold
until the display changes.
• If the displayed value is the same as the value in transmitter memory, you will be returned to the

previous screen.

• If the displayed value is not the same as the value in transmitter memory, SAVE/YES? flashes on the
display. Activate Select.

6. Switch back from exponential notation to decimal notation.

a) Activate Select until the E is flashing.

b) Activate Select until d is displayed.

c) Activate Select.

D.1.4 Display codes for process variables
Table D-2: Display codes for process variables

Code Definition Comment or reference

AVE_D Average density Petroleum measurement application only

AVE_T Average temperature Petroleum measurement application only

BRD_T Board temperature

CONC Concentration Concentration measurement application only

DRIVE% Drive gain

EXT_P External pressure

EXT_T External temperature

GSV F Gas standard volume flow

GSV I Gas standard volume inventory

GSV T Gas standard volume total

LPO_A Left pickoff amplitude

LVOLI Volume inventory

LZERO Live zero flow

MASSI Mass inventory
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Table D-2: Display codes for process variables (continued)

Code Definition Comment or reference

MTR_T Case temperature (T-Series sensors only)

NET M Net mass flow rate Concentration measurement application only

NET V Net volume flow rate Concentration measurement application only

NETMI Net mass inventory Concentration measurement application only

NETVI Net volume inventory Concentration measurement application only

PWRIN Input voltage Refers to power input to the core processor

RDENS Density at reference temperature Concentration measurement application only

RPO_A Right pickoff amplitude

SGU Specific gravity units

STD V Standard volume flow rate Concentration measurement application only

STDVI Standard volume inventory Concentration measurement application only

TCDENS Temperature-corrected density Petroleum measurement application only

TCORI Temperature-corrected inventory Petroleum measurement application only

TCORR Temperature-corrected total Petroleum measurement application only

TCVOL Temperature-corrected volume Petroleum measurement application only

TUBEF Raw tube frequency

WTAVE Weighted average

D.1.5 Codes and abbreviations used in display menus
Table D-3: Codes and abbreviations used in display menus

Code or
abbreviation Definition Comment or reference

ACK ALERT Acknowledge alert

ACK ALL Acknowledge all alerts

ACT Action

ADDR Address

AO1 Analog output 1
(primary mA Output)

AO 1 SRC Fixed to the process variable
assigned to the primary output

AO2 Analog output 2
(secondary mA Output)

AUTO SCRLL Auto Scroll

BKLT

B LIGHT

Backlight
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Table D-3: Codes and abbreviations used in display menus (continued)

Code or
abbreviation Definition Comment or reference

CAL Calibrate

CH A Channel A

CHANGE PASSW

CHANGE CODE

Change password
or passcode

Change the password or passcode required for
access to display functions

CH B Channel B

CH C Channel C

CONFG Configuration

CORE Core processor

CUR Z Current zero

DENS Density

D EV Discrete event Events configured using the enhanced event
model

DGAIN, DRIVE % Drive gain

DISBL Disable Select to disable

DO1 Discrete Output 1

DO2 Discrete Output 2

DSPLY Display

E1OR2 Event 1 or Event 2 Events configured using the basic event model

ENABL Enable Select to enable

ENABLE ACK Enable acknowledge all Enable or disable the ACK ALL function

ENABLE ALERTS Enable alert menu Access to alert menu from display

ENABLE AUTO Enable Auto Scroll Enable or disable the Auto Scroll function

ENABLE OFFLN Enable off-line Access to off-line menu from display

ENABLE PASSW Enable password Enable or disable password protection for display
functions

ENABLE RESET Enable totalizer reset Enable or disable totalizer reset from display

ENABLE START Enable totalizer start Enable or disable totalizer start/stop from display

EVNT1 Event 1 Event configured using the basic event model
only

EVNT2 Event 2 Event configured using the basic event model
only

EXTRN External

FAC Z Factory zero

FCF Flow calibration factor
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Table D-3: Codes and abbreviations used in display menus (continued)

Code or
abbreviation Definition Comment or reference

FLDIR Flow direction

FL SW

FLSWT

Flow switch

FO Frequency Output

FO FREQ Frequency factor

FO RATE Rate factor

FREQ Frequency

FR FL Frequency=Flow

GSV Gas standard volume

HYSTRSIS Hysteresis

INTERN Internal

IO Input/output

LANG Language

LOCK Write-protect

LOOP CUR Loop current

M_ASC Modbus® ASCII

M_RTU Modbus® RTU

MAO1 mA Output 1
(primary mA Output)

MAO2 mA Output 2
(secondary mA Output)

MASS Mass flow

MBUS Modbus

MFLOW Mass flow

MSMT Measurement

MTR F Meter factor

OFF-LINE MAINT Off-line maintenance

OFFLN Off-line

P/UNT Pulses/unit

POLAR Polarity

PRESS Pressure

QUAD Quadrature

r. Revision

SCALE Scaling method
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Table D-3: Codes and abbreviations used in display menus (continued)

Code or
abbreviation Definition Comment or reference

SIM Simulation Used for loop testing, not simulation mode.
Simulation mode is not accessible through the
display.

SPECL Special

SRC Source Variable assignment

TEMP, TEMPR Temperature

UNT/P Units/pulse

VAR 1 Display Variable 1

VER Version

VERFY Verify

VFLOW Volume flow

VOL Volume, volume flow

XMTR Transmitter
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E Using ProLink III with the transmitter

E.1 Basic information about ProLink III
ProLink III is a configuration and service tool available from Micro Motion. ProLink III runs on a Windows
platform and provides complete access to transmitter functions and data.

Version requirements

Use the latest version of ProLink III and the device firmware to support all features. For details about ProLink III
device support, refer to the ProLink III ChangeLog.txt file.

ProLink III requirements

To install ProLink III, you must have:

• The ProLink III installation media

• The ProLink III installation kit for your connection type:

To obtain ProLink III and the appropriate installation kit, contact customer support.

ProLink III documentation

Most of the instructions in this manual assume that you are already familiar with ProLink III or that you have a
general familiarity with Windows programs. If you need more information than this manual provides, see the
Micro Motion ProLink III with ProcessViz Software User Manual.

In most ProLink III installations, the manual is installed with the ProLink III program. Additionally, the
ProLink III manual is available on the documentation CD or at Emerson.com.

ProLink III features and functions

ProLink III offers complete transmitter configuration and operation functions. ProLink III also offers a number
of additional features and functions, including:

• A Professional version with expanded features not available on the Basic version

• The ability to save the transmitter configuration set to a file on the PC, and reload it or propagate it to
other transmitters

• The ability to log specific types of data to a file on the PC

• The ability to view performance trends for various types of data on the PC

• The ability to connect to and view information for more than one device

• A guided connection wizard

These features are documented in the Micro Motion ProLink III with ProcessViz Software User Manual. ProLink III
features are not documented in this manual.

ProLink III messages

As you use ProLink III with a Micro Motion transmitter, you will see a number of messages and notes. This
manual does not document all of these messages and notes.
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Important
The user is responsible for responding to messages and notes and complying with all safety messages.
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F Using a field communicator with the
transmitter

F.1 Basic information about field communicators
A field communicator is a handheld configuration and management tool that can be used with a variety of
devices, including Micro Motion transmitters. It provides complete access to transmitter functions and data.

Field communicator documentation

Most of the instructions in this manual assume that you are already familiar with field communicators and can
perform the following tasks:

• Turn on the field communicator

• Navigate the field communicator menus

• Establish communication with HART®-compatible devices

• Send configuration data to the device

• Use the alpha keys to enter information

Field communicator menus and messages

Many of the menus in this manual start with the On-Line menu. Ensure that you are able to navigate to the On-
Line menu.

As you use a field communicator with a Micro Motion transmitter, you will see a number of messages and
notes. This manual does not document all of these messages and notes.

Important
The user is responsible for responding to messages and notes and complying with all safety messages.

F.2 Connect with the FF host
A connection from the FOUNDATION Fieldbus host to your transmitter allows you to read process data,
configure the transmitter, and perform maintenance and troubleshooting tasks.
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G Default values and ranges

G.1 Default values and ranges
The default values and ranges represent the typical factory transmitter configuration. Depending on how the
transmitter was ordered, certain values may have been configured at the factory and are not represented in
the default values and ranges.

Table G-1: Transmitter default values and ranges

Type Parameter Default Range Comments

Flow Flow direction Forward

Flow damping 0.8 sec(1) 0.0 – 51.2 sec User-entered value is corrected
to the nearest valid value in list
of preset values.In Special mode,
the preset values are 1/5 normal.
For gas applications, a minimum
value of 2.56 is recommended.
The 2.56 value will be
automatically rounded up to 3.2
seconds.

Flow calibration factor 1.00005.13 For sensors, this value represents
the FCF and FT factors
concatenated.

Mass flow units g/s

Mass flow cutoff Sensor-specific
value set at
factory

For most sensors, the typical
setting is 0.05% to 0.10% of the
sensor's rated maximum flow
rate. For some sensors, the
setting may be higher.

Volume flow type Liquid

Volume flow units L/s

Volume flow cutoff 0/0 L/s 0.0 – x L/s x is obtained by multiplying the
flow calibration factor by 0.2,
using units of L/s.

Meter factors Mass factor 1

Density factor 1

Volume factor 1

Density Density damping 1.6 sec 0.0 – 51.2 sec User-entered value is corrected
to nearest valid value in a list of
preset values.

Density units g/cm3

Density cutoff 0.2 g/cm3 0.0 – 0.5 g/cm3

D1 0 g/cm3

D2 1 g/cm3
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Table G-1: Transmitter default values and ranges (continued)

Type Parameter Default Range Comments

K1 1000 µsec 1000 – 50,000
µsec

K2 50,000 µsec 1000 – 50,000
µsec

FD 0

Temp Coefficient 4.44

Two-phase
flow

Two-phase flow low limit 0.0 g/cm3 0.0 – 10.0
g/cm3

Two-phase flow high limit 5.0 g/cm3 0. 0 – 10.0
g/cm3

Two-phase duration 0.0 sec 0.0 – 60.0 sec

Temperature Temperature damping 4.8 sec 0.0 – 38.4 sec User-entered value is corrected
to nearest valid value in a list of
preset values.

Temperature units Deg C

Temperature calibration factor 1.00000T0.000
0

Pressure Pressure units PSI

Flow factor 0

Density factor 0

Cal pressure 0

Special units Base mass unit g

Base mass time sec

Mass flow conversion factor 1

Base volume unit L

Base volume time sec

Volume flow conversion factor 1

LRV Mass flow rate −200.000 g/s

Volume flow rate −0.200 L/s

Density 0.000 g/cm3

Temperature −240.000 °C

Drive gain 0.000%

Gas standard volume flow rate −423.78SCFM

External temperature −240.000 °C

External pressure 0.000 psi

URV Mass flow rate 200.000 g/s
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Table G-1: Transmitter default values and ranges (continued)

Type Parameter Default Range Comments

Volume flow rate 0.200 L/s

Density 10.000 g/cm3

Temperature 450.000 °C

Drive gain 100.000%

Gas standard volume flow rate 423.78 SCFM

External temperature 450.000 °C

External pressure 100.000 psi

Display Backlight on/off On

Refresh rate 200
milliseconds

100 – 10,000
milliseconds

Variable 1 Mass flow rate

Variable 2 Mass total

Variable 3 Volume flow
rate

Variable 4 Volume total

Variable 5 Density

Variable 6 Temperature

Variable 7 Drive gain

Variable 8–15 None

Display totalizer start/stop Disabled

Display totalizer reset Disabled

Display auto scroll Disabled

Display offline menu Enabled

Display offline password Disabled

Display alarm menu Enabled

Display acknowledge all alarms Enabled

Offline password 1234

Auto scroll rate 10 sec

(1) In Special mode, the default value is 0.64 sec.

Configuration and Use Manual Default values and ranges
20000326 August 2022

Configuration and Use Manual 295



Default values and ranges Configuration and Use Manual
August 2022 20000326

296 Micro Motion 2700 Transmitters with FOUNDATION Fieldbus



H Transmitter components and installation
wiring

H.1 Installation types
The transmitter was ordered and shipped to be installed in one of several possible configurations.

Figure H-1: Integral installation

The transmitter is mounted directly to the sensor. Integral installations do not require separate transmitter
installation. Power supply must be field wired to the transmitter.

A. Transmitter
B. Sensor
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Figure H-2: High-temperature meters with factory connection

The transmitter is shipped with a flexible connection factory installed between the sensor and the transmitter.
The transmitter must be dismounted from its shipping location (spot-welded to the sensor case) and then
mounted separately. Power supply must be field wired to the transmitter.

A. Sensor
B. Transmitter or core processor
C. Factory-installed flexible connection

Figure H-3: 4-wire remote installation for Coriolis meters

The transmitter is installed remotely from the sensor. The 4-wire connection between the sensor and
transmitter must be field wired. Power supply must be field wired to the transmitter.

A. Transmitter
B. Field-wired 4-wire connection
C. Core processor
D. Sensor
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Figure H-4: 4-wire remote installation for density and viscosity meters (CDM, FDM, or FVM with
fieldbus only)

The transmitter is installed remotely from the Compact Density Meter (CDM), Fork Density Meter (FDM), or
Fork Viscosity Meter (FVM). The 4-wire connection between the sensor and transmitter must be field wired.
Power supply must be field wired to the transmitter.

A. Transmitter
B. Field-wired 4-wire connection
C. Meter electronics

Figure H-5: 9-wire remote installation

The transmitter and core processor are combined in a single unit that is installed remotely from the sensor.
The 9-wire connection between the transmitter/core processor and the sensor must be field wired. The power
supply must be field wired to the transmitter.

A. Transmitter
B. Field-wired 9-wire connection
C. Junction box
D. Sensor
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Figure H-6: Remote core processor with remote sensor installation

The transmitter, core processor, and sensor are all mounted separately. The 4-wire connection between the
transmitter and core processor must be field wired. The 9-wire connection between the core processor and
the sensor must be field wired. The power supply must be field wired to the transmitter. This configuration is
sometimes called double-hop.

A. Junction box
B. Sensor
C. Transmitter
D. Field-wired 4-wire connection
E. Core processor
F. Field-wired 9-wire connection

H.2 Power supply terminals and ground
Figure H-7: Power supply wiring terminals

A. Warning flap
B. Equipment ground
C. Power supply wiring terminals (9 and 10)
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H.3 Fieldbus wiring terminals

A. FOUNDATION Fieldbus
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I NE53 history
Operating instructions within this document are English versions. Instructions in other languages have
different part numbers but matching revision letters.

Date Version Type Change Operating
instruction

09/2000 1.0 Initial
Product
Release

N/A 3600326 A

06/2001 2.0 Feature Feature additions:

• Backlink active scheduler (LAS)

• PID function block

• Analog output function block for pressure
compensation

• Support for pressure compensation to the transducer
block (TB)

• Drive gain as a selectable channel for AI blocks

• Ability to enable fieldbus siulate mode through the
service port

3600326 B

Expansion Support to configure the process variable units for mass
flow, volume flow, density, and temperature from the
display

Adjustment Clarified the interaction of the digital fault setting and the
last measured value timeout

02/2002 2.2 Feature Added protections against low power conditions 3600326 C

Adjustment • Improved handling of RS-485 communication through
the service port

• Improved display

07/2004 3.x Feature Feature additions:

• Petroleum measurement application

• Gas standard volume functionality

• Enhanced density application

• Support for enabling fieldbus simulation mode through
the display

• Support for 32-character tagnames configurable
through Modbus

• Supoort for Analog Input Block configurable through
Modbus

3600326 D
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Date Version Type Change Operating
instruction

Expansion • Software version information available either through
the display or through Modbus

• Totalizers can be disabled, in addition to starting and
stopping

• Doubled the number of virtual communication
relationshups (VCRs)

Adjustment • Improved handling of AI block status when slug flow is
detected

• Some fieldbus parameters made persistent across
power resets

• Introduced finer-grained control over operator access
to display functions

06/2007 4.0 Feature Feature additions:

• Configurable alarm severity

• Additional support for gas standard volume
functionality

• Meter verification as an option

• Multiple display language selections

• PlantWeb Alerts II

• Ability to enable simulate mode through the Device
Information TB

• Default value for AI1 block: mass flow in g/s

• Default value for AI2 block: temperature in °C

• Default value for AI3 block: density in g/cm3

• Default value for AI4 block: volume flow in l/s

3600326 D

Expansion • Added Temperature and density units to API TB

• Added additional configuration ability for the display

01/2008 5.0 Feature Feature additions:

• Support for Meter Verification AMS Snap-On

• Extra security for local display off-line menu access

3600326 EA

Adjustment • Improved handling of Gas Standard Volume cutoffs

• Improved local display functionality for API and
concentration measurement variables

03/2009 5.1 Adjustment Resolved non-volatile memory(NVM) reliability issue
present in version 4.0 and version 5.0.

3600326 EA
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Date Version Type Change Operating
instruction

06/2010 6.0 Adjustment • Smart Meter Verification

• Improved representation of gas volume on local display

• Harmonized behavior of gas volume density parameter
with other gas

• Standard volume parameters

3600326 EA

07/2012 7.0 Adjustment • Added DI channels to increment the Concentration
Mass Curve

• Added Special units support for both Mass Flow and
Volume Flow

• Moved mass flow, volume flow, and density limit
parameters from the Device Info TB to the
Measurement TB

• Added alarms A6, A22, A23, and A24 to alarm status
information

3600326 EB

02/2015 8.0 Feature • Added Density Viscosity core support

• Added Density Viscosity core-related AI channels

• Made units local to respective TBs to avoid cross-block
communication

3600326 EC

05/2017 9.0 Adjustment Density Viscosity phase 2 changes:

• Restricted Velocity unit codes to ft/sec and m/sec

• Decoupled API referred density unit from Density units

• Added Pressure input type selection for Density
Viscosity cores

• Abbreviated parameter labels for DD4

3600326 ED

08/2022 10.0 Adjustment Updated SMV documentation to add or clarify the
following sections:

• SMV test preparation

• Smart Meter Verification capabilities

• Interpreting Smart Meter Verification results

• Resolving a failed Smart Meter Verification test

Added Transducer blocks and views overview topic to
Appendix A.

3600326 EE
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